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Copyright 2011
Attorneys’ Title Fund Services, LLC. 

All Rights Reserved.

“The Fund” is a registered trademark of Attorneys’ Title Insurance Fund, Inc. and is 
used by permission. All references herein to title insurance policy forms and 
endorsements refer to the policy forms and endorsements issued by Fund Members as 
duly appointed title agents of Old Republic National Title Insurance Company.
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Introduction
Introduction

DoubleTime Overview
DoubleTime is a complete, comprehensive, and flexible closing software package that 
was designed by experienced closing agents. It is the only software available that 
perfectly matches your needs, with full automation and total integration. Features 
include:

• Single point data entry that links all documents and eliminates repetitive 
typing.

• Accommodates unlimited parties, properties, and loans in most transaction.
• Database driven for flexibility and adaptability.
• Electronic filing of Fund commitments, policies, and electronic payments.
• Order and receive Fund Branch Products electronically.
• Superb technical support. 

Easy to learn and use, DoubleTime was created by The Fund and is designed for 
Microsoft Windows®. DoubleTime can be used in a network environment or on a 
stand-alone workstation. It allows staff to work faster and more efficiently.
NOTE: The Help Desk may be reached at 1-800-421-9378.  You may also email the 
Help Desk at helpdesk@thefund.com.

About This Workbook
This student workbook is designed for individuals with real estate closing knowledge 
and experience, as well as a basic knowledge of Windows. 
Each lesson has three sections:

Concept: The concept explains the purpose of the module and its relationship to 
the closing. 

Objective:The objective for each lesson is the particular task or set of tasks you 
will learn. 

Lesson: Lessons are step-by-step instructions designed to walk you through the 
module. They provide hands-on experience using DoubleTime.

In addition to the regular lessons, practice sessions are included. The practice sessions 
are given where additional hands-on experience might be helpful. The practice 
sessions may be covered in the class, if time permits, or you may work on them at your 
office.
This workbook was produced by the Product Training Team at The Fund. The Product 
Training Team serves The Fund’s mission by providing exceptional education, training 
and support needed to develop real estate professionals’ knowledge, skills, and 
abilities. You may contact this unit by phone at 888-407-7775 or by email at 
educationregistrar@thefund.com. The Member Support Representatives who provide 
hands-on training for the DoubleTime application are part of the Product Training 
Team. 
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Introduction
“The Fund” is a registered trademark of Attorneys’ Title Insurance Fund, Inc. and is 
used by permission. All references herein to title insurance policy forms and 
endorsements refer to the policy forms and endorsements issued by Fund Members as 
duly appointed title agents of Old Republic National Title Insurance Company. 

About The Examples Used
For the lessons in this workbook, the following information has already been entered 
in your DoubleTime database.

Firm name:Richard P. Bruce, Esq.
Address: 5955 T.G. Lee Blvd. 

Orlando, FL 32828
Phone No.:(407) 555-5000

A common real estate closing scenario is used to illustrate how the DoubleTime 
program works. The information for this scenario is:

You are an employee for the law firm of Richard P. Bruce, Esq. You have been given a 
real estate contract for sale and purchase, with the attorney acting as the closing agent.

• Open a closing file and process the closing information.
• Prepare, print, and electronically request a title insurance commitment jacket 

through Old Republic National Title Insurance Company /ATFS.
• Prepare the Policy Rating Worksheet.
• Create a Closing Disclosure Settlement Statement.
• Track deposits and disbursements.
• Prepare the Deed, Bill of Sale, and other documents.
• Produce the 1099-S.
• Prepare, print, and file electronically an owner’s and mortgagee policy through 

Old Republic National Title Insurance Company /ATFS.
• Add file notes.

In this workbook, you are provided with the information you need to complete these 
tasks. 

Starting DoubleTime

 From the Start menu, click All Programs > The Fund > DoubleTime > 
DoubleTime (Version).  Or, if you have a shortcut on your desktop, doubleclick the 
icon.
Page 4 DT Version: 8.1



Introduction
Conventions
The following conventions are used in this workbook. 

Convention Meaning
Bold characters Text that identifies all or part of a DoubleTime window or 

instructs you to type information is represented by Arial 
font in bold. All other text is Times New Roman.

Choose Pick an item (button or a menu item) to initiate an action. 
Windows supports more than one method to accomplish an 
action. For example, you could click a specific button and 
press ENTER. Choose is used when the method is not 
important for the discussion.

Click Use the mouse to position the pointer over a button in a 
dialog box, then press and release the left mouse button. For 
example, “click OK” means position the pointer over the OK
button, then press and release the left mouse button.

Key names The names of keys with special functions that you press on 
the keyboard are in all CAPITAL letters. For example, use 
the TAB key to move to the DATE box and type 3/22/16. 

Select Pick one or more items for processing. For example, select 
the name(s) from the list.
Training Workbook: August 2018 Page 5



Introduction
Windows Terms
The following figure shows a typical DoubleTime window with the terms used in this
 workbook.
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Introduction
Term Function

Title Bar Displays the DoubleTime name and the name of the active 
closing file.

Menu Bar Displays the DoubleTime menu. Click a command to use it. Or 
use the keyboard with the underlined letter in the command 
name.

 To use an underlined letter:
1. Press and hold the ALT key on your keyboard.
2. Press and release the underlined letter.
3. Release the ALT key. 

Main Toolbar Displays buttons used to start DoubleTime modules. Click the 
button to start a module. Or use the Modules menu on the 
menu bar. 

Secondary Toolbar A secondary toolbar is also displayed for each of the 
DoubleTime modules. Each button performs a unique task. 
Click the button to complete a task. For a complete list and 
description of all the DoubleTime buttons, refer to the 
Reference Tables section of this Workbook. 

Tabs Many of the windows are divided into tabs. Tabs, like the folder 
tabs used in a filing system, group similar functions. Each tab 
opens a new window. Click a tab to display the window. 

Boxes Boxes are areas where you can select or type information. Only 
boxes with a white background can be changed. Information 
that is displayed in gray boxes cannot be changed in the active 
module.

 
Example 1: To enter text into this box, click the box and type 
the information. In this example, you would type the last name 
in the box.

Example 2: To enter text into this box, click the down arrow to 
the right and select information from a list.
Training Workbook: August 2018 Page 7



Introduction
Windows Shortcut
A useful Windows shortcut to remember while working in DoubleTime is to press 
ALT + TAB to switch between DoubleTime and another open Windows application on 
your desktop.

Term Function

Option Buttons Use an option button to select a single item from a group of 
mutually exclusive items. To select an option, click the circle 
next to it. A black dot appears in the circle. Any previously 
selected option is cleared. 

Example: In this example, Female is selected from the Gender 
options.

Check Boxes Use a check box to select one or more items in a group. To 
select an item, click the box next to it. A check mark is 
displayed in the box. To clear a check box, click it again.

Status Bar The Status Bar displays information about the program. For 
example, as you move the pointer over the buttons, a 
description of the button is displayed on the Status bar.
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Introduction
General Information

Additional Assistance. From the Help menu on the main menu bar of the DoubleTime 
application you have access to many different tools that can further assist you with any 
problems that may arise when working in the application. These tools include:  
Workbooks (Downloadable PDF copies of the most current version of this Training 
Workbook and Escrow Accounting workbook are available. Note: Having the 
workbooks downloaded to your computer enables you to search for answers to 
questions using Adobe’s search tool.) Release Notes (The Release Notes provide 
you a list of the changes that have occurred with the current version of DoubleTime 
that you have installed. These release notes may provide you with quicker and easier 
ways to complete tasks as well as enhancements that are made to the application.) For 
your convenience, interactive and downloadable PDF copies of Fund Title Notes & 
SCC Handbook and Fund Procedures Handbook are available. DoubleTime 
Broadcast Messages - DoubleTime now has internal messaging built in so 
important product information can be communicated directly to you. When 
DoubleTime opens, notifications such as when a new version is available will be 
streamed directly to your PC. DoubleTime Support Website is a quick link to the 
DoubleTime Support Center. You have access to new enhancements, FAQ’s, 
training videos and the latest software version downloads. On-Demand Videos - 
Discover what DoubleTime has to offer and more by going to The Fund’s On-
Demand Training Library to view the full “DoubleTime Training Class”, 
“DoubleTime Customization” or “DoubleTime Quick Tips” videos to get answers 
quickly. You may view the learning videos at your pace and convenience. Access the 
videos thru DoubleTime or at www.thefund.com/ondemand from different types of 
devices (PC, Laptop, iPhone, iPad, etc.). Tutorials - There are DoubleTime tutorials 
built into the DoubleTime application to assist you in completing many tasks such as 
creating a Fundnet ID and password, DoubleTime/ATIDS Integration, DoubleTime 
electronic payments, etc. 
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Introduction
The Fund’s Website
The Fund provides support for members via its website www.thefund.com. This is 
your source for Fund products and services, as well as information relevant to a real 
estate law practice. The Product Support section can be accessed for technical support, 
product updates, and the latest news for select Fund products. Simply click Support 
in the top navigation bar, and then click DoubleTime from the list of products.

To use the eSolutions for Fund Forms features within DoubleTime, Electronic 
Delivery and Electronic Serial Numbers, the office administrator must grant each 
individual user the appropriate rights. Your office administrator controls access 
rights to eSolutions features for your office staff by logging into the admin page of 
the FundNet web site.
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Closing File Module
 Closing File Module

Concept
The Closing File module is an electronic equivalent to your closing file folder. It is 
the starting point for collecting general file details such as buyers, sellers, property, 
deposits, loan information, and closing and title agents. Participants and notary fields 
are also established.
When you modify the closing file information, you automatically update the 
information in other modules such as Title Insurance, Settlement Statements,
and Documents.
The Closing File module also interacts with the Contacts and Master Property
modules. The Contacts module is the electronic card file of all the persons and 
service providers you do business with. Throughout your closing file, you can select 
from stored contact names or add new contacts.
The Master Property module allows you to store and maintain legal descriptions, 
recording information, and title exception information for real property. When you 
have multiple closing files pertaining to a property (such as a subdivision or 
condominium), it is particularly useful to have access to this information for repeated 
use in those files. You can create master properties for closings that require common 
information. From the Closing File module, you may enter new property information 
for use in that file alone, or select property information entered using the Master 
Property module and copy that information to any closing file for reuse.

Objective
The objective of this lesson is to show you how to create a new closing file by adding 
information and selecting existing information to copy to your file. You will also learn 
how to print a closing file worksheet.

Creating A New Closing File
In this session, you will create a new closing file establishing the parties involved, 
along with the property and loan information.
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Closing File Module
.
What You Do Comments

1.  On the main toolbar, 
click the New Closing 
File button.

The General tab of the Closing File
window is displayed. Date Opened defaults 
to today’s date. The Status box defaults to 
Open. You can change this value to Closed
or Cancelled. The Type box defaults to 
Sale. You can change this value to 
Refinance. 

2. In the Closing File No.
box, type your name.

You assign a number to the new file. You can 
type up to 15 characters, letters, numbers, and 
some symbols. NOTE: The closing file 
number allows you to search for a file by the 
number or name you assign.

3. Click the Sales Price box 
and type 225000.

The comma, decimal point, and dollar sign are 
automatically inserted.

4. Click the Account No.
box and select 123456-78 
Friendly Bankers, Inc.

This is the closing agent’s trust/escrow 
account. Account numbers are entered in 
Preferences/Account Maintenance. Selecting 
the trust/escrow account allows you to export 
the deposits and disbursements to Quicken®, 
QuickBooks®, Dapix®, and Perfect Practice®. 
Selecting the trust/escrow account will also 
allow you to post or post and print your 
checks through the DoubleTime Escrow 
Accounting feature.
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Closing File Module
5. In the Dates section, click 
the down arrow to the 
right of the Closing box.

The monthly calendar is displayed with 
today’s date selected. Click the right arrow
to display the next month. Click the left 
arrow to display the previous month.    

6. Click the appropriate 
arrow at the top of the 
calendar to display March.

The closing takes place in March.

7. Click on day 17 in the 
calendar.

The selected date is displayed in the Closing, 
Disbursement, and Proration boxes. 
These dates are editable. Taxes Paid Thru date 
defaults to 12/31 of the previous year, except 
during the month of December, when it 
defaults to 12/31 of the closing date year.

8. Click the down arrow to 
the right of the Contract
box.

The calendar displays today’s date.

9. On the Contract box 
calendar, click the 
appropriate arrow to 
display February of the 
current year.

The contract will be fully executed on 
February 14.

10. Click on day 14 in the 
calendar.

The date the contract was fully executed, 02/
14/(current year), is displayed in the 
Contract box. This date is editable.

What You Do Comments
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Closing File Module
Adding The Buyer - New Contact 

NOTE: (1) Source File - This field is unavailable. DoubleTime allows the 
user to copy closing files. Once the user has selected the file to copy, 
DoubleTime will populate the Source File number, and it will not allow the user 
to make any changes to this field. (2) Branch - For offices with more then one 
location, the user may enter all of the office locations in the Maintenance 
(Lists) Module. Doing so will populate the list of office locations in the 
Branch field, allowing the user to select from the drop down menu the office 
location for the transaction. (3) Import File Number - This field is 
unavailable. DoubleTime populates this information when importing a Fund 
Branch Title Commitment. (4) Voucher Reference - Only for DoubleTime 
Escrow Accounting users. This field allows the user to add additional 
tracking data to checks printed from DoubleTime Escrow Accounting
Module. (5) Rating Type - This field affects the Premium Calculation 
(Rating) Module. Selecting the Mortgage Modification option will disable the 
Commitment Module. Changing the Rating Type after the Commitment 
Module has been activated, will remove the Title Commitment from the 
Documents Module and deactivate the Commitment Module. 

What You Do Comments
1. Click the Buyer tab. The Buyer tab is displayed. No information 

is shown at this time. A “US Treasury OFAC 
Sanctions List Search” link is available to 
allow you to search the Specially Designated 
Nationals and Blocked Persons list.

What You Do Comments
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Closing File Module
 Tip: Whenever you come to a tab that 
has no information in it, use the Insert
button.

2.  On the secondary 
toolbar, click the Insert
button.

The Select Buyer window is displayed. The 
Contact Type defaults to Individual.

NOTE: Names that were previously entered 
are displayed in the Individual Name box.

3. In the Last box, type 
thomas.

This is the last name of the buyer. The first 
letter of the name will be capitalized 
automatically for Individual names.

4. TAB to the First box and 
type susan.

This is the first name of the buyer.

What You Do Comments
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Closing File Module
5. TAB to the Middle box
and type s.

This is the middle initial of the buyer. Be sure 
to include the period (.) when typing in an 
initial.

6. TAB to the SSN box and 
type the following: 
456 34 8795

This is the buyer’s social security number. 
The cursor automatically tabs to each field.

7. Click Add Contact. The Select Buyer dialog box is displayed, 
asking if you wish to add a mailing address.

8. Click Yes. The Address tab is displayed. The address 
Type defaults to Mailing Address.

9. In the Street box, type  
1 Southern Place.

This is the buyer’s mailing address. This 
address is generally the address of the 
property to be purchased. The information 
entered here is carried over as a selection on 
the Property Address tab.

What You Do Comments
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Closing File Module
10. In the Postal code box,
type 32828 and press 
TAB. Then, click the City
down arrow to select 
Orlando from the list.

The City, State, and County boxes are filled 
with information for the postal code you 
entered. 

NOTE: Cities and/or municipalities 
associated with a specific postal code will 
appear as a selection in the drop down.

11. Click OK. The Select Buyer window closes and the 
Buyers tab is re-displayed with Susan S. 
Thomas added to the closing file. NOTE:
Susan S. Thomas is also added to the 
Contacts module Individual Name list. To 
change the spelling of a buyer or seller name, 
double-click the name, make changes in the 
Name Change window, and click OK. The 
Update window displays the New Name(s) 
and Proposed Revisions. The names will be 
updated automatically throughout the 
Closing File and Contacts modules.

What You Do Comments
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Closing File Module
12. In the Gender section, 
click Female.

This selection denotes the buyer’s gender.

13. Click the Marital box and 
select Single.

This selection denotes the buyer’s marital 
status.

14.  On the secondary 
toolbar, click the Insert 
Name Clause button.

The Insert Name Clause window for 
Susan S. Thomas is displayed. It is 
necessary to complete the Name(s) with 
Status box for Susan S. Thomas for her 
name to display on other modules and on 
documents. NOTE: If the Name(s) with 
Status box is not completed, a message will 
display a reminder to complete this 
information when a save is initiated.

15. Click the Format box, and 
select single woman.

The tenancy phrase, Susan S. Thomas, a 
single woman is displayed in the Name(s) 
with Status box. This is an editable field. 
NOTE: This tenancy phrase is used in other 
modules and on your documents. It can be 
edited.

16. Click OK. The Insert Name Clause window closes 
and the Buyer tab is displayed with the 
tenancy clause in the Name(s) with Status
box. This is an editable field. 

What You Do Comments
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Closing File Module
17. Click the Phone tab. The Phone tab is displayed.

18. Click the Type box and 
select Home.

This selection identifies the phone type.

19. Click the Area box and 
type: 
407 889 3928

This is the buyer’s phone number. The cursor 
automatically tabs to each field.

20.  On the secondary 
toolbar, click the Insert
button.

Another phone field is displayed. The Insert
button has different functions in the Closing 
File module depending on where the cursor is 
located when you select it.

If the cursor is in the top 
half of the screen, a field 
is added here.

If the cursor is in the 
bottom half of the 
screen, a field is added 
here.

21. Click the Type box and 
select Cell.

22. Click the Area box and 
type: 
407 809 1986

23. Click the Email tab. The Email tab is displayed.

24. Click the E-Mail 
Address box and type: 
susanthomas@ 
email.com

The default type is E-mail Address. You 
may select the appropriate type from the 
Service Type drop down list.

What You Do Comments
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Closing File Module
Adding The Seller - Existing Contact 
What You Do Comments

1. Click the Seller tab. The Seller tab is displayed. No information is 
shown at this time.

2. On the secondary 
toolbar, click the Insert
button.

The Select Seller window is displayed. The 
Contact Type defaults to Individual. 

3. In the Last box, type 
glenn.

Linda Glenn is highlighted in the 
Individual Name list. Names are listed in 
alphabetical order.

4. Tab to the First box  
and type p.

Peter R. Glenn’s name is highlighted. 

5. Click OK. The Select Seller window is closed and the 
Seller tab is re-displayed. Peter R. Glenn is 
displayed with information that was entered 
previously.

6.  Click the 
Spouse button.

Linda Glenn is displayed, as previously 
entered in the Contacts module, along with the 
address and phone number information. 
NOTE: The spouse’s mailing and phone 
information can be changed if it differs from 
the partner’s.
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Closing File Module
7. Click Peter R. Glenn. Peter R. Glenn will appear first in the 
Name(s) with Status box and on the 
documents. NOTE: Prior to using Insert 
Name Clause button, it is necessary to 
select the name to appear first in the Name(s) 
with Status box.

8.  On the secondary 
toolbar, click Insert 
Name Clause button.

The Insert Name Clause window for 
Peter R. Glenn is displayed, with Linda 
Glenn shown as the Spouse.

9. Click the Format box and 
select husband and 
wife.

The tenancy phrase, Peter R. Glenn and 
Linda Glenn, husband and wife is 
displayed in the Name(s) with Status box.
This is an editable field.

10. Click OK. The Insert Name Clause window is closed 
and the Sellers tab is redisplayed with the 
tenancy phrase in the Name(s) with Status 
box. This is an editable field.

What You Do Comments
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Closing File Module
Adding Property Information
What You Do Comments

1. Click the Property tab. The Property tab is displayed. No 
information is shown at this time.

2. On the secondary 
toolbar, click the Insert
button.

The Master Property Search Selection 
window is displayed. The State and County 
default to Florida and Orange.  NOTE: The 
county default can be changed in 
Preferences > User Settings > General 
tab.
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Closing File Module
3. In the Required section, 
click Subdivision.

This selection will reference subdivisions 
only.

4. Click New. The Master Property Search Selection
window is closed and the Property tab is 
redisplayed. You can now enter the property 
information for this closing file.

NOTE: If you are using the Master Property feature, you may click the 
Browse button. The Master Property Search Selection window displays 
all previously entered subdivisions in the Master Property module. Select a 
previously entered Master Property from the list and click OK.  The Master 
Property Search Selection window is closed and the Property tab is 
redisplayed with previously entered information for the selected property.

What You Do Comments
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Closing File Module
5. Type 14-23-27-8226-
00040 in the PIN box.

This will complete the Property 
Identification Number for the property. 
This number is assigned to the property by the 
property appraiser’s office.

6. Type Southern Acres 
Subdivision in the 
Property Name box.

This will complete the Property Name for 
the property. 

7. In the Address tab, click 
the arrow in the Street
box and select 1 
Southern Place from the 
drop down list.

The property address information is 
displayed. The Street information is carried 
over from the Buyer tab. NOTE: Buyer and 
Seller addresses within the state of Florida 
only will display for selection.

What You Do Comments
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Closing File Module
8. Click the Details tab. The Details tab is displayed.

9. In the Lot box, type 4. Type information on this tab to allow 
searching for an existing closing file by lot, 
block, unit, and/or building number in the 
Closing File Selection window next time 
you need to access this file.

10. Click the Legal tab.

11.  Click the Clause 
Library button on the 
secondary toolbar.

The Clause Library window is displayed 
with Clause Titles and Clause Text. The 
Clause Type defaults to Legal and All 
Clauses are automatically selected.  When a
Clause Title is selected, the clause text is 
displayed in the Clause Text box.

What You Do Comments
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Closing File Module
12. Click on Plat under 
Clause Title and click 
OK.

The Clause Library window is closed and 
the Plat Clause is added. This information is 
editable.

13. In the Plat clause, replace 
the first set of asterisks 
with 4.

This is the lot number for the property.

14. In the Plat clause, delete 
the word Block, the second 
set of asterisks and the 
comma.

What You Do Comments
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Closing File Module
15. Replace the third set of 
asterisks with Southern 
Acres Subdivision.

This is the subdivision name for the property.

16. Replace the asterisks after 
the word Book with 31 and 
after Page with 68.

This is the book and page number where the 
subdivision is recorded.

17. Replace the last set of 
asterisks with Orange.

This is the county for the property.

18. Click the Usage tab. The Usage tab is displayed. NOTE: The 
Improvement Description box is used to 
identify any improvements to the property, 
such as a building being constructed on vacant 
land. It is an informational field only.

19. Click the Usage arrow 
and select Single Family 
Dwelling.

NOTE: For Miami-Dade County: Selecting 
Single Family Dwelling in the Usage tab 
eliminates any calculations on the Settlement 
Statements regarding documentary stamp 
surtax.

20. Click the Remarks tab. The Remarks tab is displayed. Notes may be 
added with information such as HOA contact 
information. 

What You Do Comments
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Closing File Module
Storing The Deposit Information

21. Click the Declaration tab. NOTE: Use the Declaration tab when 
preparing loan documents to enter the 
Declaration information for the PUD Rider.

22. Click the Recording tab. The Recording tab is displayed. 

23. Click the Book Type
arrow and select Plat.

The property, Southern Acres 
Subdivision, is recorded in a plat. This 
information also flows to the Closing File 
Worksheet. 

24. In the Book No. box, type
31.

This is the book number where the 
subdivision is recorded. 

25. In the Starting Page No.
box, type 68.

This is the page number where the subdivision 
is recorded.

What You Do Comments
1. Click the Deposit tab. The Deposit tab is displayed. No information 

is shown at this time.

2. On the secondary 
toolbar, click the Insert
button.

The deposit information line is displayed. 

What You Do Comments
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Closing File Module
Adding A Lender - Existing Contact

3. Click the Deposits Held 
By box and select 
Buyer’s Broker.

The Search Contact window is displayed. 
The Contact Type defaults to Corporation
and the Service Provided defaults to Real 
Estate Brk. NOTE: Previously entered Real 
Estate Brokers display in the Legal Entity 
Name box. Any new contact added here will 
be associated as providing real estate broker 
services.

4. Select Realty Company, 
Inc. and click OK.

The Search Contact window is closed and 
the Deposits tab is redisplayed with Realty
Company, Inc. added to the closing file.

5. Click the Amount box 
and type 45000.

This is the amount of the deposit received 
with the contract. The Received Date is the 
Contract date entered on the General tab 
and is an editable field. NOTE: Any 
additional deposits required by the contract 
will also be entered here.

What You Do Comments
1. Click the Loan tab. The Loan tab is displayed. No information is 

shown at this time.
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Closing File Module
2. On the secondary 
toolbar, click the Insert
button.

The Select Lender window is displayed. 
The Contact Type defaults to 
Corporation. Service Provided defaults 
to Lender. 

3. Select Bank of Florida
and click OK.

The Select Lender window is closed and 
the Loans tab is redisplayed with Bank of 
Florida added to the closing file.

What You Do Comments
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Closing File Module
NOTE: To Change a Lender. In the Closing 
File module, click the Loan tab, select the 
correct loan, and either double-click the 
Lender name or click the Update Lender
button. Add or choose a different lender from 
the Search Contact window. Deleting 
lender will result in Settlement Statement data 
being lost.

4. Click the Status box and 
select New.

This will denote a new loan.

5. Click the Priority box and 
select First.

This will denote a first mortgage.

6. Click the Type box and 
select Conv. Unins.

This will denote a conventional uninsured 
mortgage. NOTE: When Type ”Other” is 
selected you will be able to type in the loan 
type in the Type Description box.

7. Click the Original Loan 
Amount box and type 
180000. 
 
 
 

This is the mortgage amount. The comma and 
decimal point are automatically inserted. The 
Original Loan Amount applies to the new 
loan value. If the loan Status is a Payoff, the 
Original Loan Amount will also display on 
the Satisfaction of Mortgage in the 
Documents module.

8. Ensure Closing 
Disclosure is the 
Settlement Statement 
type selected.

The options for this field are HUD, HUD 
GFE and Closing Disclosure.
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Closing File Module
NOTE: (1) New closing files default to the Closing Disclosure format when 
a New loan is inserted for the transaction. New closing files without a loan 
default to the two page HUD-1. The other option in the Settlement 
Statement drop down menu is HUD-GFE. (2) The Settlement Statement 
type should be selected before any information/data is entered in the 
Settlement Statements module. (3) Another way to switch between 
Settlement Statement types is by using Format on the menu bar while in 
the Settlement Statements module. (4) Switching the Settlement 
Statement type after entering data in the Settlement Statements module 
will result in Settlement Statement data being lost. (5) If the address that 
populates for your lender is incorrect, you must check the drop down arrow for 
Street and toggle to the correct address.  If the correct address is not listed, go 
to the Contacts module for the lender and select the address tab. Click the 
Insert button to add a new address line. Close the Contacts module and re-
open the Closing File module.  You may now select the correct address from 
the drop down menu in the Loan tab.

9. Click the Terms tab. The Terms tab is displayed. 

10. Type 14583 in the Loan 
No. box.

This is the loan number given by the lender 
for this mortgage.

11. Click the Purpose arrow 
and select Purchase 
existing home, 
previously occupied.

The lender will supply you with this 
information.

12. Type Fixed Rate in the 
Product field.

The lender will supply you with this 
information.

What You Do Comments
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Closing File Module
13. Type 3.5 in the Interest 
Rate box.

NOTE: (1) When the interest rate is added 
here, the Per Diem amount in Section F-3 
(Pre-paid Interest) of the Closing 
Disclosure is automatically calculated. (2) 
For the interest rate to display as required on 
the Closing Disclosure Settlement 
Statement, the interest rate must be entered 
on the Terms tab of the Closing File
module. 

14. Click the Payment 
Interval arrow and select 
Monthly.

The lender will supply you with this 
information.

15. Type 360 in the # of 
payments box.

The lender will supply you with this 
information.

16. In the Days/Year section, 
click 365.

The lender will supply you with this 
information.

NOTE: Mtg. Ins. Sched. Termination Date is exclusively used for a loan 
transaction that requires mortgage insurance. 

NOTE: Prop.Val. Method and Prop. Val. Amount are exclusively used for 
a refinance transaction. 

NOTE: Loan Approval Due Date and Loan Approval checkbox are used 
to track the days left in the loan approval period. Enter the Loan Approval 
Period listed on the real estate contract. A Closing File By Loan Approval
report is available in the Reports module.  Once the loan is approved, checking 
the Loan Approval checkbox will remove the closing file from reflecting on 
the Closing File By Loan Approval report.
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Closing File Module
Adding The Payoff Lender - Existing Contact

NOTE: Exempt From Intangible Tax is used for loan transactions that do 
not require intangible taxes to be paid on the loan.           i.e. (Credit Union loans)

NOTE: Reverse Mortgage checkbox is used when the loan is a reverse 
mortgage. The appropriate compliance items will be reflected on page 3 of the 
GFE HUD.

What You Do Comments
1. Click anywhere in the top 

half of the window.
The Insert button is enabled.

2.  On the secondary 
toolbar, click the Insert
button.

The Select Lender window is displayed. 

3. Select First Eastern 
Bank and click OK.

The Select Lender window is closed and 
the Loan tab is displayed with First 
Eastern Bank added to the closing file.

4. Click the Status box and 
select Payoff.

This selection will denote a payoff of the 
seller’s mortgage. The Type defaults to 
Unknown and can be changed.

5. Click the Priority box and 
select First.

This will denote a payoff of the seller’s first 
mortgage. NOTE: The Original Loan 
Amount does not apply to the payoff 
amount. The payoff amount must be entered 
in the Settlement Statement module. The 
Original Loan Amount field is used if 
preparing a Satisfaction of Mortgage.
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Closing File Module
Viewing The Participants/Selecting Referrals
What You Do Comments

1. Click the Participant tab. The Participant tab is displayed. The
Lenders and Buyer’s Broker are displayed 
with their previously added addresses, phone 
numbers, email and license. The Buyer and 
Seller are assumed participants and their 
names do not appear.

Participants that need to be referenced in the 
Contact Information table listed on Page 5 
of the Closing Disclosure must be added in 
the Participant tab and the Type must be 
assigned. The default Type is Third Party. 
Third Party will NOT populate into the 
Contact Information table. The 
information with the Type (i.e. Buyer’s 
Agent, Buyer’s Broker, Seller’s Agent, 
Seller’s Broker, Loan Officer and 
Mortgage Broker) selected will be auto 
populated in the Closing Disclosure. The 
Settlement Agent populates from the 
Closing Agent tab in the Closing File 
Module.

Select the name and click the Individual 
button to display the employee(s) of the 
company. To display an employee’s name on 
the Participant tab, select the name and click 
OK. If the employee associated with this 
transaction is not displayed, click the New 
button. Click Cancel if you are only viewing 
the information.

To add another Participant, click the Insert 
button on the secondary toolbar. To change 
the Type of participant, click the drop down 
and make the selection.
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Closing File Module
2. Click the Referral box for 
Realty Company, Inc.

This shows the closing was referred to you by 
Realty Company, Inc. and is copied to the 
Referral report. 

NOTE: Realty Company, Inc. is already 
identified as the Buyer’s Broker in the 
Type column.

3. Click the Individual 
button for Realty 
Company, Inc.

This displays the employees of Realty 
Company, Inc.

4. Select Rick W. 
Robertson and click the 
OK button.

This adds Rick W. Robertson as a 
participant. Rick’s role type is automatically 
added.
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Closing File Module
5. Click on Bank of Florida
and then click the 
Individual button.

This displays the employees of Bank of 
Florida.

6. Select Thomas Price and 
click the OK button.

This adds Thomas Price as a participant. 
Thomas’s role type is automatically added.

7.  On the secondary 
toolbar, click the Insert
button.

The Select Participant window is 
displayed.

8. Click the Contact Type
down arrow and select 
Corporation. 

9. Type Better Homes, Inc. 
in the Name box and click 
the OK button.

This adds Better Homes, Inc. as a 
participant.

What You Do Comments
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10. Click the Type down 
arrow for Better Homes, 
Inc. and select Seller’s 
Broker.

11. Click the Individual 
button for Better Homes, 
Inc.

This displays the employees of Better 
Homes, Inc.

12. Select George Bigfoot 
and click the OK button.

This adds George Bigfoot as a participant. 
George’s role type is automatically added.
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Viewing The Closing Agent, Title Agent, And Prepared By

NOTE: When a participant is highlighted in blue on the top part of the window 
you may add address, phone, email and license information for the participant 
by selecting the appropriate tab in the bottom half of the window. Contact 
information may also be entered in the Contacts module. This information will 
display on the Contact Information table on Page 5 of the Closing 
Disclosure.

What You Do Comments
1. Click the Closing Agent 

tab and select Beth 
Cullum from the Closer 
down arrow.

The Closing Agent tab is displayed. The 
Company defaults to Richard P. Bruce, 
Esq. This information, along with the address 
and phone number, were previously entered in 
DoubleTime by selecting Preferences > 
User Settings from the menu bar. The Title 
for Beth Cullum was previously selected in 
the Contacts module.
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2. Click the CD Settlement 
Agent Contact down 
arrow and select Richard 
P. Bruce.

This identifies the person to be listed as the 
Settlement Agent contact on the Contact 
Information table on page 5 of the Closing 
Disclosure. If the CD Settlement Agent 
Contact is set to (None), the Closer
selection will be used on the Contact 
Information table on page 5 of the Closing 
Disclosure. The employees associated with 
your Closing Agent contact are listed in the 
drop down menu of the CD Settlement 
Agent Contact.

3. Click the Title Agent tab 
and verify Richard P. 
Bruce as the Signatory.

The Title Agent tab is displayed. The 
Company defaults to Richard P. Bruce, 
Esq. This identifies the person to sign the 
commitment & policies.

What You Do Comments
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Printing A Closing File Worksheet
What You Do Comments

1. On the secondary 
toolbar, click the Print
button.

The Print Options window is displayed 
with All pages selected and Number of 
copies is defaulted to 1.

2. Click OK. The Closing File Worksheet is printed for 
the active closing file.

3. On the secondary 
toolbar, click the Close
button.

The Closing File module is closed. NOTE:
A save is initiated each time a move is made 
to another tab. When closing a module, if a 
save has not been made, a message is 
displayed asking to save changes.

4. Verify Old Republic 
National Title 
Insurance Company/
ATFS as the 
Underwriter.

This is the underwriter used for this closing. 
The underwriter information was previously 
selected in Preferences/User Settings. 
NOTE: Additional underwriters can be added 
in the Contacts module.

5. Click the Prepared By 
tab and verify Richard P. 
Bruce as the Individual.

The Prepared By tab is displayed. The 
Company defaults to Richard P. Bruce, 
Esq. This identifies the person preparing the 
documents. The information will appear on 
recordable documents in the Prepared By 
and Return to sections. NOTE: If you are 
not changing the selections previously made 
in Preferences/User Settings, accessing 
the Closing Agent, Title Agent, and 
Prepared By tabs is not required.
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Tips

1.  The Signature/Notary button can be selected from any tab after the 
Buyer and Seller tabs have been completed. You can select the number of 
witnesses for each signatory or signature block on documents, as well as the 
ability to select witness names. Notary format can also be established and 
previewed. Access to Signature/Notary button can also be made from the 
Documents module. (See the Documents module in this workbook for 
detailed instructions.)

2.  To electronically generate a Closing Protection Letter, click the CPL
button on the secondary toolbar. The eSolutions Closing Protection 
Letter Delivery window displays. Click Next and complete the requested 
information on each screen until the View CPL button is displayed. Click 
View CPL and the Closing Protection Letter will be available for printing 
or to be saved. 

3.   To close any module, click the Close button on the secondary toolbar, 
or click the DoubleTime button on the module title bar and choose Close.

4.  To access another established closing file, click the Switch Active 
Closing File button on the main toolbar. In the Closing File Selection
window, you can use the buyer and/or seller name boxes and/or the property 
boxes when browsing to locate an existing closing file. Click Browse to 
display the listing of files. Select the file and click OK. The selected file 
number is displayed in the title bar and is now available for any of the 
DoubleTime modules. NOTE: Be sure all modules are closed before 
clicking the Switch Active Closing File button.

5. To search for your file by lot, block, unit, or building number, click the 
Property tab, then the Details tab and add this information when you first 
establish the closing file.

6.  To open the Closing File module for the active file, click the Open 
Closing File button on the main toolbar. An alternate way to open the 
Closing File module is to select Modules from the menu bar and choose 
Closing File. You can also use the shortcut, Ctrl+O from any window.

7. From the Closing File module, click the  Open button on the 
secondary toolbar to display the Closing File Selection window. To view 
all existing file numbers, click Browse. To open an existing closing file, 
select the closing file and click OK, or you can type in the search criteria in 
the boxes and click Browse to find the file, then OK.
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8. To add escrow accounts to the Account No. box on the General tab, 
select Preferences on the menu bar, and then choose Account 
Maintenance. Click the Insert button on the secondary toolbar and key in 
the necessary information. Click the Close button and click Yes to save the 
changes. To display the new account on the General tab of the Closing 
File module, click the Refresh button. Select the new account from the 
Account No. drop down list.

9.  To add a spouse in the Buyer or Seller tabs, click the Spouse
button. Enter the mailing address only if it differs from the partner’s address.

10. If you insert buyer or seller names on the Buyer or Seller tabs and do not 
include the tenancy in the Name(s) with Status box, a reminder message 
is displayed when you select another tab. Click Yes to display the Insert
Name Clause window and select the tenancy phrase.

11. To change the spelling of a contact name, double-click the name, make your 
changes in the Name Change window, and click OK. The new name(s) 
and Proposed Revisions are displayed in the Update window. The 
names are updated automatically throughout the Closing File and 
Contacts modules.

12. To change the spelling of a lender name, select Modules on the menu bar 
and choose Contacts. The Select Contact window is displayed. Select 
the name you want to change and click OK. The Contact window for the 
selected name is displayed. Make the change(s), being sure to use capital 
letters where necessary, and click the Save button on the secondary toolbar. 
The Update window is displayed with the New Name(s) and the Current 
Name(s). Click OK to make the change(s). The Contact window is 
displayed with the change(s). Click the Close button on the secondary 
toolbar to return to the Closing File module. Click the Refresh button to 
bring the change(s) into the closing file.

13.   ATIDS Integration allows you to perform title searches using 
information that has been entered in your Closing File. You can also look 
up and store legal description information, search for and order prior 
policies, order hard copies of documents, view images of documents, and 
update title searches. See the ATIDS Integration section of this workbook 
for detailed information.

14. If the Property Selection for Closing File does not contain an existing 
property you will be using for multiple files, click the Master Property 
button to add the property to the DoubleTime database. This will make the 
property information available as a selection for any new closing file.
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15.  To insert a degree symbol (°) in a legal description on the Property
tab, click the Insert Degree Symbol button. You can also use the 
keystroke of Control+Shift+the letter “o”.

16.  To delete a field and the associated information, click the Delete
button.

17.  To check the spelling of a legal description on the Legal tab, click the 
Spell Check button on the secondary toolbar. The Spell Check button is 
also available for the Usage, Remarks, and Declaration tabs.

18. If the lists in the Closing Agent, Title Agent, and Prepared By tabs do 
not include the names you want, exit the Closing File module and use the 
Contacts module to add them.

19. If changes are made to the sales price and/or loan amount in the Closing 
File module after the Commitment has been prepared, the Update Sales 
Price (and/or Update Loan Amount) window is displayed. Modules that 
are affected are displayed, showing the item, and the old and new amounts. 
A check mark is displayed in the modules that have previously been 
accessed. Unchecked boxes with an exclamation point (!) will not change to 
the new amount unless you place a check mark in the box.

20. An alternative to the Refresh button  is to press the CTRL + R keys to 
refresh the on-screen information.

21. When searching for individual contacts, you can scroll down the list by first 
and last names or by first names only.

22. Users can create a Master Property within the Closing File module 
using the  Create Master Property button on the secondary toolbar. 
Exception clauses added in the Commitment or Policy modules can also 
be exported into a Master Property, eliminating the need to copy and 
paste text or re-enter information.

23. Use the Clause Library button   on the secondary toolbar to pull in a 
standard legal description on the Property tab in the Closing File module. 
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Frequently Asked Questions
Question Answer

1. How do I add buyer/seller 
names to a closing file?

Add buyer and seller names to a closing file 
by clicking the Insert button on the Buyer
and Seller tabs in the Closing File module. 
Or, you can add buyer and seller names in the 
Contacts module and select them to be 
included in the Closing File module.

2. How do I add a second 
mortgage loan for the 
buyer?

Click the Insert button on the Loan tab to 
add another mortgage for the buyer. Select 
New as the Status, Second as the Priority, 
and the appropriate Type for the secondary 
mortgage. DoubleTime then displays check 
boxes allowing you the option to create a 
separate Settlement Statement and/or 
Commitment for the second loan.

3. How do I add an “also 
known as” to a buyer and/
or seller name?

Open the Closing File module and select the 
Buyer or Seller tab. Go to the Name(s) 
with Status box and type “also known as” 
followed by the alias. NOTE: If you include 
an alias in the Name(s) with Status box, 
the alias will appear on the Settlement 
Statement, the commitment, and most other 
documents.

4. How do I delete an 
address?

Open the Contacts module and select the 
appropriate contact. Click the Address tab 
and select the address you want to delete. 
Click the Delete button. Save the change. To 
eliminate a duplicate address on the 
documents when you add the mailing address 
for the spouse, select No to adding a different 
address when choosing Add Contact.

5. How do I change the 
spouse listed for the seller 
or buyer? 

Open the Contacts module and select the 
husband or wife. Select File, then Break 
Relation. Click Yes. Return to the Closing 
File module and delete the wrong spouse. 
Then click the spouse button to add the 
correct spouse.
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6. How do I insert signatories 
to the Signature/Notary
box? 

For a partnership with a corporate partner, go 
to Contacts and select Partnership as the 
Contact Type. On the Partners tab, click 
the Legal Entities section and insert the 
corporate partner. Then click below to select 
the individual from the corporation on the 
Select Signatory window. 

7. How do I print a list of the 
parties involved in my 
transaction?

Click the Print button in the Closing File
module to print a worksheet listing the key 
contact information for your closing file. 
NOTE: You can enter additional parties on 
the Participants tab in the Closing File
module. Click the Insert button to add a new 
participant and set the Type to a selection 
other than Third Party. (Third parties will not 
print on the worksheet.)

8. How do I change the 
lender?

In the Closing File module, click the Loan 
tab, select the correct loan, and either double-
click the Lender name or click the Update 
Lender button. Add or choose a different 
lender from the Search Contact window.

9. How do I find a closing file 
with only a legal 
description?

Select the Switch Active Closing File
button, type the subdivision or condominium 
name and click Browse. Or, if you have 
previously entered the lot, block, unit or 
building numbers on the Property/Details
tab in the Closing File module, you can 
search those numbers.

10. How do I change a closing 
file number, when I’ve 
already entered it in a file?

Simply type over the existing number and 
save the file. However, the file cannot be 
changed once an electronic policy jacket has 
been received or the Balance Sheet has 
been posted to the Escrow Transaction 
Management module.

11. How do I add a new 
employee to an existing 
firm?

Open the Contacts module and select the 
firm. Add the person as an employee of the 
firm. Save the changes.

Question Answer
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12. How do I view the service 
providers involved in a 
closing transaction? 

Go to the Participants tab of the Closing 
File module to view all the service providers 
involved in a closing transaction. Click the 
Insert button to add attorneys, law firms, real 
estate agents, brokers, mortgage brokers and 
their companies, loan officers, and third 
parties to the Closing File. Associate a 
company with an individual by adding an 
individual to the file.

13. Why are my contacts not 
populating on the Contact 
Information table on 
page 5 of the Closing 
Disclosure?

1) You need to associate the contact with the file by adding them in the 
Closing File module on the Participant tab.

     a.  Remember that each column on the contact table has 2 entries. 

- The first entry is the company. This pulls in the company name, 
address and the company license information.

- The second entry is the actual contact for the company. This pulls 
in the contact name, contact license information, contact email 
and contact phone number. 

- MAKE SURE THAT you have selected the correct role type for 
your contact using the drop down selection for the second 
column name Type. Below are the correct types that should be 
used.

• Lender and Loan Officer
• Mortgage Broker Company and a Mortgage 

Broker
• Buyer Broker and a Buyer Agent
• Seller Broker and a Seller Agent

Question Answer
Page 52 DT Version: 8.1



Closing File Module
2)    The Settlement Agent information is associated with the Contact
       Information table from the Closing File module on the Closing
       Agent tab.  
             -   The contact for the Settlement Agent is populated from
                   the CD Settlement Agent Contact drop down field. The 
                   contact card in the Contacts module for this person will pull in
                   the contact name, contact license information, contact email and
                   contact phone number. 

3) If you have completed steps 1 and 2 above and your contact is still not 
visible in the Contact Information table on page 5, you can right click 
with your mouse on the dark grey field that populates the company 
names. A small window appears and shows the words Add and Delete. 
Click on the Add and the Select Contact window opens. It lists 
contacts that have been associated with the file but have not yet been 
added to the Contact Information table. Highlight the entry that you are 
adding and click the OK button. The contact is added to your table. 
Repeat step 3 if more than one contact needs to be added.
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Commitment Module

Concept
The Commitment module is used to select information to be printed on the title 
insurance commitment. Information from the Closing File module is copied to the 
Commitment module. The commitment is printed in the Documents module and 
attached to the title insurance commitment jacket. After the title examination is 
complete, the title insurance commitment is prepared. It consists of: 

• Schedule A – proposed insured information
• Schedule B-I – requirements
• Schedule B-II – exceptions.

Standard and User-Defined Clauses can be inserted in the Requirements and 
Exceptions tabs for the commitment. Information from the Commitment module 
is copied to the Premium Calculation (Rating) and the Policy modules. 
Commitment jackets can be requested electronically and then printed in the 
Documents module. For more information, please see OnDemand Videos in 
DoubleTime Help.

Objective
The objective of this lesson is to show you how to enter the gathered information 
necessary for preparing a commitment. 

Preparing A Title Insurance Commitment
In this session, you will create a title insurance commitment for your closing file. 

What You Do Comments

1.  Click the 
Commitment button on 
the main toolbar.

The Title Insurance Commitment
window is displayed. The Commitment 
Type and Template defaults to FUND 
Commitment (CF6R); Signatory to 
Richard P. Bruce, and Issue Date to 
today’s date. These are editable fields. 
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Depending on the underwriter selected, the 
Commitment No. box may or may not be 
displayed. For underwriters such as Old 
Republic National Title Insurance Company/
ATFS, the field will not be displayed because 
its commitment jackets are not serialized. For 
underwriters whose commitment jackets are 
serialized, the Commitment No. box will 
contain a list of unused commitment numbers 
previously entered in DoubleTime. Scroll 
down if necessary to select the correct 
number. Selecting a commitment number 
associates a paper serialized jacket to this 
closing file. NOTE: Form numbers are 
entered by selecting Modules > Serialized 
Forms > Create Forms Inventory from 
the main menu.

2. Type 0302(current year)
in the Effective Date
box.

This reflects the date through which title was 
searched and examined. NOTE: The time 
defaults to 11:00 PM. You must press the 
Tab key to access this field if the time needs 
to be changed. The Issue Date is the date the 
commitment was prepared. The Issue Date
defaults to today’s date and can be changed. 
The Type of Estate defaults to Fee 
Simple. Leasehold is an option in the drop 
down box. NOTE: A Revision Number 
field is available and the data will be 
displayed in the commitment header section. 
If a commitment is revised, each revision 
number should be reflected in this field.
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3. Click the Owner tab. The Owner tab is displayed.

4. Click the Policy 
Required check box.

A check mark is displayed in the box, 
indicating that an owner policy is required. 
The Policy Type defaults to Owner Policy 
(OF6) and Template defaults to FUND 06 
Owner’s Policy (OF6). The contract sales 
price and the buyer information are carried 
over from the Closing File module. Editing 
the name here is only effective in the Title 
Insurance Commitment and Policy
modules.

5. Click the Mortgagee tab. The Mortgagee tab is displayed. The 
Lender defaults to Bank of Florida with a 
Priority of 1st and a Loan Amount of 
$180,000. This information is carried over 
from the Closing File module.

6. Click the Policy 
Required check box.

A check mark is displayed in the box, 
indicating that a mortgagee policy is required. 
The amount of insurance and the lender name 
are carried over from the Closing File
module. The Policy Type defaults to 
Mortgagee Policy (MF6) and Template
defaults to FUND 06 Mortgagee Policy 
(MF6).

What You Do Comments
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7. In the Name of Insured 
box, place the cursor at the 
end of Bank of Florida. 
Ensure that Bank of 
Florida is not highlighted 
in blue.

The initial click within this box activates the 
cursor. A second click after Bank of Florida is 
necessary to activate its proper location, to 
include the additional information required by 
the lender.

8.  Click the Clause 
Library button on the 
secondary toolbar.

The Clause Library window is displayed 
with Clause Titles and Clause Text. The 
Clause Type defaults to Lender Name and 
All Clauses are automatically selected. 
When a Clause Title is selected, the clause 
text is displayed in the Clause Text box.

9. Click on Conventional 
under Clause Title and 
click OK.

The Clause Library window is closed and 
the Conventional Clause is added to the 
Bank of Florida. This information is editable.

What You Do Comments
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Selecting Endorsements
What You Do Comments

1. Click the Endorse 
Policy tab.

The Endorse Policy tab is displayed. The 
selected policy types are displayed with the 
Mortgagee Policy (MF6) automatically 
highlighted. The Policy Endorsements
available for selection are displayed on the 
bottom half of the screen. NOTE: Use the 
scroll bar on the right side to view all 
available endorsements.

What You Do Comments
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Adding Requirement Clauses To The Commitment 

2. Click the 06 ALTA 5.1 
PUD check box.

A check mark is displayed, denoting the 
selection.

3. Click the 06 ALTA 8.1 
Environmental 
Protection Lien check 
box.

A check mark is displayed, denoting the 
selection.   

4. Click the 06 ALTA 9 REM
check box.

A check mark is displayed, denoting the 
selection. NOTE: If endorsements are 
required for the owner policy, select the policy 
type for Owner Policy (OF6) to display the 
selections available.

What You Do Comments
1. Click the Requirements

tab.
The Requirements tab is displayed. 
Requirements No.1, 2 & 3 of Schedule B-I 
are standard on all commitments and are not 
displayed, but will print on Schedule B-I of 
your commitment. The Recording 
Requirements defaults to No. 4.

What You Do Comments
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2. View the requirements 
defaulted in line numbers 
4A, 4B, and 4C.

The warranty deed, mortgage, and satisfaction 
requirements are created from information 
entered in the Closing File module and can 
be edited in the Text box.

 You can click the Clause Library
button to replace or add to the existing 
requirements.

3. Replace the groups of 
asterisks in the Satisfaction 
clause on line 4C with the 
information below:

    August 25, 1995
    4942
    3929

The clause defaults to Orange County, as 
identified in the Master Property module 
for Southern Acres Subdivision. This is the 
date and O.R. Book and Page number of the 
mortgage to First Eastern Bank. When 
completed, requirement number 4C looks as 
follows.

4.  On the secondary 
toolbar, click the Insert
button.

A Text box for requirement No. 5 is created 
and located in the Other Requirements
section. The cursor is active in this Text box.

What You Do Comments
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5.  On the secondary 
toolbar, click the Clause
Library button.

The Clause Library window is displayed 
with clause titles and text. The Clause Type
defaults to Requirement and the All 
Clauses button is automatically selected. 
The clauses are listed in alphabetical order by 
clause title. NOTE: The clauses can be sorted 
numerically by clicking the Reference Id.

6. In the search field at the 
top left window, type 
marriage.

The clauses related to marriage display.

7. Select the clause titled GR-
4.2 Judgments and 
Other Nonconsensual 
(Nonvoluntary) Liens: 
Continuous Marriage 
Affidavit.

What You Do Comments
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.

8. Click OK. The Clause Library window is closed and 
the Requirements tab is displayed. The 
selected clause is added as Requirement
No. 5.                NOTE: Click the Insert

button  to create additional numbered 
requirements. You can insert clauses from the 
Clause Library, or type the information in 
the Text box.

9. In the Continuous 
Marriage Affidavit clause, 
replace the groups of 
asterisks with the 
following text:

    Peter R. Glenn
    Linda Glenn

See below for the completed clause.

What You Do Comments
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Viewing Or Adding Exceptions
What You Do Comments

1. Click the Exceptions tab. The Exceptions tab is displayed. 

NOTE: Click the Insert button  to create numbered exceptions. You can 
insert clauses from the Clause Library, or type the information in the Text 
box.
NOTE: The Multiple Clause Import feature allows you to import clauses 
from a word processing application and enter them as Requirements or 
Exceptions in the Commitment module, as well as in the Owner and Mort-
gagee Exceptions tab in the Policy module. From the Edit menu, select 
either Paste Clauses from Clipboard or Import Clauses from Text File, 
whichever applies. 
2. Minimize DoubleTime.

 

3. On your desktop, 
doubleclick on the 
Microsoft Word® 
document named DT 
Exceptions for Glenn 
Sale.

The DT Exceptions for Glenn Sale 
document is displayed. NOTE: Any Windows 
based word processor can be used to copy 
documents and place them within 
DoubleTime.
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4. Hold down the Ctrl button 
on the keyboard and then 
click on the letter A.

The entire document is selected. 

5. Hold down the Ctrl button 
on the keyboard and then 
click on the letter C.

All of the document content is copied to the 
clipboard. 

6. On the Microsoft Word® 
menu bar, click File and 
select Exit.

The Microsoft Word® program closes and 
the desktop is displayed. 

7. Maximize DoubleTime. The DT Exceptions for Glenn Sale 
window is re-displayed.

8. Select Edit > Paste 
Clauses from 
Clipboard from the menu 
bar.

The Paste Clauses from Clipboard
message is displayed.

What You Do Comments
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9. Click Yes. The Paste Clauses from Clipboard
window is closed and the Exceptions tab is 
displayed.

Exceptions 1 through 3 of Schedule B-II are 
standard and are not displayed, but will print 
on Schedule B-II of your commitment. 
Exceptions 4 through 6 are copied from the 
clipboard.
The Scope check boxes are automatically 
selected, denoting the exceptions will be 
copied to the Title Insurance Policy 
module. To prevent an exception from being 
copied to a particular policy, click the 
appropriate box to remove the check mark.

What You Do Comments
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Endorse Commitment Tab

What You Do Comments
1. Click the Endorse 

Commitment tab.
The Endorse Commitment tab is 
displayed. 

NOTE: There are two ways to re-issue a Title Insurance Commitment after 
revisions have been made.

1) The Endorse Commitment tab is used to create a General 
Endorsement to the Title Insurance Commitment if changes need to be 
made after the Title Insurance Commitment has been issued. The General 
Endorsement is printed in the Documents module. 

- OR -

2) You may also use the Revision Number field in the header on Schedule A 
of the CF6R. If a Title Insurance Commitment is revised, each revision 
number should be reflected in this field.

For additional information see The Fund Concept article Introducing the New 
2016 ALTA Commitment by Jalinda B. (Jay) Davis in the May 2017 issue for 
guidelines.
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Requesting A Jacket Electronically 
What You Do Comments

1.  Click the 
Commitment Jacket 
Request button on the 
secondary toolbar.

You may only request Commitment Jackets 
electronically if you are writing on Old 
Republic National Title Insurance Company 
through Attorneys’ Title Fund Services, LLC. 
The eSolutions Commitment Request
window opens. Type the appropriate 
information in the FundNet User ID and 
FundNet Password boxes.

2. Click Next. The billing address for this transaction is 
displayed. If only one address is available for 
your office, the address is displayed as the 
default.
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3. Click Next. The eSolutions Commitment Request 
window opens. A connection with Attorneys’ 
Title Fund Services, LLC is established. Once 
a commitment request is finished the message 
field will update that the jacket request 
completed successfully. The commitment and 
jacket are now available to print in the 
Documents module.

What You Do Comments
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Tips

4. Click Finish.

5. Click  Close on 
the secondary toolbar. 

The Commitment module closes.

1. An alternate way to open the Title Insurance Commitment module is to 
select Modules > Title Insurance > Commitment from the menu bar, 
or press Ctrl + Alt + C.

2. If the property information has not been entered in the Master Property
module, use the Insert and Clause Library buttons on the secondary 
toolbar to select and add appropriate exceptions.

3. To create User-Defined Clauses, select Modules > Clause Library 
Maintenance from the menu bar.

4. To issue an endorsement to the commitment, use the Endorse 
Commitment tab.

What You Do Comments
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5.  Use the Copy Master Property Exceptions to add or replace 
existing exceptions from the Master Property module.

6.  Use the Build Clauses button to update changes made in the Closing 
File module (for example, changes to the lender name) that affect the 
Owner, Mortgagee, and/or Requirements tab.

7.  Use the Automatic Renumber button to keep remaining paragraph 
numbers in sequence when you delete paragraphs.

8. To return a paper serialized form to inventory after associating it to a file, 
select Modules > Serialized Forms > Forms Tracking from the menu 
bar, and change the status to Received. It is then available for selection 
with another file.

9. The Multiple Clause Import feature allows you to import clauses from a 
word processing application and enter them as Requirements or 
Exceptions in the Commitment module, as well as in the Owner and 
Mortgagee Exceptions tab in the Policy module. From the Edit menu, 
select either Paste Clauses from Clipboard or Import Clauses from 
Text File, whichever applies. 

10. An alternate way to open the Clause Library is to press Ctrl + L.

11. To request a commitment jacket electronically for an ORNTIC/ATIF 
closing, users must first set up in www.thefund.com through their office 
FundNet Administrator as well as in Preferences> User Settings.

12. If issuing a Mortgagee Short Form Policy (SF6), remember to change 
the template selection type.

Question Answer
1. How do I pull buyer names 

into the commitment 
requirements?

Verify that the buyer names have been added 
on the Buyer tab in the Closing File
module. Click the Build Recording
Requirements Clause button. Warning:
Any changes previously made to the second 
requirement will be lost. The entire second 
requirement clause will be rebuilt. 
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2. How do I renumber 
exceptions in the Title 
Insurance 
Commitment module?

Insert the exceptions at the end of the list. 
With the Automatic Renumber button off, 
change the exception’s number. For example, 
to change number 20 to number 10, simply 
insert number 10 in number 20’s place. Then 
change the existing number 10 to 11. Click 
Save. All the requirements will renumber 
appropriately.

3. How do I put a form back 
in the Inventory?

Go to the Forms Tracking module. Go to 
the Assignment/Form Status tab of the 
Forms Tracking window. Set the Form 
Status to Received. Click Save. The form 
is back in the inventory.

4. Why isn’t the title agent’s 
address displayed on the 
commitment?

You added the agent’s address as an address 
other than a mailing address. Return to the 
Contacts module and add a mailing address 
for the agent or change the existing address to 
mailing. Save your changes. Open the
Documents module and select the 
commitment. If the Documents module is 
already open when you add the mailing 
address, click Refresh for the changes to 
take effect.

5. Why isn’t the 4B 
requirement displayed on 
the commitment?

Verify that the loan information has been 
added on the Loan tab in the Closing File
module. In the Title Insurance 
Commitment module, click the Build 
Recording Requirements Clause button 
to bring in the loan data.

Question Answer
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6. Why don’t the buyers and 
sellers display on the 
commitment?

There are two possible reasons: (1) You 
haven’t added text to the Name(s) with 
Status box in the Closing File module for 
the buyers or sellers. Open the Closing File
module and select the Buyer or Seller tab. 
Click the Insert Name Clause button to 
add text for the buyers/sellers to these boxes 
and save. Return to the Title Insurance - 
Commitment module, click Refresh and 
then click Rebuild Defaults. (2) You 
opened the commitment before you filled in 
the Name(s) with Status boxes in the 
Closing File module. Click the Owner tab 
in the commitment. Click Refresh, then click 
Rebuild Defaults.

7. Why aren’t the exceptions 
displayed in the 
Commitment module?

There are two possible reasons: (1) The 
property was added as a new property in the 
Closing File module/Property tab, instead 
of being selected from the existing Master 
Property list. (2) The Master Property
was added after inserting the new property in 
Closing File. Go to the Closing File
module/Property tab. Select the property and 
click Delete to remove it. Click Insert to 
open the Master Property Selection
window. Browse to locate the property and 
select it. Click OK and save the Closing 
File. Go to the Commitment module 
Exceptions tab. Click Copy Master 
Property Exceptions and select Add to 
pull in the exceptions.

Question Answer
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8. How are the Type of 
Estate fields on Schedule 
A of the Commitment 
completed? 

DoubleTime populates Paragraph 3 of 
Schedule A of the Commitment with the 
default language of Fee Simple. The default 
language is editable in the Documents
module. NOTE: There is a Type of Estate
drop down box on the General tab of the 
Commitment module which includes a 
choice between Fee Simple and 
Leasehold. The Documents module 
completes the fields on Schedule A based on 
the selection made in this drop down box.

Question Answer
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Documents Module - Print 

Concept
The Documents module is used to prepare and print documents such as title 
commitments, title policies, deeds, affidavits, and bills of sale. You can select 
documents from the Master Document Selection list for each closing file and, if 
necessary, edit them. Documents can also be emailed using Outlook or Outlook 
Express or faxed from your personal computer. Customized documents can be created, 
and then related to each closing file. If you do not have Outlook or Outlook Express, 
documents can be saved, and then emailed using other email programs.

Objective
The objective of this lesson is to show you how to print the commitment schedules and 
jacket for this closing.

Printing Documents
What You Do Comments

1.  On the main toolbar, 
click the Documents 
button.

The Closing Document Selection
window is displayed. The FUND 
Commitment (CF6R), FUND  Commitment 
(CF6R) Jacket, FUND 06 Mortgagee Policy 
(MF6), and FUND 06 Owner’s Policy (OF6) 
were previously selected in the Title 
Insurance/Commitment module. The Old 
Republic Privacy Notice is included in every 
file that includes a loan.
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2. Select FUND 
Commitment (CF6R)
from the Closing 
Document Selection 
window.

3. Click OK. The FUND Commitment (CF6R) 
document is displayed. The gray-shaded areas 
indicate information that is carried over from 
other modules in DoubleTime.

What You Do Comments
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CF6R Header

CF6R Footer

A footer, which includes the required 
language appears on every page of the 
Commitment (CF6R). NOTE: If using an 
Exhibit “A” with the Commitment (CF6R), 
it must also contain the footer statement. You 
can find the form in the Documents module 
named Exhibit “A” Legal Description 
(CF6R).

4.  On the secondary 
toolbar, click the Open 
Document button.

The Closing Document Selection 
window is displayed.

What You Do Comments
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Tips

5. With FUND 
Commitment (CF6R)
selected, press and hold the 
CTRL key and click Fund 
Commitment Jacket
(CF6R).

NOTE: (1) Commitment jackets issued by 
Old Republic National Title Insurance 
Company are not serialized. Therefore, the 
Document Information field remains blank. 
(2) The Commitment jacket will not appear as 
an available document for selection and 
printing until after you have used the 
eSolutions feature to electronically request 
it.      

6. Click Print. The Commitment Schedules and 
Commitment Jacket are printed.

7. Click Cancel. The Documents module is closed.

1. An alternate way to open the Documents module is to select Modules
from the menu bar and choose Documents. You can also use the shortcut, 
Ctrl+D from any window.

2. To view a document, select the document from the Closing Document 
Selection window and click OK.

3.  Use Spell Check on the secondary toolbar to check the spelling of a 
displayed document.

What You Do Comments
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4.  The Signature/Notary button allows you to select witness names as 
well as the number of witnesses for each signatory or signature block on a 
document. You can also establish and preview the Notary format.

5. Use the selections available in the Insert menu to insert page breaks and 
page numbers.

6. Use the Edit menu to add custom variables, notary information, and headers 
and footers.

7. Use the Format menu to format fonts, paragraphs, and tabs.

8. Select Protect Document (Read Only) from the Tools menu to prevent 
changes from being made to the open document.

9. An alternate way to select text for editing is to press and hold the SHIFT key 
and use the arrow keys. You can also press and hold the SHIFT key and 
press the END key to select text from the cursor position to the end of the 
line.

10. You can modify and save a custom document if it is currently opened in the 
Documents module. To save changes to the master custom document, 
select File, Save As, Existing Master.

11. To email a single document, open the document or click the email button on 
the Closing Document Selection window, then choose eSolutions, 
email. To select and email multiple documents, click the email button on 
the Closing Document Selection window. The email feature uses 
Outlook or Outlook Express only.

12. Fax documents by selecting File, Print, Properties, and then selecting the 
currently installed fax program on your personal computer.

13. Press Ctrl + L as an alternate way to open Clause Library.

14. Use Tools > Regenerate Document to restore a changed document.

15. When saving a document and to utilize the Save-As feature, follow these 
steps. While in the desired document, click on File > Save-As > 
Document Image… A window will appear and the Save-in: location 
will default to the location you selected in User Preferences.
Page 78 DT Version: 8.1



Documents Module - Print
Frequently Asked Questions
Question Answer

1. How do I print documents 
from the Documents
module?

Select the document in the Closing 
Document Selection window and click 
Print. To print more than one document at a 
time, press Ctrl and select all the documents 
you want to print. Click Print.

2. How do I save a document 
as a New Master
document?

You can save and create custom master 
documents in Preferences, Document 
Customization. In the Documents
module, select File, Save As, New Master. 
When the Save as New Master window is 
displayed, type a template name and click
OK. 

3. How do I print a 
commitment?

Open the Documents module, select the 
commitment, and click Print. If the 
commitment is not available as a selection, 
open the commitment in the Title 
Insurance/Commitment module. Click the 
Save button before you return to the 
Documents module.

4. How do I add documents 
for selection in the 
Closing Document 
Selection window for my 
closing file?

Open the Documents module. When the 
Closing Document Selection window is 
displayed, click New. Select the document(s), 
such as the warranty deed and other 
documents needed for the file, and click OK.
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5. Why isn’t the document I 
want to print listed in the 
Documents module?

Here are some possible reasons:
• You haven’t created it. Commitments and 
policies need to be completed in the 
Commitment or Policy modules before 
they can be selected and printed in the 
Documents module.
• If a general endorsement is not selected in 
the Commitment module, it will not be 
available to print in the Documents module.
• The document you want to print is an 
endorsement to the FUND 06 Mortgagee 
Policy (MF6) and was automatically checked 
off in the Commitment or Policy module 
and will show as an issued endorsement on 
Schedule A of the issued policy.
• The document must be printed from a 
different DoubleTime module. For example, 
the Settlement Statement is printed in the 
Settlement Statements module; the 1099-
S forms are printed in the 1099-S module.
• The document isn’t in the DoubleTime 
database. DoubleTime includes commitment 
and policy documents for those items issued 
through The Fund, not those of other insurers. 
However, if you select a different underwriter 
in the Closing File, that name will be 
reflected on the commitment, policy, and 
endorsement forms. 
• If you changed the Rating Type in the 
Closing File module after creating the Title 
Commitment, DoubleTime removes the Title 
Commitment from the Commitment 
Module and deactivates the Commitment 
Module.

Question Answer
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6. What document contains 
language regarding 
condominium and 
homeowners’ associations 
assessments dues?

The Closing Statement Addendum
document includes this language, and the Tax 
Re-Proration and Disbursement Authorization 
language. The condominium language in the 
Addendum reads as follows:

HOMEOWNER’S/CONDOMINIUM 
ASSOCIATIONS: The Buyer(s) 
acknowledge(s) the existence of any 
homeowner’s and/or condominium 
association(s) and is aware that monthly, 
quarterly, or annual maintenance assessments 
may be due to said association(s). Said 
association(s) may also have the authority to 
regulate and enforce community covenants 
and restrictions. The Buyer hereby 
acknowledges receipt of a copy of any 
association estoppel letters for the subject 
transaction.

You can modify the language for a specific 
closing, then save the document as a custom 
document.

Question Answer
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Premium Calculation (Rating) Module

Concept
The Premium Calculation (Rating) module is used to calculate the rates and 
charged amounts for title insurance policies and endorsements. The amount to be sent 
to the underwriter is also calculated. This information is copied to the Settlement 
Statements module. Premium Calculation (Rating) is composed of four sections.

• Closing File displays the calculated rates based on the Sale Price and Loan 
Amount for a specific closing file and gives you the opportunity to adjust the 
charges. 

• Quote calculates the rates for a title insurance quote to a client not associated 
with a closing file. 

• Electronic Delivery of Fund policies can be done within the Premium 
Calculation (Rating) module. A request can be made within DoubleTime to 
have serialized form numbers delivered electronically. Forms can also be 
delivered to The Fund electronically. All rating types can be electronically 
submitted to The Fund, with the exception of Mortgage Modification. 
Mortgage Modification can not be delivered electronically. DoubleTime will 
submit policies, endorsements, and worksheet. Users will also have the ability 
to remit payment electronically during delivery.  

• Advanced Rating includes Mortgage Modification and Substitution Loan 
rating. Rating type must be selected in the Closing File Module. 

Objective
The objective of this lesson is to show you the calculated rates for your file for the 
owner and mortgagee policies and endorsements, and produce a Policy Rating 
Worksheet.

Premium Calculation For A Closing File  
What You Do Comments

1.  On the main toolbar, 
click the Premium 
Calculation (Rating) 
button.

The Premium Calculation (Rating) – 
Closing File window is displayed. 
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The Agent and Underwriter sections 
contain information previously entered in the 
Closing File module. The Agent No. was 
previously entered on the Services tab in the 
Contacts module.
The Rating Date defaults to today’s date and 
can be changed. Rating Remarks will 
appear on the Policy Rating Worksheet.

NOTE: When working on a file that has an Owner’s Policy or the sum of the 
Mortgagee Policy(s) is greater than or equal to one million dollars, a check box 
will be displayed on the “General Information” tab asking if underwriting 
approval was given to issue this policy. Check the check box once you have 
received underwriting approval to issue the policy. This does not apply to 
mortgage modifications.
NOTE: The 1-4 Residential checkbox will default on if all policies total more 
than $20K or less than $1 million: otherwise the box is checked off. This 
defaulted logic can be overridden by the end user if the closing type falls outside 
these parameters.

What You Do Comments
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2. Click the Policies tab. The Policies tab is displayed. The Owner 
Policy and Mortgagee Policy boxes 
contain information entered in the 
Commitment module. A “Payor” drop 
down selection is available which allows you 
to select which party is paying for the 
Owner’s Title Insurance. This selection 
effects the Florida Premium Disclosure 
(DFS - 2146) document only. Click the Prior
check box to calculate a prior policy Reissue 
Rate. Enter the prior policy amount and press 
Tab. The Amount Used will default to the 
amount entered for Policy Amount; 
however this can be changed if necessary. 
Also, the Total Calculated and Charged 
Amount for the Owner Policy line will 
automatically be re-calculated. Be sure to 
select the underwriter of the prior policy by 
clicking the Prior Underwriter Name box. 
Also enter the Policy Number and Policy 
Date. For a New Home Purchase Discount, 
click the Prior check box, then the New 
Home Purchase Discount check box. The 
discount is not calculated as it is based on the 
premium(s) charged on the prior 
transaction(s). Guidelines for determining 
Reissue Rates or New Home Purchase 
Discounts can be found in the Fund 
Procedures Handbook. NOTE: See 
Advanced Rating Section. For questions 
regarding policy premium rating, contact 
Finance Customer Service at 1-800-275-2843. 
Interactive rating worksheets are available on 
The Fund’s Website (www.thefund.com) by 
clicking on Rating Worksheets in the Launch 
Center after you have logged in. 

What You Do Comments
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3. Click the Endorsements
tab.

The Endorsements tab is displayed with 
information previously entered in the 
Commitment module. The amounts in the 
Charged box can be changed.

4. Click the Worksheet tab. The Worksheet tab is displayed. The Policy 
Rating Worksheet is displayed for the 
closing file. A breakdown of the rates from 
the other Premium Calculation (Rating)
tabs are included.

What You Do Comments
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5. Use the scroll bar to view 
the Policy Rating 
Worksheet.

The worksheet is display only and cannot be 
changed on this tab. Data from the General 
Information, Policies, and 
Endorsements tabs are displayed on the 
worksheet. To make changes to the insurance 
amount, use either the Closing File or the 
Title Insurance module. 

6.  On the Premium 
Calculation (Rating) – 
Closing File toolbar, 
click the Print button.

The Print Options window is displayed with 
All selected and number of copies defaults to 
1.

7. Click OK. The worksheet is printed with the calculated 
amounts. NOTE: Completed policy forms can 
be sent to The Fund via electronic delivery. 

Use the  Electronic Delivery button for 
electronic retrieval of owner and mortgagee 
policy numbers and the electronic delivery of 
the completed policies.

What You Do Comments
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Tips

8.  On the Premium 
Calculation (Rating) – 
Closing File toolbar, 
click the Close button.

The Premium Calculation (Rating) – 
Closing File module is closed.

1. An alternate method to open the Premium Calculation (Rating) – 
Closing File module is to select Modules > Premium Calculation 
(Rating) > Closing File from the menu bar.

2.  Use the Calculator button to use the calculator. You can type the 
numbers on the keyboard or use the mouse to click the numbers on the 
displayed calculator. 

3.  Use the Premium Calculation (Rating) – Quote button to open 
the Premium Calculation (Rating) – Quote module. Use this module to 
rate a policy and endorsements for a quote in any file. Data entered in the 
Quote module is not saved.

4. To use the Premium Calculation (Rating) – Quote module when not in 
a closing file, select Modules on the menu bar, then Premium 
Calculation (Rating) and then Quote. Data entered in the Quote module 
is not saved.

5.  Use the Spell Check button on the secondary toolbar to check the 
spelling for the Rating Remarks.

6.  Use the First Page, Prior Page, Next Page, and Last 
Page buttons on the secondary toolbar to navigate between pages when the 
transaction results in a multi-page worksheet.

7. A request can be made through DoubleTime to have serialized form 
numbers delivered electronically. Forms can also be delivered to The Fund 
electronically. Choose eSolutions, Fund Forms, Electronic Delivery. 
To find out more, select Run Tutorials within the Help menu.

What You Do Comments
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Frequently Asked Questions
Question Answer

1. Why don’t endorsements 
appear in the Premium 
Calculation - Rating
module?

Here are some possible reasons:
• You haven’t selected the endorsements.
Open the Title Insurance - Commitment
module and select the Endorse Policy tab. 
Select the endorsements you want and save 
your changes. When you reopen the Pre-
mium Calculation Rating module, the 
endorsements will be included in the calcula-
tions.
• You selected the endorsements after the pol-
icy was rated. Go to the Endorse Policy tab 
of the Commitment module. Click the check 
box(es) to select the endorsement(s). Then re-
rate the policy.

8. Rating Type is selected in the Closing File Module. The selected Rating 
Type will be displayed in the General Information tab. When a 
Substitution Loan is selected, the Policies tab displays an area for the 
user to enter the Original Policy Number, Effective Date, Unpaid Principal 
Balance and the underwriter. The Worksheet tab will display the 
Worksheet for the selected Rating Type (Basic, Mortgage Modification, and 
Worksheet Substitution Loan). Basic and Substitution Loan rating types can 
be electronically submitted to The Fund (see pages for Advanced Rating). 
You also have the ability to remit payment electronically during delivery for 
all three rating types. Mortgage Modification Rating Type cannot be 
submitted electronically.

9. The FundNet website contains policy rating spreadsheets that may be 
downloaded and used independently from DoubleTime.
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Settlement Statements - Closing Disclosure (CFPB)

Concept
The Settlement Statements module automates and speeds the preparation of the 
closing disclosure and other settlement statements including the HUD and GFE-HUD. 
Data entry is minimized because much of the information necessary for completion 
has already been entered in other modules, such as Closing File, Commitment and
Premium Calculation (Rating). The calculations are automatically performed and 
the repetitious typing of numbers is eliminated. The Settlement Statements
module is flexible in that information can be entered as you receive it or you can 
complete the entire settlement statement at one time. You can view the tabs and enter 
information in any order. In addition to the Closing Disclosure Settlement 
Statement, there are a variety of forms that can be printed in the Settlement 
Statements module such as Seller Only CD, Borrower Only CD, Non-Seller 
or Refinance CD, Borrower’s/Seller’s Closing Statement (2 Column 
Ledger), Borrower’s Closing Statement (2 Column Ledger), Seller’s 
Closing Statement (2 Column Ledger), ALTA Settlement Statement - 
Combined > TRID Rates, ALTA Settlement Statement - Borrower/Buyer > 
TRID Rates, ALTA Settlement Statement - Seller > TRID Rates, ALTA 
Settlement Statement - Combined > Florida Promulgated Rates, ALTA 
Settlement Statement - Borrower/Buyer > Florida Promulgated Rates, 
ALTA Settlement Statement - Seller > Florida Promulgated Rates. These 
statements can also be emailed.

Objective
The objective of this lesson is to show you how to use the Settlement Statements
module to complete a Closing Disclosure Settlement Statement and then how to print 
the completed statement.

Closing Disclosure Form
The Closing Disclosure form in DoubleTime has been designed to look and handle 
like the H-25(A) model form provided by the CFPB. DoubleTime has time saving 
features available in the Closing Disclosure, GFE HUD and HUD formats, including 
broker, payoff and recording calculators, automatic policy rating calculations and 
other defaulted values. The Closing Disclosure form has been divided into 6 tabs that 
follow the format and order of each page, with an additional tab used for selecting 
Closing Disclosure Options. DoubleTime's intuitive approach makes completing the 
Closing Disclosure very easy. You can click in most areas of the form and type directly 
on it. In many areas, DoubleTime will default in standard language set forth by the 
Uniform Closing Dataset (UCD) but will allow you to override text making it easy to 
accommodate anything the Lender may request.
Training Workbook: August 2018 Page 89



Settlement Statements - Closing Disclosure (CFPB)
Closing Disclosure Page 1
What You Do Comments

1.  Click the 
Settlement Statements 
button on the main toolbar.

The Closing Disclosure window displays 
with the Page 1 tab open. The module’s title 
bar displays the file name and indicates that a 
Closing Disclosure settlement statement was 
selected in the Closing File module. Page 1 
has 4 sections, General Information, Loan 
Terms, Projected Payments, and Costs 
at Closing.

NOTE: For new loans, you will select 
between a Closing Disclosure and the 
three page GFE HUD when you enter the 
loan on the Loans tab of the Closing File
module. If no loans have been associated with 
the closing file the two-page HUD will be 
displayed when the Settlement Statement
module is opened. The appropriate type of 
settlement statement should be chosen before
any information/data is entered in the 
Settlement Statements module. Switching 
the settlement statement type after entering 
data in the Settlement Statements module 
will result in that data being lost. However the 
data that carries over into the Settlement 
Statements module from other modules will 
not be lost.

NOTE: When the Closing Disclosure is selected, the Settlement 
Statements module has two vertical scroll bars (inner and outer) on the right 
side of the screen. At the bottom of the screen a horizontal scroll bar will allow 
you to navigate through the Closing Disclosure. User may also use the roller ball 
on the mouse, if available. 

Depending on the screen resolution, user may need to use the lower scroll bar to 
view both vertical scroll bars.
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General Information
The General Information at the top of Page 1 will automatically populate based on 
entries made in the Closing File and/or Loan Module. Double-clicking the 
Property, Borrower, Seller, or Lender fields will initiate a Detail window, giving 
you the ability to override text and request the information to be sent to Closing 
Disclosure Addendum A (used to display excess data). The product type field can 
be edited by typing on the line. 

What You Do Comments
1. Position the cursor over the 

Property Address and 
double-click to edit the 
field.

The Property Detail window opens.

2. Select the Override 
Description? check box

The Property Address is now available to be 
edited

What You Do Comments
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3. In the Property Detail
box, place the cursor 
before the word Orlando. 

The initial click within this box activates the 
cursor. A second click is necessary to activate 
its proper location.

4. Press Enter. The address after the cursor spot is moved to a 
second line.

NOTE: By selecting the Use Addendum?
box, the data will be sent to Addendum A in 
the order that the section appears in the 
Closing Disclosure Settlement Statement. 
This feature can be used to list long names or 
addresses. 

5. Delete the comma after the 
word Place.

6. Click OK. The Property Detail window closes. 

NOTE: If the Override Description? box 
is selected, no new information will populate 
from the Closing File module. You must 
deselect the Override Description? box to 
update changes.

7. Position the cursor over the 
Borrower name and 
double-click to edit the 
field.

The Borrower Detail window opens.

8. Select the Override 
Description? check box. 

The Borrower name and address are now 
available to be edited.

What You Do Comments
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9. In the Borrower Detail
box, place the cursor 
before the word Orlando.

The initial click within this box activates the 
cursor. A second click is necessary to activate 
its proper location.

10. Press Enter. The address after the cursor spot is moved to a 
new line.

11. Click OK. The Borrower Detail window closes. 

12. Position the cursor over the 
Seller name and double-
click to edit the field. 

The Seller Detail window opens.

13. Select the Override 
Description? check box.

The Seller name and address are now 
available to be edited.

14. In the Seller Detail box, 
place the cursor before the 
word Chicago.

The initial click within this box activates the 
cursor. A second click is necessary to activate 
its proper location.

15. Press Enter. The address after the cursor spot is moved to a 
new line.

16. Click OK. The Seller Detail window closes. 

What You Do Comments
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Loan Terms Table
The Loan Terms Table will display the standard verbiage when the "Can this 
amount increase after closing?" values are set to 'Yes'. Double clicking on the standard 
verbiage will initiate the Loan Terms Detail window and allow you to modify 
values or override the standard language. This information is provided by the lender.

NOTE: The Loan Amount and Interest Rate are auto-populated from data 
entered in the Closing File Module.

What You Do Comments
1. Type 808.28 in the 

Monthly Principal & 
Interest field.

2. Select Yes from the Does 
the loan have these 
features? drop down list 
on the Prepayment 
Penalty line.

The Prepayment Penalty standard 
verbiage is displayed.

3. Doubleclick on the 
Prepayment Penalty
standard verbiage.

The Loan Terms Detail – Prepayment 
Penalty window is displayed and you can 
edit the values or override the standard 
language.
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4. Type 5000 in the Penalty 
Amount box.

5. Type 24 in the 
Prepayment Penalty 
Expiration in Months
box.

6. Select the Override?
check box.

The standard Prepayment Penalty verbiage 
has been updated and is now available to be 
edited.

7. Click into the 
Prepayment Penalty
verbiage box.

A standard edit font toolbar is displayed.
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Projected Payments Table
The Projected Payments Table on Page 1 will allow you to enter up to 4 separate 
payment intervals. To add a new payment interval, simply check the box at the top of 
the column and enter in the appropriate information. This information is provided by 
the lender.

8. Place the cursor to the left 
of 2 years. 

9. Left click and hold, then 
drag the mouse and 
highlight to the end of 2 
years.

10. Click the Bold button on 
the edit font toolbar.

11. Click OK. The Loan Terms Detail window closes.
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What You Do Comments
1. Type 30 in the Payment 

Calculation Years 1-
box.

2. Type 808.28 in the 
Principal & Interest
field for Years 1 – 30.

3. Type 400.69 in the 
Estimated Escrow field 
for Years 1 – 30. Press 
the Tab key.

The Estimated Total Monthly Payment
field is automatically populated with the totals 
from the Payment Calculations.

NOTE: A Final Payment Title checkbox is available in the Projected 
Payments table. This selection allows you to change the title of the last active 
payment interval column from showing a year range to having a title of Final 
Payment. The title field is also editable to allow you to match lender 
instructions.

4. Type 484.02 in the 
Estimated Taxes, 
Insurance & 
Assessments field.
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5. Select the check box for 
Property Taxes in the 
This estimate includes
column.

6. Select Yes for Property 
Taxes from the drop down 
list in the In escrow?
column.

7. Select the check box for 
Homeowner’s 
Insurance in the This 
estimate includes
column. 

8. Select Yes for 
Homeowner’s 
Insurance from the drop 
down list in the In 
escrow? column.

9. Select the check box for 
Other in the This 
estimate includes
column.

When the Other check box is selected, a text 
box opens where text can be added to match 
Lender’s instructions.

10. Type Flood Insurance & 
Additional Costs in the 
Other field box.

11. Select Some for Other: 
Flood Insurance & 
Additional Costs from 
the drop down list in the In 
escrow? column.
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Costs at Closing Table
The Costs at Closing Table at the bottom of page 1 will display calculated values 
from the totals on pages 2 and 3.

NOTE: The Costs at Closing table amounts automatically calculates as you 
complete pages 1 thru 5. 

Closing Disclosure Page 2
Page 2 of the Closing Disclosure has 2 sections. The Loan Costs include sections A 
through sections D and the Other Costs include sections E through J. You can click 
directly on a line and type in the description, select a payee and enter an amount in any 
of the 5 columns. When greater detail is needed, double click the line to initiate a 
Detail window. The detail window can be used to enter in an Amount Withheld
from the loan (Net Funding) and/or specify the Payor when the Paid by Others
column is used. 

A triangular blue symbol  called a Line Detail Indicator will appear in the 
top left corner of a row that contains an extra selection or entry from the Detail
window. This indicator will appear on rows that contain Amount Withheld, Paid 
by Others POC or a Transaction Type of TRID Variance Adjustment. This 
feature helps you quickly identify items on the Closing Disclosure that have extra 
options selected without having to open the detail window.

A triangular yellow symbol  called a Line Detail Indicator will appear in 
the bottom left corner of a row that contains a Line Description that does not match a 
GSE Fee Type for that row. ** (This feature is for future use and not intended to be 
used with this release.) 

The detail windows for Section B and Section C will allow you to change the 
Section and Fee Type in the top left of the window. This is useful when you need to 
move an amount from one section to the other or designate an item as a Title Fee.
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Loan Costs
What You Do Comments

1. Click the Pg. 2- Closing 
Cost Details tab.

The Update Recording Charges dialog 
box is displayed listing the calculated values 
for the documentary stamps on the deed and 
note, and the intangible tax on the mortgage. 
DoubleTime uses the appropriate charges 
based on the county in which the property is 
located, purchase price and loan amount.

The dialog box is used to update the Old 
Amount with the New Amount.

2. Click Yes. The Update Recording Charges dialog 
box closes and a message to add lines in the 
Recording and Transfer Taxes lines 
appears. 

3. Click Yes. The dialog box closes and the Line 
Administrator window is displayed.
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NOTE: The Closing Disclosure allows for the movement of available lines 
from each section on Page 2 to accommodate additional fees and credits. Simply 
click on the Insert button on the secondary toolbar and the Line 
Administrator window displays. In this window, you can select one or more 
available lines to move to another section. First, click on Select which blank 
line(s) to move and then Select which section to move the blank 
line(s) to. To complete the move, click on the Move To >>> button. The 
Status window will confirm your selection and the lines will be moved after 
clicking OK. 

4. Select Section B:03 
from the Select which 
blank line(s) to move: 
list. Press Ctrl + B:04
from the Select which 
blank line(s) to move: 
list.

These lines will be removed from section B.

5. Select Section E:Taxes 
and Other Government 
Fees from the Select 
which section to move 
the blank line(s) to: list.

This is where the selected lines will be moved 
to.
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6. Click on the Move To 
>>> button.

7. Click OK. The Line Administrator window closes and 
the Closing Cost Details tab, with sections A 
through J is displayed. The available lines 
have been moved to the E section. The 
Documentary Stamps and Intangible 
Taxes are now shown on multiple lines.

What You Do Comments
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Section A - Origination Charges

The Closing Disclosure Page 2 has 5 columns to enter fees. They are from left to 
right, Borrower Paid At Closing, Borrower Paid Before Closing, Seller Paid At 
Closing, Seller Paid Before Closing and Paid by Other. The Paid by Others 
column is used for fees paid on behalf of the borrower by payees such as a 
lender or realtor.

What You Do Comments
1. Double click section A, 

line 01.
The detail window opens. The default Payee 
in section A is the lender. 

2. Type 3000 in the 
Borrower Paid At 
Closing box.

The At Closing box is used when the funds 
are collected and disbursed at the closing. 
The Before Closing box is used when the 
funds were paid prior to the closing.

3. Double click the Amount 
Withheld box.

The $3000.00 fee is displayed in the Amount 
Withheld box. This charge will be withheld 
from the loan proceeds by the lender. The 
adjustment will be displayed on the Balance 
Sheet.

What You Do Comments
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4. Click OK. The detail window closes. DoubleTime places 
the entered amount in the correct columns on 
line A01.

NOTE: A triangular blue symbol called a Line Detail Indicator will appear in 
the top left corner of a row that contains an extra selection or entry from the 
Detail window. This indicator will appear on rows that contain Amount 
Withheld, Paid by Others POC or a Transaction Type of TRID 
Variance Adjustment. This feature helps you quickly identify items on the 
Closing Disclosure that have extra options selected without having to open the 
detail window. If you hover your mouse over the Line Detail Indicator for a 
particular row, a pop-up will appear indicating the transaction information.

5. Double click section A, 
line 02.

The detail window opens.

6. Click the down arrow in 
the Description box and 
Type D.

DoubleTime has pre-typed line descriptions 
(in alphabetical order) that are accessed from 
the down arrow in the description drop down 
list. Use the Maintenance (Lists) module to 
customize the drop-lists to match the 
requirements of your office.

7. Select Document 
Preparation Fee from 
the Description drop 
down list.

This is the description of the fee paid by the 
Borrower.

What You Do Comments
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8. Type 250 in the 
Borrower Paid At 
Closing box.

9. Double click the Amount 
Withheld box.

10. Click OK. The detail window closes.

11. Double click section A, 
line 03.

The detail window opens.

12. Type Underwriting Fee
in the Description box.

DoubleTime provides the ability to free type 
when the line description is not listed in the 
drop down selection.

13. Type 500 in the 
Borrower Paid At 
Closing box.

14. Double click the Amount 
Withheld box.

15. Click OK. The detail window closes.
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Section B - Services Borrower Did Not Shop For

DoubleTime displays the total charges for the Buyer at the top of each section 
header (in the grey bar).

NOTE: A triangular yellow symbol called a Line Detail Indicator will appear 
in the bottom left corner of a row that contains a Line Description that does not 
match a GSE Fee Type for that row. ** This feature is for future use and not 
intended to be used with this release.

What You Do Comments
1. Double click section B, 

line 01.
The detail window opens.

2. Click the down arrow in 
the Description box.

3. Use the Scroll bar in the 
Description box to view 
additional pre-typed lines. 
Select Appraisal Fee
from the Description
drop down list.

4.  Click the Search 
Contact button for the 
Payee.

The Search Contact window opens. The 
Contact Type defaults to Corporation and 
the Service Provided to None in Section
B.

The Payee default is (none). The drop down 
selections are previously associated 
participants/contacts added in the Closing 
File module or the Settlement Statement
module.
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5. Click the down arrow in 
the Service Provided
box.

The Service Provided box allows the user 
to select provider types such as Credit 
Report, Surveyor and Recording Dept. 
The option None allows you to search all 
Service Providers. When a specific Service 
Provider is selected, DoubleTime displays 
only contacts for that Service Provider type 
which narrows down your selection.

6. Select Appraiser from the 
Service Provided drop 
down list.

7. Select Appraisers, Inc.

8. Click OK.

9. Type 250 in the 
Borrower Paid Before 
Closing box.

10. Click OK. The detail window closes. The line 
Description, Payee, and amount is referenced 
on line B1.

11. Double click section B, 
line 02.

The detail window opens.

12. Click the down arrow in 
the Description box and 
Type C.

13. Select Credit Report Fee
from the Description
drop down list.
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14.  Click the Search 
Contact button for the 
Payee.

The Search Contact window opens. The 
Contact Type defaults to Corporation and 
the Service Provided to None in Section 
B.

15. Click the down arrow in 
the Service Provided
box.

16. Select Credit Report
from the Service 
Provided drop down list.

17. Select Credit Bureau, 
Inc.

18. Click OK.

19. Type 50 in the Paid by 
Others box.

The Paid by Others box is used for third 
parties that are paying the fee.

20. Click the down arrow in 
the Paid by Others 
contact box.

The Paid by Others drop down selection 
provides previously associated contacts. Users 
may utilize the Contacts button to add a new 
payee for the Paid by Others box.

21. Select Bank of Florida. DoubleTime automatically places a (L) in the 
Paid by Others column to indicate that this 
fee was paid by the lender.

22. Double click the Paid by 
Others POC Amount 
Withheld box.

Enter the amount of Paid by Others that 
will not be funded at closing. The $50.00 fee 
is displayed in the Paid by Others POC 
Amount Withheld box. This amount will 
not be displayed on the Balance Sheet.

What You Do Comments
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Section C - Services Borrower Did Shop For

23. Click OK. The detail window closes. Line B02 displays 
the Credit Report Fee line description, Payee, 
Paid By Others and the amount Paid by 
Others box with an (L). The blue triangular 
symbol Line Detail Indicator appears in the 
top left corner of the row.

DoubleTime displays the total charges for the Buyer at the top of each section 
header (in the grey bar).

What You Do Comments
1. Select section C, line 01.

The CFPB's ruling on disclosing simultaneously issued Owner and Lender Title 
Insurance Policy charges on the Closing Disclosure differs from Florida's Office 
of Insurance Regulations requirements. It may be necessary for the Seller to 
credit the Borrower for extra charges incurred when the Seller is contracted to 
pay the Owner's Policy premium. DoubleTime will automatically disclose the 
Title Insurance charges in Section C and H according to the CFPB's Final Rule. 
The TRID rule rates the Mortgagee policy at the full promulgated rate vs. the 
Owner’s policy. The Lender’s Policy Variance amount calculated by 
DoubleTime is the difference between TRID rates and FL Promulgated rates for 
the Lender’s policy and Endorsements. DoubleTime places the TRID rates in 
Section C for the Lender’s Policy and Endorsements and the TRID rate for the 
Owner Policy in Section H.

An additional breakdown of the Title Insurance charges will be included on the 
'Florida Insurance Premium Disclosure' document. The 'Florida Insurance 
Premium Disclosure' document will be automatically added to the Documents 
Module for all Closing Files that contain a loan and policy. A 'CD Addendum B 
– Customary Recitals' document will also be added to Closing Files that use a 
Closing Disclosure. 
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What You Do Comments
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2.  Click the Title 
Premium Allocation
button on the secondary 
toolbar.

The Title Insurance Calculator window is 
displayed with the C.01 Loan Policy tab 
active. This tab is the Lender’s Title Insurance 
amount that is displayed on line C01.  H.01 
Owner’s Policy tab is located on line H01 
and is the difference of the TRID rate and the 
Florida Rate.

3. Click on the TRID 
Variance tab.

The variance amount is shown. The Owner’s 
Policy Variance Amount calculated by 
DoubleTime is the difference between FL 
Promulgated rates and TRID rates. It may 
help with determining a possible credit 
amount back to the Borrower when the Seller 
is paying the Owner’s Policy premium. 

4. Click on the Loan Policy
tab.
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5. Select Split B/S from the 
Payor drop down list.

The Loan policy Payor can be set to: 
Borrower, Seller, Other, Split B/S, or
Split.

6. Change the Seller 
Amount to $925.00.

This is the credit to the buyer for the 
remaining fee for the owners policy per the 
contract. DoubleTime calculated the amount 
in the TRID Variance tab.

7. Click the Tab key. Notice that the Borrower Amount has been 
automatically changed to $197.50. 

You may also put the Borrower Amount in 
first and then the Seller Amount will 
automatically adjust.
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NOTE:  In order for the ALTA Settlement Statements with Florida Rates to 
reconcile with the Closing Disclosure, you have to identify if and where a 
variance credit is given by selecting a Transaction Type of TRID Variance 
Adjustment. 
If showing the variance adjustment on page 2 by splitting the Lender’s Policy 
charges, you must open the Title Calculator from the secondary toolbar and 
change the Payor on the Loan Policy tab to the Split B/S option. This allows 
you to show the Seller paying a portion of the Loan policy (The Seller’s portion 
is equal to the variance amount). 
When changing the Payor to Split B/S, a Transaction Type selection 
becomes available. Set the transaction type to TRID Variance Adjustment. 
TRID Variance Adjustments are excluded from the ALTA Settlement Statement 
reports with Florida rates because the variance credit is only needed when using 
the TRID rating rules. It is also important that the TRID Variance 
Adjustment credit is equal to Variance Amount that is calculated in the 
Title Calculator, TRID Variance tab for the bottom line totals to match the 
Closing Disclosure. 

8. Click OK. The Title Insurance Calculator window 
closes and the Title - Lender’s Title Insurance 
and Endorsement fee is now split on the 
Closing Disclosure on line C01.

NOTE: You can also adjust the Title 
Insurance Premium paid by the Seller and 
Buyer by showing a credit from the Seller to 
the Buyer on Page 3, sections L & N.
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9. Select section C, line 02.

10. Click the down arrow in 
the Description box and 
Type t.

11. Select Title - Survey Fee
from the Description
drop down list.

NOTE: Per the CFPB rule all title charges 
must be described as Title – then the fee 
description.

By selecting the down arrow in the 
description box, user can access the pre-typed 
lines without using the Detail window.

12. On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window opens. The 
Contact Type defaults to Corporation and 
the Service Provided to None in Section
C. Using the Search Contact button is an 
alternative way to access the search contact 
without using the Detail window.

13. Click the down arrow in 
the Service Provided
box.
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14. Select Surveyor from the 
Service Provided drop 
down list.

All survey companies that have been added to 
Richard P. Bruce’s Contact module are 
shown in the Legal Entity Name box.

15. Select Property 
Surveyors, Inc.

16. Click OK.

17. Type 350 in the 
Borrower Paid At 
Closing box.

DoubleTime provides the ability to free type 
amounts in the columns without accessing the 
Detail window.

18. Select section C, line 03.

19. Click the down arrow in 
the Description box and 
Type P.

20. Select Pest Inspection 
Fee from the 
Description drop down 
list.

Pest Inspection Fee is displayed as the line 
description on C03.

21. On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window opens. The 
Contact Type defaults to Corporation and 
the Service Provided to None in Section 
C.  Leaving the default, Service Provided 
to None, user can search all previously added 
Corporations. Changing the Service Pro-
vided to Pest Inspector, user views only Pest 
Inspector companies which were previously 
added in the Contacts module.

22. Click the down arrow in 
the Service Provided
box.

23. Select Pest Inspector
from the Service 
Provided drop down list.

24. Select Pest Inspector, 
Inc.

25. Click OK.
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26. Type 84 in the Borrower
Paid At Closing box.

27. On the secondary 
toolbar, click the Save 
button.

When the Save button is used, DoubleTime 
automatically alphabetizes the line descrip-
tions for each section on page 2 per the CFPB 
rule. This will also occur when a new tab is 
selected, when a detail window is closed, 
selecting the print option or exiting out of the 
Settlement Statement module.

28. Select section C, line 04.

29. Click the down arrow in 
the Description box and 
Type t.

30. Select Title – Settlement 
Closing Fee from the 
Description drop down 
list.

31. Click the down arrow in 
the Payee box.

Payee default is (None).

32. Select Richard P. Bruce, 
Esq., closing agent.

Richard P. Bruce, Esq. is displayed as the 
payee.

33. Type 250 in the 
Borrower Paid At 
Closing box.

34. Type 250 in the Seller
Paid At Closing box.

Line C04 displays a Title - Settlement Closing 
fee in the amount of $250 paid by the Buyer 
and Seller Paid at Closing.

35. Select section C, line 05.

36. Click the down arrow in 
the Description box and 
Type t.
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37. Select Title–Title Search
from the Description
drop down list.

Use the Description box scroll bar to view 
all pre-typed lines.

38. On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window opens. The 
Contact Type defaults to Corporation and 
the Service Provided to None in Section
C.

39. Click the down arrow in 
the Contact Type box.

40. Select LLC from the 
Contact Type drop down 
list.

41. Select ATFS, LLC.

42. Click OK.

43. Type 150 in the Seller
Paid At Closing box.

DoubleTime displays the total charges for the Buyer at the top of each section 
header (in the grey bar).

Section D Total Loan Costs (Borrower - Paid) is the loan costs subtotals 
for the A, B and C section. DoubleTime automatically populates these fees. It 
also provides totals for the Borrower Paid At Closing column and the 
Borrower Paid Before Closing column.
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Other Costs
The Other Costs section of page 2 includes sections E through I.

Section E - Taxes and Other Government Fees
Clicking the calculator button on line E.01 under the Other Costs section of Page 2
for Taxes and Other Government Fees, initiates the Recording Calculator. 
The Recording Calculator window contains multiple tabs to help calculate your 
recording fees and transfer taxes. Simply enter the number of pages of your Deed, 
Mortgage and other documents on the Recording Fees (Deed/Mtg) and 
Recording Fees (Other) tabs and the correct amount will be calculated for you. 
You also have the option to split the charges between the buyer, seller and a third party 
participant.

What You Do Comments

1. Click the Recording 
Calculator button on 
section E, line 01.

The Recording Calculator window is 
opened and the Recording Fees (Deed/
Mtg) tab is displayed.

2. Type 2 in the # of Pages
box in the Deed column.

The calculations is automatically made for 
recording a 2 page deed after you select a 
different field or click the OK button. The 
default Payor in this series is set by custom 
and can be changed by selecting the down 
arrow.

3. Type 24 in the # of 
Pages box in the 1st 
Mortgage column.

The charge for recording a 24 page mortgage 
is automatically calculated after you select a 
different field or click the OK button.
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4. Click the Recording 
Fees (Other) tab.

The Recording Fees (Other) tab is used to 
calculate the recording charges for other 
instruments besides the Deed and Mortgages. 

5. Type Continuous 
Marriage Affidavit in the 
Description box for 
Other Doc 1 column.

6. Type 2 in the # of Pages
box in the Other Doc 1
column.

The calculation is automatically made for 
recording a 2 page Continuous Marriage 
Affidavit after you select a different field or 
click the OK button. The default Payor in 
this series is set by custom and can be 
changed by selecting the down arrow. 
NOTE:  The Report menu in the Settlement 
Statement module offers a Recording 
worksheet which displays the recording 
documents and amounts charged.
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7. Click OK. The Recording Calculator window is 
closed.

NOTE: On the State Document Stamps
and Deed Surtax & Intangible Taxes
tabs, the correct charges automatically 
calculate based on your file's sales price and 
loan amount and the property county.

NOTE: Transfer taxes are disclosed on one 
total line in Section E02 by default. You may 
choose to disclose the transfer taxes on 
multiple lines by changing the Show Total 
Transfer Taxes... selection on the CD 
Options tab. User’s may save this setting by 
using Preference - User Setting - 
Settlement Statement tab.

8. Select Section E, line 01.

9. On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window opens. The 
Contact Type defaults to Other and the 
Service Provided to Recording Dept in 
Section E.
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Section F - Prepaids

10. Select Orange County 
Comptroller.

11. Click OK.

12. Select section E, line 02.

13. On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window opens. The 
Contact Type defaults to Other and the 
Service Provided to Recording Dept in 
Section E.

14. Select State of Florida.

15. Click OK.

16. Select section E, line 03.

17. Click the down arrow in 
the Payee box.

18. Select State of Florida.

19. Select section E, line 04.

20. Click the down arrow in 
the Payee box.

21. Select State of Florida.

DoubleTime displays the total charges for the Buyer at the top of each section 
header (in the grey bar).

What You Do Comments
1. Select section F, line 01. The F section displays prepaid items which 

the lender may require to be shown.
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2. Type 12 in the (    mo.)
field for Homeowner’s 
Insurance Premium and 
press the Tab key.

3.   On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Insurance Comp.

4. Select Home Insurance, 
Inc.

5. Click OK.

6. Type 750 in the 
Borrower Paid Before 
Closing box.

The Before Closing box indicates the Buyer 
has paid the charges prior to closing.

7. Select section F, line 03. The interest rate, supplied by the lender, is 
entered in the Closing File module on the 
Loans tab and then the Terms tab. 
DoubleTime automatically calculated the per 
diem rate as well as the total interest due from 
the closing date entered in the Closing File
module. The total interest due is from the 
closing date to the first day of the following 
month. NOTE: The per diem amount can be 
edited as necessary.

8. Change the Prepaid 
Interest amount from 
17.2603 to 17.27 and 
press the Tab key.

9. Select section F, line 05.

10. Click the down arrow in 
the Description box and 
Type F.

11. Select Flood Insurance 
Premium from the 
Description drop down 
list.

What You Do Comments
Page 122 DT Version: 8.1



Settlement Statements - Closing Disclosure (CFPB)
Section G - Initial Escrow Payment at Closing

12. Type 12 in the (    mo.)
field for Flood 
Insurance Premium and 
press the Tab key.

13. Click the down arrow in 
the Payee box.

14. Select Home Insurance, 
Inc.

Home Insurance, Inc. was previously 
associated with this closing file when we 
selected it as the payee for the homeowner’s 
insurance.

15. Type 325 in the 
Borrower Paid Before 
Closing box.

DoubleTime displays the total charges for the Buyer at the top of each section 
header (in the grey bar).

What You Do Comments
1. Select section G, line 01. The G section displays initial escrow which 

the lender may require. These figures are 
supplied by the lender.

2. Type 62.50 per month, 
then type 2 mo. in the field 
for Homeowner’s 
Insurance and press the 
Tab key.

The Homeowner’s Insurance is calculated and 
the total of $125.00 is displayed in the 
Borrower Paid At Closing column. 
NOTE: If you select another line or press 
enter instead of pressing tab, the calculated 
amount will also display on the appropriate 
line.

3. Select section G, line 03.
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Section H - Other             
NOTE: The CFPB's ruling on disclosing simultaneously issued Owner’s and Lender’s 
Title Insurance Policies charges on the Closing Disclosure, differs from Florida's 
Office of Insurance Regulations requirements. It may be necessary for the Seller to 
credit the Buyer for extra charges incurred when the Seller is contracted to pay the 
Owner's Policy premium. DoubleTime will automatically disclose and rate as per 
TRID Final Rule, the Mortgagee Policy as line description Title - Lender’s Title 
Insurance in the C section. The difference for the Owner’s Policy and Florida’s rate, 

4. Type 311.11 per month, 
then type 6 mo. in the field 
for Property Taxes and 
press the Tab key.

The Property Tax is calculated and the total of 
$1,866.66 is displayed in the Borrower Paid 
At Closing column.

5. Select section G, line 04.

6. Type Flood Insurance in 
the Description field.

7. Type 27.08 per month, 
then type 2 mo. in the field 
for Flood Insurance and 
press the Tab key.

The Flood Insurance is calculated and the 
total of $54.16 is displayed in the Borrower 
Paid At Closing column.

8. Select section G, line 08.

9. In section G, line 08, type 
-427.11 in the Borrower 
Paid At Closing box in 
the field for Aggregate 
Adjustment and press the 
Tab key.

The Aggregate Adjustment figure is supplied 
by the lender. This amount is entered as a 
negative number because it is a credit used to 
reduce the reserves collected from the 
borrower.

DoubleTime displays the total charges for the Buyer at the top of each section 
header (in the grey bar).
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DoubleTime will automatically rate and disclose in the H section as line description 
Title - Owner’s Title Insurance (optional).
An additional breakdown of the Title Insurance charges is included on the Florida 
Insurance Premium Disclosure document. The Florida Insurance Premium 
Disclosure document is automatically added to the Documents module for all 
Closing Files that contain a loan and policy. A CD Addendum B – Customary 
Recitals document will also be added to closing files that use a Closing 
Disclosure.

What You Do Comments
1. Select section H, line 01. DoubleTime automatically generated, a line 

description Title - Owner’s Title Insurance 
(optional) and rated the Owner’s Policy based 
on CFPB rule, and placed the charge in the 
Seller Paid at Closing column.

2. Remove the word optional 
from the Description
box.

The Seller is paying for the Owner’s Title 
Insurance per our contract. Therefore, the 
Owner’s Title Insurance is not optional. 
DoubleTime provides the ability to edit line 
description as necessary. 

3. Select section H, line 02.  

4. Click the down arrow in 
the Description box and 
Type H.

5. Select Home Warranty 
Fee from the 
Description drop down 
list.

6.  On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is None.

7. Type Home Warranty, 
Inc in the Name field.

8. Click OK. The Search Contact window is closed and 
line H02 now displays Home Warranty, Inc. in 
the Payee box.
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9. Type 729.50 in the Seller 
Paid At Closing box in 
the field for Home 
Warranty Fee.

The Seller is paying the Home Warranty fee as 
per the contract.

10. Double click section H, 
line 03.

The Detail window opens.

NOTE: The detail windows for Section H allows you to change the Fee Type
in the top left of the window. To access the Real Estate Broker 
Commission Calculator, change the Fee Type by selecting the down arrow 
and select Broker Commission Fees. The Real Estate Broker 
Commission Calculator allows you to calculate multiple Real Estate Broker 
commissions based on a Basis Amount and Percentage. You also have the 
option to withhold amounts from deposits added in the Closing File module. 

NOTE: The Broker Commission Calculator must be used in order for the 
Broker Commission fee to show correctly on the ALTA Settlement Statements 
reports.

11. Select Broker 
Commission Fees from 
the Fee Type drop down 
list.

The Real Estate Broker Commission
Calculator opens. The purchase price of 
$225,000 is displayed in the Basis Amount
box of the work area.

What You Do Comments
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12. Type 6 in the Percentage
field and then press the 
Tab key.

The commission of $13,500.00 is displayed 
in the Amount box. NOTE: The total 
commission percentage for all real estate 
broker’s involved in the transaction is entered 
in the Percentage box. You may also type 
in the total dollar amount for all commission 
in the Amount box.

13. Select Real Estate 
Commission Buyers 
Broker from the 
Description drop down 
list.

14. Click the down arrow in 
the Broker payee box.

15. Select Realty Company, 
Inc.

Realty Company, Inc. was associated with this 
file in the Closing File module.
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16. Delete the 6 and type 3 in 
the Percent box for 
Realty Company, Inc., 
and press the Tab key.

The commission amount is split between  two 
real estate brokers. A second real estate broker 
commission work area is added to the 
window. DoubleTime automatically 
calculated the split, and displays 3% in the 
Percentage box and $6,750.00 in the 
Commission box, for the second real estate 
broker work area. NOTE: A dollar amount 
may also be entered in the Commission 
box.

17. In the second realtor 
commission work area, 
select Real Estate 
Commission Sellers 
Broker from the 
Description drop down 
list.

18. Click the down arrow in 
the Broker payee box.

19. Select Better Homes, 
Inc.

Better Homes, Inc. was associated with this 
file in the Closing File module.
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20. Click the OK button at the 
bottom of the window.

The Real Estate Broker Commission
Calculator closes and populates both real 
estate broker commissions on lines H02 and 
H03. NOTE: When exiting out of any 
calculator, all line descriptions on page 2 are 
automatically alphabetized as per CFPB Final 
Rule.

21. Select section H, line 05.

22. Click the down arrow in 
the Description box and 
Type R.

23. Select Roof Inspection 
Fee from the 
Description drop down 
list.

24.  On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is None.

25. Type Roof Inspectors, 
Inc in the Name field.

26. Click OK. The Search Contact window is closed and 
line H05 now displays Roof Inspectors, Inc. in 
the Payee box.

27. Type 125 in the 
Borrower Paid At 
Closing box in the field 
for Roof Inspection 
Fee.

The Borrower has decided to get a roof 
inspection done.

DoubleTime displays the total charges for the Buyer at the top of each section 
header (in the grey bar).

What You Do Comments
Training Workbook: August 2018 Page 129



Settlement Statements - Closing Disclosure (CFPB)
Closing Disclosure Page 3
Page 3 of the Closing Disclosure has two sections, Calculating Cash to Close
and Summaries of Transactions. In DoubleTime you will notice page 3 is divided 
amongst two tabs. The first tab is Pg. 3 – Calc. Cash to Close and the second tab is 
Pg. 3 – Summaries of Transactions.

NOTE: The Summaries of Transactions tab should be filled out prior to the 
Calculating Cash to Close tab.

Pg. 3 - Summaries of Transactions 
Summaries of Transactions includes sections K through N and a Calculation
section at the bottom of page 3. The Calculation section displays the Borrower and 
Seller Cash to Close amounts. 
You can click directly on a line, type in the description and enter an amount. If greater 
detail is needed, double click the line to initiate a Detail Window. The Detail window 
can be used to enter in an Amount Withheld from the loan (Net Funding) or copy 
the amount to the Seller side. 
The last line in each section can be used to show additional credits and debits by 

clicking on the  Add addendum for additional items button. 
An expanded detail window for the Addendum row is displayed allowing you to insert 
fee descriptions and amounts. The total of all addendum items is inserted on the 

Section I displays the Total Other Cost Subtotals (E, F, G, H). It also 
provides totals for the Borrower Paid At Closing column and the Borrower 
Paid Before Closing column.

Section J - Total Closing Cost contains an area for Lender Credits.

NOTE: DoubleTime contains multiple Closing Disclosure options that can be 
accessed on the CD Options tab. You are able to select multiple format 
changes for your current Closing Disclosure including the options to Use 
Pages 2A and 2B. All lines on page 2 must be used before using Pages 2A 
and 2B.

What You Do Comments
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selected row of page 3 after clicking OK. The Addendum Fee Descriptions and 
amounts will be displayed on Closing Disclosure Addendum A when the Closing 
Disclosure is printed. 
NOTE: A triangular blue symbol called a Line Detail Indicator will appear in the 
top left corner of a row that contains an extra selection or entry from the Detail
window. This indicator will appear on rows that contain Prorated Amounts or a 
Transaction Type of TRID Variance Adjustment. This feature helps you 
quickly identify items on the Closing Disclosure that have extra options selected 
without having to open the detail window. If you hover your mouse over the Line 
Detail Indicator for a particular row, a pop-up will appear indicating the transaction 
information.

A triangular yellow symbol  called a Line Detail Indicator will appear in 
the bottom left corner of a row that contains a Line Description that does not match a 
GSE Fee Type for that row. ** This feature is for future use and not intended to be 
used with this release. 

Section K - Due from Borrower at Closing/Section M - Due to 
Seller at Closing 

What You Do Comments
1. Click the Pg. 3 - 

Summaries of 
Transactions tab.

2. Doubleclick on Section K, 
line 11. 

A proration window opens. Selecting this line 
allows you to add a paid adjustment. K01 and 
M01 displays purchase price.  K03 displays 
closing cost from page 2, section J.

3. Click the Pro-rate check 
box.

Additional fields open. The Date From box
defaults to the closing date. The Count Last 
Day box is automatically selected, crediting 
the day of the closing to the seller.
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NOTE: Notice the Transaction Type field. The default is set to (none). If the 
Seller gives a Lender’s Title policy credit to the Buyer on page 3, this field must 
be set to TRID Variance Adjustment so that the ALTA - Florida Rates
report is correct.

4. Select Homeowners 
Association Dues from 
the Description drop 
down list.

This is the description of the payment by the 
seller that was paid in advance. This is an 
editable field.

5. Type 250 in the Gross 
amount box and press the 
Tab key.

This is the amount paid by the seller for 
Homeowner Association dues. 

6. Select Quarterly from the 
Period drop down list.

This will identify the amount as a quarterly 
payment. NOTE: TAB out of the Gross 
Amount box to activate the Period box.

7. Type 03/31/(current 
year) in the Date to box 
and press the Tab key.
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Section L - Paid Already by or on Behalf of Borrower at Closing/ 
Section N - Due from Seller at Closing

8. Click OK. Quarterly dues are prorated and displayed on 
section K, line 11 and section M, line 12. 
NOTE: The Count last day is automatically 
selected, crediting the day of the closing to the 
seller.  NOTE: Copy To box allows for the 
credit to display on a different line in the K 
section.

What You Do Comments
1. Doubleclick on Section L, 

line 13. 
A proration window opens. Selecting this line 
allows you to calculate the unpaid county 
taxes.

2. Click the Pro-rate check 
box.

Additional fields open. The Date To box 
defaults to the closing date. The Period box 
defaults to Annually, and can be changed if 
needed. Date From box defaults to the first 
day of current year.

3. Type 3733.30 in the 
Gross amount box.

This is the amount of the property taxes for 
the entire year.

4. Type 4 in the Discount 
percent box.

This is the maximum allowable discount 
which is determined by the Tax Collector’s 
office according to the month in which it is 
paid.

5. Press the Tab key. DoubleTime calculates the prorated taxes. 
NOTE: The default setting for the Count 
Last Day box is deselected.
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6. Click OK. The prorated taxes are displayed on section L, 
line 13 and section N, line 15. 

7. Click the Payoff 
Calculator button for 
Section N, line 04. 

The Payoff Calculator window opens. The 
information here is supplied by the payoff 
lender.

8. Type 0301(current year)
in the From Date box.

9. Type 0320(current year)
in the To Date box.

The payoff calculation includes several days 
of per diem interest after the closing date to 
allow for transmittal to and posting of funds 
by the payoff lender.

10. Type 43.32 in the Per 
Diem Amount box.

DoubleTime automatically calculates the 
Total Days. The Per Diem Amount is 
supplied by the lender holding the mortgage.

11. Type 175675.66 in the 
Mortgage Balance box 
and press the Tab key.

The Mortgage Balance amount is supplied 
by the lender holding the mortgage. When you 
press the Tab key, the Total Payoff 
Amount is calculated.
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Calculation
The Calculation section displays the Borrower and Seller Cash to Close amounts.    

Pg. 3 - Calc. Cash to Close
The Calculating Cash to Close table is used to compare changes from the Loan 
Estimate and the Closing Disclosure. DoubleTime will allow you to fill in 
amounts on the Loan Estimate column and will automatically populate most fields 
under the Final column. Selecting Yes in the Did this change? column will default 
in the standard language set forth by the UCD. If a variation of the standard language 
is needed, simply click the Override? box to type in the text box. Figures for the 
Loan Estimate column are supplied by the lender.

12. Click Print. The Print Options window is displayed with 
All selected and number of copies defaults to 
1.

13. Click OK. The Payoff figures are printed and the Payoff
Calculator is re-displayed.

14. Click OK. The Payoff Calculator is closed. The 
payoff balance totaling $176,542.06 is 
displayed on section N, line 04. NOTE: It is 
not necessary to use the Payoff Calculator
if the payoff supplied by the lender is not 
expired. You are able to type the payoff 
amount directly on N04. The name of the 
payoff lender is automatically populated as 
the Payee.
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What You Do Comments
1. Click the Pg. 3 - Calc. 

Cash to Close tab.
DoubleTime automatically populates most of 
the fields in the Final column.

2. Type 9767 for Total 
Closing Cost (J) in the 
Loan Estimate Column.

The Final column displays the total closing 
cost from page 2, section J.

3. Select Yes from the Did 
this change? drop down 
list for Total Closing 
Cost (J).

The standard language is populated for the 
Did this change? column.

4. Type -1325 for Closing 
Costs Paid Before 
Closing in the Loan 
Estimate Column.

The Final column displays page 2 total cost 
paid before closing for the Borrower.

5. Type 45000 for Down 
Payment/Funds from 
Borrower in the Loan 
Estimate Column.

The Final column displays Sales Price minus 
Deposit as the Down Payment. NOTE: You 
should not change the Final column because 
it affects Cash To Close on page 1 and 3.

6. Type -45000 for Deposit
in the Loan Estimate
Column.

The Final column displays the actual deposit 
entered in the Closing File module. 
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Page 4 - Additional Information About This Loan
This page is used to show the Borrower loan disclosures. This Information is provided 
by the lender. Page 4 displays the standard CFPB (UCD) language. You have the 
ability to select option boxes to indicate additional information regarding the 
Borrower loan. An Escrow Account section is also located on page 4.  DoubleTime 
provides the ability to free type escrow amounts and type the description of what is 
escrowed.

7. Select Yes from the Did 
this change? drop down 
list for Adjustments and 
Other Credits.

The standard language is populated for the 
Did this change? column. The Final
column displays the prorations.

NOTE: The Cash to Close totals are automatically populated for the Loan
Estimate and Final column.

What You Do Comments
1. Click the Page 4 tab.

What You Do Comments
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2. In the Assumption
section, click the “will not 
allow assumption ….” box.

The selected box displays a check mark. This 
indicates the loan will not allow assumption.

3. In the Demand Feature
section, click the “does not 
have ….” box.

The selected box displays a check mark. This 
indicates the loan does not have a demand 
feature.

4. In the Late Payment
section select Percent Of 
Principal And Interest
from the drop down 
selection.

5. In the Late Payment
section, type 15 in the “If 
your payment is more than 
days late” section.

6. Type 5 in the % of the 
late payment amount
box.

You may also use the late fee of box to 
disclose a flat late fee when the lender is not 
using a percentage.

7. In the Negative
Amortization section, 
ensure that the “do not 
have a negative ….” box is 
checked.

The selected box displays a check mark. This 
indicates the loan does not have a negative 
amortization.

8. In the Partial Payments
section, ensure that the 
“does not accept ….” box 
is checked.

9. In the Escrow Account
section, ensure that the 
“will have an escrow….” 
box is checked.

The top right side of page 4 displays the 
Escrow Account section. NOTE: In order 
to open the text boxes located in the Escrow 
section, you must first select the will have 
an escrow...box.
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10. Type 4808.28 in the 
Escrowed Property 
Costs over Year 1 field.

11. Press the Tab key.

12. Type Taxes, 
Homeowner’s 
Insurance, Flood 
Insurance in the 
“Estimated total 
amount…” field.

13. Type 1000 in the Non-
Escrowed Property 
Costs over Year 1 field.

14. Press the Tab key.

15. Type HOA Dues in the 
“Estimated total 
amount…” field.

16. Type 1618.71 in the 
Initial Escrow Payment
field.

17. Type 400.69 in the 
Monthly Escrow 
Payment field.

NOTE: The Adjustable Payment (AP) Table can be activated by selecting 
the checkbox at the top left of the table. Toggling the AP table on and off will 
affect the Loan Terms table | Monthly Principal & Interest on Page 1 of 
the Closing Disclosure. The Adjustable Payment (AP) Table provides drop 
down selections where you can disclose if the Borrower loan has these features. 
Fields/boxes are also provided to type in dates and amounts.  This information is 
provided by the lender.
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NOTE: The Adjustable Interest Rate (AIR) Table can be activated by 
selecting the checkbox at the top left of the table. Toggling the AIR table on and 
off will affect the Loan Terms table | Interest Rate on Page 1 of the Closing 
Disclosure. The Adjustable Interest Rate (AIR) Table provides drop down 
selections where you can disclose if the Borrower loan has these features. 
Fields/boxes are also provided to type in dates and amounts.  This information is 
provided by the lender.
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Page 5 - Loan Calculations and Other Disclosures 
This page is used to show the Borrower loan disclosures. This information is provided 
by the lender.
 

Loan Calculations 

The Borrower loan is a fixed rate, therefore the Adjustable Payment (AP) 
Table and Adjustable Interest Rate (AIR) Table are not used in this 
example.   

NOTE: When the tables are left untoggled they do not print on the Closing 
Disclosure, but still visible on page 4 tab.

What You Do Comments

1. Click the Page 5 tab.

What You Do Comments
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Other Disclosures 

2. Type 290980.96 in the 
Total of Payments box.

Total of payment displays in the text box.

3. Type 110980.96 in the 
Finance Charge box.

Total finance charge displays in the text box.

4. Type 170960.74 in the 
Amount Financed box.

Total amount financed displays in the text 
box.

5. Type 4.174 in the Annual 
Percentage Rate (APR)
box.

The APR displays in the text box.

6. Type 61.65 in the Total 
Interest Percentage 
(TIP) box.

The TIP displays in the text box.

What You Do Comments
1. In the Appraisal section, 

ensure that the box is 
checked.

Standard CFPB/ UCD language is displayed 
in the Other Disclosures section, located at 
the top left on page 4.

The Appraisal language is activated and will 
print on the Closing Disclosure.
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Contact Information 
The Contact Information table allows you to display important information about 
key participants from the Closing Disclosure. The key participant types that 
populate are: Lender, Mortgage Brokers, Real Estate Broker(B), Real Estate 
Broker(S) and the Settlement Agent. Column widths can be resized to allow 
information to fit within the printable margins by clicking and dragging between 
column headers. Column headings appearing in yellow indicate the contact 
information in that column does not fit within the printable margin and will appear on 
Closing Disclosure Addendum A. Contacts can be added or deleted on the table 
by right clicking any of the column headings and selecting Add or Delete. Selecting 
Add will list key participants from the Participants tab in the Closing File module 
that you can elect to include in the table.

NOTE: If you hover your mouse over the gray title bar in the Contact Information
table you will get a right click prompt. If you click on this prompt you will get an 
Add/Delete option box. Clicking on Add/Delete will give you the option to bring in 
or delete contacts to the table. You may not edit any text located in newly added 
participants from the Closing File module the Contact Information table. You 
must return to the Closing File module or the Contacts module to make any 
necessary edits.

2. In the Liability after 
Foreclosure section, 
ensure that the “state law 
does not protect ….” box is 
checked.

NOTE: DoubleTime will print standard 
language on page 5 that is not displayed in the 
tab view.
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Confirm Receipt 
The Confirm Receipt section is located at the bottom left of page 5. The Confirm 
Receipt signature line ONLY confirms receipt of the Closing Disclosure. 

What You Do Comments
1. Ensure the Show 

Confirm Receipt box is 
checked.

An Applicant signature line is displayed along 
with the standard CFPB/UCD language.

NOTE: Additional options concerning the Confirm Receipt lines can be 
selected in the CD Options tab.  The Confirm Receipt signature line ONLY 
confirms receipt of the Closing Disclosure by the Borrower. It does not confirm 
acceptances of the loan terms. DoubleTime provides the CD Addendum B - 
Customary Recitals document located in the Document module. You may 
have the Buyer and Seller sign this document.

Viewing Closing Statement Alerts 
What You Do Comments

1.  On the secondary 
toolbar, click the Closing 
Statement Alerts button.

The Closing Statement Alert window 
opens. DoubleTime provides transaction 
specific information on line items, and 
sections that may have been inadvertently 
overlooked or which may be logically 
inconsistent with other data in this closing 
file. There is one reminder provided: 
Missing date issued.
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2. Click on the Close button.

3. Select the Page 1 tab. Page 1 displays Date Issued located on the 
top left area of the window.

4. Type 0317(current year)
in the Date Issued field.

Lender will provide issue date. You may also 
click the down arrow to access a calendar in 
order to enter the Date Issued.

What You Do Comments
Training Workbook: August 2018 Page 145



Settlement Statements - Closing Disclosure (CFPB)
Viewing Costs at Closing
What You Do Comments

1. Scroll down to the bottom 
of Page 1 to view the 
Costs at Closing section

NOTE: DoubleTime has populated these fields from information that was 
entered on other tabs in Closing Disclosure module. You are unable to type 
over the fields to make any edits.

CD Options 
DoubleTime contains multiple Closing Disclosure Options that can be accessed 
on the CD Options tab. You are able to select multiple format changes for your 
current Closing Disclosure including the options to Use Pages 2A and 2B, Show 
Total Transfer Taxes on a single line (Section E), as well as options for the 
Confirm Receipt signature block.

NOTE: You may change the default settings for these Closing Disclosure
Options in your User Preferences. Simply click Preferences, from the main 
menu bar and then select, User Preferences. Under the Settlement Statement
tab, you will have the ability to change your default settings for all future Closing 
Disclosures. 
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Printing The Closing Disclosure
What You Do Comments

1.  On the secondary 
toolbar, click the Print 
button.

The Print Options window is displayed. 
The Print Range defaults to All, Number 
of Copies to 1, Print What to Closing 
Disclosure and Print to Print all pages. 
NOTE: To print a different statement, 
worksheet, or report, click the Print What
drop down box and make your selection.

2. Select Borrower Only 
CD from the Print What 
drop down menu.

3. Click the More button. A variety of Closing Disclosure formats, 
reports and worksheets are available to be 
printed by clicking the desired check boxes. 
This feature allows you to print multiple items 
at one time.
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NOTE:  It is a good idea to print out an example copy of these reports for use in 
your office. Not all of them are covered in the training class. These reports may 
also be accessed from Reports on the Menu Bar, while you are in the 
Settlement Statements module. 

4. Click the Less button. The Print Options window is re-displayed.

5. Click the Preview button. A Print Preview of the Closing Disclosure is 
displayed.
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Creating Saved Versions of Printed Closing Disclosures

NOTE: While viewing a report in Print Preview mode you will be able to 
save a version of the Closing Disclosure report for future viewing and 
printing. You will not be able to make any changes to prior versions. On the 
menu bar, select Actions > Create Version. Type the name of the version. To 
view a saved version, select Actions from the menu bar and select Display 
Version.

6. Use the  
arrow buttons on the 
secondary toolbar to view 
all pages of the Closing 
Disclosure.

7.  On the secondary 
toolbar, click the Print 
button again.

The Print Options window is re-displayed. 

8. Click OK. The Print Options window closes and the 
Borrower Only Closing Disclosure prints.
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9.  Click the Close 
button.

The Print Preview window is closed.

10. From the menu bar Click 
Reports. Select Seller 
Only CD from the list.

The Seller Only CD Print Preview
window is displayed. DoubleTime provides a 
completed Seller CD when completing the 
tabs in the Settlement Statement module. 
You do not need to access another module or 
fill out another CD for the Seller, since the 
Seller fees were entered as we entered the 
Buyer fees.

11. On the secondary toolbar, 
click the print button.

The Print Options window is displayed.

12. Click OK. The Print Options window closes and the 
Seller Only Closing Disclosure prints.

13.  Click the Close 
button.

The Print Preview window is closed.

14. From the menu bar Click 
Reports. Select ALTA 
Settlement Statement - 
Combined > Florida 
Promulgated Rates
from the list.

The ALTA Settlement Statement - 
Combined - Florida Promulgated Rate
Print Preview window is displayed. Buyer and 
Seller charges are displayed since the fees 
were previously entered in the CD.

15. On the secondary toolbar, 
click the print button.

The Print Options window is displayed.
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16. Click OK. The Print Options window closes and the 
ALTA Settlement Statement - 
Combined prints.

UCD XML File Export
DoubleTime has a UCD Export feature located in the Settlement Statement 
module for both Sale and Refinance Closing Disclosures. When it is requested, 
DoubleTime has the ability to export the required data from the Closing 
Disclosure, including the required PDF into an XML formatted file. This is 
used to submit to the GSE's (Government Sponsored Enterprise’s such as Fannie 
Mae and Freddie Mac). 

From the Actions menu, select the UCD XML File Export option.

UCD XML File Export Window
Upon entering the UCD XML File Export window, select the path where you 
would like to save the XML file. The next step is to select the format that is 
requested by choosing one of the options under Select Export PDF Format. 
Finally, click on Create UCD Export File. Once completed, click on Close 
to exit the window.
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ALTA Settlement Statement Forms
Settlement Agents may choose to supplement the Closing Disclosure with an 
additional Settlement Statement. DoubleTime allows you to produce the 
ALTA Settlement Statement forms from the Settlement Statements 
module – Reports menu. 

ALTA has developed these standardized statements for title insurance and 
settlement companies to use in itemizing all the fees and charges which both the 
Buyer and Seller must pay during the settlement process of a housing 
transaction. 

All figures automatically populate on the ALTA Settlement Statements 
based on information added to the Closing Disclosure. When entering fees 
on page 2 of the Closing Disclosure, Section B Fee Type defaults to Loan 
Fees and Section C Fee Type defaults to Other Fees. When printing the 
ALTA Settlement Statement these fees will be placed in the “Other- Loan 
Charges” section. To have title fees placed in the “Title Charges & 
Escrow/ Settlement Charges” section you must change the Fee Type in 
the detail window to Title Fees. To access the statements, while in the 
Settlement Statements module for a Closing Disclosure, select 
Reports from the main menu bar and then choose from 3 different formats: 
Combined, Borrower/Buyer or Seller. Each format may be shown with 
TRID Rates or with Florida Promulgated Rates. All 3 report formats with TRID 
Rates may be printed from the Print Options window or from Reports.
Checking the Show Print View box at the top left of the report will display the 
header of the ALTA Settlement Statement. All information in the header is 
automatically populated for you based on information added in the Closing 
File module. 

You have the added flexibility of modifying line descriptions on the ALTA 
Settlement Statements without affecting the Closing Disclosure. 
Simply click in the Description column on a line and begin typing. You can 
not change amounts. Your modified line descriptions will be saved for all 
printed formats of the ALTA Settlements. 
You have the ability to check the Separate Signature Page box which 
separates the Signature Page from the rest of the Settlement Statement when 
printing.
NOTE:  On the ALTA Settlement Statement the Seller figures are located 
on the left and Borrower on the right.
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Emailing Settlement Statements
What You Do Comments

1. When the settlement 
statement is in Preview 
mode, select eSolutions 
> Email from the main 
menu.

The Settlement Statements—Print 
Preview window converts the file to an 
image file. A list of participants in reference 
to your closing file is displayed with the 
opportunity to select their email addresses. 
NOTE: The email addresses are established 
in the Contacts or Closing File module.

The EMail Properties window opens.

2. Click the  
button.

The Address Book opens in MS Outlook. If 
necessary, scroll to find your instructor’s 
name.

3. Type (the name of your 
instructor) in the 
Search box or select the 
name from the list.
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4. Select your instructor’s 
name and click To ->.

Your instructor’s name is displayed in the To -
> box.

5. Click OK. The Address Book window closes and the 
Email Properties window is re-displayed. 
The instructor’s name you selected is 
displayed at the top of the Participant list. 
NOTE:  You may add a message by typing in 
the Message box.
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Tips

6. Click Send. The email is sent.  NOTE: A copy of the 
email is also placed in your Sent folder.

7.  Click the Close 
button.

The Print Preview window is closed.

8.  Click the Close 
button.

The Settlement Statements module is 
closed.

1. An alternate way to open the Settlement Statements module is to select 
Modules from the menu bar and choose Settlement Statements.

2.  Use the Deposit Summary button, located in the secondary toolbar
to open the Deposit Summary dialog box when on page 3 of the Closing 
Disclosure.

What You Do Comments
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3.   Use the Payoff Calculator button located in the secondary 
toolbar or on line L1 on page 3 of the Closing Disclosure, to open the 
Payoff Calculator.

4.    Use the Recording Calculator button on the secondary toolbar or 
on line E1 on page 2 of the Closing Disclosure, to calculate recording fees.

5.  You must use the Title Premium Allocation button on the secondary 
toolbar to assign a payor or to split the Title Premium fees when on page 2 of 
the Closing Disclosure.

6. In the Print Options window, use the Page Range area to print 
individual pages of the Closing Disclosure.

7.  To display the entire Closing Disclosure, click the Print button on the 
secondary toolbar and select the Preview button.

8. You can display any one report selected in the Print What box by clicking 
the Preview button. You can also select a report, worksheet and other 
settlement statements to view by selecting Reports from the main menu.

9. To print multiple reports at one time, click the More button on the Print 
Options window and select as many different reports, worksheet and other 
settlement statements as needed.

10.  Click the Calculator button on the secondary toolbar to use the 
calculator. You can type the number on the keyboard or use the mouse to 
click the numbers on the displayed calculator. 

11. To obtain a copy of the figures in the Payoff Calculator, leave the Payoff 
Calculator window open after the figures have been calculated. Click the 
Print button.

12.  You can choose to display the Closing Disclosure Alerts at any 
time by clicking the Closing Disclosure Alerts button, on the secondary 
toolbar, to check for any missing items within your Settlement Statement.
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13. To email a Closing Disclosure from your PC, select eSolutions while in 
Print Preview, and click Email. In order to perform this function, you 
must be in preview mode of all Settlement Statements, including the Closing 
Disclosure, and you can only use Outlook or Outlook Express to e-mail from 
the Settlement Statement module. A list of participants in reference to 
your file are displayed with the opportunity to select their e-mail addresses. 
Email addresses need to be established in either the Contacts or Closing 
File module on the Email tab.

14. When you are Updating the Recording Charges for your loan you may 
deselect the Mortgage Intangible Tax for Credit Union loans. 

15. You may print a Proration Worksheet from the Reports menu on the 
main toolbar.

16. You may print a Recording Worksheet from the Reports menu on the 
main toolbar.

17. You may print ALTA Settlement Statements from the Reports menu 
on the main toolbar.

18. You may print a Seller Only Closing Disclosure from the Reports
menu on the main toolbar.

19. From the Print Preview window, you may create a .pdf file of any of the 
reports listed in the Reports menu, by going to the File menu, select Save 
As and save to the desired location.

20.  From the Print Preview window, you may place a draft watermark on 
your Settlement Statement by using the Draft Watermark button on the 
secondary toolbar. This will appear on all pages of your printed Settlement 
Statement.

21. While in the Settlement Statement module you may change from CD to 
HUD or to GFE HUD by using the Format menu on the main toolbar. 
Switching the Settlement Statement type after entering data in the 
Settlement Statements module will result in Settlement Statement
data being lost.

22. On page 2 of the Closing Disclosure, you have the ability to move any line 
to another section by using the Line Administrator. The Line 

Administrator is accessed by using the Insert  button on the 
secondary toolbar.
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Frequently Asked Questions

23. If you have fax software on your computer, fax the CD or other report type 
by changing the printer using the Properties button, and selecting 
Printing to Fax Machine.

24. When the Fee type is set to Broker Commissions or Broker Fees you can use 
the Amount Withheld field for Realtor held deposits. The Balance 
Sheet will show the reduced realtor commission disbursement.

25. In the Closing Disclosure, page 2, you have the ability to change the Fee 
Type. In section H, the Fee Type defaults to Other Fees. Additional 
choices are Broker Commission Fees, Title Fees, and Broker Fees. 
DoubleClick on the line to open the detail window and use the Fee Type
down arrow to make your selection. Use the Broker Commission Fees
to enter Real Estate Commissions, use Broker Fees to enter additional 
Broker Fees such as Realtor transaction fees or a processing fee. Title Fees 
are entered using the Title Fees selection. Selecting the correct Fee Type 
will allow DoubleTime to place these fees in the proper category when 
printing the ALTA Settlement Statement.  On page 2 and 3 when the Fee 
Type is set to Title Fees it will open a field called Trans Type.  When the 
Trans Type is set to TRID Variance Adjustment it will allow the line to 
show a third option for credit from seller to buyer for title fees. 

26. To show the actual Florida Promulgated credit for the Owner’s Title 
Insurance Policy from the seller to the buyer on Page 2, in section H, of the 
Closing Disclosure click on the Title Premium Allocation button on 
the secondary toolbar. Click the TRID Variance tab to get the Variance 
Amount. This amount is the credit from the seller to the buyer. Click on the 
Owner Policy tab in this window. In the Payor drop down list select Split 
B/S. type a minus sign and then type in the Variance Amount (example -
925.00). Click the Tab button on the keyboard and the Seller Amount
displays the total cost of the Owner’s Policy. Click OK. Section H displays 
the Variance Amount in the Borrower Paid At Closing column and the 
total cost of the Owner’s Policy in the Seller Paid At Closing column.

27. You have the ability to customize the Borrower Name(s) on page 5 of the 
Closing Disclosure. To show this option for the current closing file, click 
on the CD Options tab. Select the Show “Confirm Receipt” 
Signature Block and then choose Show Custom Borrower Name(s). 

Question Answer
1. Why aren’t the doc. stamps 

on the deed automatically 
calculated on the Closing 
Disclosure?

You did not insert a property on the Property
tab or a sales price on the General tab of the 
Closing File module.
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2. How do I enter an 
Aggregate Accounting 
Adjustment if it is a 
negative number?

Type a dash (-), and then type the amount. If 
the lender is withholding this amount (to add 
it to their net proceeds check) double click the 
Amount withheld field.

3. How do I add a payee in 
the Settlement 
Statements module?

Click the Search Contact button on the 
secondary toolbar to open the Search 
Contact window. Select or add the contact. 
You may also doubleclick on the line to open 
the detail window and use the Contacts
button to open the Search Contact window.

4. How do I type a negative 
number?

Type a dash (-), and then type the amount.

5. How do I change the 
holder of the deposit from 
someone else to our firm 
prior to closing?

One way to accomplish this is in the Closing 
File module by following these steps:
• Click on the Deposit tab. 
• Click on the Insert button. 
• Choose your firm in the drop down field for
Deposit Held By. 
• In the Amount field enter the dollar 
amount of monies moved to your firm’s trust 
account. 
• In the Received Date field enter the date 
on which the funds were transferred to your 
firm’s trust account.
• Select the Amount field on the line of the 
former deposit holder.
• Change that amount to 0.00
• Save your work and exit the module.
Note: Sometimes the escrow agent holding 

the deposit changes between the time the 
information has been entered in DoubleTime 
and the date of closing. For example, closing 
agents are sometimes required to have all 
deposit monies flow through their escrow 
account as collected funds as part of the clos-
ing process. 
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6. How do I get the Doc 
Stamps to display on 
multiple lines on page 2 of 
the Closing Disclosure in 
Section E?

You may choose to disclose the transfer taxes 
on multiple lines by changing the Show 
Total Transfer Taxes… selection on the 
CD Options tab. You will then be prompted 
to add more lines in section E by using the 
Line Administrator. You can set this up as a 
default in Preferences > User Settings > 
Settlement Statement.

7. How do I enter a fee on 
page 2 of the CD that will 
be paid by the lender on 
behalf of the borrower?

Double-click in the Paid by Others POC
field in the Detail window on page 2 of the 
CD. This will allow you to show the portion 
of the Paid by Others amount that is not 
being funded at closing. This amount will not 
be displayed on the Balance Sheet.

8. How do I print an ALTA 
Settlement Statement with 
Florida Promulgated 
Rates?

Generate the report while in the Settlement 
Statement module for a CD, by selecting 
Reports from the main menu bar, choose an 
ALTA Settlement Statement type, and 
then select Florida Promulgated Rates. 

Florida Title Insurance rating rules differ from 
TRID Rating rules resulting in a variance 
amount. The variance amount is usually given 
as a credit from the Seller to the Borrower so 
that each party is paying the proper Title 
Insurance charges. Lenders may choose to 
show this credit in a number of ways. 
In order for the ALTA Settlement Statements 
with Florida Rates to reconcile with the 
Closing Disclosure, you have to identify if 
and where a variance credit has been given by 
selecting a Transaction Type of TRID 
Variance Adjustment. 
If showing the variance adjustment on Page 2 
by splitting the Lender’s Policy charges, you 
can open the Title Calculator from the 
secondary toolbar and change the Payor on 
the Loan Policy tab to the Split B/S option. 
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This allows you to show the Seller paying a 
portion of the Loan policy (The Seller’s 
portion is equal to the variance amount). 

When changing the Payor to Split B/S, a new 
Transaction Type selection becomes 
available. Set the transaction type to TRID 
Variance Adjustment. 

If showing the variance adjustment on Page 3 
as a credit from the Seller to the Borrower, 
double click on any available row in Section L 
to open the detail window and set the 
Transaction Type to TRID Variance 
Adjustment. 
NOTE: For non-adjustment rows, you are 
required to check the Copy box to enable the 
Transaction Type field. 
TRID Variance Adjustments are excluded 
from the ALTA Settlement Statement reports 
with Florida rates because the variance credit 
is only needed when using the TRID rating 
rules. It is also important that the TRID 
Variance Adjustment credit is equal to 
Variance Amount that is calculated in the 
Title Calculator, TRID Variance tab for the 
bottom line totals to match the Closing 
Disclosure. 
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9. Why are my contacts not 
populating on the Contact 
Information table on 
page 5 of the Closing 
Disclosure?

1) You need to associate the contact with the file by adding them in the 
Closing File module on the Participant tab.

     a.  Remember that each column on the contact table has 2 entries. 

- The first entry is the company. This will pull in the company 
name, address and the company license information.

- The second entry is the actual contact for the company. This will 
pull in the contact name, contact license information, contact 
email and contact phone number. 

- MAKE SURE THAT you have selected the correct role type for 
your contact using the drop down selection for the second 
column name Type. The default is THIRD PARTY and if left as 
THIRD PARTY it will NOT be populated in the Contact 
Information table. Below are the correct types that should be 
used.

• Lender and Loan Officer
• Mortgage Broker Company and a Mortgage 

Broker
• Buyer Broker and a Buyer Agent
• Seller Broker and a Seller Agent

2)    The Settlement Agent information will be associated with the Con-
tact
       Information table from the Closing File module on the Closing
       Agent tab.  
             -   The contact for the Settlement Agent will be populated from
                   the Closer drop down field. The contact card in the Contacts
                   module for this person will pull in the contact name, contact
                   license information, contact email and contact phone number. 
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3) If you have completed steps 1 and 2 above and your contact is still not 
visible in the Contact Information table on page 5 you can right click 
with your mouse on the dark grey field that populates the company 
names. You will see a small window appear that shows the words Add 
and Delete. Click on the Add and the Select Contact window will 
open. It will list contact that have been associated with the file but have 
not yet been added to the contact table. Highlight the entry that you 
would like to add and click the OK button. The contact will be added to 
your table. Repeat step 3 if more than one contact needs to be added.
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 Balance Sheet Module

Concept
The Balance Sheet module is a cash-flow summary of the information in the 
Settlement Statements module. It is used to:

• Review and confirm the incoming and outgoing funds
• Make changes to the reconciliation disbursement details
• View the deposit and disbursement information
• Split or combine amounts
• Combine splits and/or split combines
• Print the Balance Sheet
• Generate Mailing Labels
• Post funds to the DoubleTime Escrow Accounting module, or export data 

to other accounting or legal software such as Quickbooks, Quicken® or Perfect 
Practice®.

Objective
The objective of this lesson is to show you how to compare the incoming and outgoing 
funds on the Balance Sheet; combine several disbursement amounts; copy a payee; 
add a payee; split a disbursement amount; and print the Balance Sheet. You will 
also create mailing labels, post funds to the DoubleTime Escrow Accounting
module, and export data to other compatible software.

Viewing Balance Sheet Funds
What You Do Comments

1.  On the main toolbar, 
click the Balance Sheet 
button.

The Balance Sheet opens, displaying the 
total Deposits, total Disbursements,
check boxes, and the appropriate Closing 
Disclosure section line numbers. The first 
line in the Deposits section is automatically 
selected.
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NOTE:    An information bubble appears to guide you thru the usage of the 
checkboxes.
NOTE: The Override checkbox in the middle column is used to stop the 
description from changing on the Closing Disclosure.

What You Do Comments
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Combining Disbursement Amounts

Use the scroll bar to view the deposits and 
disbursements. Total Deposits and Total
Disbursements continuously display at the 
bottom of the window. This information is 
carried over from the Settlement 
Statements module. 

NOTE: The Address button on the 
secondary toolbar toggles to show/hide the 
address fields for Balance Sheet payees. 
DoubleTime “remembers” whether the 
address fields are shown or hidden when you 
exit the module, and will default to that view 
the next time you enter the module. When 
toggled on the address fields are accessible for 
each payee in the lower half of the screen. 
These addresses will carry over to any checks 
that are printed or data that is exported to 
other software. 

NOTE: To change a Payee for any line item, 
click on the payee you want to change and 
make your selection from the drop-down list.

NOTE: If the figures do not balance, a 
warning message is displayed. You will not be 
allowed to Split or Combine any line items 
in the Balance Sheet module until the 
Settlement Statements module is 
balanced. You can, however, print the 
Balance Sheet.

What You Do Comments
1. Click the check boxes on 

the right for all items 
payable to Bank of 
Florida.
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NOTE: When an item is available for 
combining, the word Combine displays by 
the mouse pointer when it is over the check 
box for that item. 

NOTE: The Combine feature only works 
with the boxes on the right side of the 
window. 

2.  On the secondary 
toolbar, click the 
Combine button.

The selected items are combined. The payee 
and disbursement descriptions are moved 
closer to the bottom of the window and the 
check boxes are replaced with a C.

The description default is Loan Fees. This is 
an editable field.
The combined amount, with a check box, is 
displayed to the right of Loan Fees. The 
check box allows you to further combine the 
previous combined amount.

What You Do Comments
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3. Scroll up and click the 
check boxes on the right 
for all items payable to 
Richard P. Bruce, Esq.

This will select the items you want to combine 
into one check for Richard P. Bruce, Esq.

4.  On the secondary 
toolbar, click the 
Combine button.

The selected items are combined. The payee 
and disbursement descriptions are moved 
toward the bottom of the window. The 
description default is Combined. This is an 
editable field.
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5. Scroll up and click the 
check boxes on the right 
for all items payable to 
Orange County 
Comptroller and State 
of Florida.

This will select the items you want to combine 
into one check for Orange County 
Comptroller.

6.  On the secondary 
toolbar, click the 
Combine button.

The selected items are combined. The payee 
and disbursement descriptions are moved 
toward the bottom of the window. The 
description default is Recording Fees. This 
is an editable field.
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Splitting A Disbursement
What You Do Comments

1. Select the Cash to Seller
in the Disbursements
section.

This will select the item you want to split with 
another party. The Split button on the 
secondary toolbar is enabled.

What You Do Comments
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2.  On the secondary 
toolbar, click the Split 
button.

The Split window opens displaying the 
Payee, Description, and Amount
information. NOTE:  Notice the steps to split 
an amount in the top left corner.

3. Click the Payee button in 
the Split window. The Payee List window opens. 

4. Click the Insert button at 
the bottom of the window.

A blank Payee line is created.

What You Do Comments
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5. Type Peter R. Glenn in 
the Payee box.

This will add Peter R. Glenn to the list of 
payees. 

6. Press the Tab key. A 1 is automatically added in the Sequence
field with the cursor residing in the Street
box.

7. In the Street box, type 
4728 Church Street. 
Press the Tab key. 

This is Peter R. Glenn’s mailing address. 
NOTE: Because the Contacts module 
already contains a Peter R. Glenn with a 
mailing address at 4728 Church Street, 
DoubleTime completes the balance of the 
mailing address with the values for the rest of 
the address fields, which are editable.

8. Click on the top half of the 
split Payee List window.

9. Click the Insert button at 
the bottom of the window, 
again. 

Another blank Payee line is created.

10. Type Linda Glenn in the 
Payee box. 

This will add Linda Glenn to the list of 
payees. 
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11. Press the Tab key. A 1 is automatically added in the Sequence
field with the cursor residing in the Street
box.

12. In the Street box, type 
4728 Church Street. 
Press the Tab key.

This is Linda Glenn’s mailing address. 
NOTE: Because the Contacts module 
already contains a Linda Glenn with a mailing 
address at 4728 Church Street, DoubleTime 
completes the balance of the mailing address 
with the values for the rest of the address 
fields, which are editable.

13. Click OK. The Payee List window closes and the Split 
window is redisplayed.

14. Click the Payee field box 
and select Peter R. 
Glenn.

15. Type 15000 in the 
Amount box.

This is the amount Peter R. Glenn will receive 
from the sale. NOTE: Mr. & Mrs. Glenn have 
decided to split their net proceeds with 
$15,000 being disbursed to Mr. Glenn and the 
balance disbursed to Mrs. Glenn.

16. Press the Tab key. A blank box is created for the next Payee, 
with the Description copied and the 
Amount automatically calculated.

What You Do Comments
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17. Click the lower Payee box 
and select Linda Glenn.

18. Type Balance of 
Closing Proceeds in the 
Description column for 
the second line.

19. Type First $15,000 of 
Closing Proceeds in the 
Description column for 
the first line.
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20. Click OK. The Balance Sheet window is displayed 
with Peter R. Glenn receiving $15,000.00 
and Linda Glenn receiving the remainder.

What You Do Comments
Page 176 DT Version: 8.1



Balance Sheet Module
Repaying Excess Funds

NOTE: The payees and disbursement 
description are moved to the bottom of the 
window. The original disbursement to Peter 
and Linda check box is replaced with a “S” to 
indicate you split the fee.
NOTE: The Fund’s “best practices” limit the 
circumstances under which seller proceeds 
should be split or be disbursed to anyone other 
than the seller. See The Fund Concept article 
Disburse Correctly, Disburse Directly by W. 
Ted Conner in the August 2007 issue for 
guidelines on acceptable circumstances.

What You Do Comments
1. Select the description 

Cash from Borrower in 
the Deposits section.

The Excess Funds button on the secondary 
toolbar is enabled. NOTE: The Excess 
Funds button is available for either borrower 
or seller refund of excess funds they have 
brought to closing. (A seller may sometimes 
bring funds to closing when the mortgage debt 
plus closing expenses exceeds the sales price.)

2.  Click the Excess 
Funds button on the 
secondary toolbar.

The Excess Funds window is displayed 
with the current Amount Received
information. You may edit this field to the 
amount which the borrower brought to 
closing.

3. Click in the Amount 
Received box and type 
10000 and press the Tab
key.

The difference is calculated and displayed in 
the Excess Amount box. NOTE: This 
process can also be used to adjust Cash from 
Seller amounts, which is a common 
occurrence in Short Sale transactions.

What You Do Comments
Training Workbook: August 2018 Page 177



Balance Sheet Module
Printing The Balance Sheet
What You Do Comments

1.  On the secondary 
toolbar, click the Print
button.

The Print Options window is displayed.

2. Click OK. The Balance Sheet is printed showing all 
combinations, splits, and excess funds.

4. Click OK. A new line is added in the Disbursements
section with the borrower as payee and 
Excess Funds as the description.
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Generating Mailing Labels
What You Do Comments

1.  On the secondary 
toolbar, click the 
Generate Mailing 
Labels button.

The Balance Sheet Mailing Labels
window is displayed. This feature allows you 
to generate labels for each payee with a line 
item disbursement on that particular Balance 
Sheet. It is designed for use with Avery 5161 
labels, which contain 20 labels per page.

2. Click Print, then OK. The mailing labels are printed.

3. Click Close. The Balance Sheet Mailing Labels
window is closed and the Balance Sheet
window is re-displayed.
NOTE: If your checks are designed to be used 
with window envelopes, you can print checks 
with the payee’s address, eliminating the need 
for mailing labels.

Escrow Accounting Post And Print
The Escrow Accounting button allows you to manage your escrow/trust 
accounts. 

You can use the Escrow Accounting button for the following tasks: 
• Posting — The ability to post transactions from the Balance Sheet module 

to Escrow Accounting Transaction Management module.
• Check Writing — The ability to print checks using standard or customized 

check templates.
• Reconciliation — The ability to reconcile with your escrow/trust account.
• Reports — The ability to generate numerous reports to assist with reconciling 

to your escrow/trust account.
You can begin using this feature by clicking the Escrow Transaction 
Management button on the main toolbar. Before you can use the Escrow 

Accounting feature, you must start with an escrow account that has a 
zero balance. Then you must add the account by selecting Preferences > 
Account Maintenance from the menu bar, insert a new blank line, type and select 
the appropriate information in each column.
NOTE: The Fund offers a separate class for DoubleTime Escrow Accounting (DTEA) 
where you can learn about using DTEA in your office. Contact the Education 
Registrar to register for a DTEA class at 888-407-7775 or 
educationregistrar@thefund.com.
Training Workbook: August 2018 Page 179



Balance Sheet Module
Posting To Your Escrow Account
What You Do Comments

1.  From the Balance 
Sheet, click the Post
button from the toolbar.

 
 

The Escrow Accounting Post and Print 
window is displayed. NOTE: The Post/Print 
Date field defaults to today’s date, which is 
editable. 

2. In the Post Activity
column, select how you 
received your deposits 
(Deposit, Deposit to 
Bank, Deposit [Cash], 
or Wire In).

NOTE: Deposit, Deposit [Cash], and
Wire In allows you to post a deposit to your 
escrow account without a confirmation 
number. Deposit to Bank allows you to 
post a deposit to your escrow account with a 
confirmation number. 

NOTE: More information is provided when 
taking the DoubleTime Escrow Accounting 
training class.
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3. In the Post Activity
column, select how the 
disbursements are to be 
handled (Post and Print, 
Post Only, ePayment,
or Wire Out).

NOTE: Post Only allows you to post the 
disbursements to your escrow account. Post 
and Print allows you to post to your escrow 
account and also to print your checks.

4. Click OK. NOTE: By default all of the items are 
selected. You may click Deselect All button 
to uncheck all items. 

NOTE: If you selected to post and print your 
checks, the Check Printing window is 
displayed.

5. Select the appropriate 
Check Template type 
from the drop-down list.

6. Type or verify the 
Beginning Check No.

7. Click Print. A message is displayed asking you to confirm 
if the checks printed correctly. NOTE: Read 
the confirmation box carefully.
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8. If the checks did not print 
correctly, enter the first 
check number that did not 
print correctly and click 
No. 

Repeat steps 5-8.

9. If the checks printed 
correctly, click Yes.

A message is displayed stating that the file 
was successfully posted.

10.  Click OK. The Escrow Accounting Post and Print
window closes, and returns to the Balance 
Sheet.

11.  Click Close

What You Do Comments
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Exporting Data Files From DoubleTime
What You Do Comments

1.  On the secondary 
toolbar, click the Export 
button.

The Accounting Export window is 
displayed with the defaults that were selected 
in Preferences/User Settings, Account 
Maintenance, and the Closing File
modules. The Export Date defaults to the 
date identified in Preferences/ User 
Settings/ Accounting tab and can be 
changed. All deposits and disbursements are 
automatically selected. Use the scroll bar to 
view all the items. To de-select an item, click 
the Select check box. To de-select all the 
items, select the Deselect All button. Click 
the Select All button to return to the default. 
NOTE:  (1) You can also select Actions
from the menu bar, then Accounting 
Export. (2) The Export button is not 
available if you are out of balance or negative 
disbursements have not been combined (e.g. 
Aggregate Accounting Adjustment).
Training Workbook: August 2018 Page 183



Balance Sheet Module
Importing Files Into QuickBooks®

You can import the deposits and disbursements from your closing file that you 
exported from DoubleTime into QuickBooks. To use QuickBooks, select 
Preferences from the menu bar, then select User Settings. Click the Accounting 
tab and select QuickBooks in the Accounting Software box.
NOTE: The following steps are for importing files. If your version of QuickBooks is 
different, refer to your QuickBooks user’s guide for instructions. 

2. Click OK. The Save QuickBooks File As window is 
displayed with the file name and the.IIF
extension displayed in the File name and 
Save As type boxes, respectively.

3. Click the Save button. The Accounting Export window is 
displayed with the message File was 
successfully exported displayed.

4. Click OK. The Balance Sheet window is redisplayed. 
NOTE: The Fund offers a separate class for 
DoubleTime Escrow Accounting (DTEA) 
where you can learn about using DTEA in 
your office. Contact the Education Registrar 
to register for a DTEA class at     888-407-
7775 or educationregistrar@thefund.com.

What You Do Comments
1. Start QuickBooks. The QuickBooks startup window Homebase

is displayed. NOTE: If a Reminders message 
is displayed, click the X for the window.

What You Do Comments
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Importing Files Into Quicken®

In this lesson, you will learn how to import the deposits and disbursements from your 
closing file that you exported from DoubleTime into Quicken. If you did not choose 
Quicken previously, select Preferences from the menu bar, then select User 
Settings. Click the Accounting tab and select Quicken in the Accounting 
Software box. NOTE: The following steps are for importing files to Quicken Basic. 
If your version of Quicken is different, refer to your Quicken user’s guide for 

2. On the menu bar, click 
File, then click Import.

The IIF Import dialog box is displayed.

3. In the File Name window, 
select your file number.

4. Click OK. When the import is complete, a message box 
is displayed indicating your data has been 
imported.

5. Click OK. You can now use QuickBooks to view the 
information, generate reports, or print checks.

6. On the menu bar, click 
File, then click Exit.

QuickBooks is closed.

What You Do Comments
Training Workbook: August 2018 Page 185



Balance Sheet Module
instructions. 
What You Do Comments

1. Start Quicken. The Quicken startup window, Homebase, is 
displayed. If a Quicken Tips message is 
displayed, click Done.
If a Quicken Reminders window is displayed, 
click the X for that window.

2. On the menu bar, click 
Banking, Banking 
Activities, and then 
Enter a transaction 
into my Register.

The check register for Friendly Bankers, 
Inc. should display. This is Richard P. Bruce’s 
escrow account that was selected within 
DoubleTime.

3. On the menu bar, click 
File, Import and then 
select QIF file.

The QIF Import dialog box is displayed.
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Tips

4. Click Browse. The Import from QIF file is displayed with 
the Quickenw folder open.

5. In the Import from QIF 
file window, select your 
file number. Click OK.

The selected file number is displayed in the 
QIF File to Import name box.

6. Click OK. The Quicken 2000 for Windows dialog 
box is displayed. There are unrecognized 
categories or classes that need to be created. 
These defaults are determined within 
Preferences/User Settings/Accounting.

7. Click Yes. When the import is complete, a message box 
is displayed with the number of items 
successfully imported.

8. Click OK. You can now use Quicken to view the 
information, generate reports, or print checks.

9. On the menu bar, click
File, then click Exit.

Quicken is closed.

Information for Quicken Users: Beginning with Quicken 2005 for 
Windows, accounting import into Quicken (QIF Import) will no longer be 
available for checking accounts. Customers using Quicken 2004 for Windows, 
and earlier versions, will be able to continue using QIF Import. For more 
information, visit Intuit’s web site at www.intuit.com.

1. An alternate way to open the Balance Sheet module is to select Modules
from the menu bar and choose Balance Sheet.

2.  To combine a split or previous combine, click the check box to the 
right of the window for the item(s) you want to further combine and click 
the Combine button on the secondary toolbar.
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3.  To undo a combine, click the description for the item you want and 
click the Undo Combine button on the secondary toolbar. The combined 
items are returned as individual disbursements. 

4.  To split a disbursement (previously combined or not) among one or 
more payees, click the payee or disbursement description you want to split, 
and click the Split button on the secondary toolbar. 

5.  To undo a split, click the description for the item you want and click the 
Undo Split button on the secondary toolbar. 

6. To delete a Payee you have added to the Payee List using the Add button, 
select the name from within the Payee List window, and click the Delete
button at the bottom of the window. You cannot delete payees that have been 
added in the Closing File module. The payee you wish to delete may not 
be associated as the payee on any line.

7.  Use the Excess button on the secondary toolbar to identify excess 
funds brought to the closing by the borrower (or sometimes by the seller). 
The Excess button on the secondary toolbar is enabled when you select the 
borrower (or seller) Name or the Line Description in the Deposits
section of the Balance Sheet. 

8.  To view a payee’s address, select the payee’s Name or the Line 
Description   then click on the Address button on the secondary toolbar. 
The address will appear at the bottom of the screen. 

9. To return the Balance Sheet to its original form, click Actions on the 
menu bar, and then select Regenerate Balance Sheet. While in the 
Balance Sheet module, the Actions menu also includes functionality for 
Split, Undo Split, Combine, Undo Combine, Excess Funds, 
Accounting Export, Escrow Accounting, Show Address, and 
Generate Mailing Labels.

10.  Use the Generate Mailing Labels button on the secondary toolbar to 
generate labels for all the payees on the Balance Sheet. This feature is 
designed for use with Avery 5161 labels, which contain 20 labels per sheet 
(2 columns of 10 labels each per sheet). 

11. Amounts in the Deposits section which are red indicate they were withheld 
in the Settlement Statement. These amounts are subtracted from the original 
loan amount. Line description Loan Proceeds indicate the expected wire 
amount from lender.
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Frequently Asked Questions
Question Answer

1. How do I reflect the 
changes on the Balance 
Sheet after I correct an 
out-of-balance issue?

Simply regenerate the Balance Sheet as 
follows:

With the Balance Sheet open, select 
Actions > Regenerate Balance Sheet
from the menu bar. A balance sheet message 
will display.

Select Yes to generate the new balance sheet.

2. How can I get the 
Balance Sheet to reflect 
excess funds from the 
Lender?

Go to Page 2 tab in the Settlement 
Statements.

Select a line 
• Description: Excess Funds - Lender
• Payee: (select a lender)
• Amount withheld: (enter the excess 
amount as a negative number, for example, -
345.00)

NOTE: Leave At Closing and Before 
Closing blank. The Balance Sheet should 
reflect a Deposit item from the Lender for the 
excess amount and a Disbursement item to the 
Lender for the excess amount.
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3. Why doesn’t the Balance 
Sheet balance?

Here are some possible reasons:
• Withheld amounts. Note the dollar amount 
of the difference. Is there a line item on your 
Settlement Statement for that amount? Check 
to see that a withheld amount is offset by a 
deposit or loan amount.
• Different payee. Did you withhold a fee 
from the loan proceeds and pay it to someone 
other than the lender? If so, return to the Set-
tlement Statements module, show the cor-
rect payee in the Payee box.

4. How do I withhold funds 
that the lender is not 
sending me so that I can 
balance DoubleTime to the 
loan proceeds sent from the 
lender?

Double-Click on the line to open the Detail
window. Double-Click in the Amount 
Withheld box and the paid At Closing fee 
is auto populated in this field. Click OK for 
the detail window to display.

Question Answer
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Conveyance Module

Concept
The Conveyance module allows you to add clauses to Deeds, Title Affidavits, and 
Bills of Sale. You can also modify grantor and grantee information for deeds. The 
instruments will be printed from the Documents module. Some of the information 
initially displayed in the Conveyance module is copied from other modules. This 
includes Buyer and Seller names and tenancy, which are copied from the Closing 
File module. 

Objective
The objective of this lesson is to show you how to add clauses to the Deed and 
recordable Title Affidavits, and add personal property to the Bill of Sale.

Customizing The Deed, Title Affidavit, And Bill Of Sale 
What You Do Comments

1.  On the main toolbar, 
click the Conveyance 
button.

The Deed tab is displayed with the cursor in 
the Clauses box. The Grantor/Tenancy
and Grantee/Tenancy boxes contain the 
seller’s and buyer’s names and associated 
tenancy phrases that you previously selected 
in the Closing File module.  NOTE: You 
can use the Clause Library button to insert 
clauses, or you can type the language for the 
deed in the Clauses box.
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2.  On the secondary 
toolbar, click the Clause 
Library button. 
(Optionally, press Ctrl +
L.)

The Clause Library window is displayed. 
The Clause Type defaults to Deed.

3. In the Search field of the 
Clause Library, type 
Subject to: taxes.

The Subject To: Taxes clause is displayed.

4. Click OK. The Clause Library window is closed and 
the clause is added to the Clauses box on the 
Deed tab. The type of deed can be selected in 
the Documents module. This clause will 
appear beneath the legal description on the 
deed.

What You Do Comments
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5. Click in the Clauses box, 
and change the *** to the 
Current Year. 

When the deed is printed, the conveyance will 
reflect that it is “Subject to taxes for [current 
year] and subsequent years; covenants, 
conditions, restrictions, easements, 
reservations and limitations of record, if any.” 

6. Click the Title Affidavits
tab.

The Title Affidavits tab is displayed with the 
cursor in the Seller Clauses box. The Title 
Affidavit (Buyer), Title Affidavit (Seller), 
and Title Affidavit (Refinance) are 
customized for recording purposes using this 
tab. These documents are generated and 
printed in the Documents module.

7. Click the Bill of Sale tab 
and type Range, washer, 
and dryer.

The Personal Property Description box 
is displayed. Text typed in this box will be 
printed on the Bill of Sale in the
Documents module. 

8. On the secondary 
toolbar, click the Close
button.

9. Click Yes to save changes. The Conveyance window closes.
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Tips
1. An alternate way to open the Conveyance module is to select Modules

from the menu bar and choose Conveyance.

2.  The Spell Check button on the secondary toolbar is available for the 
Deed, Title Affidavits, and Bill of Sale tabs.

3.  To add a clause to the deed, click Clauses box. Then, on the 
secondary toolbar, click the Clause Library button. Or you can click 
Clauses box and type the clause.

4. An alternate way to open Clause Library is to press Ctrl + L.

Frequently Asked Questions
Question Answer

1. How do I update buyer and 
seller names in the 
Conveyance module?

Whenever you change the text in the buyer or 
seller Name(s) with Status box located in 
the Closing File module you are prompted 
to update by the system. Select the necessary 
check boxes and click OK. The text in the 
Title Insurance (name of insured) and/or 
Conveyance (grantor/grantee) modules is 
automatically updated. When you update the 
buyer or seller, the existing text is 
automatically replaced with the text in the 
Name(s) with Status box. 

NOTE:  (1) The Deed, Title Affidavit (Seller), Title Affidavit (Buyer), 
Title Affidavit (Refinance) and Bill of Sale are selected and printed in the 
Documents module. (2) You have access to Clause Library on the Bill of 
Sale tab. The default Clause Type is Miscellaneous. Since there are no 
clauses in the SCC Handbook that pertain to personal property descriptions, you 
may want to add your own in the Clause Library Maintenance module by 
selecting Modules from the menu bar and choosing Clause Library 
Maintenance. Then when you access the Clause Library from the Bill of 
Sale tab, you are  able to choose from your User Defined clauses.
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Documents Module/ Select, Edit, And Print

Concept
The Documents module is used to select, prepare and print documents such as Title 
Commitment, Title Policies, Deeds, Affidavits, Bills of Sale, and other closing 
documents. You can select documents from the Master Document Selection list 
for each closing file and, if necessary, edit them. Once documents are finalized they 
can then be printed. Documents can also be emailed using Outlook or Outlook Express 
and faxed from your personal computer. Customized documents can be created and 
then related to each closing file.

Objective
The objective of this lesson is to show you how to select documents, edit the deed, and 
print multiple documents.

Selecting Documents
What You Do Comments

1.  On the main toolbar, 
click the Documents 
button.

The Closing Document Selection
window is displayed, with previously selected 
documents listed for your file.

2. On the Closing 
Document Selection
window, click New.

The Master Document Selection window 
is displayed. The Classification box 
defaults to All and the Type defaults to All.

3. Select Bill of Sale. This is one of the documents you want to 
bring into your file.
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4. Press and hold the Ctrl key 
and select Continuous 
Marriage Aff - 
Spouses, FL Warranty 
Deed (Statutory Form),
and Liens Aff - Non-
Identity. 

All four document titles are highlighted. 
Master Documents Selected: 4 is 
displayed in the bottom right corner. NOTE:
Holding the Shift key will allow you to select 
a range of documents.

5. Release the Ctrl key and 
click OK.

The Master Document Selection window 
is closed. Bill of Sale, Continuous 
Marriage Aff - Spouses, FL Warranty 
Deed (Statutory Form), and Liens Aff - 
Non-Identity have been added to the 
Closing Document Selection list for your 
file.

NOTE: When using the DoubleTime 
Affidavits you should always open the 
document and ensure that the correct Buyer 
and or Seller have been associated with these 
documents.  If the parties are incorrect you 

may make changes using the  Replace 
Field With Text button.
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Editing The Deed

NOTE: The Document Size column is used to help indicate documents with 
possible embedded images. The document row will appear red if the document 
is over 250kb. 

What You Do Comments
1. Select FL Warranty 

Deed (Statutory Form)
from the Closing 
Document Selection 
window.

2. Click OK. The FL Warranty Deed (Statutory Form)
document is displayed. The gray-shaded areas 
indicate information that is carried over from 
other modules in DoubleTime, such as the 
Closing File module.

3.  Click the View Field 
Names button on the 
secondary toolbar.

The gray-shaded areas now display the field 
name indicating where the information was 
collected.
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4. Place the cursor to the left 
of Will Call No.:

5. Left click and hold, then 
drag the mouse and 
highlight to the end of 
{Will Call Number}.

This will select the line you want to remove.

6. Press the Delete key 
twice.

This will delete the text, the variable field, and 
the additional space.

7. Place the cursor after the 
{Deed Clause} field and 
press the Enter key twice.

The cursor is aligned with the indented left 
margin, where you will insert a clause.
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8.  Click the View Field 
Names button on the 
secondary toolbar.

The gray-shaded areas now display the actual 
text that will appear in the printed deed. The 
cursor remains in the spot it was, which is 
immediately below the “Subject to” language 
we added to the deed in the Conveyance
module. 

9.  On the secondary 
toolbar, click the Clause 
Library button.

The Clause Library window is displayed. 
All is the Clause Type and All Clauses is 
selected.

10. Click the Clause Type
box and select Deed.

The display is limited to deed clauses.

11. In the Search window field, 
type Non-H.

The Non-Homestead clause is displayed and 
automatically selected.
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12. Click OK. The Clause Library window is closed and 
the Document window is redisplayed. The 
Non-Homestead clause is added to the 
document. 

13. Replace the asterisks in the 
clause on the deed with 
4728 Church Street, 
Chicago, Illinois 60643.

NOTE: The clause added to the deed from 
within the Documents module is not in gray 
because it is not populated to the deed via a 
field variable. In contrast, the “subject to” 
clause which was added to the deed in the 
Conveyance module is in gray because it is 
populated to the deed via the field variable. 
Confirm this by clicking the View Field 
Names button on the secondary toolbar. 
When you do that, the non-homestead clause 
remains visible, but the “subject to” clause 
is replaced by the Field Name for the 
variable. 
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Customizing The Notary Information - Buyer And Seller
What You Do Comments

1.  On the secondary 
toolbar, click the 
Signature/Notary 
button.

The Signature and Notary Block window is 
displayed. This tree-view format is accessible 
from both the Closing File and Documents
modules. The Sellers option is currently 
selected.
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2. Click -Susan S. Thomas
under Signatory.

The number of witnesses, Two Per 
Signatory, and Signatory field are displayed. 
All Documents is the default, and a Title can 
be selected. 
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3. Click + Buyer under 
Notary Block.

Susan S. Thomas is displayed.

4. Click on Susan S. 
Thomas within Buyer 
Notary Block.

The Notary Format for Susan S. Thomas
is displayed. Individual is the default Notary 
Format.

5. Click the Notary Title 
box and select Notary 
Public, State of Florida.

The Notary Public, State of Florida title is 
displayed under the notary signature line. Note: 
To see how it will appear, click the Preview
button, and use the scroll bar (if necessary) to 
view the notary box information.

6. Click the Notary Name 
box and select Beth 
Cullum.

This is the name of the person notarizing the 
documents. Beth Cullum is displayed on the 
Printed Name line in the notary box. Beth’s 
name was added as an employee for Richard P. 
Bruce, Esq. in the Contacts module. NOTE:
To see how it will appear, click the Preview
button, and use the scroll bar (if necessary) to 
view the notary box information. 

7. Click the Expiration 
Date box and type 
03272021.

This is the date the notary commission expires 
for Beth Cullum.
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8. Click Preview. The Notary Preview is displayed.

9. Click Preview Off.

10. Click + Sellers under 
Notary Block.

Peter R. Glenn and Linda Glenn are displayed.

11. Click on Peter R. Glenn 
and Linda Glenn under 
Sellers.

The Notary Format for Peter R. Glenn and 
Linda Glenn is displayed. Individual is the 
default setting for Notary Format.
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12. Click the Notary Title 
box and select Notary 
Public, State of Florida.

The Notary Public, State of Florida title is 
displayed under the notary signature line. 
NOTE: To see how it will appear, click the 
Preview button, and use the scroll bar (if 
necessary) to view the notary box information.

13. Click the Notary Name 
box and select Beth 
Cullum.

This is the name of the person notarizing the 
documents. Beth Cullum is displayed on the 
Printed Name line in the notary box. Beth’s 
name was added as an employee for Richard P. 
Bruce, Esq. in the Contacts module.
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14. Click the Expiration 
Date box and type 
03272021.

This is the date the notary commission expires 
for Beth Cullum.

NOTE: If your transaction involves a mail-
away, the notary information for an out of state 
party should be set as follows:
• Proof of Identification: Select None
• State of: Select the appropriate state
• County of: Leave name of county blank
• Notary Title: Select Notary Public, State 
of_____________
• Notary Name: Leave blank
• Expiration Date: Leave blank
• Produced ID: Remove check mark
• Day: Delete date

15. Click Preview. The Notary Preview is displayed.

16. Click Preview Off. The Signature and Notary Block is 
displayed.

17. Click OK. The Closing File module is redisplayed with 
the Seller tab open.
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Try This - Create a Custom Document using the Save As > New Master feature 
What You Do Comments

1. Ensure your cursor is in the 
middle of the text field for 
the “Subject to taxes” 
language.

Ensure that you do not highlight the field.

2.  On the secondary 
toolbar, click the Replace 
Field with Text button.

The merge fields are displayed in grey and 
automatically populate data from other 
modules.  Simply use your mouse and click 
anywhere in the gray area and then select the 
Replace Field with Text button. 
 
The merge field will be released and you are 
free to manually make changes and save 
changes for this document.

But remember, any changes made at this 
location will only change this one document.

3. On the main toolbar, click 
File > Save As > New 
Master.

The Save As New Master window is 
displayed.
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Saving The Edited Deed
What You Do Comments

1.  On the secondary 
toolbar, click the Open 
Document button.

The Save changes dialog window will 
displayed if any changes have been made. If 
no changes have been made the Closing 
Document Selection window is displayed.

2. Click Yes. The document changes are saved for this file 
and the Closing Document Selection 
window is displayed.

4. Type New Warranty 
Deed in the Custom 
Document Name box.

This is the name of the custom document you 
will be creating.

5. Click OK. The Save As New Master window is 
closed and the original FL Warranty Deed 
(Statutory Form) window is displayed.  Your 
edits are still there and the New Warranty 
Deed document you created has been saved 
as a master document.

What You Do Comments
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Printing Multiple Documents
What You Do Comments

1. Select Bill of Sale. Press 
and hold the CTRL key 
and click to select CD 
Addendum B - 
Customary Recitals, 
Continuous Marriage 
Aff - Spouses, FL 
Warranty Deed 
(Statutory Form), 
Florida Insurance 
Premium Disclosure, 
and Liens Aff - Non-
Identity.

All six document titles are highlighted with 
Documents Selected: 6 displayed in the 
bottom right corner. 

2. Click Print. The Print Documents window is displayed 
and the selected documents are printed. The 
Closing Document Selection window is 
redisplayed.

3. Click Cancel. The Document module is closed.

Buttons Available In The Documents Module

Button Description

   
Open Document allows you to select a different 
document by opening the Closing Document Selection 
window.
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Save Document retains the document and any 
changes.

   
Print Document prints the open document. You can 
specify the number of copies, the page range, and 
collation.

   
Print Preview displays a preview of the document as 
it will appear when printed, including the paper size, 
margins, and a view of multiple pages. Click the 
Preview button again or click the Edit button to 
return to the Documents window.

   
Refresh Document redisplays the document after 
you have added or changed data.

   
Cut copies the current selection to the Clipboard and 
then deletes the selected text.

   Copy copies the current selection to the Clipboard. 
Does not delete the selected text.

   
Paste pastes the contents of the Clipboard into the 
current document.

   
Undo Edits reverses the last action. For example, if 
you deleted text, then Undo Edits will restore it. If you 
inserted text, then Undo Edits will remove it.

   
Spell Check checks the spelling in the open 
document.

   
Signature/Notary allows you to create signature 
blocks and change notary information.

   
Insert Degree Symbol allows you to insert a degree 
symbol in to a legal description     

   
Clause Library allows you to select and insert 
clauses using the Select Clause Library window.

   
Insert Field displays a list of data fields from which 
to choose to add to the open document.

   
Replace Field with Text converts a variable field to 
plain text.

Button Description
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Buttons Available On Formatting Toolbar

   
View Field Names displays the content name of the 
variable fields. Click the button again to display the 
text associated with the variable fields.

   
Custom Variable Data allows you to view and edit 
data for custom variables.

   
Set Document Options allows a new description 
(document name) and paper size (letter or legal) to be 
entered.

   
Close Documents Module closes the 
Documents module.

Button Description

            
Cut copies the current selection to the Clipboard and 
then deletes the selected text.

            Copy copies the current selection to the Clipboard. 
Does not delete the selected text.

            
Paste pastes the contents of the Clipboard into the 
current document.

            
Undo Edits reverses the last action. For example, if 
you deleted text, then Undo Edits will restore it. If you 
inserted text, then Undo Edits will remove it.

            
Redo Edits repeats the last action. For example, if 
you deleted text, then Redo Edits will repeat it. 

            
Find allows searching of a word in a document.

            
Insert Date/Time allows you to insert the current 
date and time into your document.

            
Insert Page Number allows you to insert the 
current page number into your document.

            
Insert Page Count allows you to insert the current 
page count into your document.

       
Zoom allows you to reduce or enlarge the displayed 
page.

Button Description
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Style allows you to apply formatting changes to your 
text.

Font list. Click the Font drop down list to select a 
font for the selected text.

         
Font size list. Click the Font Size drop down list to 
type or select a font size for the selected text.

            
Bold. Click the Bold button to change the selected 
text to bold, or to remove bold from the selected text.

            
Italic. Click the Italic button to change the selected 
text to italic, or to remove italic from the selected text.

            
Underline. Click the Underline button to change 
the selected text to underlined, or to remove underline 
from the selected text. 

            
Strike-through. Click the Strike-through button 
to add a line to the selected text. You can also use the 
button to remove a line from selected text. 

            
Align Left. Click the Align Left button to align the 
selected paragraphs or paragraph with the left margin.

            
Align Center. Click the Align Center button to 
center the selected text.

            
Align Right. Click the Align Right button to align 
the selected paragraphs or paragraph with the right 
margin.

            
Justify. Click the Justify button to align selected 
text to both the left and right margins.

            
Numbering. Click the Numbering button to add 
numbers to your paragraphs. Select Format > 
Bullets and Numbering from the menu bar to 
select a variety of numbering schemes.

            
Bullets. Click the Bullets button to add bullets to 
your paragraphs. Select Format > Bullets and 
Numbering from the menu bar to select a variety of 
bullet styles. 

            
Increase Indent. Click the Increase Indent button 
to move text to the right for a specific line.

Button Description
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Tips

            
Decrease Indent. Click the Decrease Indent
button to move text to the left for a specific line.

            
Hanging Indent. Click the Hanging Indent button 
to position a hanging line of text.

            
Insert Table. Click the Insert Table button to insert 
a table into a document.

1. An alternate way to open the Documents module is to select Modules
from the menu bar and choose Documents. You can also use the shortcut, 
Ctrl+D from any window.

2. To view a document, select the document from the Closing Document 
Selection window and click OK.

3.  Use the Spell Check button on the secondary toolbar to check the 
spelling of a displayed document.

4.  The Signature/Notary button allows you to select the number of 
witnesses for each signatory or signature block on documents, as well as the 
ability to select witness names. Notary format can also be established and 
previewed.

5. Use the selections available in the Insert menu to insert page breaks and 
page numbers.

6. Use the Edit menu to add custom variables, notary information, and headers 
and footers.

7.  Use the Format menu to format fonts, paragraphs, and tabs.

8. To prevent changes from being made to the open document, select Protect 
Document (Read Only) in the Tools menu.

9. An alternate way to select text for editing is to press and hold the SHIFT key 
and use the arrow keys. You can also press and hold the SHIFT key and 
press the END key to select text from the cursor position to the end of the 
line.

Button Description
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10. Custom documents can be altered and saved when the custom document is 
currently opened within the Documents module. To save the changes to the 
master custom document, select File, Save As, Existing Master or New 
Master.

11. A single or multiple document can be emailed by choosing eSolutions, 
Email. The email feature only utilizes Outlook or Outlook Express. 
Multiple documents can be selected and emailed on the Closing 
Document Selection window by clicking the Email button. NOTE: If 
you are not using Outlook or Outlook Express, documents can be saved to 
your computer and then attached to messages using your email software.

12. Documents can be faxed by selecting File, Print, Properties, and 
selecting the currently installed fax program on your personal computer.

13. An alternate way to open Clause Library is to press Ctrl + L.

14. Use Tools > Regenerate Document to restore a changed document.

15. If you associate more than one document that has the same document 
description name with your file, you can use the options button in the 
Closing Document Selection window to rename the document for that 
file only. ie: Title Affidavit (Buyer) Susan

16.  Variable (merge fields) can be inserted into documents by using the 
Insert Field button.

17. The Replace Field with Text button  allows you to stop the merging 
of data into a merge field.

18. You can open a custom document you have created from the Closing 
Documents Selection window by clicking the New button to open the 
Master Documents Selection window. In the Type area, select 
Custom to display only your custom documents.

19. Use the Document Size column in the Closing Document Selection
window in the Documents module to help indicate documents with 
possible embedded images.  The document row will appear red if the 
document is over 250kb. The Documents/Templates with Picture 
Images report in the Reports module shows a list of documents and 
templates with embedded and linked images.  This will assist users to 
determine what documents or templates should be changed to linked images.   
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Frequently Asked Questions

20. When saving a document and to utilize the Save-As feature, follow these 
steps. While in the desired document, click on File > Save-As > 
Document Image… A window will appear and the Save-in: location 
will default to the location you selected in User Preferences.

Question Answer
1. How do I print documents 

from the Documents
module?

Select the document in the Closing 
Document Selection window and click 
Print. To print more than one document at a 
time, press Ctrl key and select all the 
documents you want to print. Click Print.

2. How do I create and save a 
document as a custom 
master document?

You can create and save custom master 
documents (user-defined templates) in 
Preferences, Document 
Customization. In the Documents 
module, select File, Save As, New Master. 
When the Save as New Master window is 
displayed, type a template name and click
OK. 

3. How do I print a 
commitment and policies?

Open the Documents module, select the 
commitment, and click Print. If the 
commitment is not available as a selection, 
open the commitment in the Title 
Insurance/Commitment module. Click the 
Save button before you return to the 
Documents module

4. How do I add new 
documents into the 
Closing Document 
Selection window for my 
closing file?

Open the Documents module. When the 
Closing Document Selection window is 
displayed, click New. Select the document(s), 
such as the warranty deed and other 
documents needed for the file, and click OK.
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5. Why don’t buyers and 
sellers display on the 
commitment?

There are two possible reasons:
• You haven’t added text in the Name(s) 
with Status box of the Closing File mod-
ule for the buyers or sellers. Open the Clos-
ing File module and select the Buyer or 
Seller tabs. Click the Insert Name Clause
button to add text for the buyers/sellers to 
these boxes and save. Return to the Title 
Insurance - Commitment module and 
click the Build Clause button.
• You opened the commitment before you 
filled in the Name(s) with Status boxes. 
Click the Owner tab in the commitment. 
Then click the Build Clause button.

6. Why isn’t the document I 
want to print listed in the 
Documents module?

Here are some possible reasons:
• You haven’t created it. Commitments and 
policies need to be opened in the Commit-
ment or Policy modules before they can be 
selected and printed in the Documents mod-
ule.
• These documents are not printed from the 
Documents module. The Settlement 
Statement forms and 1099’s are printed 
from the Settlement Statements, and 
1099-S modules, respectively.
• The document you want to print is an 
endorsement to the FUND 06 Mortgagee 
Policy (MF6) and was automatically checked 
off in the Commitment or Policy module 
and will show as an issued endorsement on 
Schedule A of the issued policy. 
• The particular document you want probably 
isn’t included with DoubleTime. Title Docu-
ments that are automatically included in Dou-
bleTime are Old Republic National Title 
Insurance Company commitment and policy 
master documents, not those of other insurers. 
However, if you select a different underwriter 
in the Closing File, that name will be 
reflected on the Commitment, Policy, and 
Endorsement forms that are included in the 
DoubleTime database. 

Question Answer
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7. What document contains 
language regarding 
condominium and 
homeowners’ association 
dues?

The Closing Statement Addendum
document includes language for the 
condominium and homeowner association 
dues, as well as Tax Re-Proration and 
Disbursement Authorization language. The 
language of these items may be modified for a 
specific closing by an attorney, and then the 
document can be saved as a custom document.

Question Answer
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1099-S Module

Concept
The 1099-S module is used to generate the IRS Form 1099-S, Proceeds From Real 
Estate Transactions. This form reports to the Internal Revenue Service the sale or 
exchange of reportable real estate for each closing file. The form may be sent 
electronically to the IRS. The 1099-S module also has email functionality. When in 
the 1099-S module, select eSolutions > Email from the menu bar to send a copy of 
the form to the client. To electronically file your 1099-S forms, you must request a 
Transmitter Control Code (TCC) from the IRS. Forms and publications may be 
ordered by calling toll-free at 800-829-3676 or downloaded from the IRS website at 
www.irs.gov. Electronic files are uploaded to the IRS via https://fire.irs.gov/
NOTE: If you have any questions on electronic or magnetic media filing, you should 
contact the Electronic Product and Services Support, Information Reporting Branch as 
follows: 

Customer Service Section
M - F 8:30 a.m. to 4:30 p.m. EST 
Phone: 866-455-7438
TDD: 304-579-4827 

Objective
The objective of this lesson is to show you how to verify the information on the 
1099-S Form Copy B For Transferor and print Copy B and Copy C (Filer). You will 
also learn how to create an electronic record of the 1099-S form for a closing file. You 
will also learn how to delete a previously filed electronic record.

Viewing And Printing The 1099-S Record 
What You Do Comments

1.  On the main toolbar, 
click the 1099-S button.

A summary of the 1099-S information is 
displayed. Scroll right to view the entire 
summary. The Print and Send IRS boxes are 
automatically selected.
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2.  On the secondary 
toolbar, click the View 
Record button.

The 1099-S Copy B For Transferor is 
displayed. NOTE: Although the 1099-S form 
is populated with information from the other 
DoubleTime modules, all fields on the 1099-S 
form are editable directly in the 1099-S
module. 

NOTE: This step is necessary to create a 
record for reporting.

NOTE: You can also access this window by 
double clicking anywhere on the highlighted 
blue line.

3. Click the  Edit 
Agents button on the 
secondary toolbar

The Closing Agent Information window 
opens. This window allows changes to the 
agent’s name, address, phone number and TIN 
number. 

NOTE: You can also access this window by 
double clicking anywhere on the FILER’S 
Name or FILER’S FIN fields on the 1099-S 
form (which appear in light grey).

What You Do Comments
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4. Click OK to save changes 
and exit, or click Cancel 
to exit without saving.

5. Double click on the dollar 
amount in box 6 Buyer’s 
part of real estate tax.

The 1099-Buyer’s Real Estate Tax
window opens allowing changes to be made.

What You Do Comments
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6. Click OK to save changes 
and exit, or click Cancel 
to exit without saving.

7. Click the  Use Legal
button on the secondary 
toolbar.

The legal description for the property is 
displayed in box 3 Address or legal 
description. Click the button again to 
redisplay the address. NOTE: The button’s 
appearance changes when the box contains a 
legal description rather than the address. 

8.  On the secondary 
toolbar, click the Print
button. 

The Print Options window opens. Current 
Record and Copy B - For Transferor are 
automatically selected.

9. Select Both Copies from 
the Print What drop down 
list.

10.  Click OK Both Copy B - For Transferor and Copy C - 
For Filer print.

What You Do Comments
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Emailing A 1099-S Electronic Record 
What You Do Comments

1. Select eSolutions > 
Email on the menu bar.

The e-Mail - 1099S window opens. Copy 
B-Transferor is automatically selected.

2. Click the check box(es) to 
select or deselect copies to 
be emailed.

3. Click OK The EMail Properties window opens.

4. Click the To... button. The Address Book window opens.

5. Select name(s) to receive 
the 1099 forms.
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6. Click OK The Address Book window closes.

7. Type a message in the 
Message: box, if needed.

You may also edit the Subject: box by 
clicking in the box and typing additional text.

8. Click Send The form is sent and the EMail Properties
window closes.

9.  Click the Save button 
on the secondary toolbar.

This saves changes to the 1099-S form and 
also updates the Last Print Date and Last 
Update Date fields with the current date. 

10.   Click the View 
Record button again to 
close the record and return 
to the summary screen.

11.  Scroll right to view the 
Last Print Date and Last 
Update Date fields.

12.  On the secondary 
toolbar, click the Close 
button.

The 1099-S module is closed.

What You Do Comments
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Creating A File For Electronic Transmission
What You Do Comments

1.  Select Modules > 1099-
S > Year End 
Maintenance from the 
menu bar.

The 1099-S - Tax Year window is displayed, 
with all 1099-S files in DoubleTime for the 
current year.

2.  Click the Change 
Year button.

The 1099-Change Year window displays.

3. Select the desired year, and 
click OK.

The record(s) for the selected year are 
displayed.

4. Click the check boxes in 
the Send IRS column to 
select or deselect records 
for submission.

Records that do not have the Send IRS box 
checked will not be included in this 1099-S 
transmission file.
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NOTE: When an exclamation point displays 
in the first column for an individual record, it 
is an alert that some information is missing 
from the record.

5. Click an exclamation mark 
to view a list of the missing 
information.

6. Click OK to close the 
window.

Any changes must be made and saved in the 
appropriate module before returning to the 
Year End Maintenance module for 
electronic submission.

NOTE: You may run a 1099-S report from 
the Reports module on the main menu. The 
report can help identify files which are 
missing information.

What You Do Comments
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NOTE: Notice the two Help Topic Links. These links contain step by step 
instructions to help you complete your 1099’s.

7.  On the secondary 
toolbar, click the Create 
File button.

The 1099 - Electronic File Wizard
window opens. The Electronic File Wizard
will assist you in successfully creating an 
electronic record or a file that can be sent in 
stead of paper. NOTE: You must have a TCC
provided by the IRS in order to file 1099s 
electronically.

What You Do Comments
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NOTE: Notice the Year End hyperlink. This link contain step by step 
instructions that walk you through the entire Electronic Filing process.

8. Click Next.

9. Select the year for which 
you are creating electronic 
files.

Be sure to read the on-screen Special Note.

10. Click the Next button.

11. Select Original and click 
Next.

The default is Original. To send a test file to 
the IRS, select the Test button. To send a 
replacement file to the IRS, select the 
Replacement button.

12. Select Richard P. Bruce, 
Esq. and click Next.

The closing agent(s) defaults to Richard P. 
Bruce, Esq. You can select another listed 
closing agent for the year end filing.

13. Select Richard P. Bruce, 
Esq. and click Next.

The Transmitter listed defaults to Richard 
P. Bruce, Esq. If a Transmitter is not 
listed, select Other.

14. Type (your name) in the 
Contact Name box and 
click Next.

A Contact Name must be entered to 
continue. 

What You Do Comments
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NOTE: If missing or invalid 
data is found, a message is 
displayed once Next is 
clicked.            Click the Print
button to receive the 1099-S 
Record Validation Report
for the listing of missing or 
invalid data. You will need to 
make corrections in the 
appropriate module and submit 
the file electronically again.

What You Do Comments
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15. Click the Next button. DoubleTime will automatically save the 
electronic file in the DoubleTime folder on 
your computer and name it 
IRSTAX_(selected year). Click Browse 
to save in a different folder.

16. Click the Next button. The electronic file is completed. 

17. Click the Print button. The 1099-S Electronic File Summary 
Report is printed.

18. Click the Finish button. The 1099-S - Tax Year window is closed.

19.  On the secondary 
toolbar, click the Close
button.

The 1099-S Year End Maintenance 
module is closed.

What You Do Comments
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Deleting A 1099-S Electronic Record
What You Do Comments

1. Select Modules > 1099-
S > Year End 
Maintenance from the 
menu bar.

The 1099-S window is displayed, with all the 
1099-S files in DoubleTime for the current 
year.

2.  Click the Change 
Year button

The 1099-Change Year window displays.

3. Select the desired year, and 
click OK.

The record(s) for the selected year are 
displayed.

4. Select the 1099-S record 
you want to delete.

The selected file will not be reported to the 
IRS.

5. On the secondary 
toolbar, click the Delete
button.

The selected file’s Electronic 1099-S 
Record is deleted from DoubleTime.

6.  On the secondary 
toolbar, click the Save
button.

The changes are saved.

7.  On the secondary 
toolbar, click the Close
button.

The Year End Maintenance module is 
closed.
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1. To print a blank 1099-S form, choose Blank Form from the Record 
Range section on the Print Options window.

2.  Click Edit Agents on the secondary toolbar to change or edit the 
filing agent.

3.  To view 1099s for a previous year, click Change Year on the 
secondary toolbar.

4.  To create separate 1099’s for multiple sellers, click Insert on the 
secondary toolbar. A separate 1099 can then be issued for each party. 

5. In the Documents module, a Certificate in Lieu of 1099-S is available 
for use when appropriate.

6. It is possible to create 1099-S records for transaction files that were not 
opened in DoubleTime. To do so, choose 1099-S > Year End 
Maintenance from the menu bar. Click Insert on the secondary toolbar, 
enter identifying information for the Closing File field, and then click the 
Blank Form button. NOTE: Make sure you select the correct tax year 
when creating the record. If you need to, click the Change Year button on 
the secondary toolbar before creating the record. 

Tips

Frequently Asked Questions
Question Answer

1. May I use the Settlement 
Statement as a 1099 
Substitute Statement?

No. The Settlement Statement does not
qualify as a 1099-S Substitute Statement 
under IRS regulations. If a transaction 
requires the filing of a Form 1099-S with the 
IRS, the 1099-S module in DoubleTime may 
be used to generate a form for the IRS as well 
as the required copies for each transferor. 

2. How do I get the TCC 
(Transmitter Control 
Code)?

To have a TCC assigned to you, complete and 
submit IRS form 4419 Application for 
Filing Information Returns 
Magnetically/Electronically.

3. How do I Contact the IRS 
if I have questions on the 
4419 form?

Phone: 1-800-TAX-FORM (1-800-829-3676)
Website: www.irs.gov
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4. How do I get a TCC 
assigned quickly?

Filing by fax is the fastest route to having a 
TCC assigned. It takes approximately two 
weeks from the time of filing by fax to having 
the TCC assigned. 

Fax the completed 4419 form to 1-877-477-
0572.

You may also mail completed forms to:
Internal Revenue Service
Information Reporting Program
230 Murall Drive
Kearneysville, WV 25430

NOTE: Form 4419 should be submitted to 
IRS/ECC-MTB at least 30 days before the due 
date of the returns for current year processing.

5. How do I contact the IRS if 
I have questions on the 
1099-S form?

If you have questions about completing and 
filing 1099-S forms, call the information 
reporting customer service center at:
Toll Free: 1-866-455-7438
Local: 304-263-8700
TTY/TDD: 304-579-4827
Hours: M-F, 8:30 am - 4:30 pm, Eastern time

NOTE: All contact and filing information is from www.irs.gov.

Question Answer
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Policy Module

Concept
The Policy module is used to select information on the Owner’s and Mortgagee’s 
policies. These consist of:

• Schedule A – the name of the insured, coverage amount, recording 
information, and legal description 

• Schedule B – exceptions
• Endorsements

Information from the Commitment module is copied to the Policy module. Old 
Republic National Title Insurance Company/ATFS policy numbers can be assigned 
electronically, and electronic payment can be made, when using the Electronic 
Delivery process in the Premium Calculation (Rating) module. To use these 
features “Electronic” must be displayed in the Policy No. field(s) of the Policy 
module. The corresponding jackets will be available for printing in the Documents
module. For more information, please see On Demand Videos in DoubleTime 
Help.

Objective 
The objective of this lesson is to show you how to complete an Old Republic National 
Title Insurance Company/ATFS Owner’s and Mortgagee policy and retrieve jackets 
electronically. Policy numbers will be associated with this closing file. 
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Preparing Owner’s Policy Information   
What You Do Comments

1. On the main toolbar, 
click the Policy button.

The Title Insurance Policy module 
window is displayed. The Owner tab 
includes FUND 06 Owner’s Policy (OF6)
in the Template box, the Amount of 
Insurance, and Name of Insured, all of 
which were selected in the Commitment
module. A check mark is displayed in the 
Policy Required box. This selection carried 
over from the Commitment module. 
Electronic is displayed in the Policy No
box.  NOTE: In the Policy module users will 
be able to request policy jackets any time 
during the closing process. The user will still 
be responsible for submitting Final Policies or 
hardcopies electronically. Access the Policy 
module and click the Policy Jacket 
Request button on the secondary toolbar. 
Follow instructions on the eSolutions 
Policy Jacket Request window. 

NOTE: To find out more, select Help > On 
Demand Videos from the main menu. 

NOTE: To request Old Republic National 
Title Insurance Company/ATFS policy 
numbers electronically, access the Premium 
Calculation (Rating) module and select 
eSolutions > Fund Forms > Electronic 
Delivery from the main menu.
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2. Click the Date of Policy 
box and type 0317 
(current year).

The Date of Policy for the 2006 ALTA 
Owner’s Policy is the recording date of the 
deed. This method of determining the Date 
of Policy affords the underwriter the 
advantage of having the recording information 
and of knowing what matters, if any, were 
recorded in the gap. However, the Date of 
Policy can be the date of disbursement of 
proceeds. The ALTA 2006 policies were 
drafted with the intent to permit policy 
issuance at closing once disbursements are 
completed.  NOTE: The Date of Policy 
field populates to the Date of Policy field on 
Schedule A of the issued policies.

3. TAB to the next box and 
type 0242p.

This is the time the deed was recorded in the 
public records. NOTE: The Issue Date
defaults to the current date and can be 
changed.

4. Click the Record Deed
tab.

The Record Deed tab is displayed. The 
County defaults to Orange. The Recorded 
box defaults to the Date of Policy entered in 
the previous Owner tab and the Book Type
defaults to Official Records.
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NOTE: Deleting Standard Exceptions

Users frequently delete one or more of the standard exceptions from a policy. The Fund’s 
underwriting guidelines support this practice. In fact, in certain cases the deletion of standard 
exceptions may even be required by law. (See Title Note: TN 25.03.07: Waiver of Standard 
Exceptions.) Questions regarding the permissibility of deleting standard exceptions should be 
directed to The Fund’s underwriting counsel. However, once it has been determined which exceptions 
should be deleted, then the following three suggestions offer appropriate alternatives to accomplish 
this in DoubleTime.

5. Type 20180006578 in the 
Document No. field.

This is the Clerk’s document number for the 
deed which was recorded at the courthouse. 
NOTE: The Clerk’s File Number or 
Instrument Number are placed in the 
Document No. box. Some counties use an 
O.R. Book and Page.

6. Click the Owner Except
tab.

The tab is displayed with the exceptions 
carried over from the Commitment module. 
Exceptions can be added, deleted, and edited 
at this location. NOTE: Exception 1 - 6 are 
Standard Exceptions and will print on policy.

NOTE: The Endorse Owner and Endorse 
Mtg tabs are utilized to associate the 
endorsement documents in the Documents 
module. They are also used when issuing 
General Endorsements on policies.
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• Add an additional exception stating that “Standard Exceptions <e.g. 2, 3, 4 and 5> are hereby 
deleted” within the Policy module. You can add a user defined clause to the Clause Library to expe-
dite this process. These clauses can be added in the Owner’s Exception tab, or on the actual policy in 
the Documents module, or
• Open the policy in the Documents module, highlight the exceptions to be deleted and use the 
strike through font option, or
• Open the policy in the Documents module, highlight the exceptions to be deleted, and press the 
Delete key. DoubleTime automatically renumbers the remaining exceptions.

Preparing Mortgagee Policy And Endorsements
What You Do Comments

1. Click the Mortgagee tab. The Lender, Policy Type, Amount of 
Insurance,   and Name of Insured were 
selected in the Commitment module. The 
Date of Policy and time were entered on the 
Owner tab in the Policy module. NOTE: A 
check mark is displayed in the Policy 
Required box. This selection carried over 
from the Commitment module.
If Electronic is displayed in the Policy No
box you will need to request Old Republic 
National Title Insurance Company/ATFS 
policy numbers electronically. NOTE: In the 
Policy module users will be able to request 
policy jackets any time during the closing 
process. The user will still be responsible for 
submitting Final Policies electronically or 
mail hardcopies. Access the Policy module 
and click the Policy Jacket Request 
button on the secondary toolbar. Follow 
instructions on the eSolutions Policy 
Jacket Request window. Electronic serial 
numbers are tracked automatically, and their 
corresponding jackets can be printed in the 
Documents module. NOTE: The Date of 
Policy field contains the date which is 
populated to the Date of Policy field on 
Schedule A of the policies being issued. 
NOTE: To do so, access the Premium 
Calculation (Rating) module and select 
eSolutions > Fund Forms > Electronic 
Delivery from the main menu. 
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2. Click the Record Mtg
tab.

The Lender is copied from the 
Commitment module. The Recorded date 
defaults to the Date of Policy entered on the 
Owner tab and the Book Type defaults to 
Official Records.

3. Type 20180006580 in the 
Document No. field.

This is the Clerk’s document number of the 
mortgage which was recorded at the 
courthouse. NOTE: The Clerk’s File Number 
or Instrument Number are placed in the 
Document No. box. Some counties use an 
O.R. Book and Page.

4. On the secondary 
toolbar, click the Build 
Mortgage Description 
button.

The Mortgage Description is displayed as 
it will appear on the Mortgagee policy and as 
an exception on the Owner’s policy. NOTE:
(1) The title and function of this button 
changes from tab to tab. Place the mouse 
pointer over the button to display the title. (2) 
If an assignment of mortgage is required, 
select the Assignment box on the Lender
tab within the Loans module. This allows the 
Loan Assignment option to display on the 
Record Mtg tab of the Policy module. 
Selecting this option builds the appropriate 
assignment mortgage description.

What You Do Comments
Page 238 DT Version: 8.1



Policy Module
5. Click the Mtg Except tab. Exceptions are carried over from the 
Commitment module. Exceptions can be 
added, deleted, and edited at this location.

What You Do Comments
Training Workbook: August 2018 Page 239



Policy Module
6. Click the Endorse Mtg
tab.

This tab shows the endorsements that have 
been selected in the Commitment module to 
include with the Mortgagee Policy. The 
endorsements listed on this tab are selected in 
Schedule A, paragraph 6 of the Mortgagee 
Policy. There are 11 endorsements approved 
for issuance in this manner and will not print 
out separately. To force the scheduled 
endorsement to print out separately from the 
policy, and remove the selection from 
Schedule A, you must first deselect the Use 
Master check box for the endorsement. If a 
selected endorsement is not one of the 11 
approved for incorporation by reference, there 
will not be a Use Master check box next to 
the endorsement. It will automatically print 
out separately. NOTE: (1) Prior to accessing 
the Premium Calculation (Rating)
module to electronically transmit the policies, 
access the Documents module to view these 
policies and make any changes. (2)  There is 
no separate Master Endorsement form for use 
with the ALTA 06 forms. The Mortgagee 
Policy Schedule A, paragraph 6 contains 11 
approved endorsements which may be issued 
via incorporation by reference by the use of 
check boxes. Endorsements for the owner’s 
policy should be issued individually. 
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7.  Click the Policy 
Jacket Request button 
on the secondary toolbar

You may only request Policy Jackets 
electronically if you are writing on Old 
Republic National Title Insurance Company 
through Attorneys’ Title Fund Services, LLC. 
The eSolutions Policy Jacket Request
window opens.
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8. Click Next. A list of the policy jackets to be ordered are 
displayed. 

9. Click Next. Type the appropriate information in the 
FundNet User ID and FundNet 
Password boxes.
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Tips

10. Click Next. The Select the Billing Address! window 
opens. If only one address is available for 
your office, the address is selected as the 
default.

11. Click Next. The eSolutions Policy Jacket Request 
in Process window opens. A connection 
with Attorneys’ Title Fund Services, LLC is 
established. Once a jacket(s) has been 
requested the window closes and the Policy
module is displayed. The jacket(s) are now 
available to print in the Documents module.

12.  On the secondary 
toolbar, click the Close
button.

The Policy module closes.

1.  Use the Copy Master Property Exceptions button to add or 
replace existing exceptions from the Master Property Maintenance
module.

2.   Use the Copy Commitment Exceptions button to add or replace 
existing exceptions from the Commitment module.

3.   Click the Build Clause button to undo changes to the Owner, 
Mortgagee and/or Record Mtg tabs. You also use this to build the 
mortgage description in the Record Mtg tab.

4.   Use the Spell Check button on the secondary toolbar to check the 
spelling of a displayed document.

5. Use the Serialized Forms/Create Forms Inventory module to put new 
forms into the inventory.

6. Use the Serialized Forms/Delete Forms Inventory module to remove 
forms from the inventory.
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7. To add endorsements from within the Policy module, while on the 
Endorse Owner or Endorse Mtg tabs click on the Insert button. From 
the Type selection, choose the endorsement you want. The endorsements 
are then printed in the Documents module.

8. To obtain Owner and Mortgagee Policy numbers electronically, access 
Premium Calculation (Rating) module and select eSolutions > 
Fund Forms > Electronic Delivery. In the Policy module users will be 
able to request policy jackets any time during the closing process. The user 
will still be responsible for submitting Final Policies electronically or mail 
hardcopies. Access the Policy module and click the Policy Jacket 
Request button on the secondary toolbar. Follow instructions on the 
eSolutions Policy Jacket Request window. The electronically 
retrieved policy numbers will be tracked automatically and the policy 
jackets can be printed in the Documents module. To find out more, select 
Help > On Demand Videos from the main menu.

9. The Multiple Clause Import feature allows you to import clauses from a 
word processing application and enter them as Requirements or Exceptions 
in the Commitment module, as well as in the Owner and Mortgagee 
Exceptions tab in the Policy module. From the Edit menu, select either 
Paste Clauses from the clipboard or Import Clauses from the text file, 
whichever applies.

10. An alternate way to open Clause Library is to press Ctrl + L.

11. Users can create a Master Property within the Closing File module 
using the  Create Master Property button on the secondary toolbar. 
Exception clauses added in the Commitment or Policy modules can also 
be exported into a Master Property, eliminating the need to copy and paste 
text or re-enter information by selecting Edit > Export Exception to 
Master Property.
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Frequently Asked Questions

12. If you have files where Electronic Jacket numbers have been assigned, 
but the policies have not been submitted electronically within 75 days after 
the closing date, you will receive the following message:

13. To request a Policy Jacket electronically for an ORNTIC/ATIF closing, 
users must first setup in www.thefund.com through their office FundNet 
Administrator as well as in Preferences > User Settings.

Question Answer
1. How do I change the time 

the policy becomes 
effective?

Open the Title Insurance - Policy module 
to change the Date of Policy date and time. 
The system defaults to AM. To change the 
time of day the document was recorded, type 
the letter “P” to change AM to PM.

2. How do I put a paper jacket 
form back in the 
inventory?

Go to the Forms Tracking button, or 
Modules > Serialized Forms > Forms 
Tracking. Select the form type and click OK. 
Go to the Assignment section on the 
Inventory Status tab of the Forms 
Tracking window. Set the Form Status to 
Received. Click Save. The form is back in 
the Inventory.
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3. Where are the master 
documents for other 
insurers?

DoubleTime is shipped with only Old 
Republic National Title Insurance Company/
ATFS policy and commitment master 
documents. However, you can use another 
underwriter’s name on the forms or create 
forms for another underwriter by selecting 
Preferences > Document 
Customization from the main menu. When 
using another underwriter, be sure to confirm 
what format for commitments and policies is 
acceptable to them.

Question Answer
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4. How do I issue policies at 
closing using DT?

STEPS TO ISSUE OLD REPUBLIC 
NATIONAL TITLE INSURANCE 
COMPANY POLICIES AT CLOSING 
THROUGH ATTORNEYS’ TITLE 
FUND SERVICES, LLC: 

1. Select the Policy module in 
DoubleTime.

2. If Issuing an Owner’s Policy, select 
the Owner tab. Ensure that the 
displayed information is correct. Make 
any changes necessary. In the Date of 
Policy fields enter the date and time 
as the date and time of the funds 
disbursement.  A date is required; 
however, a time is not required. If no 
time is entered the system will put in a 
default time of 12:00am.   Most people 
use 9:00am. 

3. Select the Record Deed tab. 
Recording information does not need 
to be entered.

4. Select the Owner Exceptions tab. 
Review, add or edit any owner 
exceptions as needed.

5. Select the Endorse Owner tab. No 
action is required. If owner 
endorsements were selected in the 
Commitment module then selecting 
this tab will deliver the endorsements 
to the Documents module. 

Question Answer
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6. If issuing an Owner’s Policy only and 
you do not electronically transmit your 
policies you may proceed to step 12 to 
obtain policy jackets. If your policies 
are completed and you are ready to 
electronically transmit your policies to 
The Fund you may proceed to step 15 
to obtain policy jackets.

7. If issuing a simultaneous Mortgagee 
Policy, select the Mortgagee tab. 
Ensure that the displayed information 
is correct. Make any changes 
necessary. Proceed to step 9 Record 
Mtg tab.

8. If issuing a Mortgagee Policy only, 
select the Mortgagee tab. Ensure that 
the displayed information is correct. 
Make any changes necessary. In the 
Date of Policy fields enter the date 
and time as the date and time of the 
funds disbursement.  A date is 
required; however, a time is not 
required. If no time is entered the 
system will put in a default time of 
12:00am.   Most people use 9:00am. 

9. Select the Record Mtg tab. 
Recording information does not need 
to be entered.  Select the Build 
Mortgage Description button 
located on the secondary toolbar. 
Since no recording info has been 
entered DoubleTime automatically 
types in the language “… dated 1/15/
2017 to be recorded in the Public 
Records of Orange County. Florida, 
which encumber the Land” in the 
Mortgage Description field.

10. Select the Mtg Except tab. Review, 
add or edit any mortgagee exceptions 
as needed.

Question Answer
Page 248 DT Version: 8.1



Policy Module
11. Select the Endorse Mtg tab. No 
action is required. If mortgagee 
endorsements were selected in the 
Commitment module and the Use 
Master box has been de-selected in 
the Policy module then selecting this 
tab will deliver the endorsements to 
the Documents module.

12. If you DO NOT electronically 
transmit your policies use the 
following steps to obtain policy 
jackets. While in the Policy module 
select the Policy Jacket Request 
button located on the secondary 
toolbar. A wizard opens and assists 
you in electronically requesting policy 
jackets from The Fund. The jackets are 
delivered to your Documents 
module.

13. Select the Close button located on the 
secondary toolbar. The Policy 
module will be closed.

14. Select the Documents module. All 
schedules, endorsements and jackets 
are available to be printed. 

15. If your policies are complete and you 
are ready to electronically transmit 
your policies to The Fund use the 
following steps to obtain policy 
jackets. Select the Premium 
Calculation (Rating) module.

16.  Select the Electronic Delivery 
button located on the secondary 
toolbar. A wizard opens that assists 
you in electronically requesting policy 
jackets, delivering your completed 
policies and worksheet’s to/from The 
Fund. The jacket is delivered to your 
Documents module. 

Question Answer
Training Workbook: August 2018 Page 249



Policy Module
17. An invoice appears and you may use 
the Print button at the bottom of the 
window to print the invoice. Send your 
check along with this invoice to The 
Fund. 

18. If you pay your policy premium 
electronically select the Next button 
at the bottom of the wizard. Follow the 
directions in the wizard to complete 
your electronic payment.

19. To exit the wizard select the Close 
button located at the bottom of the 
wizard window.

20. Select the Close button located on the 
secondary toolbar. The Premium 
Calculation (Rating) module 
closes.

21. Select the Documents module. All 
schedules, endorsements and jackets 
are available to be printed. 

22. Be sure to generate the Fund Policy 
Privacy Notice to be given to the 
insured with the Owner’s Policy.

Question Answer
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Documents Module/ Print Policies And 
Endorsements

Concept
The Documents module is used to select, prepare and print documents such as Title 
Commitments, Title Policies, Deeds, Affidavits, and Bills of Sale. You can select 
documents from the Master Document Selection list for each closing file and, if 
necessary, edit them. Documents can also be emailed using Outlook or Outlook 
Express and faxed from your personal computer. Customized documents can be 
created, and then related to each closing file.

Objective
The objective of this lesson is to show you how to print a Fund Policy and jacket for a 
closing. 

Printing The Fund Policy And Endorsements
What You Do Comments

1.  On the main toolbar, 
click the Documents 
button.

The Closing Document Selection
window is displayed. The FUND 
Commitment (CF6R), FUND 06 
Mortgagee Policy (MF6), and FUND 06 
Owner’s Policy (OF6) were previously 
selected and are available for printing.
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2. With FUND 06 
Mortgagee Policy 
(MF6) selected, press 
SHIFT and click FUND 06 
Owner’s Policy (OF6) 
Jacket.

Four documents are selected. 

3. Click Print. The FUND 06 Owner’s Policy Jacket and 
FUND 06 Mortgagee Policy Jacket 
together with the accompanying schedules 
and endorsements (if any) are printed.

4. Click Cancel. The Documents module is closed.

What You Do Comments
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       Premium Calculation (Rating) Module
Electronic Delivery Of Policies And Endorsements

Concept
The Premium Calculation (Rating) module is used to calculate the rates and 
charged amounts for title insurance policies and endorsements. The amount to be sent 
to the underwriter is also calculated. This information is copied to the Settlement 
Statements module. 
The Premium Calculation (Rating) module is composed of three sections.

• Closing File displays the calculated rates for a specific closing file and gives 
you the opportunity to adjust the charges.

• Quote calculates the rates for a title insurance quote to a client not associated 
with a closing file.

• Electronic Delivery of Fund policies can be done within the Premium 
Calculation (Rating) module. A request can be made within DoubleTime to 
have serialized form numbers delivered electronically. Forms can also be 
delivered to The Fund electronically.

Objective
The objective of this lesson is to show you how to electronically submit your policies 
and endorsements, and obtain the Policy Premium Invoice.

Electronic Submission & Payment Of Policies/Endorsements  
What You Do Comments

1.  On the main toolbar, 
click the Premium 
Calculation (Rating) 
button.

The Premium Calculation (Rating) – 
Closing File window is displayed. 

2. Click the Worksheet tab. The Worksheet tab is displayed. 
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3.  Click the Electronic 
Delivery button on the 
secondary toolbar. 

The eSolutions Electronic Delivery
window is displayed.

What You Do Comments
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4. Click Next. If you have incomplete Electronic 
Delivery files that are more than 75 days 
you will get a list of the file names.

5. Click Next. Enter your Fundnet User ID and 
password.

6. Click Next. Select the Billing Address window 
for this transaction is displayed. If only 
one address is available for your office, 
the address will be displayed as the 
default.

7. Click Next. The Transaction Summary window is 
displayed with an itemization of all the 
documents to be filed electronically.
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8. Click Next. The Electronic Delivery in Process
window is displayed. A connection with 
The Fund is established. The requested 
documents have been sent to The Fund. 
The invoice can be printed for a check 
payment, or the premium can be paid 
electronically by clicking Next.

What You Do Comments
Page 256 DT Version: 8.1



Premium Calculation (Rating) Module
9. Click Print. The Print Options window is displayed 
with all pages selected and the number of 
copies defaulted to 1.

10. Click OK. The invoice is printed.

11. Click Next. The Electronic Payment option is 
displayed.
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The Electronic Payment option allows 
you to make an ACH (Automated 
Clearing House) payment from a business 
checking account.

12. Click Get Accounts. The Select Account for Electronic 
Payment window is displayed. Select 
the appropriate account from which to 
transfer funds for this transaction. A 
default bank account can be selected in 
Preferences/Account Maintenance
by checking the ePayment Default 
check box. 

13. Select Account No.123456-
78 Friendly Bankers, Inc.

14. Click OK. The Select Account for Electronic 
Payment window is closed and the 
Electronic Payment option is 
displayed.

15. In the ABA Routing No. 
box, type 263181368.
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16. Click Submit Payment. The eSolutions Electronic Payment 
in Process window is displayed. Then 
the Invoice Payment Confirmation 
window is displayed.

17. Click Print. The Print Options window is displayed.

18. Click OK. The Invoice Payment Confirmation
is printed.

19. Click Finish. The Policy Rating Worksheet tab is 
displayed.
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Tips

20.  On the secondary 
toolbar, click the Print button.

The Print Options window is displayed. 

21. Click OK. The Policy Rating Worksheet is 
printed, containing the policy numbers 
that were electronically assigned. The 
Policy Rating Worksheet can be 
emailed by selecting eSolutions/Email.

NOTE:  Electronic Premium 
Payments for multiple files can also be 
made using the Electronic Payment
button on the main toolbar, or by selecting 
eSolutions > Electronic Payment.

22.  On the secondary toolbar, 
click the Close button.

The Premium Calculation (Rating) 
module is closed.

1. An alternate method to open the Premium Calculation Rating module is 
to select Modules from the menu bar and choose Premium Calculation 
(Rating), then Closing File.
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2.  Use the Calculator button to use the calculator. You can type the 
numbers on the keyboard or use the mouse to click the numbers on the 
displayed calculator. 

3.  Use the Premium Calculation (Rating) – Quote button to open 
the Premium Calculation (Rating) – Quote module. Use this module to 
rate a policy and endorsements for a quote. 

4. To use the Premium Calculation (Rating) – Quote module when not in 
a closing file, select Modules on the menu bar, then Premium 
Calculation (Rating) and then Quote. Data entered in the Quote module 
is not saved.

5. Use the Spell Check button on the secondary toolbar to check the 
spelling for the Rating Remarks.

6.  Use the First Page, Prior Page, Next Page, and Last 
Page buttons on the secondary toolbar to navigate between pages when the 
transaction results in a multi-page document.

7.  DoubleTime allows you to deliver policy schedules electronically. 
Forms can also be delivered to The Fund electronically. Choose 
eSolutions > Fund Forms > Electronic Delivery. To find out more, 
select Tutorials within the Help menu.

8.  Click Electronic Payment on the main toolbar, or select 
eSolutions, then Electronic Payment, to make an electronic payment.

9. If the legal description in the Closing File is an “Exhibit A” instead of an 
actual legal description, a message is displayed in the Electronic Delivery 
wizard instructing you to fax the legal description to the Finance Customer 
Service Department of The Fund, at 407.816.0150. Please remember to 
include the policy number on the document containing the legal description.

10. If an electronic delivery is initiated, but not completed, you will be notified 
about the incomplete delivery. Notate the Closing File number(s) in the 
Warning message and switch to the appropriate file to re-initiate the 
electronic delivery.

11. If you have files where the Electronic Jacket Request has been used, 
but the policies have not been submitted electronically within 75 days after 
the closing date, you will receive the following message:
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12. If not transmitting policies to ATFS electronically, remember to change the 
status of the policies to Sent to Underwriter in the Forms Tracking
module, otherwise the policies will continue to be listed on the Policies in 
Progress report.
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Frequently Asked Questions
Question Answer

1. Why don’t the 
endorsements appear in the 
Premium Calculation
module?

Here are some possible reasons:
• You haven’t added the endorsements. Open 
the Title Insurance Commitment module 
and select the Endorse Policy tab. Select 
the endorsements you want and save your 
changes. When you reopen or refresh the Pre-
mium Calculation module, the endorse-
ments will be included in the calculations.
• You haven’t saved the endorsements. In the 
Title Insurance Commitment module, 
save your changes. When you reopen the Pre-
mium Calculation module, the endorse-
ments will be included in the calculations.
• You added the endorsements after the policy 
was rated. Go to the appropriate tab of the 
Policy module (Endorse Owner or 
Endorse Mtg). Click the Insert button and 
select an endorsement. Then re-rate the policy.
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Concept
The Notes module allows users to create and save file specific notes that can be 
viewed by other DoubleTime users in the office. Notes are saved with a Subject, 
Category and Note Author. All notes are date and time stamped. Users also have 
the ability to reply to Notes that have been saved, as well as print file specific Subjects 
or all file notes at once.

Objective
The objective of this lesson is to show you how to create and reply to file specific 
notes that can be viewed by any DoubleTime user in your office.

Adding A File Note 

What You Do Comments

1.  On the main toolbar, 
click the Notes module 
button. (While on grey 
screen)

The Notes window is displayed. You may 
also access the Notes module by selecting 
Modules from the menu bar. Selecting either 
of the above options while located on the grey 
screen will display all categories of notes and 
all notes for the file. You may deselect or 
select all categories by clicking on the Select 
all categories button or the Deselect all 
categories button on the secondary toolbar. 
The default is that all of the categories are 
selected. You may select a specific category in 
the Filter Notes box to view specific notes 
for that category only.

NOTE: If the Notes module is initiated 
while another module is open, it will default 
on a category filter for the open module.

2.  On the secondary 
toolbar, click the Insert
button.

The new note section opens up in the bottom 
half of the Notes window.
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3. Select Closing File from 
the Category drop down 
menu.

The default Category is Other. Note: 
Custom Categories may be added from Main 
Menu> Maintenance Lists> Note 
Category Type.

4. Type your name in the 
Note Author field.

Note Author defaults to the DoubleTime 
user name created in Preferences.

5. Type Lender’s package
in the Subject field.

6. In the Note field, type 
Lender’s closing 
package was sent 
overnight FedEx on 
3/17/CY via tracking 
number 12345.

7.  Click the Save button 
on the secondary toolbar.

Your note has been saved. 

NOTE: Users may cancel a Note BEFORE it 
has been saved by selecting the Cancel
button on the secondary toolbar. Once a Note
or Reply has been saved, it CANNOT be 
deleted or edited. File specific notes can be 
viewed by other DoubleTime users in the 
office.

8. Highlight the note with a 
subject of Lender’s 
Package.
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9.  Click the Reply
button on the secondary 
toolbar.

The Reply note section opens up in the bottom 
half of the Notes window. 

10. Type your name in the 
Note Author field.

Note Author defaults to the DoubleTime 
user name created in Preferences.

11. In the Note field, type 
Confirmed with lender 
that package was 
received.

Replies to saved notes will be in the Subject
section at the top of the window. NOTE: The 
Reply is indented under the original note.

12.  Click the Save button 
on the secondary toolbar.

NOTE: Once a Note or Reply has been saved, 
it cannot be deleted or edited. 

13. Click the Print button on 
the secondary toolbar.

The Notes - Note Report window opens.

14. Click the Yes button. By selecting “Yes” on the prompt, all notes 
saved to the file will be printed. If “No” is 
selected, only the current subject selected and 
any of its replies will be printed. 
WARNING: When printing notes for 
numerous replies, be sure to select the 
beginning note in order to view ALL notes 
for the reply.

15. Click the Cancel button.

What You Do Comments
Page 266 DT Version: 8.1



Notes Module
16.  On the secondary 
toolbar, click the Close 
button.

The Notes module closes.
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 Order Branch Product Module

Concept
DoubleTime’s Order Branch Product module allows users to order Fund Branch 
Products within the application. Users may order a Fund Branch Commitment and 
receive the Fund Data File automatically using the View Branch Product Orders
module. 

Objective
The objective of this lesson is to show you how to order a Fund Branch Product 
Commitment within DoubleTime using the Order Branch Product module.

Ordering A Fund Branch Product 

What You Do Comments

1.  On the main toolbar, 
click the Switch Active 
Closing File button. 

The file is created and the Closing File 
module contains the necessary information 
needed to order a Fund Branch Commitment, 
for example: Sales Price, Buyer, Seller, Loans 
and Property.
NOTE: Users may avoid re-typing 
information by entering the Closing File 
module information prior to ordering the Fund 
Branch Product.

2. In the Closing File 
Number box, type 
14-0062.

3. Click Browse.

4. Click OK.
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5.  On the main toolbar, 
click the Open Closing 
File button. 

The General tab of the Closing File 
window is displayed.
NOTE: If the Branch Product Order 
module is initiated while the Closing File 
module is open, it associates the order with 
the current file. If you first enter the Seller, 
Buyer, Lender and Property information in the 
Closing File module, DoubleTime defaults 
that information into the current Branch 
Product Order. Entering your closing file 
information in the Branch Product Order 
wizard will not enter that information into the 
Closing File module. If you are ordering a 
product that will deliver a Fund Data File 
(.FPX), you are able to import the data file 
into DoubleTime.

6.  On the main toolbar, 
click the Order Branch 
Product   module button.          

The eSolutions Branch Product Order
wizard opens. You may also select 
eSolutions from the main menu, then 
Branch Product Order and Order 
Branch Product on the sub menu. This can 
be done while the Closing File module is 
open or closed. NOTE: Branch Product 
Orders placed through DoubleTime require a 
valid FundNet ID and Password. This 
information can be stored and saved in 
DoubleTime’s Preferences> User 
Settings menu. To obtain a FundNet ID, 
contact your office’s FundNet Administrator 
or call The Fund’s Help Desk for assistance.
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7. Click Next. The Select Member and Branch 
Information! window opens. The billing 
address for this transaction is displayed. If 
only one address is available for your office, 
the address is displayed as the default.
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8. Click Next. The Select a Branch Product! window 
opens. The Transaction Type defaults to 
Residential and the default Product is 
Residential – Commitment A&B (R20). 
Using the drop down arrow in the 
Transaction Type field will allow you to 
choose other Transaction types: 
Commercial, Foreclosure, Other, 
Copies/Document and Courthouse 
Service.   NOTE: User may request an 
Update Branch Product (39B) when they 
previously order a Commitment in 
DoubleTime.    
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NOTE: An Update Branch Product order 
is a pre or post-closing report that provides a 
list of any documents that have been recorded 
between the last effective date and the current 
effective date and should not be used for 
requesting changes to an existing Branch 
Product Order request. Requests for changes 
can be handled by ordering a Rework. 

NOTE: User may request a Rework (37) to 
request changes to an existing Branch Product 
Order. To order a Rework, click on the 
Order Branch Product button on the main 
toolbar and select the Closing File used for the 
original Branch Product Order request. 

After selecting Rework on the Select a 
Branch Product! window, you will be 
prompted to select the original Branch 
Product you would like to have changed. 

The Special Instructions field on the last page of the Branch Product Order 
wizard should be used to state what you would like changed from the original 
request. 
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9. Click Next. The Enter Customer/Charge to 
Information! window opens. The Email, 
Delivery Method, Propel, Resp. Party 
Email, Delivery Name, Delivery 
Address will populate with information 
from your FundNet User ID and your 
DoubleTime Contact module data.
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10. Type the desired business 
date in the Date Needed 
By field.

11. Your name will be pre 
populated in the Order By
field.

NOTE: If the name of the person ordering the 
product needs to be changed you must use a 
User ID that matches the email name to be 
used. 

12. Ensure that the Email and 
Delivery Method have 
defaulted to the correct 
information.

This is a required field.

13. Click Next. The Enter Owner, Buyer and Lender 
Names! window opens.
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14. Ensure that all of the 
information that has been 
populated is correct. Make 
any changes that are 
necessary.

The Owner Name(s) is a required field. The 
Owner Name(s), Buyer Name(s) and 
Lender(s) field populate with information 
previously entered in your Closing File
module. 

NOTE: User can edit this field, but changes 
are not saved in the Closing File module.
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15. Click Next. The Legal Description is a required field. 
Legal Description, PIN/Folio# and 
Property Address is populated with 
information previously entered in your 
Closing File module. 

NOTE:  Attach Legal Documents button, 
allows you to attach an exhibit or document 
referencing a long property legal. This avoids 
the user to type long legal descriptions. The 
attached document is included with your order 
when sent to the branch for processing. 
During the Branch Product Order wizard, 
you are prompted with an option to “Attach 
Legal Document”. 
Once selected, you can browse your PC for a 
document to include with your order. Double-
Time will allow most document formats to be 
attached to the order, including .bmp, .doc, 
.docx, .gif, .jpeg, .jpg, .msg, .pdf, .png, .rtf, 
.txt, .wpd, .wps, .xls, .xlsx and .xps. 
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16. Click Next. The Enter and Attach Branch Order 
Supporting Information! window opens. 
The Owner and Mortgagee Policy Form 
Type and Amount will populate with 
information previously entered in your 
Commitment module. These are required 
fields.

NOTE: In addition to including documents 
with the legal description, you can attach 
other supporting documents with the Attach 
Documents button. Example: Prior Policy
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NOTE: When Name(s) with Status is entered in the Closing File module,
this information will carry over into Special Instructions of the Branch 
Product Order wizard. This will allow the branch to keep the exact formatting 
you have setup for the buyer and seller vesting information when delivering the 
product back to you.
17. Click the Submit Order

button. 
A connection with Attorneys’ Title Fund 
Services, LLC is established. Once your order 
has been requested a message will be 
displayed: Branch Product Order 
Submitted Successfully. Go to View 
Branch Product Orders to check the 
status of your order.

18. Click Finish button. The Order Branch Product wizard closes. 
You may print a copy of your receipt using 
the Print button.

19.  On the secondary 
toolbar, click the Close 
button.
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Tips
1. Access the electronic delivery by selecting Preferences> User 

Settings> Electronic Delivery tab. 

2. User’s have the ability to request an Update Branch Product when the 
commitment branch product was previously ordered in DoubleTime.

3. The Order Branch Product module allows you to order products for 
Residential, Commercial, Foreclosure, and Other as Transaction 
Types.

4. When the property contains a long legal, use the Attach Legal Document
button in the wizard to browse your PC and attach an exhibit or document 
containing the property’s long legal.

5. Use the Attach Document button to add prior policies or supporting 
documents to your order.
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Concept
The View Branch Product Orders module allows you to check the status of orders 
placed through the Order Branch Product module in DoubleTime and provides the 
ability to receive Fund Data Files (.FPX) automatically. With a Fund Data File, 
you can import the data from the product into the Closing File or Commitment
module. It can be accessed in two ways: 1. Selecting the eSolutions from the main 
menu, then selecting Branch Product Order and View Branch Product Orders
on the sub menu. 2. Selecting the View Branch Product Orders button on the main 
toolbar. 

Objective
The objective of this lesson is to show you how to view the status of your Fund 
Branch Product order within DoubleTime using the View Branch Product 
Order module. You will also learn how to import a Fund Data File in DoubleTime 
from the View Branch Product Orders module.

Viewing The Status Of A Fund Branch Product 

What You Do Comments

1.  On the main toolbar, 
click the View Branch 
Product Order button. 

The Branch Product Order Search 
window is displayed.
NOTE: There are 4 types of Order Status:

• Order submitted – confirms the 
order request was successfully 
submitted to the branch.

• Order received at The Fund – 
confirms the order was processed and 
a Fund Order No. was obtained.

• Order delivered – confirms the 
order was completed and a Fund Data 
File delivered to DoubleTime.

• Order Imported – confirms an 
import of the Fund Data File.
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2. Double click on the order 
for Closing File No. 
14-0062.        

The DoubleTime Branch Product Order 
Detail Report is displayed. This report along 
with a Branch Product Order Summary
report can also be generated from the 
Reports module. You may print a copy of 
your report using the Print button.

3. Click Cancel. The Branch Product Order Search
window is re-displayed.
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Importing A Fund Branch Product 

What You Do Comments
1. Change the Order Date 

From in the Search 
Criteria section to 
01/01/2015.

The search criteria data range defaults to the 
previous 14 days. You may search for your 
order using any of the fields in the Search 
Criteria section of the Branch Product 
Order Search window. 

The View Branch Product Orders 
module helps differentiate between Fund Data 
Files that have already been received and 
those that have been reworked and 
redelivered. Any new Fund Data File sent to 
DoubleTime shows New in the Import 
column. After the Fund Data File has been 
imported, the button changes to show Import. 

This helps determine when new information is 
received from the branch after requesting a 
Rework and using the Re-retrieve 
Product from Fund Servers option from 
the Actions menu or secondary toolbar. 

2.  Click the New 
button for Closing File No. 
15-0045C. 

The Fund Data File Import Branch 
Product window opens. 
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3. Select or deselect check 
boxes in the Import?
column.

This indicates what information will be 
imported from the file.

NOTE: The Fund Data File (.FPX) Import
wizard allows you to replace your current 
closing file’s legal description with an 
updated legal description provided by the 
Fund Branch. In the event your closing file 
contains multiple properties, a reference 
message will be displayed in the Current 
File Data column.
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After saving, an additional prompt is 
displayed and allows you to choose the legal 
you wish to replace. You also have the option 
to click on the New Property button of the 
window to add the imported legal as the new 
property legal.

4. On the secondary 
toolbar, click Close.

The Fund Data File Save window opens, 
asking if you want to save the Fund Data 
File.
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5. Click Yes. The Update Sales Price window opens. If 
you have not previously opened the 
Commitment module for this file you are 
prompted to make updates.

6. Click OK. A message displays stating “Congratulations 
on the successful import of the Fund Data 
File.”

7. Click OK. The Branch Product Order Search
window is redisplayed.

8. On the secondary 
toolbar, click Close.

The Branch Product Order Search
window is closed.
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Tips

9.  On the main toolbar, 
click the Switch Active 
Closing File button. 

10. In the Closing File 
Number box, type 
15-0045C.

11. Click Browse.

12. Click OK.

13.  On the main toolbar, 
click the Commitment
button. 

The Commitment window is displayed. 
User may review and edit the imported 
commitment.

14. On the secondary 
toolbar, click Close.

The Commitment window is closed.

1.   Click the New button to open the Fund Data File Import 
Branch Product window.

2.   Filter On — is activated when importing a file. It displays only boxes 
that include data from the Fund Data file.

3.   Filter Off — displays all boxes on the window, whether or not they 
contain data.

4.   Information symbols contain important details about your order 
request and should be reviewed.

5.   If a member imports a Fund Data File the Import button remains 
to provide the member an opportunity to re-import the same exact product if 
needed.   
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6. There is a Re-retrieve Product From Fund Services button on the 
secondary toolbar in the Branch Product Order Search module. To re-
retrieve updated Fund Data Files from the branch, highlight the order and 
click the Re-retrieve Product From Fund Services button. After 
DoubleTime finishes processing the request, you can click on the Import
button again to import the new information. NOTE: The re-retrieve option 
is also accessible from the Actions menu while in the Branch Product 
Order Search module.
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Settlement Statements For Cash Closings/               
Non-RESPA/CFPB

Concept
Cash closings are Non-RESPA and Non-CFPB related transactions because there is no 
lender involved and use a two page Settlement Statement. Commercial transactions are 
not subject to RESPA or CFPB regulations even when a loan is involved. The 
Settlement Statements module can be used to complete the two-page Buyer/
Seller Closing Statement (HUD Format), as well as a variety of other types of 
Settlement Statements. Just as with the CFPB closing file we created earlier in 
training, DoubleTime will automate much of the preparation.

Objective
The objective of this lesson is to show you how to use the Settlement Statements
module to complete a two-page Buyer/Seller Closing Statement (HUD Format) for a 
cash closing transaction and how to print the completed statement.

Switching The Active Closing File
What you Do Comments

1.  On the main toolbar, 
click the Switch Active 
Closing File button.

The Closing File Selection window is 
displayed. This window allows you to switch 
the active file to a different closing file 
established within DoubleTime.
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Update Recording Charges

2. In the Closing File 
Number box, type 15-
0010. 

Since the file was partially completed by a 
coworker, searching by the closing file 
number will locate the file.

3. Click Browse. File number 15-0010 displays.

4. Click OK. File number 15-0010 is now open and the file 
number displays in the title bar.

What you Do Comments

1.  On the main toolbar, 
click the Settlement 
Statements button.

The Update Recording Charges dialog 
box is displayed listing the calculated values 
for the documentary stamps on the deed. 
DoubleTime uses the appropriate charges 
based on the sales price and the county in 
which the property is located. This dialog box 
is used to update the Old Amount with the 
New Amount. 
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2. Click Yes. The Update Recording Charges dialog 
box is closed and the Settlement 
Statements window is displayed with the 
General tab open. The two page settlement 
statement is divided by sections. Each section 
has its own tab. In the General tab, you can 
view the top portion of page 1 of the 
Settlement Statement, sections A through I. 
These sections contain the names of the 
parties, and property and settlement 
information. Use the Closing File module to 
change or make additions to the information.
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Page 292 DT Version: 8.1



Settlement Statements For Cash Closings/ Non-RESPA/CFPB
3. Position the cursor over the 
Seller Credits tab.

A brief description of the series purpose is 
displayed.

4. Click the Seller Credits
tab.

The Seller Credits tab, with the 100/400 
line series, displays showing the contract sales 
price (line 101/401), and the settlement 
charges to borrower (line 103). NOTE: On 
each tab of the HUD-1 Settlement 
Statement module, the top half of the 
window is where you will select the line 
where you want information to appear. Once 
you click on a line, it highlights in blue and a 
work area is provided for the selected line at 
the bottom half of the window.
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5. Click the Adjustments - 
Paid tab.

The Adjustments - Paid tab displays lines 
106/406 through 112/412. 

This section is used to Pro-rate fees that 
have been paid by the seller such as HOA 
dues and taxes (if due for current year).
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Viewing Buyer Credits And Payoffs 
What you Do Comments

1. Click the Buyer Credits
tab.

The Buyer Credits tab displays showing the 
buyer’s deposit amount (line 201).

 NOTE: Click the Deposit Summary
button to view details of the deposit(s), or you 
may also double click on line 201 to view this 
information.

2. Select line 504.
  NOTE: If you position the cursor over 

line 504 and double-click, the Payoff 
Calculator opens. The information entered 
here is supplied by the payoff lender. This 
feature is used for expiring payoffs to 
calculate additional days of interest.

3. Type 225182.59 in the 
Total Amount box.

The payoff amount is supplied by the lender 
holding the mortgage. 

4. Select line 208.

5. Click the Copy checkbox 
in the work area.

The Payor box disappears and the Total 
Amount will be populated on lines 208 and
508.
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Calculating Adjustments For Items Unpaid By Seller

6. Type Seller credit 
towards Buyer’s 
closing cost in the 
Description box.

7. Type 250 in the Total 
Amount box and press the 
Tab key.

What you Do Comments
1. Click the Adjustments - 

Unpaid tab.
The Adjustments - Unpaid tab is displayed 
with lines 210/510 through 219/519. 

2. Select line 211/511. Selecting this line allows you to calculate the 
unpaid county taxes.

3. Click the Pro-rate check 
box in the work area.

Additional fields open for lines 211/511. 
The Date from defaults to the beginning of 
the year. The Date to defaults to the date of 
closing. 

4. Click the Gross Amount
box and type 3733.00.

This is the amount due in March of the 
property taxes for the entire year.
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Entering Broker’s Commission

5. Type 4 in the Discount 
percent box 

This is the maximum allowable discount 
which is determined by the Tax Collector’s 
office. A 4% discount is the November 
amount.

6. Press the Tab key. DoubleTime calculates the prorated taxes.

What You Do Comments
1. Click the Brokers tab. The Brokers tab is displayed showing the 

700 line series. The purchase price of 
$450,000.00 is displayed in the Basis 
Amount box of the work area.
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2. Type 6 in the % box of the 
work area and press the 
Tab key.

The commission of $27,000.00 is displayed 
on lines 700, 701, and in the seller’s column 
on line 703.  NOTE: The broker commission 
can be added to the settlement statement by 
typing a percentage amount, or by typing the 
total dollar amount on this tab.

3. Select line 701. Selecting this line allows you to add the payee 
information and split the fee if there is more 
than one broker involved.

4. Delete the 6 and type 3 in 
the % box of the work area.

The commission amount will be split between 
two brokers on line 701 and 702.  NOTE: A 
dollar amount may also be entered in the 
Commission box, including any additional 
fees owed to the broker. DoubleTime will 
calculate the difference and display the typed 
amount on line 701, and the remaining 
amount on line 702.

5.  Click Search 
Contact button on the 
secondary toolbar.

The Search Contact window opened with 
Corporation as the Contact Type and 
Real Estate Brk as the Service Provided. 
Users may also select contacts that have 
already been associated with the file from the 
drop down arrow in the payee field on the 
line.
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6. Select Realty Company, 
Inc. and click OK.

This is the Buyer’s broker. The Search 
Contact window is closed and the Role 
Selection window opens.

7. Select Buyer’s Broker 
and click OK.

This identifies the payee as the buyer’s broker. 
The Role Selection window closes, and 
Realty Company, Inc. is listed as the payee 
on line 701.

NOTE: If the wrong role is selected for the 
broker, it can be changed on the Participants
tab of the Closing File module.

8. Select line 702. The split is calculated and 3% is displayed in 
the Rate box.

9.  Click Search 
Contact on the secondary 
toolbar.

Another broker is to be added. The Search 
Contact window opened with Corporation
as the Contact Type and Real Estate Brk 
as the Service Provided. 
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10. Select Sunshine Realty, 
Inc. and click OK.

This is the seller’s broker. The Search 
Contact window is closed and the Role 
Selection window opens.

11. Select Seller’s Broker 
and click OK.

This identifies the payee as the seller’s broker. 
The Role Selection window closes, and 
Sunshine Realty, Inc. is listed as the payee 
on line 702.

NOTE: Line 704 is an additional line 
provided by DoubleTime for any other broker 
charges, such as listing a third broker’s co-
brokerage and a processing fee. This line also 
identifies the payee and amount.
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Adding Title Charges
What you Do Comments

1. Click the Title tab. The Title tab is displayed with lines 1101
through 1113. Line 1101 is selected. The 
Payee defaults to Richard P. Bruce, Esq. 

NOTE: The detail window at the bottom of 
the screen provides two columns. One for 
Borrower fees and the other for Seller fees. 
The rows allow for fees that are Paid from 
funds or a P.O.C. amount. 

2. Type 250 in the Paid 
from funds box for the 
Borrower and press the 
Tab key.

The $250 Settlement or closing fee is 
charged to the borrower.

3. Type 250 in the Paid 
from funds box for the 
Seller and press the Tab
key.

The $250 Settlement or closing fee is 
charged to the seller.

4.  Select line 1102. The Description field defaults to Abstract 
or title search. 
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5. Type 150 in the Paid 
from funds box for the 
Seller. Press the Tab key.

This transaction requires the seller to pay for 
the Title Search.

6.   Click the Search 
Contacts button on the 
secondary toolbar.

The Search Contact window opened with 
Corporation as the Contact Type and 
Title-Other as the Service Provided. 

7. Select LLC from the 
Contact Type drop down 
list.

8. Select ATFS, LLC from 
the Legal Entity Name
list.

9.  Click OK. The payee name for line 1102 changes as 
indicated.
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Recording Charges

NOTE: Line 1108 displays the Title 
Insurance amounts. DoubleTime 
automatically calculates the rate in the 
Premium Calculation (Rating) module 
and populates the amounts on line 1108.

What you Do Comments
1. Click the Recording tab. The Recording tab is displayed with lines 

1201 through 1205. Line 1201 is selected. 

2. Double click line 1201. The Recording Calculator window is 
displayed.
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3. Type 2 in the # of Pages
box in the Deed column.

The calculation is automatically made for 
recording a 2 page deed. The payors default to 
the typical payor, but can be changed as 
needed by selecting the Payor down arrow.

4. Click OK. The Recording Calculator window closes 
and the calculated amounts display.
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Adding Additional Settlement Charges

5.  Click the Search 
Contact button on the 
secondary toolbar.

The Search Contact window opens. The 
Contact Type is Other and the Service 
Provided is Recording Dept.

6. Select State of Florida
and click OK.

The Search Contact window closes and the 
Recording tab redisplays. State of Florida
is listed in the Payee box. NOTE: This 
information is not displayed on the settlement 
statement, but reflects the payee for the 
Balance Sheet.

What You Do Comments
1. Click the Add’l Charges

tab.
The Add’l Charges tab is displayed with 
lines 1301 through 1308. Line 1301 is 
selected. 

This line defaults to Survey in the 
Description box. This field can be edited.
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2.   On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Surveyor.

3. Select Property 
Surveyors, Inc. and click 
OK.

The Search Contact window is closed and 
the Add’l Charges tab is redisplayed. 
Property Surveyors, Inc. is now displayed 
in the Payee box. 
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4. Type 275 in the Paid 
from funds box for the 
Borrower. Press the Tab
key.

5. Select line 1302. This line defaults to Pest Inspection in the 
Description box. This field can be edited.

6.   On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Pest Inspector. 

7. Select Pest Inspectors, 
Inc. and click OK.

The Search Contact window is closed and 
the Add’l Charges tab is redisplayed. Pest 
Inspectors, Inc. is now displayed in the 
Payee box.

8. Type 275 in the Paid 
from funds box for the 
Seller. Press the Tab key.

The $275 Pest Inspection search fee is 
charged to the seller.
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Viewing Closing Statement Alerts
What you Do Comments

1.  Click the Closing 
Statement Alerts button 
on the secondary toolbar.

The Closing Statement Alerts window 
opens. It provides helpful information on 
specific line items for the current transaction 
that may have been inadvertently overlooked. 
NOTE: (1) The Alerts can be viewed on any 
tab within the Closing Statement module 
by clicking this button. (2) The Missing 
amount alert displays. 

This alert is for a missing amount for a 
recording release for the mortgage payoff. 
The payoff lender indicated they would record 
the release. 

What You Do Comments
Page 308 DT Version: 8.1



Settlement Statements For Cash Closings/ Non-RESPA/CFPB
Viewing Totals Summary

2. Click the box for Do not 
automatically display 
Closing Statement 
Alerts.

NOTE: If you click the Do not 
automatically display Closing 
Statement Alerts check box, alerts will no 
longer display automatically when exiting the 
Settlement Statements module for this 
file.

3. Click Close. The Closing Statement Alert window closes. 

What you Do Comments
1. Click the Totals 

Summary tab.
The Totals Summary tab is displayed. In 
the upper portion of the window is line 1400
from page two of the Settlement Statement. In 
the lower portion of the window are lines 
300/600 through 303/603 from page one.

What you Do Comments
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Printing The Settlement Statement
What you Do Comments

1. Click Format > HUD 
Signatures-Separate 
Page from the menu bar.

Mr. Bruce prefers to have the signatures on a 
separate page. NOTE: No window opens or 
message displays after this action. The 
separate signature page will print with the rest 
of the Settlement Statement.

What you Do Comments
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2.  Click the Print
button on the secondary 
toolbar.

The Print Options window opens. The 
Print Range defaults to All, Copies to 1, 
Print What to HUD-1 and Print to Print all 
pages. NOTE: To print a different statement, 
worksheet, or report, click the Print What
box or the More button and make your 
selection.

3. Using the drop down arrow 
in Print What select 
Buyer/ Seller Closing 
Statement.

The Buyer/ Seller Closing Statement 
will print Buyer instead of Borrower in 
section D on page 1 of the Settlement 
Statement.

4. Click Preview...button. A preview of the Settlement statement 
displays. Use the Next and Back buttons on 
the secondary toolbar to check each page of 
the document.

What you Do Comments
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Tips

5. On the secondary toolbar, 
click the Print button 
again.

The Print Options window opens again.

6. Click OK button. The Settlement Statement including a separate 
signature page prints.

7.  Click the Close
button on the secondary 
toolbar.

The print preview closes and the Settlement 
Statements module redisplays.

8.  Click the Close
button on the secondary 
toolbar.

The Settlement Statements module 
closes.

1. An alternate way to open the Settlement Statements module is to select 
Modules from the menu bar and choose Settlement Statements.

2.  Use the Double Click! feature on line 201 - Deposit or earnest 

money to open the Deposit Summary dialog box. It can also be used to 
open the Payoff Calculator on line 504 and the Recording Calculator
on line 1202.

What you Do Comments
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3. Use the Deposit Summary button, located in the Settlement 
Statements secondary toolbar, to open the Deposit Summary dialog 
box.

4.  Another way to access the Payoff Calculator is to select line 504 and 
click the Payoff Calculator button on the Settlement Statements
secondary toolbar.

5. Use the Recording Calculator to automatically calculate recording 
fees for lines 1202 through 1205 on the Recording tab.

6. In the Print Options window, use the Page Range area to print 
individual pages of the Settlement Statement.

7.  To display the entire Settlement Statement, click the Print button 
on the secondary toolbar and select the Preview button.

8. You can display any one report selected in the Print What box by clicking 
the Preview button. You can also select a report to view by selecting 
Reports from the main menu.

9. To print multiple reports at one time, click the More button on the Print 
Options window and select as many different reports as needed. Click the 
Less button to return to the previous window. You can also select other 
reports by clicking the Reports menu on the main toolbar.

10. A HUD Signatories-Separate Page should be used if all signatures 
cannot be disclosed on the two page settlement statement. This can be 
selected from Format on the menu toolbar.

11.  Click the Calculator button on the secondary toolbar to use the 
calculator. You can type the number on the keyboard or use the mouse to 
click the numbers on the displayed calculator. 

12. To obtain a copy of the figures in the Payoff Calculator, leave the Payoff 
Calculator window open after the figures have been calculated. Press the 
Print button.

13. You can choose to display the Closing Statement Alerts at any time 
by clicking the Closing Statement Alerts button on the secondary 
toolbar to check for any missing items within your settlement statement.
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14. To fax a Settlement Statement from your PC, click the Print button on the 
secondary toolbar, select the Printing to fax machine check box, and 
click the Properties button. Select your fax in the Printer Setup window 
and click OK. This ensures that all the pages of the Settlement Statement are 
faxed as one “print job”, instead of treating each page as a separate fax.

15. To email a Settlement Statement from your PC, select eSolutions while in 
Print Preview, and click Email. In order to perform this function, you 
must be in preview mode of all Settlement Statements, including the HUD, 
and you can only use Outlook or Outlook Express to e-mail from the 
Settlement Statement module. A list of participants in reference to your 
file are displayed with the opportunity to select their e-mail addresses. Email 
addresses need to be established in either the Contacts or Closing File 
module on the Phone tab.

16.  To email the closing statement using an email program besides Microsoft 
Outlook, first save the statement to your computer as follows: 
• Select File > Save as... from the menu bar
• DoubleTime converts the image to a PDF file 
• The Save Document Image window opens
• Type a name for the document in the File Name box
• Select a location on your computer to save the file from the Save in drop 

down list
• Click Save
• The file is saved and available for attachment to an email. 

17. Use the Settlement Statement Template Maintenance module to set 
up Settlement Statement defaults for specific lenders. The initial setup of a 
template is done under Modules/Closing Statement Template Maintenance. 
See the Settlement Statement Template Maintenance lesson in 
Additional Features for more information.

18. The Buyer/ Seller Closing Statement will print Buyer instead of 
Borrower in section D on page 1 of the Settlement Statement.

19.  From the Print Preview window, you may place a ‘Draft’ 
Watermark on your Settlement Statement by using the ‘Draft’ 
Watermark button on the secondary toolbar.  This will appear on all pages 
of your printed Settlement Statement.
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Frequently Asked Questions
Question Answer

1. How do I add more lines? Click the Add’l Charges tab, then click the 
Insert button. An addendum is automatically 
generated, and the addendum total is 
maintained on line 1309.

2. How do I add more lines to 
the 800 Series of the 
Settlement Statement for 
lender fees?

Additional lines cannot be added to the 800
series. However, you can change the 
description of the lines in the 800 series. If 
you have additional lender fees, you can enter 
them in the 1300 section, which can be added 
to, if needed.

3. How do I enter a LIP or 
Construction Loan 
account?

DoubleTime allows you to enter the LIP 
(Loan in Progress) or Construction amount on 
line 104 or 105 of the Settlement Statement. 
Type the Description in line 104 or 105 of 
the Settlement Statement, type the amount of 
the LIP account in Total Amount. Double-
click Amount Withheld. Finally, set your 
Loan Statement to the appropriate loan (for 
example, First).

4. How do I put tax re-
proration language on the 
Settlement Statement?

You cannot add Tax Re-Proration language 
directly to the Settlement Statement, however, 
you can print the Closing Statement 
Addendum document from the
Documents module. The Closing 
Statement Addendum document includes 
the Tax Re-Proration language, as well as 
other information, such as the Disbursement 
Authorization language. 

5. How do I delete an amount 
from Line 402 (Personal 
Property)?

Delete the amount on line 102 and press Tab
or Enter. line 402 will be changed to zero 
(0).

6. How do I print the 
Settlement Statement?

Click the Print button. The Print What box 
will display the default of HUD, or you can 
select a different settlement statement. Select 
Print Preview if desired, and then click Print
button to print the settlement statement.
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7. How do I add a contact on 
the Settlement Statement?

Click Search Contact button on the 
secondary toolbar to open the Search 
Contact window. Select the contact.

8. How do I type a negative 
number?

Type a dash (-), and then type the amount.

9. How do I deduct a deposit 
credit from the loan fees 
check being remitted by 
the Closing Agent to the 
Lender?

Let’s say a Borrower pays a deposit to the 
Lender that needs to be credited to the 
Borrower on the Settlement Statement. The 
Lender remits a check for the exact loan 
amount (no withhelds). The deposit credit 
must be deducted from the loan fees check 
being remitted by the Closing Agent to the 
Lender. NOTE: This situation is similar to an 
Aggregate Accounting Adjustment, which is 
typically a Borrower credit reflected as a 
negative number. Go to the Loan Fees tab in 
the Settlement Statements module. On an 
available 800 section line, enter the following 
information:
• Description: Enter language acceptable to 
the Lender, (such as “Application Fee 
Refund” or “Loan Deposit Credit”).
• Payee: Select the lender.
• Paid from Funds/Borrower: Enter the 
deposit credit amount here as a negative 
number, (such as  
$-500.00).
• Amount withheld: Leave this blank.
• Loan statement: Select the appropriate 
loan.

The Balance Sheet module now reflects a 
negative number for a disbursement item. 
Combine this negative item with the items 
being disbursed to the Lender to create a net 
check for the Lender. NOTE:  You cannot 
access the accounting export function until 
this negative disbursement item has been 
combined.

Question Answer
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10. Why aren’t the doc stamps 
on the deed automatically 
calculated on the 
Settlement Statement?

You did not select a property on the Property
tab of the Closing File module.

11. Why doesn’t the payoff 
amount or lender display?

Payoff loans must be added in the Closing 
File module/Loans tab. The lender will be 
displayed on the Settlement Statement. The 
payoff amount is entered directly in the 
Settlement Statements module. To add 
the payoff amount, type the amount or double-
click the payoff line in the Settlement 
Statement to bring up the payoff calculator. 
Type the mortgage balance, per diem interest, 
and other miscellaneous fees associated with 
the payoff. Click OK. The amount will be 
displayed in the proper box.

Question Answer
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Introduction – Part II
Introduction – Part II

About The Example Used
You are an employee for the law firm of Richard P. Bruce, Esq. You are processing a 
closing file wherein the buyer is assuming the seller’s first mortgage, and the 
individual representing the seller will be holding a purchase money second mortgage. 
The property involved is a partially developed subdivision in Orange County, FL. You 
will perform the following functions in DoubleTime:

• Establish defaults for closing files
• Customize drop-down selections
• Add a partnership to Contacts and modify an existing contact
• Customize a document
• Customize notary information
• Create a Master Property
• Switch to an active closing file
• Create clauses in Clause Library
• Enter loan details and calculate an amortization schedule
• Prepare a Non-RESPA two-page settlement statement
• Prepare loan and other documents and create custom documents
• Copy and delete closing files, review database backup and delete closing 

documents related to a file
• Generate reports

In this workbook, you are provided with the information you need to complete these 
tasks.
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Maintenance (Lists) Module

Concept
Use the Maintenance (Lists) module to customize drop-down lists located 
throughout DoubleTime. The selections can be changed to match the requirements of 
your office. Commonly used information, such as a individual’s title in the Contacts 
module, or Settlement Statement line descriptions in the Settlement Statements
module, can be added. Cities and postal codes are also maintained in the 
Maintenance (Lists) module.

Objective
The objective of this lesson is to show you how to insert a city name and postal code. 
You will also create a line description for the Closing Disclosure Settlement 
Statement, a individual’s title and a service type for the Contacts module.

Adding A Municipality
What You Do Comments

1. On the menu bar, select 
Modules >
Maintenance (Lists).

The Select List window is displayed with 
the list of available tables.
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2. Select Municipality and 
click OK.

The Maintenance (Lists) – Municipality
window is displayed with an alphabetical list 
of municipalities currently entered in the 
system. Use the scroll bar on the right side of 
the window to view all the items on the list. 
When you select Municipality, the Select 
State For Municipality box is displayed 
below the list, and Florida is displayed as the 
default selection. The municipality we will 
add is located in Florida. NOTE: Another 
state may be selected. 

3.  On the secondary 
toolbar, click the Insert
button.

A blank row is inserted at the end of the list.

4. In the highlighted 
Municipality Name box, 
type Bithlo.

5. TAB to the County box 
and type or. Select Orange. 

Orange is displayed as the county. NOTE:
You can also click the County box and select 
from the list.

6. TAB to the Municipality 
Type box and type c. 
Select City.

City is displayed as the municipality type.

What You Do Comments
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Associating A Postal Code To A Municipality

7. TAB to the Payment 
Time box and type f. 
Select First Day of January.

The First Day of January is displayed. 
This is the beginning of the fiscal year and can 
be edited.

8.  On the secondary 
toolbar, click the Open
button.

The Maintenance (Lists) – Municipality
save window is displayed.

NOTE:  You can also click Save. 

9. Click Yes. The changes are saved. The Maintenance 
(Lists) – Municipality save window is 
closed and the Select List window is 
redisplayed.

What You Do Comments
1. On the Select List

window, scroll to and 
select Postal Code.

When you select Postal Code, the Select 
State For Postal Code box is displayed 
below the list, and Florida is displayed as the 
default selection. NOTE:  Another state may 
be selected. 

2. Click OK. The Maintenance (Lists) – Postal Code
window is displayed with the list of 
municipalities and their associated postal 
codes.

What You Do Comments
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3. On the secondary 
toolbar, click the Insert
button.

A blank row is inserted at the end of the list.

4. Type 32820 in the 
highlighted Postal Code
box.

5. Click the Municipality 
Name box and select 
Bithlo, Orange County.

Use the scroll bar on the right side of the 
window to view all the names in the list.

What You Do Comments
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Adding Settlement Statement Line Descriptions 

6.  On the secondary 
toolbar, click the Open
button.

The Maintenance (Lists) – Postal Code
save window is displayed.

NOTE:  You can also click Save. 

7. Click Yes. The changes are saved. The Maintenance 
(Lists) – Postal Code save window is 
closed and the Select List window is 
redisplayed.

What You Do Comments
1. On the Select List

window, scroll to and 
select Line Description 
(Settlement 
Statement).

NOTE:  The Select the Settlement 
format box is displayed. Line descriptions 
added in this module are available for 
selection on the Closing Disclosure or Old 
HUD/ HUD GFE.

2. Select Closing 
Disclosure from the drop 
down list for the settlement 
statement format.

What You Do Comments
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3.  Click OK. The Maintenance (Lists) – Settlement 
Statements Line Description window is 
displayed along with the line descriptions 
available in DoubleTime arranged by Line 
Description and Closing Disclosure 
Section. 

What You Do Comments
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4. On the secondary 
toolbar, click the Insert
button twice.

Two blank rows are inserted at the end of the 
list.

5. Type Underwriting Fee
in the first blank Line 
Description box.

6. Select A from the Closing 
Disclosure Section
drop down list for the first 
blank line.

This is the section of the Closing Disclosure 
in which this line description will be available 
for selection.

NOTE:  In a Closing Disclosure you can 
select “ALL” to add the Line Description to 
all sections.

7. Type Flood Insurance in 
the second blank Line 
Description box.

8. Select G in the Closing 
Disclosure Section
drop down list for the 
second line.

This is the section of the Closing Disclosure 
in which this line description will be available 
for selection.

What You Do Comments
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Adding Service Types For Contacts

9.  On the secondary 
toolbar, click the Open
button.

The Maintenance (Lists) – Settlement 
Statement Line Description save window 
is displayed.

10. Click Yes. The changes are saved. The Select List
window is redisplayed.

What You Do Comments
1. On the Select List

window, scroll to and 
select Provider Type.

What You Do Comments
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2. Click OK. The Maintenance (Lists) – Provider 
Type window is displayed.

3.  On the secondary 
toolbar, click the Insert
button.

A blank row is inserted at the end of the list.

4. Type Builder in the 
Provider Type box.

To add Builder as a selection on the 
Services tab in the Contacts module.

5. Type Builder in the 
Provider Type 
Description box.

This Provider Type is now available for 
selection on the Services tab in the 
Contacts module.

What You Do Comments
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Adding A Title Type

6.  On the secondary 
toolbar, click the Open
button.

The Maintenance (Lists) – Provider 
Type save window is displayed.

7. Click Yes. The changes are saved. The Select List
window is redisplayed.

What You Do Comments
1. On the Select List

window, scroll to and 
select Title.

What You Do Comments
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2. Click OK. The Maintenance (Lists) – Title window is 
displayed.

3.  On the secondary 
toolbar, click the Insert
button.

A blank row is inserted at the end of the list.

4. Type Manager in the 
Title box.

To add Manager as a selection on the 
Contacts module and the Signature/
Notary Block window.

What You Do Comments
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Select List Definitions 

5.  On the secondary 
toolbar, click the Close
button.

The Maintenance (Lists) - Title save 
window is displayed.

6. Click Yes. The changes are saved. The Maintenance 
(Lists) module is closed. 

Code Comments
Arm Index Type Add ARM index types for selection in the Loans 

module (Loan Details). When you select the 
Adjustable Rate check box on the Classification
tab under Loan Options, the ARM tab is displayed. 
You can then select options from the ARM Index. 

Branch (User 
Defined)

Add office or branch locations for a firm that has 
more than one office. The different locations will be 
available as selections in the Branch drop down list 
on the General tab of the Closing File module.

Caps Driver 
Code

Add caps driver codes for selection in the Loans 
module (Loan Details). When you select the 
Adjustable Rate check box on the Classification
tab under Loan Options, the ARM tab is displayed. 
You can then select options from the Caps Driver. 

Country Add countries for selection in country code lists in 
address blocks.

County Add counties for selection in county code lists in 
address blocks.

What You Do Comments
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County Tax Add county-specific tax or fee rates (for example 
documentary surtax, document abstracting fees) for 
calculation of taxes and fees. Line series 1200 of the 
HUD automatically calculate recording fees for the 
intangible tax and doc stamps on the deed and 
mortgage, when applicable. These calculations are 
based on the default for the county in which the 
property is located. New fees other than the county 
default can be calculated by using the county tax 
rates.

Electronic 
Address Type

Add electronic address types for selection in the 
Contacts module. An electronic address can be 
added on the Phone tab. 

Legal Entity 
Relationship

The Legal Entity Relationship list is for adding Entity 
Relationships, such as “its Corporate Partner”, for use 
in the Signature and Notary Block.

Legal Proof Type Add legal identification types, including a blank line 
for selection in Notary.

Line Description 
(Settlement 
Statement)

Add Settlement Statement line descriptions for 
selection in the Settlement Statements module. 
Descriptions are added according to the closing 
statement section or series numbers, not by line 
number. Descriptions added within one series (for 
example, section A) will not be available in other 
section.

Municipality Add U.S. cities, townships, villages, etc. for selection 
in municipality lists in address blocks.

Municipality tax Add municipality tax types and rates for calculation 
of taxes and fees. Line series 1200 of the HUD 
automatically calculate recording fees for the 
intangible tax and doc stamps on the deed and 
mortgage, when applicable. These calculations are 
based on the default for the municipality in which the 
property is located. 

Municipality 
Type

Add the type of municipality (city, township, village, 
etc.) for selection in municipality lists in address 
blocks.

Notary Title Add customized notary information for selection in 
the Notary Title box within the Closing File and 
Documents modules.

Code Comments
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Notes Category Add customized category types for selection in the 
Notes module.

Payment Time Add the beginning date of a county tax payment time 
frame for default selection in the Settlement 
Statements module. The “From” date for proration 
on the Adjustments-Paid or Adjustments 
Unpaid tab defaults to the Payment Time date 
identified when you add a Municipality in the
Maintenance (Lists) module.

Phone Type Add a phone description for selection in the 
Contacts and Closing File modules.

Postal Code Add ZIP codes for linking to city, state, and county 
information in address blocks.

Prepayment 
Code

Add VA or FHA loan prepayment codes for selection 
in the Closing File and Loans modules (Loan 
Details). These codes pertain to interest on the loan.

Problem 
Category

Add categories for the type of legal proceeding or 
document related to a problem for selection in the 
Checklist module.

Problem Type Add problem types for selection in the Checklist
module.

Property 
Registry

Add codes to identify where property registry occurs. 

Property Usage Add codes to identify how property is used for 
selection in the Closing File module.

Provider Type Add services provided by contacts for selection in the 
Contacts module.

Recording Fees 
Tax

This table shows the rates for the Recording 
Calculator located within the Settlement 
Statements module.

Security 
Instrument

Add security instruments for loans for selection in the 
Loan Details module on the Classification tab.

State Add information about the payment of state real 
property taxes for any state or to add another state to 
the table. The tax information includes payment 
method, month or interval payment is due, tax 
discount (if any), deadline date, and tax penalty 
percentage (if any).

Code Comments
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Tips
1. The Title table can be used to insert titles for individuals added in the 

Contacts module or available in the Schedule Closing/Closing 
Meeting module.

2. The selection (None) can be added to lists to replace a selection that is no 
longer required.

3. Use the Notary Title list to add customized notarial officer information.

4. Standard items appear in grey and cannot be altered or deleted.

Frequently Asked Questions

State Tax Add information about the payment of state real 
property taxes. The tax information includes tax type 
and tax rate per specified amount.

Title Add individual titles for selection in the Contacts
module on the Employee’s tab and the Closing 
File module on the Buyers and Sellers tab.

Witness Title Witness Title can be used to add specific title for your 
Witnesses, such as “Witness as to Both” and “Witness 
as to All”, for use in the Signature Block.

Escrow Transfer 
Reason

Add additional reasons for transferring funds in the 
DoubleTime Escrow Accounting module.

Escrow Void 
Reason

Add additional reasons for voiding funds in the 
DoubleTime Escrow Accounting module.

Question Answer
1. How do I add an employee 

title?
Open the Maintenance (Lists) module. 
Select Title and click OK. Click the Insert
button, type the new title, and save your 
changes.

2. How do I add line 
descriptions for the 
Closing Disclosure?

Open the Maintenance (Lists) module. 
Select Line Description (Settlement 
Statement), select the settlement statement 
format as Closing Disclosure and click 
OK. Click the Insert button, type a new line 
description, and select the appropriate 
Closing Disclosure section and save your 
changes.

Code Comments
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3. How do I add my city to 
the selection?

Open the Maintenance (Lists) module. 
Select Municipality, and type or select the 
state. Click OK. Click the Insert button and 
type the new city name. Save your changes.

4. How do I add the correct 
postal code for my city?

Open the Maintenance (Lists) module. 
Select Postal Code, and type or select the 
state. Click OK. Click the Insert button, type 
the new postal code, and select the city name. 
Save your changes.

Question Answer
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Contacts Module

Concept
The Contacts module is like an electronic address book of all individuals and entities 
with whom you come in contact. Contact information may be viewed, modified, or 
added. A variety of contact types can be maintained: Individuals, Corporations, 
LLC’s, Guardianships, Trusts, Partnerships, and Estates.
The Contacts module can be used two different ways:

• As a stand-alone electronic address book to locate a specific name.
• As an interface with other modules, such as the Closing File module, to 

select or add a contact's name and address, thus avoiding repetitious typing.
Some of the information entered in the Closing File module, such as Buyer, Seller, 
Broker, and Lender, is actually stored in the Contacts module.
Contact information is added to the contact card and then interfaces with the 
Settlement Statement module to populate the Contact Information table on 
Page 5 of the Closing Disclosure.

Objective
The objective of this lesson is to show you how to modify an existing contact and to 
add a new contact to the Contacts module.

Modifying An Existing Contact
What You Do Comments

1. On the main toolbar, 
click the Contacts button.

The Select Contact window is displayed. 
The Contact Type defaults to Individual. 
NOTE: The Status defaults to Active,
displaying all Active contacts. To display 
inactive contacts, remove the check mark 
from the Active check box.
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2. Click the Contact Type
box and select Other.

All previously entered contacts with the 
Contact Type Other are displayed. 

3. Select Richard P. Bruce, 
Esq. and click OK.

The Other tab of the Contact window is 
displayed with information previously entered 
for Richard P. Bruce, Esq. 

NOTE:  Licensing information for a contact may be added on this tab and then 
interfaces with the Settlement Statement module to populate the Contact 
Information table on Page 5 of the Closing Disclosure.

What You Do Comments
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4. View the Address, 
Phone, and Associates
tabs.

This information was previously entered in 
the Contacts module.

5. With the Associates
tab displayed, click the 
Insert button on the 
secondary toolbar.

The Select Associate window is displayed 
with all previously entered individuals in the 
Contacts module. You can select an existing 
contact or add a new one to both the 
Contacts module and to the Associates
tab for Richard P. Bruce, Esq.

What You Do Comments
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6. In the Last box, type 
(your last name).

This will add you as an associate of Richard 
P. Bruce, Esq.        NOTE:   When the 
Contact Type is Individual, it is not 
necessary to capitalize names. DoubleTime 
does this automatically when the data is 
saved.

7. TAB to the First box, and 
type (your first name).

8. TAB to the Middle box, 
and type (your middle 
initial) followed by a 
period, if applicable.

The period is required for middle initials. This 
box can also be used for a complete middle 
name.

9. Click New. The Select Associate window is closed and 
the Associates tab is re-displayed with your 
name as an associate.

10. Click the Title box and 
select Manager.

The title selected here will appear in the Title
box when this name is selected as the closer, 
signatory, or prepared by individual in the 
Closing File module.

What You Do Comments
Page 342 DT Version: 8.1



Contacts Module
11. Click the Sign? check 
box.

This is to identify you as a signatory for 
documents. NOTE: The Inactive check box 
is selected for Jayne Garcia. This indicates 
that she is no longer an active employee for 
Richard P. Bruce. Her name will display in 
Italics at the end of drop down lists, where 
applicable.

12. Click the Services tab. The Services tab is displayed with selected 
service types previously entered.

13. On the secondary 
toolbar, click the Insert
button. 

A new blank line is created in the 
Underwriter section. Old Republic 
National Title Insurance Company/
ATFS. was previously established in the 
Contacts module.

14. Click the blank 
Underwriter box and 
select Old Republic 
National Title 
Insurance Company.

Refer to the Setting Up chapter in this 
workbook for a list of contacts already in 
DoubleTime. If the underwriter you want is 
not listed, create a new contact in the 
Contacts module and select Underwriter in 
the Services tab. When you click the blank 
Underwriter box, the underwriter name will 
be displayed in the list.
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Adding Notary Expiration Date

15. TAB to the Agent #, and 
type 7890.

This is the agent number given by Old 
Republic National Title Insurance 
Company to Richard P. Bruce, Esq.

16.   Click the Save
button. 

Changes are saved.

17.   Click Open on the 
secondary toolbar.

The Select Contact window opens allowing 
you to select another party.

What You Do Comments

18. Type (your last name) in 
the Last box of the Select 
Contact window.

19. Select your name from the 
Individual Name list and 
click OK.

The Contact window opens with your name 
on the displayed Individual tab.

20. Type 07/18/2021 in the 
Notary Expiration Date
box.

When your name is selected in the Notary
Block, your expiration date will 
automatically fill in.

21.   Click Save on the 
secondary toolbar.
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Adding A New Contact
In this section you will add a new contact. Your office is now doing business with a 
new builder.

22.  Click Open on the 
secondary toolbar.

The Select Contact window opens.

What You Do Comments
1. Select Partnership from 

the Contact Type drop 
down list.

This will identify the new contact as a 
partnership.

2. Type We Build Homes, 
LTD in the Name box.

This is the legal name of the partnership.

3. Click New. The Contact – We Build Homes LTD
window is displayed with the Partnership
tab open. The cursor is in Legal Entity box. 
The Type Description defaults to a 
partnership and Status defaults to Active. 
NOTE: The Details and Federal EIN
sections can be selected if applicable.
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4. TAB to the Type 
Description field and insert 
the words Florida limited
between a and 
partnership. 

5. Click the Address tab. The Address tab is displayed. The Type
defaults to Mailing and the Country defaults 
to United States.

6. Click the Street box and 
type P.O. Box 2233.

The mailing address is displayed at the top of 
the Address tab once you press TAB.
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7. In the Postal Code box, 
type 32820 and press Tab. 
Then, click the City down 
arrow to select Bithlo 
from the list.

The City, State, and County boxes display 
information associated with the postal code in 
the Detail Address section and the top of 
the Address tab. 

8. Click the Phone tab. The Phone tab is displayed. Use this tab to 
enter telephone and e-mail information.

9. Click the Phone Type
box and select Business.

This identifies the telephone number type. A 
phone type must be selected for each 
telephone number.

10. Type 407 423 9185 in the 
Area, Exchange, and Ph 
No.   boxes.                                                                                                                                                                                                                                                                                                                      

After you type the area code, the cursor 
advances to Exchange. After you type the 
three digits of the telephone exchange, the 
cursor advances to Ph No.    NOTE: Enter 
the e-mail address for your contacts to utilize 
the Send to E-mail option for all modules.

11. Tab to the Service Type
box and select Email from 
the pull down choices.

NOTE: Enter the e-mail address for your 
contacts to utilize the Send to E-mail option 
for all modules.

12. Tab to the E-Mail Address 
box and type: 
info@webuildhomes.c
om.
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13. Click the Partners tab. The Partners tab is displayed. No 
information is displayed at this time.

14.  On the secondary 
toolbar, click the Insert
button.

The Select Partner window is displayed 
with the Contact Type defaulted to 
Individual.

15. In the Last box, type 
Price.

Thomas Price was previously entered in the 
Contacts module and is displayed in 
Individual Name.
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16. Click OK. The Select Partner window is closed and 
Thomas Price is displayed on the Partners
tab.

17. Click the Title box, type g
to select General 
Partner.

Titles are displayed alphabetically. The Title
list closes and General Partner is displayed.

18. Click the Sign? check 
box.

This identifies Thomas Price as a signatory 
for documents.

19.  On the secondary 
toolbar, click the Insert
button.

The Select Partner window is displayed.

20. In the Last box, type 
Reynolds.

21. TAB to the First box and 
type Steven.

22. Click New. The Select Partner window is closed and 
Steven Reynolds is displayed on the 
Partners tab.
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23. Click the Title box, type g
to select General 
Partner.

24. Click the Sign? check 
box.

This will identify Steven Reynolds as a 
signatory for the limited partnership.

25. Click in the Legal 
Entities area.

26.  On the secondary 
toolbar, click the Insert
button.

The Select Partner window is displayed. 
The Legal Entity Type defaults to 
Corporation.

27. In the Name box, type 
Homes Built For You, 
Inc.

28. Click New. The Select Partner window is closed and 
Homes Built for You, Inc. is displayed on 
the Partners tab.
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29. Click the lower section of 
the Partner’s tab, beneath 
Prefix.

30. On the secondary 
toolbar, click the Insert
button.

The Select Signatory window is displayed. 
The Legal Entity type defaults to 
Individual.

31. In the Last box, type 
Rosco.

This is the last name of the Signatory.

32. TAB to the First box and 
type Edwin.

This is the first name of the Signatory.

33. TAB to the Middle box 
and type Henry.

This is the middle name of the Signatory.

34. Click New. The Select Signatory window closes and 
Edwin Henry Rosco is displayed. The 
Sign check box is automatically selected.

35. Click the Title box and 
select Vice President.

What You Do Comments
Training Workbook: August 2018 Page 351



Contacts Module
36. Click the Services tab. The Services tab is displayed. Use this tab to 
indicate the Type of Service(s) provided by 
the contact.

37. Click the Builder check 
box.

This indicates the contact is a builder. We 
added the Builder as Types of Services in 
the Maintenance (Lists) module.

38. On the secondary 
toolbar, click the Close
button.

The Save window is displayed.

39. Click Yes. The changes are saved. The Contacts
module is closed. 
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Try This

1.  Click the Open Closing File button.

2. Click the Closing Agent tab and select yourself as the Closer.

3. Click the Title Agent tab and select yourself as the Signatory and Old 
Republic National Title Insurance Company as the Underwriter.

4. Click the Prepared By tab and select yourself as Individual.

5. Close and save the changes.

Tips
1. An alternate way to open the Contacts module is to select Modules > 

Contacts from the main toolbar. 

2. Use the Remarks box on the Address tab for any miscellaneous 
information such as directions, temporary address information, etc.

3.  To add address, telephone number, employees, and underwriters, click 
the Insert button. Underwriter is activated when Title Agent is selected 
as the service type.

4. To change a contact to inactive, click the Active check box on the General 
tab to remove the check mark. The contact is no longer included in the 
Individual Name listing. If a person is no longer employed by a company, 
select the company name, open the Associates tab, and click the Inactive
check box.

5. To delete a contact, from the menu bar select File, then Delete Contact. 
NOTE: You cannot delete a contact if it has been used in a closing file.

6. To break the marital relationship between contacts, from the menu bar select 
File, then Break Relation.

7. You can scroll by first name when searching for individual contacts in 
conjunction with the last name field or by itself.

8. If the Signatory for an entity is unknown you may select Unknown in the 
Contacts module. Doing so will generate a blank signature line on 
documents where the signature is required. 
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Frequently Asked Questions

9. It is recommended that you only have one occurrence of the contact in the 
Contacts module before selecting it from the drop down list. Duplicate 
listings for a contact may each have slightly different information. To insure 
consistency, once a contact is entered, only edit the existing contact, do not 
add a new contact with different information (i.e. spelling).

10. User may export contacts to Excel or any database that accepts “Coma 
Delimited files”.

11. When adding a Professional Association contact in the Contacts module, 
you must enter it as Contact Type “Other”

Question Answer
1. How do I add a new 

underwriter?
You can add a new underwriter as a 
corporation contact in the Contacts module. 
Select the Underwriter check box on the 
Services tab.

2. How do I add employees? Open the Contacts module. Select the firm 
or company name and click OK. Click the 
Employees or Associates/Partners tab. 
Click the Insert button to add or select 
employees. 

3. How do I correct the agent 
number?

Open the Contacts module. Select the agent 
and click OK. Click the Services tab. Type 
the correct number. Save your changes. 

4. How do I change the 
contact listed in User 
Settings?

To use a different contact as your default 
office name, title agent, closing agent, or 
preparer, select another contact from the list. 
To add another contact to the list, add the 
contact as a corporation in the Contacts
module. Select the Attorney, Title Agent, 
and Closing Agent check boxes, as 
appropriate. Save your changes. The next time 
you select Preferences/User Settings, the 
contact you added will be listed on the menu.

5. How do I correct the 
spelling of a contact’s 
name?

Open the Contacts module. Select the 
contact and click OK. Type the name 
correctly. Save your changes.
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6. How do I delete a contact? To delete a contact, open the Contacts
module. Select the contact and click OK. 
Select File, Delete Contact from the menu 
bar. Click Yes to delete the contact. Save your 
changes. NOTE: You cannot delete a contact 
if it has been used in a closing file. However, 
you can de-select the Active check box so the 
name is no longer included on the Select 
Contact window.

7. Why are my contacts not 
populating on the Contact 
Information table on 
page 5 of the Closing 
Disclosure?

1) You need to associate the contact with the file by adding them in the 
Closing File module on the Participant tab.

     a.  Remember that each column on the contact table has 2 entries. 

- The first entry is the company. This pulls in the company name, 
address and the company license information.

- The second entry is the actual contact for the company. This pulls 
in the contact name, contact license information, contact email 
and contact phone number. 

- MAKE SURE THAT you have selected the correct role type for 
your contact using the drop down selection for the second 
column name Type. Below are the correct types that should be 
used.

• Lender and Loan Officer
• Mortgage Broker Company and a Mortgage 

Broker
• Buyer Broker and a Buyer Agent
• Seller Broker and a Seller Agent

Question Answer
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2)    The Settlement Agent information is associated with the Contact
       Information table from the Closing File module on the Closing
       Agent tab.  
             -   The contact for the Settlement Agent is populated from
                   the CD Settlement Agent Contact drop down field. The 
                   contact card in the Contacts module for this person will pull in
                   the contact name, contact license information, contact email and
                   contact phone number. 

3) If you have completed steps 1 and 2 above and your contact is still not 
visible in the Contact Information table on page 5, you can right click 
with your mouse on the dark grey field that populates the company 
names. A small window appears and shows the words Add and Delete. 
Click on the Add and the Select Contact window opens. It lists 
contacts that have been associated with the file but have not yet been 
added to the Contact Information table. Highlight the entry that you are 
adding and click the OK button. The contact is added to your table. 
Repeat step 3 if more than one contact needs to be added.
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Preferences

Concept
Preferences contains information about your firm and your preferred selections. 
Preferred selections can be established for Office Settings, Settlement Statements, 
closing file defaults, Account Maintenance, Document Customization and 
notary blocks, Security Administration, and escrow accounting. Your firm name 
and address are entered as part of the installation process, which will automatically 
display as your default office location. All the other preferred selections can be 
established as a one-time entry before you create closing files. These are stored as 
permanent selections, until changes to them are made again, which can be done at any 
time within Preferences. Office settings, account maintenance, and customizing 
selections can also be established for use across the office network. DoubleTime also 
offers the ability to set up security for users and at least one administrator. 
Administrators have full access to and authority throughout DoubleTime. In addition, 
Administrators can assign access to users for secured modules such as the Checklist 
Template Maintenance, Escrow Accounting, Posting to Escrow Accounting 
from the Balance Sheet, Escrow Accounting Reports, and the Check / Deposit Slip 
Customization. The administrator can even set security for access authority to 
DoubleTime.

Objective
The objective of this lesson is to show you how to establish defaults for your closing 
files and escrow accounts. You will also learn how to establish security settings, add a 
custom variable, customize a document, and establish default settings for your 
Settlement Statements.

Office Settings  
What You Do Comments

1. Select Preferences > 
Office Settings from the 
main toolbar.

The Office Settings window is displayed 
with the Office tab open. Richard P. 
Bruce, Esq. is the company name.
NOTE: The 1099 Transmission
information (i.e. TCC number) must be 
obtained from the IRS. It is used in the 1099-
S module for creating a 1099-S file that can 
be electronically transmitted electronically to 
the IRS.
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2. Click on the HUD 
Settings Box.

This places a check mark to activate showing 
the Policy Reissue Discount only on the 
GFE HUD Settlement Statement. When 
activated, and an Owner’s or Mortgagee 
Policy is being issued with a reissue discount, 
the Settlement Statement (as applicable) will 
include the language “Policy Reissue 
Discount” and the difference between the 
original rate and the reissue rate will be 
disclosed. This option is not available on a 2 
page HUD or a Closing Disclosure.

To see what happens when this option is 
selected, let’s now assume that a Reissue 
Discount was applicable in a transaction 
because the Seller had an eligible prior 
Owner’s Policy in the amount of $185,000. 
Here is what the appropriate lines of page 2 of 
the GFE HUD would like, with the Policy 
Reissue Discount option activated.
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3. Click the Notary tab. The default Affidavit and Deeds and 
Other Instruments phrases displayed here 
are included in those documents that contain a 
notary selected in the Documents module. 
These are editable.
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4. Click the Recording tab. Several counties have adopted the Document 
Number recording method in lieu of Official 
Records Book and Page Number method. If 
your county adopts the Document Number 
method, visit the Maintenance (Lists) 
module >County to change the Recording 
selection for that county. You can also create 
your own wording for the Mortgage 
Recording Clause, as long as you include the 
Document Number and Recording County 
fields.

5. Click the Backup tab. Be sure to set your desired backup interval. 
You will receive a message to perform the 
backup at your requested interval. You can 
also select Utilities from the menu bar, then 
choose Database Backup, to backup the 
database at any time. NOTE: The best 
practice is to back up to a drive other than 
your hard drive, such as a portable hard drive.                 

If the box is checked for Enable 
DoubleTime database validation....., at 
startup, Doubletime will run a validation 
check and will place a copy of the database in 
the default directory where your database 
resides. If you receive any validation message 
call the Help Desk.
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Please note the warning message on the screen.
Warning: It is necessary to use the Database Backup utility within 
DoubleTime even if your system uses other backup software, because it 
improves DoubleTime performance for all types of systems. For networks, 
most backup software does not back up the DoubleTime database. NOTE:
The best practice is to back up to a physical drive other than your hard 
drive. For example, a mass storage device, a portable hard drive, or on the 
network of your computer system.

6. Click the Proxy tab. Proxy is for those who access the Internet via 
a Proxy server and would like to use 
eSolutions features for Fund forms — 
electronic delivery and electronic serial 
numbers.

7. Click the Escrow 
Accounting tab.

8. Select the appropriate 
option in the Check 
Number Sequence area.

If all users are printing from the same 
sequence of check numbers, select Office 
Check Stock.

If each user has their own starting sequence 
number for checks, select Individual Check 
Stock.
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Account Maintenance  

9. Select the appropriate 
option for Default Post 
Activity in the Fund 
Remittance Posting
area.

To select your Default Post Activity for the 
Fund Remittance, select ePayment, Post 
and Print, or Post Only.

10. On the secondary 
toolbar, click the Close
button.

The Office Settings within Preferences is 
closed.

11. Click Yes. The changes are saved and the Office Settings 
window is closed.

What You Do Comments
1. Select Preferences > 

Account Maintenance
from the main toolbar.

The Account Maintenance window is 
displayed with the previously entered escrow 
and trust accounts used by Richard P. Bruce, 
Esq. Outgoing funds and incoming deposits 
will be placed in these accounts when 
exporting to DoubleTime’s Escrow 
Accounting module, or other accounting 
software.

2. On the secondary 
toolbar, click the Insert
button.

A blank line is inserted, allowing you to add 
another account. The cursor is active in the 
Account No. box.
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3. In the Account No. box, 
type 54321.

This is the new trust/escrow bank account 
number.

4. TAB to the Account 
Description box and type 
Prestige Bank.

This is the name that will display when this 
account is selected for a transaction.

5. TAB to the Bank Name
box and type Prestige 
Bank.

This field must be completed to use the 
Positive Pay feature.

6. TAB to the ABA Routing 
No. box and type 
123456789.

The routing number identifies your bank or 
financial institution. It is a nine-digit number 
that appears at the lower left area of your 
check.
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7. Select the company name 
for your Closing Agent. 

The Closing Agent field is required if using 
the Escrow Accounting feature in 
DoubleTime. NOTE: It is recommended that 
you only have one occurrence of the Closing 
Agent in the Contacts module before 
selecting it from the drop down list. Duplicate 
listings for a contact may each have slightly 
different information. To insure consistency, 
once a contact is entered, only edit the 
existing contact, do not add a new contact 
with different information (i.e. spelling).

8. Click the check box for 
ePayment Default.

When you select this check box DoubleTime 
will use this account to automatically fill in 
the required information for ACH payments 
every time you make an electronic payment to 
The Fund for title insurance remittance.

9. Click the Inactive check 
box for account 88765-32, 
Southern Bank of 
Florida.

This indicates that Southern Bank of Florida 
is no longer an active bank for your company. 
The bank name will display in Italics from the 
drop down lists, where applicable.

10. On the secondary 
toolbar, click the Close
button.

The Save window opens. 

11. Click Yes. The changes are saved and the Account 
Maintenance window is closed.
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Customizing An Existing Master Document
What You Do Comments

1. Select Preferences > 
Document 
Customization from the 
main toolbar.

The Master Document Selection window 
is displayed. 

2. In the Master Document 
Selection window, select 
FL Warranty Deed 
(Statutory Form), and 
click OK.

The Save As New Master window is 
displayed. This document will be used as the 
base template for the custom document you 
want to create. NOTE: The base template 
document you choose in DoubleTime must be 
similar to the type of document being copied, 
such as, if an affidavit is created, use an 
existing affidavit as your base template. The 
variable fields will be placed on the resulting 
master document and will be saved as a 
custom document.
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3. In the Custom 
Document Name box, 
type Custom Deed.

This is the name of the custom document you 
will be creating.

(1) Clauses will be added to the stock 
Warranty Deed and saved to create our 
customized Warranty Deed for use in similar 
future transactions. (2) To change the paper 
size from Letter to Legal click the Paper 
Size box.

4. Click OK. The Customize- Custom Deed window is 
displayed.

5. Highlight Will Call No.: 
{Will Call Number} and 
press the Delete key.

The text is deleted.
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6. Scroll down to {Deed 
Clause}, and place the 
cursor beneath it.

7. Press the Enter key. The cursor is aligned with the left margin.
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8.  On the secondary 
toolbar, click the Clause 
Library button.

The Clause Library window is displayed. 
All is the Clause Type and All Clauses is 
selected.

9. Click the Clause Type
box and select Deed.

The display is limited to deed-related clauses.

10. In the blank field at the top 
left window, type Taxes.

The Clause Text is displayed in the bottom 
half of the Clause Library window.

11. Click on the Clause Title 
Subject To: Taxes.
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12. Click OK. The Clause Library window is closed and 
the Documents window is redisplayed with 
the clause added to the document.

13. Place the cursor at the end 
of the inserted clause and 
press ENTER.
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14. On the secondary 
toolbar, click the Open
button.

The Customize - Custom Deed save 
dialog box is displayed. 

15. Click Yes. The custom document Custom Deed is 
saved and is available for selection from the 
document list. The Document 
Customization window is opened.
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Creating A New Custom Master Document 
What You Do Comments

1. In the Master Document 
Selection window, select 
Contract Addendum.

This document will be used as the source 
template for the custom document you want to 
create.

2. Click OK. The Save As New Master window is 
displayed.

3. In the Custom 
Document Name box, 
type Welcome Letter 
Buyer.

This is the name of the custom document you 
will be creating.

4. Click OK. The Customize - Welcome letter buyer
window is displayed.

5. On the menu bar select 
Edit, and choose Select 
All.

The entire document is highlighted.

6. Press the Delete key on 
the keyboard.

The document content has been removed, 
however field variables are still available for 
placement as you create a new document.
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Copying A Word Processing Document Into A Master Document
What You Do Comments

1. Minimize DoubleTime.

2. On your desktop, double 
click on the Microsoft 
Word® document named 
Welcome Letter Buyer.

The Welcome Letter Buyer document is 
displayed. NOTE: Any Windows based word 
processor can be used to copy documents and 
paste them within DoubleTime.

3. Hold down the Ctrl button 
on the keyboard and then 
click on the letter A.

The entire document is selected.

4. Using your mouse, right 
click on the document and 
select Copy.

All of the document content is copied to the 
clipboard.

5. On the Microsoft Word®

menu bar, click File and
select Exit.

The Microsoft Word® program closes and 
the desktop is displayed. NOTE: Some 
formatting issues may occur when copying 
from Microsoft Word® and pasting into 
DoubleTime. Pasting the file into Microsoft 
WordPad® first will resolve any formatting 
issues.
Page 372 DT Version: 8.1



Preferences
Adding Variable Fields To A Custom Master Document 

6. Maximize DoubleTime. The Customize - Welcome Letter Buyer
window is re-displayed.

7. On the Double 
Time® secondary toolbar, 
click the Paste button.

The copied Welcome Letter Buyer is 
displayed.

What You Do Comments
1. Scroll up and highlight 

(Date). 

2. Press the Delete key. This removed the text. A variable field will 
now be inserted.
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3. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed You 
have access to an alphabetized list of 
hundreds of fields for document 
customization.

4. In the Field Name box, 
type system.

The System Date field is selected. This is 
the current date on your computer.

5. Click Insert. The System Date field is displayed. 
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6. Highlight (Buyer Name)
and press the Delete key.

7. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

8. In the Field Name box, 
type buyer name. 

9. Select Buyer Name (s) 
w/o Status. 

This will insert a field that will populate all of 
the Buyers names that are associated with the 
file.

10. Click Insert. The Buyer Name (s) w/o Status field is 
displayed. 

11. Highlight (Buyer 
Address 1) and press the 
Delete key.

12. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

13. In the Field Name box, 
type Buyer Address 1.

The Buyer Address 1 field is selected.

14. Click Insert. The Buyer Address 1 field is displayed. 
This will insert a field that will populate the 
buyers street address that is associated with 
the file.

15. Highlight (Buyer 
Address 2) and press the 
Delete key.

16. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

17. In the Field Name box, 
type Buyer Address 2.

The Buyer Address 2 field is selected.
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18. Click Insert. The Buyer Address 2 field is displayed. 
This will insert a field that will populate the 
buyers apartment or suite address that is 
associated with the file.

19. Highlight (Buyer 
Address 3) and press the 
Delete key.

20. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

21. In the Field Name box, 
type Buyer Address 3.

The Buyer Address 3 field is selected.

22. Click Insert. The Buyer Address 3 field is displayed. 
This will insert a field that will populate the 
buyers city, state and postal code that is 
associated with the file.

23. Click after Property 
Address: and press TAB.
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24. On the secondary 
toolbar, click the Insert 
Field button.

25. In the Field Name box, 
type property address.

The Property Address field is selected.

26.  Click Insert. The Property Address field is displayed. 
This will insert a field that will populate the 
entire property address that is associated with 
the file. The address will appear on 1 line. 

27. Press the DOWN ARROW
key on the keyboard and 
press the TAB key.

This places the cursor in the correct section 
where the next align field will be inserted.

28. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

29. In the Field Name box, 
type seller name. 

30. Select Seller Name (s) 
w/o Status. 

This will insert a field that will populate all of 
the sellers names that are associated with the 
file.

31. Click Insert. The Seller Name (s) w/o Status field is 
displayed. 

32. Press the DOWN ARROW
key on the keyboard. 
Ensure the cursor is lined 
up correctly on the next 
row.

This places the cursor in the correct section 
where the next align field will be inserted.

33. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

34. In the Field Name box, 
type closing file.

The Closing File Number field is selected.

35. Click Insert. The Closing File Number field is 
displayed.
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36. Press the DOWN ARROW
key on the keyboard and 
press the TAB key.

This places the cursor in the correct section 
where the next align field will be inserted.

37. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

38. In the Field Name box, 
type closing date.

The Closing Date field is selected.

39.  Click Insert. The Closing Date field is displayed.

40. Place the cursor after 
Richard P. Bruce, Esq. in 
the signature line. 

41. On the menu bar, click 
Insert and select Break > 
Page.

This will automatically add a page break 
when the document is created. 

42. On the secondary 
toolbar, click the Close
button.

The Save window displays.
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Try This

43. Click Yes. The Welcome Letter Buyer custom 
document is saved for future use and the 
Master Document Selection window is 
closed.

What You Do Comments
1. In the Master Document 

Selection window, select 
Agency Selection 
Form (aka Anti-
Coercion Form).

This document will be used as the source 
template for the custom document you want to 
create.

2. Click OK. The Save As New Master window is 
displayed.

3. In the Custom 
Document Name box, 
type Assumption 
Request.

This is the name of the custom document you 
will be creating.

4. Click OK. The Customize - Assumption Request
window is displayed.

5. On the menu bar select 
Edit, and choose Select 
All.

The entire document is highlighted.

6. Press the Delete key on 
the keyboard.

The document content has been removed, 
however field variables are still available for 
placement as you create a new document.
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7. Minimize DoubleTime.

8. On your desktop, double 
click on the Microsoft 
Word® document named 
Assumption Request.

The Assumption Request document is 
displayed. NOTE: Any Windows based word 
processor can be used to copy documents and 
place them within DoubleTime.

9. Hold down the Ctrl button 
on the keyboard and then 
click on the letter A.

The entire document is selected.
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10. Using your mouse, right 
click on the document and 
select Copy.

All of the document content is copied to the 
clipboard.

11. On the Microsoft Word®

menu bar, click File and
select Exit.

The Microsoft Word® program closes and 
the desktop is displayed. NOTE: Some 
formatting issues may occur when copying 
from Microsoft Word® to other word 
processor programs. Copying the file into 
Microsoft WordPad® first will resolve any 
formatting issues.

12. Maximize DoubleTime. The Customize - Assumption Request
window is re-displayed.

13. On the Double 
Time® secondary toolbar, 
click the Paste button.

The copied Assumption Request is 
displayed.

14. Scroll up and highlight 
(Date). 
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15. Press the Delete key. This removed the text. A variable field will 
now be inserted.

16. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed You 
have access to approximately 460 fields for 
any document you customize.
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17. In the Field Name box, 
type system.

The System Date field is selected. This is 
the current date on your computer.

18. Click Insert. The System Date field is displayed. 

19. Highlight (To) and press 
the Delete key.

20. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

21. In the Field Name box, 
type lender name. 

The Lender Name field is selected.

22. Click Insert. The Lender Name field is displayed. 

23. Press Enter. This will position the cursor on the line 
beneath the Lender Name.

24. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

What You Do Comments
Training Workbook: August 2018 Page 383



Preferences
25. In the Field Name box, 
type lender.

The Lender Address field is selected.

26. Click Insert. The Lender Address field is displayed.

27. Point to Lender Address 
field and click the right 
mouse button.

28. Click Field Attributes. The Attributes window is displayed.

29. In the Name box, select 
Assumption First from 
the down arrow and press 
the Tab key.

This will designate which lender information 
to display in the Lender Address field.

30. In the Format box, select 
Multi Line Address 
Sep. by AND, w/New 
Line.

This allows the Lender Address to appear 
in proper correspondence format.

31. Click OK. The Lender Address field is displayed with 
the appropriate lender address designation.
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32. Click after Name(s): and 
press TAB twice.

 Click the Show/Hide button on the 
formatting toolbar to display non-printing 
characters such as spaces, tabs, and returns. 
This will help when positioning variable 
fields in your custom document.

33. On the secondary 
toolbar, click the Insert 
Field button.

34. In the Field Name box, 
type seller name.

The Seller Name field is selected.

35. Click on Seller Name(s) 
w/o Status.

The Seller Name(s) w/o Status field is 
displayed.

36.  Click Insert. The Seller Name field is displayed.

37. Press the DOWN ARROW
key on the keyboard.

This places the cursor in the correct section 
where the next align field will be inserted.
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38. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

39. In the Field Name box, 
type closing file.

The Closing File Number field is selected.

40.  Click Insert. The Closing File Number field is 
displayed.

41. Press the DOWN ARROW
key on the keyboard.

This places the cursor in the correct section 
where the next align field will be inserted.

42. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

43. In the Field Name box, 
type loan number.

44. Click Insert. The Loan Number field is displayed.

45. Press the DOWN ARROW
key on the keyboard.

This places the cursor in the correct section 
where the next align field will be inserted.
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46. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

47. In the Field Name box, 
type property.

The Property Address field is selected.

48. Click Insert. The Property Address field is displayed.

49. Press the DOWN ARROW
key on the keyboard.

This places the cursor in the correct section 
where the next align field will be inserted.

50. Click after Closing Date:
and press TAB twice.

51. On the secondary 
toolbar, click the Insert 
Field button.

The Insert Field window is displayed.

52. In the Field Name box, 
type closing date.

The Closing Date field is selected.

53.  Click Insert. The Closing Date field is displayed.
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Notary Customization 

54. On the secondary 
toolbar, click the Close
button.

The Save window displays.

55. Click Yes. The Assumption Request custom 
document is saved for future use and the 
Master Document Selection window is 
closed.

What You Do Comments
1. Select Preferences > 

Notary Customization
from the main toolbar.

The Master Document Selection window 
is displayed and the Classification defaults 
to Notary.

2. Select Partner-
Corporate and click OK.

The Save As New Master is displayed.
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3. In the Custom Notary 
Name, type BCullum 
Partner-Corporate.

A Custom Notary will be created for Beth 
Cullum.

4. Click OK. The Customize window is displayed.

5. Highlight 
{NTRY_ST_NM} field 
and press the Delete key.

6. After {NTRY_ST_OF}
type Florida.

This will be the permanent state.
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7. Highlight 
{NTRY_CNTY_NM} field 
and press the Delete key.

8. After 
{NTRY_CNTY_OF} type 
Orange.

This will be the permanent county.

9. Highlight 
{NTRY_OFFICER_OFFI
CER_NM} and press the 
Delete key.

10. Type Notary Public, 
State of Florida.

This will be the permanent notary officer.

11. Highlight 
{CNTCT_ALIAS_NM}
and press the Delete key.

12. Type Beth Cullum. This will be the permanent notary name.

13. Highlight 
{NTRY_EXP_DT@mm
mmdyyyy} and press the 
Delete key.

14. Type March 27, 2021. This is Beth Cullum’s current commission 
expiration date until it renews in 2021. 
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Change User Name  

15. On the secondary 
toolbar, click the Close
button.

The Customize-BCullum save dialog box 
is displayed. 

16. Click Yes. The Customize-BCullum is saved and is 
available for selection from the Notary 
Format within the Edit Notary module.

What You Do Comments
1. Select Preferences > 

Change User Name
from the main toolbar.

The Change User window is displayed.

2. Type (your name) in the 
User Name box.

This will establish you as the user on your PC. 
All settings placed within User Settings
will default to your name when it is selected 
within User Name.
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Delete User Name

3. Click New. The Change User window is closed.

What You Do Comments
1. Select Preferences > 

Delete User Name from 
the main toolbar.

The Delete User window is displayed.
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2. Select the name you wish 
to delete.

NOTE: The user name currently in use 
(yours!) cannot be deleted and is not shown as 
available for deletion.

3. Click OK. A message is displayed, confirming that you 
want to delete the selected user.

4. Click Yes. The user name is deleted and the Delete 
User window is closed. 
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Security Administration
What you Do Comments

1. Select Preferences > 
Security 
Administration from the 
main toolbar.

The Security Administration window is 
displayed. NOTE: Before using Security 
Administration, set up your 
Administrator first, and then set up your 
Users.

2. On the Security tab, click 
the Access to 
DoubleTime box if you 
want to require each user to 
log into DoubleTime. 

3. To restrict access to 
specific users, select the 
modules they are permitted 
to access.
Page 394 DT Version: 8.1



Preferences
4. Click the Users tab.

5.  Click Insert and select a 
user to modify access 
rights.

6. Click OK.

7. Select specific access 
rights for the user.
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8. Enter the User Information. You will be asked to enter a Password for each 
User added.  The User will be prompted to 
change the password upon first access.

9.  Click Save to keep 
the changes and select 
another user. 

10.  Click Close to exit 
the module.

The Security Administration module is 
closed.

NOTE: Users may be prompted to log into DoubleTime or to access certain 
features. See your DoubleTime Security Administrator for more details.
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User Settings  
What you Do Comments

1. Select Preferences > 
User Settings from the 
main toolbar.

The General tab of the User Settings 
window is displayed. You can select State 
and County defaults in the Location box, a 
Recording Department Will Call 
Number, and establish defaults for displaying 
Marital Status on Title Insurance 
Commitments and Policies. State and County 
defaults are used in Master Property and 
Notary defaults. The Will Call Number is 
displayed in the recording information section 
of documents that need to be recorded. This is 
an internal mail slot code assigned to your 
office from your local county recorder. The 
Will Call Number can also be added or 
changed in the Closing File module. The 
Title Insurance Include Marital Status
check box is provided for the purpose of 
automatically including the marital status for 
the named insured buyer on the Commitment 
and Owner’s Policy. DoubleTime Broadcast 
Messages may be turned on or off by 
selecting or deselecting the box for Show 
Informational messages.

Doubletime Save-As Directory is used to set a default location when saving 
documents in the Documents module. By default, this directory will be empty. 
To select a default location for your documents, click on the Browse button, 
choose your designated path, and then click OK.
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2. Click the Closing File
tab.

The Closing File window is displayed. 
Defaults for Closing Agent, Closer, Title 
Agent, Signatory, Underwriter, 
Prepared By Company and Prepared By 
Individual are established in Preferences 
> User Settings and can be changed in the 
Closing File module.

3. Click the Closer box and 
select your name.

Your name will be displayed as the default 
Closer on your Closing files.

4. Click the Signatory box 
and select your name.

Your name is displayed as the default 
Signatory on your Closing files.

5. Click the Underwriter
box to select a default 
underwriter. Select Old 
Republic National Title 
Insurance Company/
ATFS.

Old Republic National Title Insurance 
Company/ATFS is displayed as the default 
Underwriter on your closing files.

6. Click the Prepared By 
Individual box and select 
Richard P. Bruce.

Richard P. Bruce will be displayed as the 
default on the Prepared By and Return to
portion of recordable documents.
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NOTE: You can select the number of 
witnesses for buyer and sellers to default Per 
Signatory or by Signature Block on your 
documents. If One Witness Per Signatory
is selected, and your closing file has only one 
seller (or buyer), then you will be prompted to 
change your selection for that file so that there 
are two witnesses for the one signatory.

7. Click the Settlement 
Statement tab.

The Settlement Statement window is 
displayed with the defaults used in the 
Settlement Statement module.

NOTE: The Settlement Statement tab is divided into two sections. The top half 
is used to set default preferences for a Closing Disclosure and the bottom 
half is used to set preferences for a HUD/ HUD GFE.
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8. Click the Accounting
tab.

The default information that displays was 
previously selected - and can be changed at 
any time - in Preferences > User 
Settings. 
Export Detail contains default selections for 
Quicken®. The Use as Category is
Closing File Number, the Use as Class 
is Closer. These selections are displayed in 
the check stub section of either Quicken®, 
QuickBooks®, QuickBooks (Real Time)®, 
Dapix®, or Perfect Practice®, and are used for 
the Report sorting. You can change these 
defaults, but either Use as Category or 
Use as Class must be Closing File 
Number. 
Use as Export Date is Today’s Date and 
can be changed.

NOTE: When using DoubleTime Escrow 
Accounting module, it is not necessary to 
adjust any settings on this tab.

What you Do Comments
Page 400 DT Version: 8.1



Preferences
9. Click the Electronic 
Delivery tab.

The Electronic Delivery tab is displayed. 
This is your first step towards delivering your 
Old Republic National Title Insurance 
Company/ATFS policies the electronic way, 
as well as enabling the ability to obtain policy 
serial numbers electronically and remitting 
premiums electronically. 

10. Click the Enable 
Electronic Delivery box.

11.  Click the Default button 
to complete the HTTP 
settings, enter your 
FundNet User ID and 
Password as established by 
your FundNet 
Administrator. 

Access rights for these electronic functions 
are established in FundNet at: https://
www.thefund.com
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12. Click the Test 
Connection button. 

Once you connect to The Fund successfully, 
you can begin using the Electronic 
Delivery feature. Electronic will be the 
default selection for Commitment and 
Policy numbers, and you’ll be ready to start 
delivering Forms electronically. NOTE: An 
Internet connection is necessary to connect to 
The Fund. To find out more, select Help > 
Tutorials > DoubleTime from the main 
toolbar.

13. Click the ATIDS tab. The ATIDS (Automated Title Information 
Data System) tab is displayed. This tab sets up 
access to the ATIDS Integration feature, 
where property and name searches can be 
conducted.

 To access ATIDS Integration after it has 
been configured for your use, you do so from 
within the Closing File module. Open the 
closing file for which you want to run 
searches, and select the ATIDS Integration
button on the secondary toolbar.

14. Click the Escrow 
Accounting tab. 

Available settings for Escrow Accounting
display.
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15. In the General section, 
select the preferred 
reminders.

If you select to be reminded to order new 
checks, enter the specific check number for 
the reminder. NOTE: Consider the 
appropriate choice for Default Post Date,
Check Post Preference and Deposit 
Post Preference for your office.

16. Click the Integrations
tab. 

Available settings for Integrations display.
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Tips

17. Click the Enable 
Integrations box. Enter 
your User ID’s and 
Password’s.

DoubleTime is integrated with PropLogix. 
Users may order and track Municipal Lien 
Searches, Association Estoppels, Land 
Surveys and Payoff Tracking. Click the 
Proplogix Registration link. If you do not 
have a PropLogix account, you must register. 
This tab allows users to setup the connection 
to PropLogix.

 Use the Order PropLogix Product(s)
button on the main toolbar after it has been 
configured for your use to place an order. 

 Use the View PropLogix Orders
button on the main toolbar after it has been 
configured for your use to view all orders you 
have placed. 

NOTE: Located in the DoubleTime Support 
Center refer to the comprehensive 
“DoubleTime PropLogix Integration User 
Guide” for specific instructions on how to use 
this module.

18. On the secondary 
toolbar, click the Close
button.

The User Settings save dialog box is 
displayed. 

19. Click Yes. The changes are saved and the User 
Settings window is closed.

1. To file 1099-S documents electronically, you must first complete IRS form 
4419 and submit it to the IRS to obtain a transmitter code (TCC Number). 
The TCC Number is entered in Office Settings and then used in the 1099-
S module.

2. To change the User Settings, select Preferences on the main menu and 
first use Change User Name to switch to the user for whom you wish to 
change settings. Type or select a User Name and click OK. Then select 
Preferences > User Settings and make the changes.
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3.  Click the Show/Hide button on the formatting toolbar to display non-
printing characters such as spaces, tabs, and returns. This will help when 
positioning variable fields in your custom document.

4. Document Customization is used for customizing Master documents 
used in the Documents module. Notary Customization is used for 
customizing the format of the Notary block. To modify Notary phrases, use 
the Notary tab in Preferences >Office Settings.

5. When saving a document and to utilize the Save-As feature, follow these 
steps. While in the desired document, click on File > Save-As > 
Document Image… A window will appear and the Save-in: location 
will default to the location you selected in User Preferences.

6. Closing File Default variables can be created and edited in 
Preferences. The variables can be edited or used in the Documents 
module. System-wide Variables are created and modified in Custom 
Variable Setup only. These variables are established for data that does not 
change from file to file.

7. On the General tab of User Settings, there are both State and County
drop down boxes. The selections made in these two drop down boxes will 
have the effect of being the default selections for State and County for this 
User when the User inserts a Property in the Closing File module as 
well as when the User is selected as the notary on documents. These 
defaults may be changed when necessary. 

8. When copying a document into DoubleTime from Word, WordPerfect or 
other word processing programs it may be necessary to copy the document 
to WordPad first. This will eliminate any format differences between word 
processing programs. (see below for steps)

What You Do Comments
1. Minimize DoubleTime.

2. On your desktop, double 
click on the Microsoft 
Word® document you 
want to copy.

NOTE: Any Windows based word processor 
can be used to copy documents and place 
them within DoubleTime.

3. Hold down the Ctrl button 
on the keyboard and then 
click on the letter A.

The entire document is selected.

4. Using your mouse, right 
click on the document and 
select Copy.

All of the document content is copied to the 
clipboard.
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5. On the Microsoft Word®

menu bar, click File and
select Exit.

The Microsoft Word® program closes and 
the desktop is displayed. NOTE: Some 
formatting issues may occur when copying 
from Microsoft Word® to other word 
processor programs. Copying the file into 
Microsoft WordPad® first will resolve any 
formatting issues.

6.  Click the Windows 
Start button.

Note: You may also type WordPad in the 
Search Program and Files field when you 
open the Start menu.

7. Place and hold mouse 
pointer over All 
Programs.

8. Click Accessories.

9. Click WordPad. A blank page labeled Document - 
WordPad is displayed.

10. Using your mouse, right 
click on the document and 
select Paste.

11. Hold down the Ctrl button 
on the keyboard and then 
click on the letter A.

The entire document is selected.

12. Using your mouse, right 
click on the document and 
select Copy.

13. Click the red X Close
button.

14. Click the Don’t Save
button.

The Microsoft WordPad® program closes 
and the desktop is displayed. 

15. Maximize DoubleTime. 

16. On the Double 
Time® secondary toolbar, 
click the Paste button.

The copied document is displayed.
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Master Property Module

Concept
You can use the Master Property module to store and maintain property information 
such as the legal description, recording information, and title exceptions. This is 
particularly useful if you do multiple closings on similarly situated properties, such as 
condominiums or within the same subdivision. The information stored in the Master 
Property module can be retrieved through the Closing File and Title Insurance
modules. This capability eliminates the need to retype information.

Objective
The objective of this lesson is to show you how to create a master property record for 
the first phase a subdivision and copy the property information for the second phase.

Creating A Master Property Record  
What you Do Comments

1.  On the main toolbar, 
click the Master 
Property button.

The Master Property Search Selection
window is displayed. The state and county 
were established in Preferences >User 
Settings.
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2. Click the Subdivision
option button, then click 
New.

The Master Property - New window is 
displayed with the General Information tab 
open.

3. In the Name box, type 
Bear Run I.

This is the name of the Subdivision for our 
property. 

4. Click the Remarks box 
and type HOA Thomas 
Bradley (407) 628-6899.

This information is carried over to the 
Remarks tab on the Property tab in the 
Closing File module.

5. Click the Legal 
Description box.
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6. On the secondary 
toolbar, click the Clause 
Library button.

The Clause Library window is displayed 
and All Clauses is selected. The Clause 
Type is Legal.

7. Double-click Plat. This will select the Plat clause. The Clause 
Library window is closed and the Plat clause 
text is displayed in the Legal Description
box in the Master Property window.

8. Starting with the third set 
of asterisks, (just before the 
word according), replace 
each following group of 
asterisks with the 
following text:

Bear Run I
2452
5996
Orange
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9. Click the Recording tab. The Recording tab is displayed.

10. Click the Source box and 
select Plat.

NOTE: The Document No. box can be used 
to store a secondary reference such as a 
Clerk’s File Number.

11. TAB to the Book box and 
type 2452.
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12. TAB to the Page box and 
type 5996.

13. Click PIN and type  
50-43-35-04-***.

This is the tax identification number for the 
subdivision.

NOTE: The Declaration Description box 
is completed when mortgage documents are 
created that require a PUD rider. When a 
Master Property is used in a Closing File, 
the Declaration Description is 
automatically copied to the PUD rider in the 
Documents module.
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Establishing Title Exceptions For The Master Property File
What you Do Comments

1. Click the Exceptions tab. The Exceptions tab is displayed.

2.  On the secondary 
toolbar, click the Insert
button.

Sequence number 1 is created. The cursor is 
located in the Description box. This is an 
editable field.

3. On the secondary 
toolbar, click the Clause 
Library button.

The Clause Library window is displayed 
and All Clauses is selected. The Clause 
Type defaults to Exception. 
Page 412 DT Version: 8.1



Master Property Module
4. In the blank field at the top 
left window, type 
Municipal.

NOTE: (1) The clauses are sorted 
alphabetically by Clause Title. To sort by 
reference identification numbers, click the 
Reference Id header. (2) Reference ID
numbers correspond to the Fund’s Standard 
Commitment Clauses nomenclature.

5. Click (E-24.1) 
Municipal/ County 
Liens: For Service 
Charges and Waste 
Fees.

6. Click OK. The Clause Library window is closed and 
the Exceptions tab is displayed. This clause 
has been added as exception number 1 and 
can be edited. 

7. On the secondary 
toolbar, click the Insert
button.

Sequence number 2 is created.
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8. On the secondary 
toolbar, click the Clause 
Library button.

9. In the blank field at the top 
left window, type Plat.

10. Click (E-5.1) Plat: All 
Matters in Plat.

11. Click OK. The Clause Library window is closed and 
the Exceptions tab is displayed. This clause 
has been added as exception number 2 and 
can be edited. 

12. Replace the 3 sets of ***
with 

Bear Run I
2452
5996

13. Delete the words and/or 
Instrument No.***.
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Copying A Master Property

14. On the secondary 
toolbar, click the Open
button.

The Master Property – Bear Run I save 
dialog box is displayed. 

15. Click Yes. Bear Run I is saved as a master property 
record.

What you Do Comments
1. Select Subdivision on 

the Master Property 
Search Selection
window.

2. In the Name box, type 
bear and click Browse.

All subdivision properties beginning with the 
letters bear will be displayed on your screen. 
Bear Run I is highlighted.
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3. Click the Copy button. A copy of the Bear Run I master property 
has been created, with all information copied 
but the name.

4. In the Name box, type 
Bear Run II.

5. In the Legal Description
box, replace I with II after 
Bear Run.

6. In the Legal Description
box, change 5996 after 
Page to 6223.
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7. Click the Recording tab

8. In the Starting Page No.
box, change 5996 to 6223.

9. Change 04 to 62 in the 
PIN box.
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10. Click the Exceptions tab. The exceptions are copied to the new master 
property. Exceptions can be added or deleted 
on this tab.

11. In Exception 2 replace I 
with II after Bear Run.

12. In Exception 2 change the 
Page number from 5996 to 
6223.
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Try This

1. Open the Master Property module and create a master property for 
the condominium Grand Floridian, located in Palm Beach County, Florida.

2. Remember to change the County, and to select the Condominium radial 
button.

3. On the General Information tab, type Grand Floridian in the Name
box.

4. In the Legal Description box, open Clause Library and find the 
Condominium clause title.

5. Insert the clause.

6. Starting with the third set of asterisks, replace the *** with the following 
text:

Grand Floridian
3211
9876
Palm Beach

7. Click the Recording tab. 

8. Select Official Records as the Source and type 3211 in the Book box. 
Type 9876 in the Starting Page No. box.

9. The PIN is 20-20-15-***.

10. Click the Exceptions tab and insert the following two clauses:
E-7.1 Condominiums: Declaration of Condominium
E-12.3 Water/Submerged Land Rights: Properly Filled Land

11.  Save and close the file.

13. On the secondary 
toolbar, click the Close
button.

The      Master Property - Bear Run, Phase 
II save dialog box is displayed.

14. Click Yes. Bear Run, Phase II is saved as a master 
property record.

What you Do Comments
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Tips
1. An alternate way to open the Master Property module is to select 

Modules from the menu bar and choose Master Property.

2. When you add a new property, be sure to specify the type of property in the 
Master Property Search Selection window.

3. If you are setting up several property phases, locate the first phase in the 
Master Property Search Selection window, then click Copy to 
duplicate the master property. Type the new name (e.g., Grand Floridian 
Condominium, Phase II) in the Name box on the General Information
tab and be sure to change the book and page numbers in the legal description 
and also on the Recording tab.

4.  Use the Spell Check button to check the spelling of the legal 
description, remarks, declaration description, and exceptions.

5. When you edit exceptions on the Exceptions tab, you can use the right 
mouse button to cut, copy, and paste or place the cursor where you want to 
add information and type it in.

6.  Use the Insert Degree Symbol to add a degree (°) symbol for metes 
and bounds legal descriptions.You can also use the keystroke of 
CTRL+SHIFT+O. 

7. The Declaration Description section is used when mortgage documents 
are created that require a PUD rider. When a Master Property is used in a 
Closing File, the Declaration Description is automatically copied to the PUD 
rider in the Documents module.

8. The Multiple Clause Import feature allows you to bring in multiple 
clauses from a word processor and enter them as exceptions in the Master 
Property module. From the Edit menu, select either Paste Clauses from 
Clipboard or Import Clauses from Text File.

9. Users can create a Master Property within the Closing File module 
using the  Create Master Property button on the secondary toolbar. 
Exception clauses added in the Commitment or Policy modules can also 
be exported into a Master Property, eliminating the need to copy and paste 
text or re-enter information.

10. Use the Clause Library button   on the secondary toolbar to pull in a 
standard legal description on the Property tab in the Closing File module. 
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11. Use the Remark’s field to enter information about the property such as a 
homeowner’s association name, phone numbers, etc.

12. You may import exceptions from Word, Word Perfect or other word 
processing software into the Master Property. You may also import 
exceptions from other Branch products.
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Closing File Module - Miscellaneous 
Switch Active Closing File

Open Closing File

Concept
Switch Active Closing File allows you to switch to a different closing file. You can 
search for a closing file with information previously entered into DoubleTime for that 
transaction, including: the Closing File Number, Seller Name, Buyer Name, 
Subdivision Name, Lot, Unit, Block, Building or Street Address. Simply 
type the known information into one of these fields and browse DoubleTime for the 
desired file. You can also browse all closing files that have been created in 
DoubleTime. Once a Closing File has been selected, use Open Closing File to 
open the Closing File module for that file.

Objective
The objective of this lesson is to switch to another closing file and to open that closing 
file in order to add and edit information to it. Other miscellaneous features contained 
within the Closing File module are also demonstrated. 

Switching The Active Closing File
What you Do Comments

1.  On the main toolbar, 
click the Switch Active 
Closing File button.

The Closing File Selection window is 
displayed. This window allows you to switch 
the active file to a different closing file 
established within DoubleTime.
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2. In the Seller Name box, 
type Town. 

Since the file was partially completed by a 
coworker, searching by the seller’s name will 
locate the file.

3. Click Browse. File number 04-0044 displays.

4. Click OK.

5. On the main toolbar, 
click Open Closing File.

The Closing File window is displayed. 
Information previously entered on this file is 
displayed.

What you Do Comments
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Associating A Buyer - Existing Contact

6. Click the Account No.
box and select 54321 
Prestige Bank.

This is the account number added in 
Preferences/Account Maintenance. It 
will be the trust account used for this file.

7. Type 0902(current year)
in the Closing date box.

NOTE: The Disbursement, Proration, 
and Taxes Paid Thru dates are changed by 
this entry, but may be edited.

8. Type 0604(current year)
in the Contract date box.

What you Do Comments
1. Click the Buyer tab. The Update Closing File Dates window 

opens due to the date changes made on the 
General tab.

What you Do Comments
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2. Click OK The dates are updated throughout the closing 
file.

3. On the secondary 
toolbar, click the Insert
button.

The Select Buyer window opens. The 
Contact Type defaults to Individual.

What you Do Comments
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4. Select Partnership from 
the Contact Type drop 
down list.

All previously entered partnership contacts 
are displayed in the Legal Entity Name 
box.

5. Select We Build Homes, 
LTD

We Build Homes, LTD is the partnership 
we previously created in the Contacts
module.

6. Click OK. The Select Buyer window is closed and We 
Build Homes, LTD is displayed on the 
Buyer tab with the Mailing Address
displayed on the Address tab. NOTE: The 
Street and City are editable fields.

What you Do Comments
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7. On the secondary 
toolbar, click the Insert 
Name Clause button.

The Insert Name Clause window is 
displayed. NOTE: The description entered 
when we created the contact is shown and is 
the presumptive Name with Status entry, 
which may be edited.

What you Do Comments
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8. Click OK. The Insert Name Clause window closes, 
and the Buyer tab is redisplayed. NOTE: The 
Name(s) with Status box is now shown 
populated with the way this party’s name will 
appear and be printed on the documents 
generated by DoubleTime. This field remains 
editable. NOTE: Sometimes when a business 
entity is added as a contact its domiciliary 
state and organizational format are not known. 
For example, We Build Homes might have 
been entered as a partnership, without being 
identified as “Florida limited.” In such an 
instance, when the Insert Name Clause
window displays, it becomes useful to use the 
State drop down box and the Format drop 
down box which will insert those qualifiers 
into the party’s name for printing purposes 
and will also populate the Name(s) with 
Status field. 

What you Do Comments
Page 428 DT Version: 8.1



Closing File Module - Miscellaneous
Changing A Seller Name
What you Do Comments

1. Click the Seller tab. The Seller tab is displayed with Towne & 
Country Properties, Inc.

What you Do Comments
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2. Position the cursor over 
Towne & Country 
Properties, Inc. and 
double-click.

The Seller Name Change window is 
displayed.

What you Do Comments
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Editing Notary Information - Buyer And Seller

3. Click the Legal Entity 
Name box and remove the 
letter “e” from the word 
“Towne.”

4. Click OK. The Seller Update window is displayed, 
reflecting the proposed change.

5. Click OK. The Seller Update window is closed and the 
Seller tab is displayed with the changes. 
NOTE: This change is also made in the 
Contacts module.

What you Do Comments

1. On the secondary 
toolbar, click the 
Signature/Notary
button.

The Signature/Notary window is displayed, 
with the Seller Signature Block field open. 

2. Click the + for Buyer in 
the Signature Block
section. 

This will display an expand view of the 
Buyers Signature Block fields.

What you Do Comments
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3. Click on Steven 
Reynolds.

Number of Witnesses for Steven 
Reynolds is displayed and Steven 
Reynolds is the designated Signatory.

4. Click the Delete button at 
the bottom of the window.

The Delete Signatory dialog box is 
displayed.

5. Click Yes. Steven Reynolds has been removed as a 
signatory for the Seller from this closing file.

What you Do Comments
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6. Click the + for Notary 
Block/Buyer.

Thomas Price, General Partner is displayed 
(there is additional text visible if you move 
the horizontal scroll bar).

What you Do Comments
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7. Click Thomas Price, 
General Partner.

The Signature and Notary Block for 
Thomas Price is displayed. NOTE: The 
Notary Format defaults to Partner-
Corporate. 

8. Click Preview.

What you Do Comments
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9. Click Preview Off.

10. Click the + for Notary 
Block/Seller.

Eric B. Wilson, President is displayed.

11. Click Eric B. Wilson. The Notary Format for Eric B. Wilson is 
displayed.

12. Click the Signatory 
Name drop down box and 
select Eric B. Wilson, 
President. 

This updates the entity name in the 
Signature Block. NOTE: You may also 
select the signatory’s gender at this time so 
that the documents are properly customized.

13. Click the Notary Name 
box and select your 
name.

This is the name of the person notarizing the 
documents. Your name is displayed on the 
printed name line in the notary box. The 
Expiration Date automatically defaults to 
the notary date added in Contacts module.

14. Click OK. The Closing File module is redisplayed with 
the Seller tab open.

What you Do Comments
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Pulling Master Property Data Into A Closing File
What you Do Comments

1. Click the Property tab. The Property tab is displayed.

2. On the secondary 
toolbar, click the Insert
button.

The Master Property Search Selection
window is displayed. The default county and 
state were established in Preferences/User 
Settings and can be changed.

3. Click the Subdivision
option button, then click 
Browse.

All subdivisions previously established for 
Orange county are displayed.

4. Select Bear Run I.

5. Click OK. The Property tab is redisplayed with data 
from the Master Property module for Bear 
Run I.
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6. Replace the *** in the PIN
box with 131.

This completes the PIN number for this 
property.

7. In the Address tab, click 
the Street box and type 
100-300 Alligator 
Crossing.

8. Click the Postal Code, 
box, type 32820, and press 
the Tab key. Use the down 
arrow to select Bithlo
from the list.

The first city in the alphabetical listing 
associated with the postal code is displayed. 
This city and postal code were established in 
the Maintenance (Lists) module.

What you Do Comments
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9. Click the Details tab. The Details tab is displayed.

10. In the Lot box, type 13-
65.

11. In the Block box, type 1. NOTE: The information in the Lot and 
Block boxes will appear on the Closing File 
Worksheet.

12. Click the Legal tab. The Legal tab is displayed with the legal 
description of the property.

13. Type s after Lot.

What you Do Comments
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Pulling A Second Master Property’s Data Into A Closing File

14. Replace the first set of 
asterisks after Lots with 
13-65.

15. Replace the second set of 
asterisks after Block with 
1.

16. Click the Remarks tab. The remarks entered in Master Property are 
displayed, allowing you to easily contact the 
HOA for information.

What you Do Comments
1. Click anywhere in the top 

half of the window.
The Insert button is enabled.

2. On the secondary 
toolbar, click the Insert
button.

The Master Property Search Selection
window is displayed.

3. In the Name box, type be
and click Browse.

All properties that begin with be are 
displayed. 

What you Do Comments
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4. Select Bear Run II and 
click OK.

The Property tab is redisplayed and Bear 
Run II, is displayed.

5. Replace the *** in the PIN
box with 231.

This completes the PIN number for this 
property.

6. Click the Address tab, 
and type 201-299 
Manatee Harbor Drive
in the Street box.

7. Click the Postal Code
box, type 32820, and press 
the Tab key. Use the down 
arrow to select Bithlo
from the list.

What you Do Comments
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8. Click the Details tab. The Details tab is displayed. Verify that the 
correct property is selected.

9. In the Lot box, type 1-65.

10. In the Block box, type 2.

What you Do Comments
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11. Click the Legal tab. The Legal tab is displayed with the legal 
description of the property.

12. Type s next to Lot.

13. Replace the asterisks with 
the following text:

1-65
2

What you Do Comments
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Adding A Loan To A Closing File
What you Do Comments

1. Click the Loan tab. The Loan tab is displayed with the lender 
information previously entered. NOTE: (1) 
The Settlement Statement drop down list is 
always available on the Loan tab. You may 
select between a Closing Disclosure, a 3-page 
GFE HUD or a 2-page HUD-1. (2) This 
transaction is not subject to CFPB or RESPA, 
so it does not require the Closing Disclosure or 
GFE HUD (3) Changing the Settlement 
Statement selection will result in the loss of 
previously entered Settlement Statement data. 

2. With Palm Beach 
Banque selected, click the 
Street arrow in the 
Address tab and select 
6060 Highway 1.

These addresses were added in the Contacts 
module for Palm Beach Banque.

3. Click the Terms tab.

4. In the Loan No. box, type 
8675309.

This is the loan number for the assumed loan.

5. Click the Rate box and 
type 7.5.

This is the interest rate for the assumed loan.
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6. Click anywhere in the top 
half of the Loan tab 
window.

The Insert button is enabled.

7. On the secondary 
toolbar, click the Insert
button.

The Select Lender window opens allowing 
you to add another lender to this file.

8. Click the Contact Type
box and select Individual.

Previously entered individual names 
designated as Lenders in the Contact 
module will be displayed.

9. Click the Service 
Provided box and select 
None.

A list of individual names previously entered 
in the Contact module will be displayed.

10. Type w in the Last Name
box and select Eric B. 
Wilson.

What you Do Comments
Page 444 DT Version: 8.1



Closing File Module - Miscellaneous
11. Click OK. The Loan tab is redisplayed with Palm 
Beach Banque and Eric B. Wilson listed 
as lenders.

12. Select New from the 
Status drop down list.

13. Select Second from the 
Priority drop down list.

This identifies the loan as a second mortgage.

14. Select Other from the 
Type drop down list.

Eric B. Wilson is personally holding the 
second mortgage. Loan documents will be 
created for this file in the Loans module. 

15. Type 500000.00 in the 
Original Loan Amount
box.

The amount of the second mortgage is 
$500,000.00.

What you Do Comments
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16. Type 177 Clarendon 
Ave. in the Street box on 
the Address tab in the 
bottom half of the screen.

This is the mailing address for Eric B. Wilson.

17. Type 33480 in the Postal 
Code box. Press the Tab 
key.

This mailing address will also be saved in the 
Contacts module for Eric B. Wilson.

18. Click the Terms tab.

19. In the Interest Method
section click 365.

20. Click the Closing Agent
tab

21. Click the Closer box and 
select your name

Your name will be available as entered in the 
Contacts module.

22.  On the secondary 
toolbar, click the Close
button. 

The Closing File save dialog box is 
displayed. 

23. Click Yes. The information you entered in the Closing 
File module is saved and the Closing File
window is closed.

What you Do Comments
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Updating The Commitment Module & Adding A Policy
What you Do Comments

1.  Click the 
Commitment button on 
the main toolbar.

The Commitment module opens.

2. Select Commitment 
(CF6R) from the 
dropdown arrow in the 
Commitment Type field.

The Commitment Type field defaulted to 
Commitment (CF6) since the 
Commitment module was initially accessed 
before the commitment was changed to 
Commitment (CF6R).

3. Change the Effective 
Date to 07/30/18.

NOTE: The Issue Date field is editable and 
can be changed to current date.

4. Click the Owner tab. Since the Commitment module was initially 
accessed before the buyer was added to the 
file, the Name of Insured box is blank.
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What you Do Comments

5. Click the Rebuild 
Defaults button.

The Rebuild Defaults button updates the 
Commitment module with changes or 
additions that have been made in the Closing 
File module.

6. Click the Mortgagee tab.

7. Select the 2nd mortgage 
where Eric B. Wilson is 
the lender.

The lender holding the first mortgage will not 
require a policy because the mortgage is being 
assumed.

8. Click the Policy 
Required check box.

No endorsements will be issued for the 
Mortgagee Policy.
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Rating The Added Policy

What you Do Comments

9. On the secondary 
toolbar, click the Close
button. 

The Commitment save dialog box is 
displayed. 

10. Click Yes. The information you entered in the 
Commitment module is saved and the 
Commitment window is closed.

What you Do Comments
1. Click the Premium 

Calculation (Rating)
button on the mail tool bar.

A warning message displays letting the user 
know to seek assistance with rating files with 
multiple legal descriptions.

2. Click OK. A prompt is displayed with a message letting 
the user know a 1-4 Residential check box 
will default on all policies that total more than 
$20K or less than $1 million; otherwise the 
check box is checked off.   NOTE:
Underwriter approval or a pro forma 
commitment to issue a $1 million or higher 
value policy is required.

3. Click Yes.
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Tips

What you Do Comments

4. Select the Policies tab. The mortgagee policy added in the 
Commitment module has been 
automatically rated.

5. Click Print. The Print Options window opens

6. Click OK. The Policy Rating Worksheet prints.

7. On the secondary 
toolbar, click the Close
button. 

The Premium Calculation (Rating) save 
dialog box is displayed. 

8. Click Yes. The information you entered in the Premium 
Calculation (Rating) module is saved and 
the Premium Calculation (Rating)
window is closed.

1. An alternate way to open the Closing File module is to select Modules
from the menu bar and choose Closing File. You can also use the shortcut, 
Ctrl+O from any window.

2.  To access another existing closing file, click the Switch Active 
Closing File button on the main toolbar and click Browse to display the 
listing of files. Select the file and click OK. The selected file number is 
displayed in the title bar and is now available for any of the DoubleTime 
modules.
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3. On the Closing File Selection window, you can use the buyer and seller 
name boxes and/or the property boxes when browsing to locate an existing 
closing file.

4. To search for your file by lot, block, unit, or building number, click the 
Property tab, then the Details tab and add this information when you first 
create the closing file.

5.  To open the Closing File module for the active file, click the Open 
Closing File button on the main toolbar. 

6. From the Closing File module, click the  Open button on the 
secondary toolbar to display the Closing File Selection window. To view 
all existing file numbers, click Browse. To open an existing closing file, 
select the closing file and click OK, or you can type in the search criteria in 
the boxes and click Browse to find the file, then OK.

7. To add escrow accounts to the Account No. box on the General tab, 
select Preferences on the menu bar, and then choose Account 
Maintenance. Click the Insert button on the secondary toolbar and key in 
the necessary information. Click the Close button and click Yes to saving 
the changes to display in the General tab in the Closing File module. 
Click the Refresh button to bring the change into the Account No. 
selection box and choose the account number.

8.  To add a spouse in the Buyer or Seller tabs, click the Spouse
button. Enter the mailing address only if it differs from the partner’s address.

9. If you insert buyer or seller names on the Buyer or Seller tabs and do not 
include the tenancy in the Name(s) with Status box, a reminder message 
is displayed when you select another tab. Click Yes to display the Insert
Name Clause window and select the tenancy phrase.

10. To change the spelling of a buyer or seller name, double-click the name, 
make changes in the Name Change window, and click OK. The Update
window displays the New Name(s) and Proposed Revisions. The names will 
be updated automatically throughout the Closing File and Contacts
modules.
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11. To change the spelling of a lender name, select Modules on the menu bar 
and choose Contacts. The Select Contact window is displayed. Select 
the name you want to change and click OK. The Contact window for the 
selected name is displayed. Make the change(s) being sure to use capital 
letters where necessary, and click the Save button on the secondary toolbar. 
The Update window is displayed with the New Name(s) and the Current 
Name(s). Click OK to make the change(s). The Contact window is 
displayed with the change(s). Click the Close button on the secondary 
toolbar to return to the Closing File module. Click the Refresh button to 
bring the change(s) into the closing file. The Name(s) with Status box
tenancy phrase is automatically updated.

12. The Signature/Notary button can be selected from any tab after the 
Buyer and Seller tabs have been completed. You can select the number of 
witnesses for each signatory or signature block on documents, as well as the 
witness names. Notary format can also be established and previewed. 
Access to Signature/Notary can also be made from the Documents
module.

13. If the Property Selection for Closing File does not contain an existing 
property you will be using for multiple files, click the Master Property 
button to add the property as a permanent selection.

14. To insert a degree symbol (°) in a legal description on the Property
tab, click the Insert Degree Symbol button. You can also use the 
keystroke of Control+Shift+the letter “o”.

15. To delete a field and the associated information, click the Delete
button.

16.  To check the spelling of a legal description on the Legal tab, click the 
Spell Check button on the secondary toolbar. The Spell Check button is 
also available for the Usage, Remarks, and Declaration tabs.

17. If the lists in the Closing Agent, Title Agent, and Prepared By tabs do 
not include the names you want, exit the Closing File module and use the 
Contacts module to add them.
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Frequently Asked Questions

18. If changes are made to the sales price and/or loan amount in the Closing 
File module after the commitment has been prepared, the Update Sales 
Price (and/or Update Loan Amount) window is displayed. Modules that 
are affected are displayed, showing the item, and the old and new amounts. 
A check mark is displayed in the modules that have previously been 
accessed. Unchecked boxes with an exclamation (!) will not change to the 
new amount unless you place a check mark in the box.

19. You can scroll by first name when searching for individual contacts in 
conjunction with the last name field or by itself.

Question Answer
1. How do I add buyer and 

seller names to a closing 
file?

Add buyer and seller names to a closing file 
on the Buyer and Seller tabs in the Closing 
File module. Or you can add buyer and seller 
names in the Contacts module and select 
them to be included in the Closing File 
module.

2. How do I add an “also 
known as” to a buyer and 
seller name?

Open the Closing File module and select the 
Buyer or Seller tab. Go to the Name(s) 
with Status box and type “also known as” 
followed by the alias. NOTE: If you include 
an alias in the Name(s) with Status box, 
the alias will appear on the Settlement 
Statement, the commitment, and most other 
documents.

3. How do I delete an 
address?

Open the Contacts module and select the 
appropriate contact. Click the Address tab 
and select the address you want to delete. 
Click the Delete button on the secondary 
toolbar. Save the change.

4. How do I correct a wrong 
spouse listed for a buyer or 
seller?

Open the Contacts module and select the 
husband or wife. Select File, then Break 
Relation. Click Yes. Return to the Closing 
File module and delete the wrong spouse. 
Then click the spouse button to add the 
correct spouse.
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5. How do I print a list of the 
parties involved in my 
transaction?

Click the Print button in the Closing File
module to print a worksheet listing the key 
contact information for your closing file. 
NOTE: You can enter additional parties on 
the Participants tab in the Closing File 
module. Click on the Insert button to add a 
new participant and set the Type to a 
selection other than Third Party. (Third 
parties will not print on the worksheet.)

6. How do I change the 
lender?

In the Closing File module, click the Loan
tab, select the correct loan, and either double-
click the Lender name or click the Update 
Lender button. Add or choose a different 
lender from the Search Contact window.

7. How do I find a closing file 
with only a legal 
description?

On the Closing File Selection window, 
type the subdivision or condominium name 
and click Browse. Or, if you have previously 
entered the lot, block, or building numbers on 
the Property/Details tab in the Closing 
File menu, you can search those numbers.

8. How do I change a closing 
file number, when I’ve 
already entered it in a file?

Simply type over the existing number and 
save the file. This step cannot be done if you 
have already received jackets from The Fund.

9. What if the closer isn’t 
listed?

Open the Contacts module and select the 
closing firm. Add the closer as an employee of 
the firm. Save the changes. When you return 
to the Closing File module, click the
Refresh button.

10. Where can I view the 
service providers involved 
in a closing transaction? 

Go to the Participants tab of the Closing 
File module to view all the service providers 
involved in a closing transaction. Click the 
Insert button to add attorneys, law firms, real 
estate agents, brokers, mortgage brokers and 
their companies, loan officers, and third 
parties to the closing file. Associate a 
company with an individual by adding an 
individual to the file.

Question Answer
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11. Why doesn’t my signatory 
display on the Seller tab?

Although you added signatories in the 
Contacts module (to a corporation or other 
legal entity) after you designated the 
corporation as the seller, the signatories will 
not be displayed automatically. One solution 
is to delete the seller from the Seller tab and 
then add it again after the signatories have 
been added to the contact in the Contacts
module. Another solution is to access the 
Signature/Notary button, then insert the 
signatories. NOTE: If the seller is a 
partnership with a corporate partner, you can 
add the partnership within Signature/
Notary or in the Contacts module. For a 
partnership with a corporate partner, go to 
Contacts and select Partnership. On the 
Partners tab, click the Legal Entities 
section and insert the corporate partner. Then 
click below to select the individual from the 
corporation on the Select Signatory
window. To establish the Partnership in 
Signature/Notary, highlight the seller’s 
name, previously created as a partnership, and 
click the Add button. The Contacts module 
is displayed. Change the contact type to 
Corporation and select or add the corporate 
partner. Click OK, and the Signature/
Notary window is re-displayed with the 
Corporate Partner.

Question Answer
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Clause Library Maintenance Module

Concept
Standard and user defined clauses are available from the Clause Library for use in 
Title Insurance >Commitment, Title Insurance > Policy, Master Property, 
Conveyance, Documents, and other DoubleTime modules. Standard Clauses, 
including clauses from The Fund’s Standard Commitment Clauses Handbook, are 
included in the DoubleTime database. Using the Clause Library Maintenance
module, you can create new clauses, called User Defined Clauses. Both standard 
and user defined clauses are retrieved by accessing the Clause Library that is
available throughout DoubleTime. User defined clauses, unlike standard clauses, can 
be modified or deleted.

Objective
The objective of this lesson is to show you how to create a User Defined Clause
from a Standard Clause, create a new User Defined Clause, and modify and 
delete a User Defined Clause using the Clause Library Maintenance module.

Creating A User-defined Clause From A Standard Clause
What you Do Comments

1. On the menu bar, select 
Modules > Clause 
Library Maintenance.

The Clause Library window is displayed 
with the list of available clauses. The Clause 
Type defaults to (ALL) with All Clauses
selected.
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2. Click the Clause Type
box, scroll and select 
Mortgage.

This will display all Mortgage clauses only.

What you Do Comments
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3. In Clause Title, select the 
2nd Mortgage clause.

This is the standard clause you want to 
modify. The Clause Text is displayed in the 
bottom half of the window.

Clauses are displayed in alphabetical order by 
Clause Title. NOTE: Click Reference ID 
to sort numerically for those clauses found in 
the Fund’s Standard Commitment Clauses 
Handbook. Only standard Exceptions and 
Requirements have these numbers.

What you Do Comments
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4. Place the cursor at the 
beginning of the clause 
text, and click the right 
mouse button. Click 
Select All.

The clause text is highlighted. NOTE: An 
alternate method to highlight is to hold the left 
mouse button down while dragging across the 
text you want to select.

5. Click the right mouse 
button, and click Copy.

The Windows copy function is activated. 
Note: You can also copy text using CTRL + C.

6. Click the New button. The Clause Library Maintenance window 
is displayed with Mortgage in the Clause 
Type box.

What you Do Comments
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7. Click the Clause Title
box and type 2nd PMM.

This will identify the clause as a User-Defined 
Clause. NOTE: The Reference ID box is 
optional. If you are assigning numbers to your 
User-Defined Clauses, type the number in 
Reference ID.

8. Click the Clause box, 
then click the right mouse 
button, and select Paste.

The Windows paste function is activated. The 
clause text copied from the previous window 
is displayed in the Clause box. NOTE: You 
can also paste text using Ctrl + V.

9. Place the cursor before the 
word second and type 
purchase money.

10.  Click the Save
button. 

The 2nd PMM is saved as a User-Defined 
Clause and is available for selection.

What you Do Comments
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Creating A New User-Defined Clause
What you Do Comments

1. On the secondary 
toolbar, click the Open
button.

The Clause Library window is displayed.

2. Click the New button. The Clause Library Maintenance window 
is displayed.

3. Click the Clause Title
box and type Delete 
Standard Exceptions.

This is the name you are giving to the User-
Defined Clause.

4. Click the Clause Type
box and select Exception.

5. TAB to the Clause box 
and type Standard 
exceptions *** are 
hereby deleted.

This is the clause text for the User-Defined 
Clause, Delete Standard Exceptions.

6. On the secondary 
toolbar, click the Open
button.

The Clause Library Maintenance save 
dialog box is displayed.

7. Click Yes. The Clause Library window is redisplayed 
with the list of available clauses.
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Modifying A User-Defined Clause
What you Do Comments

1. Click the User Defined 
Clauses button.

This restricts the display to User-Defined 
Clauses.

2. Select the Taxes clause 
from the Clause Title list.

The Clause Text is displayed in the bottom 
half of the window.

3. Click OK. The Clause Library Maintenance window 
opens with the selected clause displayed. 
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4. In the Clause box, replace 
the 03 with ** and insert a 
comma (,) after the word 
any and type the words 
without reimposing 
same. 

5. On the secondary 
toolbar, click the Open
button.

The Clause Library Maintenance save 
dialog box is displayed.

6. Click Yes. The Clause Library window, with the list of 
available clauses, is redisplayed.

What you Do Comments
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Deleting A User-Defined Clause
What you Do Comments

1. Click the User Defined 
Clauses button.

The display is limited to User-Defined 
Clauses.

2. In Clause Title, select the 
Assumption of 
Property clause.

The Clause Text is displayed in the bottom 
half of the window. 

3. Click OK. The Clause Library Maintenance window 
is displayed with the Assumption of 
Property clause.
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Tips

4. On the secondary 
toolbar, click the Delete
button.

The Clause Library Maintenance delete 
dialog box is displayed. 

5. Click Yes. The Assumption of Property clause is deleted 
and the Clause Library Maintenance
window is closed. The Clause Library
window is redisplayed with the list of all 
available clauses.

6. Click Cancel. The Clause Library Maintenance module 
is closed.

1. Standard Clauses cannot be changed or deleted.

2. To retrieve User-Defined Clauses, click the Clause Library button in the 
following modules: Conveyance, Documents, Loan Details, Master 
Property, Title Insurance > Commitment, and Title Insurance > 
Policy.

What you Do Comments
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Frequently Asked Questions
Question Answer

1. How do I add exceptions 
that were created in a word 
processor?

In the Clause Library Maintenance
module, select User Defined Clauses and 
select Exception from the Clause Type
list. Click New. Type the clause name and 
click in the Clause box. Minimize 
DoubleTime and open the word processor. 
Select and copy the exception clause. Return 
to DoubleTime and press CTRL + V to paste 
the clause into DoubleTime. Save your clause. 
Repeat the above steps for each exception 
clause you want to keep in DoubleTime.

3. Use the Spell Check button to check the spelling of the User-Defined 
Clause.

4. Information can be copied and pasted from a Windows-based word 
processor into the Clause Library Maintenance window. Press Alt + Tab 
to switch between DoubleTime and the word processing program, or you 
can copy the information in the word processing program, minimize it, and 
then paste the information into DoubleTime.
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Loans Module
 Loans 

Concept
The Loans module contains loan-related information for a closing file. It is primarily 
used to store and maintain the loan terms in order to generate mortgage documents in 
the Documents module. Additionally, an amortization schedule can be displayed 
and/or printed by selecting Modules> Loans > Amortization Calculator from 
the main toolbar.

Objective
The objective of this lesson is to show you how to enter the loan information for the 
purchase money mortgage for this closing file in order to generate a purchase money 
note and mortgage in the Documents module. You will also use the Amortization 
Calculator to calculate the principal and interest amounts for the purchase money 
mortgage and promissory note.

Adding New Loan Information
What you Do Comments

1. On the main toolbar, 
click the Loans button.

The Select Loan window opens displaying 
the loans associated with this closing file.
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2. With Eric B. Wilson 
highlighted, click OK.

The New Loan for Eric B. Wilson is 
displayed, with the Classification tab open.

NOTE:  For Credit Union loans, users can select the Exempt 
From Intangible Tax box. When selecting this feature 
DoubleTime will not automatically populate the Intangible Tax 
on the Settlement Statement.

3. Click the Lender tab. NOTE: On the Lender tab, the name and 
address information for Eric B. Wilson are 
displayed. If the loan is to be assigned to a 
different lender, click the Assignment check 
box. The assigning lender information can be 
added.

What you Do Comments
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4. Click the Property tab. The Property tab is displayed containing no 
information. It is not necessary to insert the 
properties. All properties are automatically 
associated with the loans in the related 
Closing File module. 

5. Click the Features tab. NOTE: If this were a balloon mortgage, this 
is where the mortgage would be identified as 
such and the required statutory language 
would be inserted. 

What you Do Comments
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6. Click the Terms tab. The Terms tab is displayed and contains the 
loan amount and closing date information 
entered previously in the Closing File
module.

7. Type 9 in the Interest 
Rate box.

This is the interest rate for this loan.

8. Select Monthly from the 
Payment Interval drop 
down list.

This is the frequency of payments.

9. Type 180 in the # 
Payments box.

The mortgage is 15 years for this property, 
which is 180 monthly payments.

10. Type 11/01/(current 
year) in the 1st Payment 
box in the Dates section.

This is the date the 1st payment is due. 

What you Do Comments
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Using The Amortization Calculator
What you Do Comments

1. On the secondary 
toolbar, click the 
Amortization Calculator
button.

The Mortgage Calculator window is 
displayed with information copied from the 
Terms tab.

NOTE: The Balloon check box enables the 
Pmt # box for a Balloon mortgage.

2. Click the Calculate button. DoubleTime calculates the Amortization 
Schedule. The monthly payment amount, 
including the principal and interest, is 
displayed in Total Payment field. NOTE:
The screen page count is not the same as 
printed pages. Five screen pages are 
equivalent to one printed page.
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3. Click the Print button. The Amortization Schedule is printed. 
You will need this printout to complete the 
information on the Terms tab.

4. Click the Close button. The Mortgage Calculator window is 
closed and the Terms tab is redisplayed.

5. Type (the six - digit date)
[example 100133] from the 
Amortization Schedule in 
the Maturity box.

This is the due date for the final payment.

6. Click the P&I box and type 
5071.33.

This is the amount of the Total Payment 
from your printout.

What you Do Comments
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7. Click the Riders tab. Use the Riders tab to select rider(s) 
associated with the mortgage. The appropriate 
box(es) will automatically be checked on the 
mortgage when it is printed in the 
Documents module.

8. Click the Clauses tab. Clauses incorporated on this tab will display 
on the Note and/or selected Mortgage when 
accessed in the Documents module.

9. Click in the Mortgage/
Deed of Trust box.

The 2nd PMM clause needs to be added.

What you Do Comments
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10.  Click the Clause 
Library button on the 
secondary toolbar.

The Clause Library window opens. The 
Clause Type defaults to Mortgage with All 
Clauses selected. NOTE: You can also press 
Ctrl + L to access the Clause Library.

11. Select User Defined 
Clauses.

The 2nd PMM displays along with any other 
user defined clauses created in Clause 
Library Maintenance. 

12. Select 2nd PMM and click 
OK.

The Clause Library window is closed and 
the Clauses tab is redisplayed. The 2nd 
PMM clause has been added for this loan.

13. Replace the asterisks (***) 
in the clause with Palm 
Beach Banque.

The completed clause will be incorporated 
into the purchase money mortgage in the 
Documents module.

14.  On the secondary 
toolbar, click the Open
button.

The New Loan for Eric B. Wilson save 
dialog box is displayed.

15. Click Yes. The loan information is saved and the Select 
Loan window displays again. 

What you Do Comments
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16. Select Palm Beach 
Banque.

17. Click OK. The Select Loan window closes and the 
Loan Assumption for Palm Beach 
Banque information displays.

18. Click the Estoppel tab.

19. Type 1,500,000 in the 
Current Balance box.

What you Do Comments
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Tips

20.  Click the Close button 
on the secondary toolbar.

The Loan Assumption for Palm Beach 
Banque save dialog box is displayed.

21. Click Yes to save changes. Changes are saved and the Loans module 
closes.

1. An alternate way to open Loan Details or Amortization Calculator is to 
select Modules on the menu bar, then Loans, and then Loan Details or 
Amortization Calculator.

2. Select the Property tab in the Loan Details module if there is more than 
one property associated with a closing file, but not all of the properties are 
encumbered by a loan. Here you can identify which of the properties are 
encumbered by a loan.

3. When there is an assignment of mortgage, select the Lender tab to indicate 
the name of the assignee and other assignment information.

4. When preparing a balloon loan, ensure the proper language for balloon 
mortgages appear on the documents as follows:

•For fixed rate balloon mortgages, select the Balloon check box on the 
Features tab of the Loans module.

•For adjustable rate balloon mortgages, select the Balloon check box as 
noted above, as well as the Adjustable Rate check box on the 
Classification tab of the Loans module

•When the documents, such as a FL Mortgage or FL Mortgage (Seller) are 
printed from the Documents module, the appropriate balloon language 
will be included.

What you Do Comments
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5. Use the Riders tab to select rider(s) associated with the loan. This will 
check the appropriate box(es) on the mortgage. 

6.  To check the spelling in the Clauses tab, click Spell Check on the 
secondary toolbar.

7. This module is used when the seller or a private lender is holding a purchase 
money mortgage and you need to create the mortgage and note documents 
for the seller or the lender. Use the FL Mortgage (Seller) or FL 
Mortgage and Promissory Note (Seller) or Promissory Note
documents in the Documents module.
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Settlement Statements For Non-RESPA/Non-CFPB 
Transactions

Concept
Settlement Statements for Non-RESPA and Non-CFPB transactions are two pages 
long. If a transaction has no loan connected with it, there will be no lender involved. 
Commercial transactions are not subject to RESPA or CFPB regulations even when a 
loan is involved. The Settlement Statements module can be used to complete the 
two-page HUD, as well as a variety of other types of Settlement Statements. Just as 
with the CFPB closing file we created earlier in training, DoubleTime will automate 
much of the preparation.

Objective
The objective of this lesson is to show you how to use the Settlement Statements
module to complete a two-page HUD Settlement Statement for a Non-RESPA/Non-
CFPB transaction and how to print the completed statement.

Verifying Amounts Due To And Paid By Seller
What you Do Comments

1.  On the main toolbar, 
click the Settlement 
Statements button.

The Update Recording Charges dialog 
box is displayed listing the calculated values 
for the documentary stamps on the deed and 
note, and the intangible tax on the mortgage. 
DoubleTime uses the appropriate charges 
based on the county in which the property is 
located and the purchase price and loan 
amount. This dialog box is used to update the 
Old Amount with the New Amount. 
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2. Click Yes. The Update Recording Charges dialog 
box is closed and the Settlement 
Statements window is displayed with the 
General tab open. The title bar indicates the 
file name. In the General tab, you can view 
the top portion of page 1 of the HUD 
Settlement Statement, sections A through I. 
These sections contain loan information, the 
names of the parties, and property and 
settlement information. Use the Closing File
module to change or make additions to the 
information.

What you Do Comments
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3. Click the Seller Credits
tab.

What you Do Comments
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Calculating Adjustments For Items Paid By Seller
What you Do Comments

1. Click the Adjustments - 
Paid tab.

The Adjustments - Paid tab displays lines 
106/406 through 112/412. 

Viewing Buyer Credits And Loan Amounts/Payoffs 
What you Do Comments

1. Click the Buyer Credits
tab.

The Buyer Credits tab displays showing the 
buyer’s deposit amount (line 201), the loan 
assumption balance (line 203/503), and the 
new second mortgage amount (line 204).
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Calculating Adjustments For Items Unpaid By Seller
What you Do Comments

1. Click the Adjustments - 
Unpaid tab.

The Adjustments - Unpaid tab is displayed 
with lines 210/510 through 219/519. 

2. Select line 211/511. Selecting this line allows you to calculate the 
unpaid county taxes.

3. Click the Pro-rate check 
box in the work area.

Additional fields open for Line # 211/511. 
The Date from defaults to the beginning of 
the year. The Date to defaults to the date of 
closing. 

4. Click the Gross Amount
box and type 225,500.00.

This is the amount of the property taxes for 
both parcels for the entire year.

5.  Type 4 in the Discount 
percent box 

This is the maximum allowable discount 
which is determined by the Tax Collector’s 
office. 

6. Press the Tab key. DoubleTime calculates the prorated taxes.
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Calculating Loan Fees
What you Do Comments

1. Click the Loan Fees tab. The Loan Fees tab is displayed with lines 
800 through 811. 

2. Click line 807. The lender is charging an assumption fee of 
1% of the unpaid loan balance for a total of 
$15,000.00. The fee will be charged to the 
borrower.

3. Type 15,000.00 in the 
Paid from funds box for 
the Borrower and press the 
Tab key.

The fee is charged to the Borrower, but can be 
changed if needed. NOTE: (1) The default 
descriptions for lines 801 through 807 can be 
changed or added to as needed.

Adding Title Charges
What you Do Comments

1. Click the Title tab. The Title tab is displayed with lines 1101
through 1113. Line 1101 is selected. The 
Payee defaults to Richard P. Bruce, Esq. 
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2. Type 1000 in the Paid 
from funds box for the 
Borrower and press the 
Tab key.

The $1000 Settlement or closing fee is 
charged to the borrower.

3. Double click line 1108. The Title Insurance Calculator for 
Orange County window opens. NOTE: (1) 
The county name defaults to the county in 
which the property resides. (2) The borrower 
is charged $25 for the mortgagee policy. The 
owner policy, in the amount of $8,825 is 
charged to the seller.

What you Do Comments
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4. Select Seller from the 
Payor drop down list in 
the Mortgagee column.

NOTE: Based on provisions in the contract, 
the Payor for the title policies must be 
changed.

5. Click OK. The Title Insurance Calculator for 
Orange County window closes.

What you Do Comments
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6.  Select line 1107.

7. Type 500 in the Paid 
from funds box for the 
Seller.

The Seller’s attorney asked to collect and pay 
the Attorney’s Fee as part of the closing 
process and to show it on the Settlement 
Statement

8.   Click the Search 
Contacts button on the 
secondary toolbar.

The Search Contact window opens.

What you Do Comments
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9. Select Smith & Foster, 
PA from the Legal Entity 
Name list.

10.  Click OK. The payee name for line 1107 changes as 
indicated.

What you Do Comments
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Calculating Recording And Transfer Charges
What you Do Comments

1. Click the Recording tab. The Recording tab is displayed with lines 
1201 through 1205. Line 1201 is selected. 

2. Double click line 1201. The Recording Calculator window is 
displayed.

What you Do Comments
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3. Type 2 in the # of Pages
box in the Deed column.

The calculations will be automatically made 
for recording a 2 page deed. The payors 
default to the typical payor, but can be 
changed as needed.

4. Type 10 in the # of Pages
box in the Add’l 
Mortgage(s) column.

This is the charge for recording a 10 page 
second mortgage.

5. Click OK. The Recording Calculator window closes 
and the calculated amounts display.

What you Do Comments
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6.  Click the Search 
Contact button on the 
secondary toolbar.

The Search Contact window opens. The 
Contact Type is Other and the Service 
Provided is Recording Dept.

7. Select Orange County 
Comptroller and click 
OK.

The Search Contact window closes and the 
Recording tab redisplays. Orange County 
Comptroller is listed in the Payee box. 
NOTE: This information is not displayed on 
the Settlement Statement, but reflects the 
payee for the Balance Sheet.

8. Double click line 1202. The Recording Calculator for Orange 
County dialog box displays, with the Tab for 
Line 1202 open. NOTE: Take a moment and 
click on the various tabs to become familiar 
with them. Values from the Update 
Recording Charges dialog box are copied 
to lines 1202 and 1203. The dollar amount of 
the intangible tax on line 1202 and the note 
documentary stamps on line 1203 are charged 
to the borrower. The deed documentary 
stamps on line 1203 are charged to the seller. 
The payee for all line items in the 1200 series 
will default to the payee selected on line 
1201.

What you Do Comments
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Viewing Closing Statement Alerts
What you Do Comments

1.  Click the Closing 
Statement Alerts button 
on the secondary toolbar.

The Closing Statement Alerts window 
opens. It provides helpful information on 
specific line items for the current transaction 
that may have been inadvertently overlooked. 
NOTE: (1) The Alerts can be viewed on any 
tab within the Settlement Statement
module by clicking this button. (2) The No 
broker commission alert displays. 

2. Click the Do not 
automatically display 
Closing Statement 
Alerts check box. 

Alerts will no longer display automatically 
when exiting the Settlement Statements
module for this file.

3. Click Close. The Alert window closes. NOTE: No action 
is required since there are no brokers 
associated with this transaction. 

9. Click OK. The Recorded Calculator For Orange 
County dialog box is dismissed. 

What you Do Comments
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Printing The HUD-1 Settlement Statement
What you Do Comments

1. Click Format > HUD 
Signatures-Separate 
Page from the main menu.

Due to the number of signatories for the 
buyer, we will choose to have all signatures on 
a separate page. NOTE: No window opens or 
message displays after this action. The 
separate signature page will print with the rest 
of the HUD.

2.  Click the Print
button on the secondary 
toolbar.

The Print Options window opens. The 
Print Range defaults to All, Copies to 1, 
Print What to HUD-1 and Print to Print all 
pages.  NOTE: To print a different 
statement, worksheet, or report, click the 
Print What box and make your selection.
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Tips

3. Click the Preview button. A preview of the HUD statement displays. 
Use the Next and Back buttons on the 
secondary toolbar to check each page of the 
document.

4.  Click the Close
button on the secondary 
toolbar.

The HUD preview closes and the 
Settlement Statements module redisplays.

5.  Click the Print
button on the secondary 
toolbar.

The Print Options window opens again.

6. Click OK. The HUD including a separate signature page 
prints.

7.  Click the Close
button on the secondary 
toolbar.

The HUD preview closes and the 
Settlement Statements module redisplays.

1. An alternate way to open the Settlement Statements module is to select 
Modules from the menu bar and choose Settlement Statements.

What you Do Comments
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2.  Use the Double Click! feature on line 201 - Deposit or earnest 

money to open the Deposit Summary dialog box. It can also be used to 
open the Payoff Calculator on line 504 and the Recording Calculator
on line 1202.

3. Use the Deposit Summary button, located in the Settlement 
Statements toolbar, to open the Deposit Summary dialog box.

4.  Another way to access the Payoff Calculator is to select line 504 and 
click the Payoff Calculator button on the Settlement Statements
secondary toolbar.

5. Use the Recording Calculator to automatically calculate recording 
fees for lines 1202 through 1205 on the Recording tab.

6. In the Print Options window, use the Page Range area to print 
individual pages of the HUD.

7.  To display the entire HUD, click the Print button on the secondary 
toolbar and select the Preview button.

8. You can display any one report selected in the Print What box by clicking 
the Preview button. You can also select a report to view by selecting 
Reports from the main menu.

9. To print multiple reports at one time, click the More button on the Print 
Options window and select as many different reports as needed. Click the 
Less button to return to the previous window. You can also select other 
reports by clicking the Reports button on the main toolbar.

10. A HUD Signatories-Separate Page Settlement Statement should be 
used if all signatures cannot be disclosed on the two page Settlement 
Statement. This can be selected from Format on the menu toolbar.

11.  Click the Calculator button to use the calculator. You can type the 
number on the keyboard or use the mouse to click the numbers on the 
displayed calculator. 

12. To obtain a copy of the figures in the Payoff Calculator, leave the Payoff 
Calculator window open after the figures have been calculated. Press the 
Print button.
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Frequently Asked Questions

13. You can choose to display the Closing Statement Alerts at any time 
by clicking the Closing Statement Alerts button to check for any 
missing items within your Settlement Statement.

14. To fax a HUD from your PC, click the Print button on the secondary 
toolbar, select the Printing to fax machine check box, and click the
Properties button. Select your fax in the Printer Setup window and click
OK. This ensures that all the pages of the HUD are faxed as one “print job”, 
instead of treating each page as a separate fax.

15. To email a Settlement Statement from your PC, select eSolutions while in 
Print Preview, and click Email. In order to perform this function, you 
must be in preview mode of all Settlement Statements, including the HUD, 
and you can only use Outlook or Outlook Express to e-mail from the 
Settlement Statement module. A list of participants in reference to your 
file are displayed with the opportunity to select their e-mail addresses. Email 
addresses need to be established in either the Contacts or Closing File 
module on the Phone tab.

16. Use the Settlement Statement Template Maintenance module to set 
up HUD defaults for specific lenders. The initial setup of a template is done 
under Modules/Settlement Statement Template Maintenance. See the 
Settlement Statement Template Maintenance lesson in Additional 
Features for more information.

17. To email the Settlement Statement using an email program besides 
Microsoft Outlook, first save the statement to your computer as follows: 
• Select File > Save as... from the menu bar
• DoubleTime converts the image to a PDF file 
• The Save Document Image window opens
• Type a name for the document in the File Name box
• Select a location on your computer to save the file from the Save in drop 

down list
• Click Save
• The file is saved and available for attachment to an email. 

Question Answer
1. How do I add more lines? Click the Add’l Charges tab, then click the 

Insert button. An addendum is automatically 
generated, and the addendum total is 
maintained on Line 1309.
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2. How do I add more lines to 
the 800 Series of the HUD 
for lender fees?

Additional lines cannot be added to the 800
series. However, you can change the 
description of the lines in the 800 series. If 
you have additional lender fees, you can enter 
them in the 1300 section, which can be added 
to, if needed.

3. How do I enter a LIP or 
Construction Loan 
account?

DoubleTime allows you to enter the LIP 
(Loan in Progress) or Construction amount on 
Line 104 or 105 of the HUD. Type the 
Description in Line 104 or 105 of the 
HUD, type the amount of the LIP account in 
Total Amount. Double-click Amount 
Withheld. Finally, set your Loan Statement 
to the appropriate loan (for example, First).

4. How do I put tax re-
proration language on the 
HUD?

You cannot add Tax Re-Proration language 
directly to the HUD, however, you can print 
the Closing Statement Addendum
document from the Documents module. The 
Closing Statement Addendum document 
includes the Tax Re-Proration language, as 
well as other information, such as the 
Disbursement Authorization language. 

5. How do I delete an amount 
from Line 402 (Personal 
Property)?

Delete the amount on Line 102 and press 
Tab or Enter. Line 402 will be changed to 
zero (0).

6. How do I print the HUD? In the Settlement Statements module, 
select Format and verify that HUD-1 is 
selected. Then click Print button. The Print 
What box will display the default of HUD-1, 
or you can select a different settlement 
statement. Select Print Preview if desired, 
and then click Print button to print the 
settlement statement.

7. How do I add a contact on 
the HUD?

Click Search Contact button on the 
secondary toolbar to open the Search 
Contact window. Select the contact.

8. How do I type a negative 
number?

Type a dash (-), and then type the amount.

Question Answer
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9. How do I deduct a deposit 
credit from the loan fees 
check being remitted by 
the Closing Agent to the 
Lender?

Let’s say a Borrower pays a deposit to the 
Lender that needs to be credited to the 
Borrower on the HUD. The Lender remits a 
check for the exact loan amount (no 
withhelds). The deposit credit must be 
deducted from the loan fees check being 
remitted by the Closing Agent to the Lender. 
NOTE: This situation is similar to an 
Aggregate Accounting Adjustment, which is 
typically a Borrower credit reflected as a 
negative number. Go to the Loan Fees tab in 
the Settlement Statements module. On an 
available 800 section line, enter the following 
information:
• Description: Enter language acceptable to 
the Lender, (such as “Application Fee 
Refund” or “Loan Deposit Credit”).
• Payee: Select the lender.
• Paid from Funds/Borrower: Enter the 
deposit credit amount here as a negative 
number, (such as  
$-500.00).
• Amount withheld: Leave this blank.
• Loan statement: Select the appropriate 
loan.

The Balance Sheet (Balance Sheet 
module) should now reflect a negative 
number for a disbursement item. Combine this 
negative item with the items being disbursed 
to the Lender to create a net check for the 
Lender. NOTE: You cannot access the 
accounting export function until this negative 
disbursement item has been combined.

10. Why aren’t the doc stamps 
on the deed automatically 
calculated on the HUD?

You did not select a property on the Property 
tab of the Closing File module.

Question Answer
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11. Why doesn’t the payoff 
amount or lender display?

Payoff loans must be added in the Closing 
File module/Loans tab. The lender will be 
displayed on the HUD. The payoff amount is 
entered directly in the Settlement 
Statements module. To add the payoff 
amount, type the amount or double-click the 
payoff line in the HUD to bring up the payoff 
calculator. Type the mortgage balance, per 
diem interest, and other miscellaneous fees 
associated with the payoff. Click OK. The 
amount will be displayed in the proper box.

Question Answer
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Documents Module

Concept
The Documents module is used to prepare and print documents such as Title 
Commitments, Title Policies, Deeds, Mortgages, Notes, Affidavits, and Bills of Sale. 
You can select documents from the Master Document Selection list for each 
closing file and, if necessary, edit them before printing. Documents can also be 
emailed using Outlook or Outlook Express and faxed from your computer. 
Customized documents can be created, and then related to a closing file.

Objective
The objective of this lesson is to show you how to select, edit documents, and print the 
loan documents.

Associating Documents With Your File 
What you Do Comments

1.  Click the 
Documents button on the 
main toolbar.

The Closing Document Selection
window is displayed.
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2. Click New. The Master Document Selection opens. 
The Classification drop down list and the 
Type area selection both default to All.

3. Scroll down and select 
Custom Deed from the 
Name list.

This is one of the documents you want to 
bring into your file.

4. Press and hold the Ctrl
key, and scroll down and 
select Non-Foreign 
Certification by Entity 
Transferor.

The Ctrl key allows you to select more than 
one document at the same time.

5. Release the Ctrl key and 
click OK.

The Closing Document Selection
window is redisplayed with the additional 
documents you selected. 

What you Do Comments
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6. Click New. The Master Document Selection window 
is displayed. The Classification box 
defaults to All and the Type defaults to All.

7. Click the Classification
box and select Loans - 
All.

This will restrict the display to all loan 
documents.

8. Scroll to and select FL 
Mortgage.

9. Press and hold the Ctrl key 
and select Promissory 
Note.

What you Do Comments
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Editing A Custom Document

10. Release the Ctrl key and 
click OK.

The Select Loan window is displayed with 
the lenders associated with this file.

11. With Eric B. Wilson 
selected, click OK.

The selected documents are displayed in the 
Closing Document Selection with Eric 
B. Wilson listed in the Document 
Information column. This indicates these 
documents are associated with the loan to 
Eric B. Wilson.

What you Do Comments
1. Double click Custom 

Deed. 
The Custom Deed is displayed.

What you Do Comments
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2. Place your cursor above 
the Subject to taxes 
language.

3.  Click the Clause 
Library button on the 
secondary toolbar.

The Clause Library window opens. 

What you Do Comments
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4. Select Deed from the 
Clause Type drop down.

 

5. Select Subject To: 
Mortgage Assuption 
and click OK.

6. In the first subject to
paragraph, replace the 
asterisks with the 
following text:

Palm Beach Banque
3421
4599
20010004599
Orange
1,550,000.00

This information is specific to this closing 
file.

7. Place your cursor at the 
end of the inserted clause 
and press ENTER twice.

 

8.  Click the Clause 
Library button on the 
secondary toolbar.

The Clause Library window opens. 

9. Click Deed from the
Clause Type drop down.

 

10. Select Subject To: PMM 
and click OK. Press 
ENTER.

11. In the second subject to
paragraph perform the 
following steps:

•  Delete First/
•  Highlight “Grantor” and 
type Eric B. Wilson
• Replace the asterisks with 
500,000.00 

What you Do Comments
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12.  On the secondary 
toolbar, click the Open 
button.

The Custom Deed for the active closing file 
save dialog box is displayed.

13. Click Yes. The changes to the Custom Deed document 
are saved for this file. The Closing 
Document Selection window is displayed.

What you Do Comments
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14. Select Custom Deed and 
hold the Ctrl key and 
select FL Mortgage, 
Non-Foreign 
Certification Entity 
Transferor and 
Promissory Note.

4 document titles are highlighted with 
Documents Selected: 4 displayed in the 
bottom right corner.

15. Click the Print button. The Print Documents window is displayed 
as the selected documents are printed, then 
closes automatically and the Closing 
Document Selection window is 
redisplayed.

16. Click Cancel. The Documents module is closed.

What you Do Comments
Page 506 DT Version: 8.1



Documents Module
Tips
1. An alternate way to open the Documents module is to select Modules

from the menu bar and select Documents. You can also use the shortcut, 
Ctrl+D from any window.

2. To view a document, select the document from the Closing Document 
Selection window and click OK.

3.  Use the Spell Check button on the secondary toolbar to check the 
spelling of a displayed document.

4.  The Signature/Notary button allows you to select the number of 
witnesses for each signatory or signature block on documents, as well as the 
ability to select witness names. Notary format can also be established and 
previewed.

5. Use the selections available in the Insert menu to insert page breaks and 
page numbers.

6. Use the Edit menu to add custom variables, notary information, and headers 
and footers.

7. Use the Format menu to format fonts, paragraphs, and tabs.

8. To prevent changes from being made to the open document, select Protect 
Document (Read Only) in the Tools menu.

9. An alternate way to select text for editing is to press and hold the Shift key 
and use the arrow keys. You can also press and hold the Shift key and press 
the End key to select text from the cursor position to the end of the line.

10. Custom documents can be altered and saved when the custom document is 
currently opened within the Documents module. To save the changes to the 
master custom document, select File > Save As > Existing Master.

11. A single document can be emailed by choosing eSolutions, Email. The 
email feature only utilizes Outlook or Outlook Express. Multiple documents 
can be selected and emailed on the Closing Document Selection 
window by clicking the eMail button.

12. Documents can be faxed by selecting File > Print > Properties, and 
selecting the currently installed fax program on your computer.
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Reports Module                                                                   

Concept
DoubleTime enables you to produce the following reports:

• 1099-S
• Branch Product Order Detail
• Branch Product Order Summary
• Checklist - Problem Report
• Checklist - Tasks Completed
• Checklist - Tasks Due
• Clause Library
• Closing File
• Closing File by Closer
• Closing File by Lender
• Closing File by Loan Approval
• Closing File by Prepared By
• Closing File Mortgage ID
• Contact List by Service Type
• Contact List by Service Type (Mailing Labels) - Avery 5161
• Custom Master Document Usage
• Daily Order
• Documents/Templates with Picture Images
• Fund Policy Premium Invoices
• Fund Policy Premium Invoices Paid Electronically
• Fund Policy Premium Invoices Unpaid Electronically
• Loan Closing Statistics
• Master Document
• Master Property List
• Notary Format
• Policies -All Open
• Policies in Progress
• Productivity Summary Report
• Referral
• Referral by Company Employees
• Serialized Forms
• Serialized Forms Electronic Delivery

Objective
The objective of this lesson is to show you how to generate Mailing Labels for a 
Contact List by Service Type and a Referral Report. 
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Creating A Contact List By Service Type Report 
What you Do Comments

1.  Click the Reports
button on the main toolbar.

The Report Selection window is displayed. 
The default Closing Agent for the 
highlighted 1099-S report is Richard P. 
Bruce, Esq.   NOTE: The information on 
the bottom half of the screen will change 
when a different document is selected. 

2. In the Report Name box, 
scroll to and select 
Contact List By 
Service Type.

The information on the bottom half of the 
window changes to a Select Provider Type
drop down list.   NOTE: You can print a list 
of Contacts, including name, address and 
phone number, by Service Provider type. The 
Service Provider types available are those 
listed on the Services tab in the Contacts
module.

3. Select Lender from the 
Select Provider Type
drop down list.
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4. Click OK. The Contact List By Service Report is 
displayed. 

What you Do Comments
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Generating Mailing Labels For Contact List By Service Type

5. On the secondary 
toolbar, click the Print
button.

The Print Options window is displayed.

6. Click OK. The Contact List By Service Report is 
printed.

What you Do Comments

1.  On the secondary 
toolbar, click the Open 
button.

The Report Selection window is re-
displayed.

2. In the Report Name box, 
scroll to and select 
Contact List by Service 
Type (Mailing Labels) - 
Avery 5161.

The Select Provider Type defaults to 
Appraiser.

3. Click the Select 
Provider Type box and 
select Lender.

4. Click OK. The Contact List By Service Type 
(Mailing Labels) is displayed. This report is 
designed for use with Avery 5161 labels, 
which contain 20 labels (2 across and 10 
down).

What you Do Comments
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5. On the secondary 
toolbar, click the Print
button.

The Print Options window is displayed.

6. Click OK. The Contact List By Service Type 
(Mailing Labels) is printed.

What you Do Comments
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Creating A Referral Report
What you Do Comments

1. On the secondary 
toolbar, click the Open
button.

The Report Selection window is re-
displayed.

2. In the Report Name box, 
select Referral.

The default Title Agent is Richard P. 
Bruce.

3. Type 0101 and the last two 
digits of the previous year 
in the Closing Date 
From box. 

This is the beginning date of the information 
you want to display. The To box defaults to 
the current day.

4. Click OK. The Referral Report is displayed with the 
data you requested.

5. On the secondary 
toolbar, click the Print
button.

The Print Options window is displayed.

6. Click OK. The Referral Report is printed.
Page 514 DT Version: 8.1



Reports Module
Tips
1. To delete serialized forms that are no longer valid in your inventory, select 

Modules from the toolbar, then Serialized Forms, then choose Delete 
Forms Inventory. 

2. To see a listing of referrals by a specific individual or entity, click the 
Referral button for the Referral Report Name and select the appropriate 
information.

3. The Fund Policy Premium Invoices report allows you to view, print 
and/or reprint invoices for underwriter remittance generated from the 
Electronic Delivery wizard. You can select a particular invoice number, 
all invoices generated between a particular invoice date range, or all 
invoices generated for a particular Closing File number.

4. Policies in Progress is a handy report that can assist you with 
determining which closing files have final policies that have not yet been 
prepared, as well as those files where the final policies have been prepared, 
but have not yet been sent to the underwriter.

5. The Serialized Forms Electronic Delivery report is similar to the 
existing Serialized Forms Report, but it lists all serialized forms that 
have been sent to The Fund electronically.

6. Reports can be emailed by selecting eSolutions > email.

7.  Click the Close 
button on the secondary 
toolbar.

The Report Selection module is closed.

What you Do Comments
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Utilities 

Concept
Utilities consists of four parts; Database Backup, Closing File Copy, Closing 
File Delete and Closing Documents Delete. Using the Database Backup
utility will create a back-up copy of your DoubleTime database and increase the 
efficiency of DoubleTime. You will receive a message to back up your files upon 
opening DoubleTime according to the number of days or number of files specified in 
Preferences > Office Settings. The Closing File Copy utility allows you to 
copy all or part of an existing file to a new closing file. This is very helpful when you 
are conducting multiple closings in the same subdivision or condominium. By creating 
a master closing file, you can include information such as buyers, sellers, conveyance 
clauses, title insurance commitment and policies, documents, properties, Settlement 
Statement fees, and other typically required information. You would then use the 
master closing file to copy information to new closing files. Use the Closing File 
Delete utility to permanently delete files from your database.The Closing 
Documents Delete utility deletes the Closing Documents for each closing file 
selected, which allows you to reuse space in your database for other files. This may 
improve system performance and save space on your hard drive.

Objective
The objective of this lesson is to familiarize you with the database backup utility. You 
will also create a master closing file, copy the master closing file, and delete closing 
files from your database.

Database Backup Utility
What you Do Comments

1. On the main menu, select 
Utilities, then Database 
Backup.

The DoubleTime Database Backup
window is displayed. The DoubleTime 
directory is located in drive c:\. It will be 
automatically selected to be backed-up, once 
the path has been selected. 
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2. Click the Browse button. The Path will change to the selected drive. 
Once this selection has been designated, it 
will remain as the default. 

3. Select the appropriate 
drive.

4. Click OK. (DO NOT 
CLICK OK WHILE IN 
TRAINING)

The database backup process begins. Once 
complete, the DoubleTime window is 
redisplayed.

5. Click Cancel.

Warning: It is necessary to use the Database Backup utility within 
DoubleTime even if your system uses other backup software, because it 
improves DoubleTime performance for all types of systems. For networks, most 
backup software does not back up the DoubleTime database. NOTE: The best 
practice is to back up to a physical drive other than your hard drive. For 
example, a mass storage device, a portable hard drive, or on the network of your 
computer system.

What you Do Comments
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Creating A Master Closing File
You will be the closing agent for Town & Country Properties, Inc. in the Bear Run I 
subdivision for other lots it did not sell to We Build Homes, LTD. These other lots 
were encumbered by a different loan from Palm Beach Banque that was not assumed 
by We Build Homes, LTD. You will create a master closing file to be copied later for 
each closing as they take place.

What you Do Comments

1.  On the main toolbar, 
click the New Closing 
File button.

The Closing File window is displayed with 
the General tab open. The Status defaults to 
Open, and the Type to Sale. These can be 
changed to Status - Closed, and Type - 
Refinance.

2. In the Closing File No.
box, type Bear Run I

This will set up a master closing file for Bear 
Run I subdivision closings.

3. Click the Account No. 
box and select 54321 
Prestige Bank.

This is the closing agent’s trust/escrow 
account used for all closings in Bear Run I.

4. Click the Seller tab. The Seller tab is displayed. No information is 
shown at this time. NOTE: We are skipping 
the Buyer tab, as we are setting up the master 
closing file for use with different buyers. 

5. On the secondary 
toolbar, click the Insert
button.

The Select Seller window is displayed. The 
Contact Type defaults to Individual. 

6. Click the Contact Type
box and select 
Corporation.
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7. Type town in the Name
box

8. Select Town & Country 
Properties, Inc. in the 
Name box and click OK.

Town & Country Properties, Inc. will be 
the seller/builder for Bear Run I.

9.  Click the Insert 
Name Clause button.

The Name(s) with Status window for 
Town & Country Properties, Inc. is 
displayed with the previously selected 
description of a Florida corporation
displayed in the Description box. 

10. Click OK. The Name(s) with Status window closes 
and the Seller tab displays with Town & 
Country Properties, Inc., a Florida 
corporation in the Name(s) with Status 
window. This is an editable field.

11. Click the Property tab.

What you Do Comments
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12. On the secondary 
toolbar, click the Insert
button.

13. Type bear in the Name
box

14. Select the Subdivision
option button and click 
Browse.

15. Select Bear Run I
subdivision and click OK.

The information from the Master Property
module for Bear Run I is copied to the 
master closing file.

16. On the secondary 
toolbar, click the Save 
button.

What you Do Comments
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17. On the secondary 
toolbar, click the Close
button.

The closing file information for the master file 
for Bear Run I is completed.

18.  Click Commitment
on the main toolbar.

The Commitment module is displayed. This 
selection will automatically be associated 
with the master closing file and will be copied 
along with the closing file information.

19. Click the Requirements
tab.

A requirement appearing on all the 
commitments for Bear Run I needs to be 
added.

20.  Click the Insert 
button on the secondary 
toolbar.

A blank line for another requirement is added.

21.  Click the Clause 
Library button on the 
secondary toolbar.

The Clause Library window opens.

22. Type satisfaction in the 
Search box, scroll down 
to GR-3.2, and select it. 

What you Do Comments
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23. Click OK. The clause is inserted in the blank 
requirements box.

What you Do Comments
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24. Replace the *** appearing 
in the Text box with the 
following

Town & Country 
Properties, Inc.
Palm Beach Banque
3429
1011
20010001011

25.  Click the Save button 
on the secondary toolbar.

The Commitment information you added to 
the master file is saved.

26.  Click the Close
button.

The Commitment module is closed. The 
common information is completed for this 
master file.

27.  Click the 
Documents button on the 
main toolbar.

The Documents module is displayed. This 
selection is used to add the documents that 
will be automatically added to each closing 
file for Bear Run I.

28. Click the New button. The Master Document Selection window 
opens.

What you Do Comments
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29. Select Basic-Sale from 
the Classification drop 
down list.

30. Select Closing Affidavit 
(Seller).

31. Hold the Ctrl key and 
select the FL Warranty 
Deed (Statutory Form) 
and the Non-Foreign 
Certification by Entity 
Transferor

These documents will be associated with the 
master closing file.

32. Click OK. The documents are saved in the master 
closing file and the Closing Document 
Selection window is redisplayed.

What you Do Comments
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Copying A Master Closing File

33. Click the Cancel button. The Documents module is closed.

NOTE: Any custom documents need to be 
opened in the Closing Document selection 
before copying the master file.

What you Do Comments
1. Select Utilities > 

Closing File Copy from 
the menu bar.

The Closing File Selection window is 
displayed. Closing File Number defaults to 
the active closing file.

What you Do Comments
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2. Press the Enter key. Pressing Enter activates the Browse button. 
Your current file is displayed and highlighted.

3. Press the Enter key again. Pressing Enter actives the OK button. The 
Closing File Copy window opens. The 
Existing File is the file you are copying 
from.

4. Click the New File box 
and type 04-2333

This is the new file you are creating.

5.  Click the Select All 
Tabs button on the 
secondary toolbar.

All the information from the existing file is 
selected across all tabs.

6.  Click the Copy File
button on the secondary 
toolbar.

All the information in the existing file is 
copied and saved under the new file name. 
The Closing File Copy window is closed. A 
message is displayed asking if you want to 
switch to closing file 04-2333.

What you Do Comments
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Guidelines For Copying Information From Tabs

7. Click Yes. 04-2333 is the active closing file.

8.  Click the Open 
Closing File button on 
the main toolbar.

The Closing File window is displayed for 
file number 04-2333. All data from your 
closing file has been copied to 04-2333.

9.  Click the Close
button on the secondary 
toolbar.

The Closing File module is closed.

Tab Comments
Closing File To copy only selected items, be sure to enter 

the closing file number for the New File on 
this tab before you initiate the copy function.

Policies If you select the Mortgagee Policy to copy, be 
sure you also copy the insured loan on the 
Loans tab.

Documents If you select Policy documents to copy, be 
sure you select the policies on the Policies
tab.

Properties If you select a property, the information from 
the Property tab in the Closing File 
module will be copied to the new closing file.

What you Do Comments
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Deleting A Closing File

NOTE: It is important to be consistent in the choices you make when you select 
items to copy. If you are copying a loan, then copy the mortgagee policy and 
mortgage documents. If you select commitments, policies, or endorsements on 
the Policies tab, then select them on the Documents tab, too. If you copy 
some items but not other related items in a file, such inconsistencies can carry 
over into later copies of files, where missing information may cause problems 
with the file.

What you Do Comments
1. Select Utilities > 

Closing File Delete
from the menu bar.

The Closing File Delete Selection
window is displayed. The active file is 
displayed in the Closing File Number box.

2. Press the Delete key on 
your keyboard

This will delete the file number from the field.

3. Click the Browse button. The listing of all the closing files in your 
DoubleTime database are displayed. 

Tab Comments
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4. Scroll down and select file 
99-0999.

5. Hold the Ctrl key and 
select file 99-0997.

The two files you want to delete are 
highlighted.

6. Click OK. The Warning window is displayed.

What you Do Comments
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Deleting Closing Documents 

7. Click Yes. The deletion process begins. NOTE: To stop 
the deletion process, click the Stop button. 
The deletion process will stop after the file 
currently being deleted is completed. When 
completed, the Closing File Delete Status
dialog box is displayed with the total number 
of files deleted.

8. Click OK. The Closing File Delete window is closed.

What you Do Comments
1. Select Utilities > 

Closing Documents 
Delete from the menu bar.

The Closing Documents Delete 
Selection window is displayed. The active 
file is displayed in the Closing File 
Number box.

What you Do Comments
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2. Press the Delete key on 
your keyboard.

This will delete the file number from the field.

3. Click the Browse button. The listing of all the closing files in your 
DoubleTime database are displayed. 

What you Do Comments
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4. Click on the first file you 
created (Example: John1)

5. Click OK. The Warning window is displayed.

6. Click Yes. The deletion process begins. NOTE: To stop 
the deletion process, click the Stop button. 
The deletion process will stop after the file 
currently being deleted is completed. When 
completed, the Closing Documents 
Delete Status dialog box is displayed with 
the total number of files deleted.

7. Click OK. The Closing Documents Delete window 
is closed.
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Tips

1. On any of the Closing File Copy tabs, you can select 
individual items to copy by clicking each check box. Or, you 
can click the Select Current Tab button to copy all the data 
on the tab. You can copy one or more buyers, sellers, loans, 
policies, or documents.

2. Use the Clear Current Tab button in Closing File 
Copy to deselect all of the check boxes on the open tab.

3. Use the Select All Tabs button to select all the check 
boxes on all the tabs.

4. Use the Copy File button to initiate the copy function 
after making your copy selections.

5. You can create Master Files for different closing scenarios like 
Cash HUD, Financing CD, Seller Docs Only file.

6. You must open custom documents in order for the copy feature 
to work.

Frequently Asked Questions
Question Answer

1. Why should I create 
backup files?

To both guard against data loss and improve 
system performance, it is important to create 
backups for your files.

2. Why would I use the 
Database Backup if my 
network’s backed up every 
night?

Most network software does not back up the 
DoubleTime database. Additionally, using this 
utility can improve DoubleTime performance 
for all types of systems
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3. How do I create backup 
files?

Using Windows Explorer, create a separate 
directory for the backup files on a different or 
separate physical drive (for example, 
DTBackup) with folders for each day of the 
week (for example, Monday—Friday). In 
DoubleTime, click Utilities and Database 
Backup. Specify the drive and path for the 
backup files.

4. When should I create 
backup files?

As a rule, you should back up your files at the 
end of each day or week. Be careful not to 
overwrite old backup files in case you 
discover the need to restore a file from an 
older backup

5. What if I forget to create 
backup files?

DoubleTime can remind you to create 
backups. Go to Preferences, click Office 
Settings and then Backup. Type the 
number of days or number of new closing 
files after which you’d like DoubleTime to 
prompt you to create a backup.

Question Answer
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Additional Features And Modules
Additional Features And Modules

Introduction
The following additional modules and features are covered in this section of the 
DoubleTime Workbook:

• Advanced Rating
• Settlement Statements For RESPA Transactions
• Import Fund Data File
• eSolutions Electronic Payment
• Serialized Forms module/Create Forms Inventory
• Forms Tracking module
• Run Tutorial
• Checklist module
• Schedule Closing module/Closing Meeting.
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Advanced Rating

Concept
Use the Premium Calculation (Rating) module to calculate the rates and charged 
amounts for title insurance policies/endorsements. The amount to be submitted to the 
underwriter is also calculated. Advanced Rating is composed of the following:

• Mortgage Modification Rate 
• Substitution Loan Rate

Objective
The objective of this lesson is to show you how to calculate a Mortgage Modification 
Rates and/ or Substitution Loan Rates. 

Mortgage Modification

Transaction Information
A loan policy is issued on June 15, 2008 insuring a mortgage in the amount of 
$400,000.00, which matures in 2039. On March 10, 2012, when the unpaid principal 
balance is $300,000.00, the mortgagor and mortgagee execute a mortgage 
modification agreement which:

• Shortens the maturity date on the note from 2039 to 2036. 
• Amends the release price formula to require a larger principal payment for 

releases of portions of the secured property.

Creating A New Closing File
You will create a new closing file establishing the parties involved, along with the 
property and loan information.

What You Do Comments

1.  On the main toolbar, 
click the New Closing 
File button.

The General tab of the Closing File
window is displayed. The Status box 
defaults to Open. You can change this value 
to Cancelled or Closed. The Type box 
defaults to Sale. You can change this value to 
Refinance. In the Dates section, the 
Opened box defaults to today’s date and 
cannot be changed.
Training Workbook: August 2018 Page 537



Advanced Rating
2. In the Closing File No.
box, type Mortgage Mod.

You assign a number to the new file. You can 
type up to 15 characters, letters, numbers, and 
some symbols.  NOTE: The closing file 
number allows you to search for a file by the 
number or name you assign.

3. Click the Type box and 
select Refinance.

Must be selected in order for the Rating 
Type field to be enabled. When Refinance
is selected DoubleTime will grey out tabs that 
are not necessary to a refinance transaction, 
like the Seller tab.

4. Click the Account No.
box and select 123456-78 
Friendly Bankers, Inc.

This is the closing agent’s trust/escrow 
account. Account numbers are entered in 
Preferences/Account Maintenance. 
Selecting the trust/escrow account allows you 
to export the deposits and disbursements to 
Quicken®, QuickBooks®, Dapix®, and Perfect 
Practice®. Selecting the trust/escrow account 
will also allow you to post or post and print 
your checks through the DoubleTime Escrow 
Accounting feature.
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5. In the Dates section, click 
the down arrow to the 
right of the Closing box.

The monthly calendar is displayed with 
today’s date selected. Click the right arrow
to display the next month. Click the left 
arrow to display the previous month.      

6. Click the appropriate 
arrow at the top of the 
calendar to display March.

Transaction closing will take place in March.

7. Click on day 10 in the 
calendar.

The selected date is displayed in the Closing, 
Disbursement, and Proration boxes. 
These dates are editable. Taxes Paid Thru
date defaults to 12/31 of the previous year, 
except during the month of December, when it 
defaults to 12/31 of the closing date year.

8. Click the Rating Type
field and select Mortgage 
Modification.

This will enable the Mortgage 
Modification Rating Worksheet in the 
Policy Module and Premium 
Calculation (Rating) Module

9. Click the Borrower tab. The Borrower tab is displayed. No 
information is shown at this time.

10.  On the secondary 
toolbar, click the Insert
button.

The Select Buyer window is displayed. The 
Contact Type defaults to Individual.

11. In the Last box, type 
Booker.

Frederick Booker is highlighted in the 
Individual Name list. Names are listed in 
alphabetical order.

12.  Click OK NOTE: Names that were previously entered 
are displayed in the Individual Name box.

NOTE: Gender and Marital status is 
populated for you. 

What You Do Comments
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13.  On the secondary 
toolbar, click the Insert 
Name Clause button.

The Name Clause window for Frederick 
Booker is displayed. It is necessary to 
complete the Name(s) with Status box for 
Frederick Booker for his name to display 
on other modules and on documents. 

NOTE: If the Name(s) with Status box is 
not completed, a message will display a 
reminder to complete this information when a 
save is initiated.

14. Click the Format box, and 
select single man.

The tenancy phrase, Frederick Booker, a 
single man is displayed in the Name(s) 
with Status box. This is an editable field. 
NOTE: This tenancy phrase is used in other 
modules and on your documents. It can be 
edited.

15. Click OK. The Name Clause window closes and the 
Buyer tab is displayed with the tenancy 
clause in the Name(s) with Status box. 
This is an editable field. 

16. Click the Property tab. The Property tab is displayed. No 
information is shown at this time.

What You Do Comments
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17. On the secondary 
toolbar, click the Insert
button.

The Master Property Search Selection 
window is displayed. The State and County 
default to Florida and Orange.  NOTE: The 
county default can be changed in 
Preferences > User Settings > General 
tab.

18. In the Required section, 
click Subdivision.

This selection will reference subdivisions 
only.

What You Do Comments
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19. Click Browse. This will display all previously entered 
subdivisions in the Master Property 
module. To display specific subdivisions, 
click the Name box and type the name, or a 
portion of the name, of the subdivision desired 
and click Browse.

20. Select Bermuda Bay and 
click OK.

The Master Property Search Selection
window is closed and the Property tab is 
redisplayed with previously entered 
information.

21. Replace the asterisks in the 
PIN box with 00040.

This will complete the Property Identification 
Number for the property. This number is 
assigned to the property by the property 
appraiser’s office.

22. Click the Address tab and 
in the Street box type 
1234 Anywhere Street
from the drop down list.

23. Tab to the Postal Code
field and type 32820

City, County and State fields will 
autopopulate when most postal codes are 
entered. 

24. Click the Details tab. The Details tab is displayed.

25. In the Lot box, type 4. Type information on this tab to allow 
searching for an existing closing file by lot, 
block, unit, and/or building number in the 
Closing File Selection window next time 
you need to access this file.

26. Click the Legal tab. The Legal tab is displayed with the 
previously entered legal for Bermuda Bay 
Subdivision.

27. Replace the asterisks in the 
Legal Description box  
with 4.

This is the lot number for the property.

28. Click the Usage tab. The Usage tab is displayed. NOTE: The 
Improvement Description box is used to 
identify any improvements to the property, 
such as a building being constructed on vacant 
land. It is an informational field only.
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29. Click the Usage arrow 
and select Single Family 
Dwelling.

NOTE: For Miami-Dade County: Selecting 
Single Family Dwelling in the Usage tab 
eliminates any calculations on the Settlement 
Statement regarding documentary stamp 
surtax.

30. Click the Remarks tab. The Remarks tab is displayed with 
previously entered information from the 
Master Property module, such as HOA 
contact information. This is an editable field.
NOTE: Use the Declaration tab when 
preparing loan documents to enter the 
Declaration information for the PUD Rider.

31. Click the Recording tab. The property, Bermuda Bay, is recorded in a 
plat. This information also flows to the 
Closing File Worksheet. This is an 
editable field.

32. Click the Loan tab. The Loan tab is displayed. No information is 
shown at this time
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33. On the secondary 
toolbar, click the Insert
button.

The Select Lender window is displayed. 
The Contact Type defaults to 
Corporation. Service Provided defaults 
to Lender. 

34. Select Bank of Florida
and click OK.

The Select Lender window is closed and 
the Loans tab is redisplayed with Bank of 
Florida added to the closing file.

35. Click the Status box and 
select Modification.

This will denote a modification loan.

36. Click the Priority box and 
select First.

This will denote a first mortgage.

37. Click the Type box and 
select Conv. Unins.

This will denote a conventional uninsured 
mortgage.

What You Do Comments
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38. Click the Terms tab. The Terms tab is displayed. The Interest 
Method defaults to 360.

39. Type 14583 in the Loan 
No. box.

This is the loan number given by the lender 
for this mortgage.

40. Type 8.375 in the Rate
box.

41. Click the Title Agent tab 
and verify Richard P. 
Bruce as the Signatory.

The Title Agent tab is displayed. The 
Company defaults to Richard P. Bruce, 
Esq. This identifies the person to sign the 
documents.

42. Verify Old Republic 
National Title 
Insurance Company/
ATFS as the 
Underwriter.

To use the Electronic Delivery process with 
Advanced Rating, the underwriter for both the 
Mortgage Modification and the Original Loan 
must be Old Republic National Title 
Insurance Company/ATFS, if it is not, a 
new rating worksheet must be faxed to the 
Finance Customer Department with the new 
underwriter. Fax No.:(407)241-8685
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Preparing A Mortgage Modification Endorsement

43. Click the Prepared by 
tab and verify Richard P. 
Bruce as the Individual.

The Prepared by tab is displayed. The 
Company defaults to Richard P. Bruce, 
Esq. This identifies the person preparing the 
documents. The information will appear on 
recordable documents in the Prepared by 
and Return to sections. NOTE: If you are 
not changing the selections previously made 
in Preferences/User Settings, accessing 
the Closing Agent, Title Agent, and 
Prepared by tabs is not required.

44. On the secondary 
toolbar, click the Close
button. Click Yes to save 
changes.

The Closing File module is closed. 
NOTE: A save is initiated each time a move is 
made to another tab. When closing a module, 
if a save has not been made, a message is 
displayed asking to save changes.

What you Do Comments

1. On the main toolbar, 
click the Policy button.

Mortgage Modification Worksheet is 
displayed.

What You Do Comments
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2. In the Endorsing Policy 
Type field select 
Mortgage Policy (MF6).

You may also select Mortgagee Short 
Form Policy (SF6)

3. Tab to the Original 
Effective Date field and 
type 061508.

4. Tab to the at field and type 
0415p.

5. Tab to the Endorsing 
Policy # field and type 
2004545.

6. Tab to the Original 
Amount Of Insurance
field and type 400000.
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7. Click option I 
Modification Which 
Changes The Terms, 
Conditions, Priority, Or 
Securities Other Than 
The Ones Permitted 
Under Rule 690-
186.005(13).

NOTE: You may select options I, II and III 
together but not option I, II, III, and IV. 
Option IV can only be selected individually.

8. In the Unpaid Principal 
Balance of Loan type 
300000.

9. Tab to the New Effective 
Date field and type 
031112.

10. Select the Endorse Mtg
tab.

11. On the secondary 
toolbar, click the Insert
button.

This will add a drop drown selection menu 
allowing you to select the required 
endorsement. 

12. In the Policy 
Endorsements Type
select General 
Endorsement.

This is a required endorsement when working 
with a Mortgage Modification. This 
endorsement must be selected for the 
calculations to take place. 

13.  Place the curser in the 

Text field and  Click 
the Clause Library
button on the secondary 
toolbar.

The Text field is an editable field. 

The Clause Library window is displayed 
with clause titles and text. The Clause Type
defaults to Endorsement and All Clauses
are automatically displayed. 

14.  Select the 06 ALTA 11 
Mortgage Modification
clause and click OK.

When a Clause Title is selected, the clause 
text is displayed in the Clause Text box.

15.  Replace the asterisks with 
March 10, 2012 and 
March 11, 2012.

This information is gathered from our 
example.
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Rating A Modification Mortgagee Policy/Endorsement

16. On the secondary 
toolbar, click the Close
button. Click Yes to save 
changes.

NOTE: A save is initiated each time a move is 
made to another tab. When closing a module, 
if a save has not been made, a message is 
displayed asking to save changes.

What you Do Comments
1. Click the Premium 

Calculation (Rating)
button on the main tool bar.

Rating Information Type reflects 
Mortgage Modification.
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2. Select the Worksheet tab. The Mortgage Modification Rating 
Worksheet is displayed.

3. Click the Print button on 
the secondary toolbar.

The Print Options window opens

4. Click OK. The Mortgage Modification Rating 
Worksheet prints.

5. On the secondary 
toolbar, click the Close
button. 

The Premium Calculation (Rating) save 
dialog box is displayed. 
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Substitution Loan

Transaction Information
On March 17, 2012, a substitution loan policy is being issued for $1,120,000.00. The 
original loan has been paid down to $1,084,000.00 and had an effective date of July 
15, 2008. (The lender wants an 06 ALTA 9 REM endorsement on the substitution loan 
policy.) 

• Calculate the premium and Old Republic’s share for the unpaid principal 
balance of $1,084,000.00.

Creating A New Closing File
You will create a new closing file establishing the parties involved, along with the 
property and loan information.

What You Do Comments

1.  On the main toolbar, 
click the New Closing 
File button.

The General tab of the Closing File
window is displayed. The Status box 
defaults to Open. You can change this value 
to Closed and Cancelled. The Type box 
defaults to Sale. You can change this value to 
Refinance. In the Dates section, the 
Opened box defaults to today’s date and 
cannot be changed.

2. In the Closing File No.
box, type Sub Loan.

You assign a number to the new file. You can 
type up to 15 characters, letters, numbers, and 
some symbols. NOTE: The closing file 
number allows you to search for a file by the 
number or name you assign.
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3. Click the Type box and 
select Refinance.

Must be selected in order for the Rating 
Type field to be enabled. 

4. Click the Account No.
box and select 123456-78 
Friendly Bankers, Inc.

This is the closing agent’s trust/escrow 
account. Account numbers are entered in 
Preferences/Account Maintenance. 
Selecting the trust/escrow account allows you 
to export the deposits and disbursements to 
Quicken®, QuickBooks®, Dapix®, and Perfect 
Practice®. Selecting the trust/escrow account 
will also allow you to post or post and print 
your checks through the DoubleTime Escrow 
Accounting feature.

5. In the Dates section, click 
the down arrow to the 
right of the Closing box.

The monthly calendar is displayed with 
today’s date selected. Click the right arrow
to display the next month. Click the left 
arrow to display the previous month.      

6. Click the appropriate 
arrow at the top of the 
calendar to display March.

Transaction closing will take place in March.

7. Click on day 17 in the 
calendar.

The selected date is displayed in the Closing, 
Disbursement, and Proration boxes. 
These dates are editable. Taxes Paid Thru
date defaults to 12/31 of the previous year, 
except during the month of December, when it 
defaults to 12/31 of the closing date year.

8. Click the Rating Type
filed and select 
Substitution Loan.

This will enable the Substitution Loan 
Rating Worksheet in the Premium 
Calculation (Rating) Module

What You Do Comments
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9. Click the Borrower tab. The Borrower tab is displayed. No 
information is shown at this time.

10.  On the secondary 
toolbar, click the Insert
button.

The Select Buyer window is displayed. The 
Contact Type defaults to Individual.

11. In the Last box, type 
Booker.

Frederick Booker is highlighted in the 
Individual Name list. Names are listed in 
alphabetical order.

12.  Click OK NOTE: Names that were previously entered 
are displayed in the Individual Name box.

NOTE: Gender and Marital status is 
populated for you. 

13.  On the secondary 
toolbar, click the Insert 
Name Clause button.

The Name Clause window for Frederick 
Booker is displayed. It is necessary to 
complete the Name(s) with Status box for 
Frederick Booker for his name to display 
on other modules and on documents. 
NOTE: If the Name(s) with Status box is 
not completed, a message will display a 
reminder to complete this information when a 
save is initiated.
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14. Click the Format box, and 
select single man.

The tenancy phrase, Frederick Booker, a 
single man is displayed in the Name(s) 
with Status box. This is an editable field. 
NOTE: This tenancy phrase is used in other 
modules and on your documents. It can be 
edited.

15. Click OK. The Name Clause window closes and the 
Buyer tab is displayed with the tenancy 
clause in the Name(s) with Status box. 
This is an editable field. 

16. Click the Property tab. The Property tab is displayed. No 
information is shown at this time.
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17. On the secondary 
toolbar, click the Insert
button.

The Master Property Search Selection 
window is displayed. The State and County 
default to Florida and Orange. NOTE: The 
county default can be changed in 
Preferences > User Settings > General 
tab.

18. In the Required section, 
click Subdivision.

This selection will reference subdivisions 
only.

19. Click Browse. This will display all previously entered 
subdivisions in the Master Property 
module. To display specific subdivisions, 
click the Name box and type the name, or a 
portion of the name, of the subdivision desired 
and click Browse.

20. Select Bermuda Bay and 
click OK.

The Master Property Search Selection
window is closed and the Property tab is 
redisplayed with previously entered 
information.

21. Replace the asterisks in the 
PIN box with 00040.

This will complete the Property Identification 
Number for the property. This number is 
assigned to the property by the property 
appraiser’s office.
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22. Click the Address tab and 
in the Street box type 
1234 Anywhere Street
from the drop down list.

23. Tab to the Postal Code
field and type 32820

City, County and State fields will auto 
populate when most postal codes are entered. 

24. Click the Details tab. The Details tab is displayed.

25. In the Lot box, type 4. Type information on this tab to allow 
searching for an existing closing file by lot, 
block, unit, and/or building number in the 
Closing File Selection window next time 
you need to access this file.

26. Click the Legal tab. The Legal tab is displayed with the 
previously entered legal for Bermuda Bay 
Subdivision.

27. Replace the asterisks in the 
Legal Description box  
with 4.

This is the lot number for the property.

28. Click the Usage tab. The Usage tab is displayed. NOTE: The 
Improvement Description box is used to 
identify any improvements to the property, 
such as a building being constructed on vacant 
land. It is an informational field only.

29. Click the Usage arrow 
and select Single Family 
Dwelling.

NOTE: For Miami-Dade County: Selecting 
Single Family Dwelling in the Usage tab 
eliminates any calculations on the Settlement 
Statement regarding documentary stamp 
surtax.
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30. Click the Remarks tab. The Remarks tab is displayed with 
previously entered information from the 
Master Property module, such as HOA 
contact information. This is an editable field.
NOTE: Use the Declaration tab when 
preparing loan documents to enter the 
Declaration information for the PUD Rider.

31. Click the Recording tab. The Recording tab is displayed with 
previously entered information from the 
Master Property module. The property, 
Bermuda Bay, is recorded in a plat. This 
information also flows to the Closing File 
Worksheet. This is an editable field.

32. Click the Loan tab. The Loan tab is displayed. No information is 
shown at this time
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33. On the secondary 
toolbar, click the Insert
button.

The Select Lender window is displayed. 
The Contact Type defaults to 
Corporation. Service Provided defaults 
to Lender. 

34. Select Bank of Florida
and click OK.

The Select Lender window is closed and 
the Loans tab is redisplayed with Bank of 
Florida added to the closing file. 
NOTE: Only one New, Assumption, or 
Modification, can be added for Substitution 
Loan files. 

35. Click the Status box and 
select New.

This will denote a Substitution loan.

36. Click the Priority box and 
select First.

This will denote a first mortgage.

37. Click the Type box and 
select Conv. Unins.

This will denote a conventional uninsured 
mortgage.

38. Click the Original Loan 
Amount box and type 
1120000.

This is the principal mortgage amount of the 
new substitution loan. The comma and 
decimal point are automatically inserted.

39. Click the Terms tab. The Terms tab is displayed. The Interest 
Method defaults to 360.

40. Type 14583 in the Loan 
No. box.

This is the loan number given by the lender 
for this mortgage.
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41. Type 8.375 in the Rate
box.

42. Click the Title Agent tab 
and verify Richard P. 
Bruce as the Signatory.

The Title Agent tab is displayed. The 
Company defaults to Richard P. Bruce, 
Esq. This identifies the person to sign the 
documents.

43. Verify Old Republic 
National Title 
Insurance Company/
ATFS as the 
Underwriter.

To use the Electronic Delivery process with 
Advanced Rating, the underwriter for the 
Substitution Loan must be Old Republic 
National Title Insurance Company/
ATFS, if it is not, a new rating worksheet 
must be faxed to the Finance Customer 
Department with the new underwriter. Fax 
No.: (407)241-8685

44. Click the Prepared by 
tab and verify Richard P. 
Bruce as the Individual.

The Prepared by tab is displayed. The 
Company defaults to Richard P. Bruce, 
Esq. This identifies the person preparing the 
documents. The information will appear on 
recordable documents in the Prepared by 
and Return to sections. NOTE: If you are 
not changing the selections previously made 
in Preferences/User Settings, accessing 
the Closing Agent, Title Agent, and 
Prepared by tabs is not required.

45. On the secondary 
toolbar, click the Close
button and click Yes to 
Save changes.

The Closing File module is closed. 
NOTE: A save is initiated each time a move is 
made to another tab. When closing a module, 
if a save has not been made, a message is 
displayed asking to save changes.
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Adding A Mortgagee Title Insurance Policy
In this session, you will enable and prepare the Mortgage Policy for your closing file. 

What You Do Comments

1.  Click the 
Commitment button on 
the main toolbar.

The Title Insurance Commitment
window is displayed. The Template defaults 
to FUND Commitment (CF6R); 
Signatory to Richard P. Bruce, and Issue 
Date to today’s date. These are editable 
fields. 
Depending on the underwriter selected, the 
Commitment No. box may or may not be 
available. For underwriters such as Old 
Republic/ATFS, the field will be unavailable 
because its commitment jackets are not 
serialized. For underwriters whose 
commitment jackets are serialized, the 
Commitment No. box will contain a list of 
unused commitment numbers previously 
entered in DoubleTime. Scroll down if 
necessary to select the correct number. 
Selecting a commitment number associates a 
paper serialized jacket to this closing file. 
NOTE: Form numbers are entered by 
selecting Modules > Serialized Forms > 
Create Forms Inventory from the main 
menu.
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2. Type 0301(current year)
in the Effective Date
box.

This reflects the date through which title was 
searched and examined. NOTE: The time 
defaults to 11:00 PM. You must press the 
Tab key to access this field if the time needs 
to be changed. The issue date is the date the 
commitment was prepared.

3. Click the Mortgagee tab. The Mortgagee tab is displayed. The 
Lender defaults to Bank of Florida with a 
Priority of 1st and a Loan Amount of 
$1,120,000. This information is carried over 
from the Closing File module.

4. Click the Policy 
Required check box.

A check mark is displayed in the box, 
indicating that a mortgagee policy is required. 
The amount of insurance and the lender name 
are carried over from the Closing File
module. The Policy Type defaults to 
Mortgagee Policy (MF6) and Template
defaults to FUND 06 Mortgagee Policy 
(MF6).

What You Do Comments
Training Workbook: August 2018 Page 561



Advanced Rating
Adding Endorsements

5. In the Name of Insured 
box, place the cursor at the 
end of Bank of Florida. 

The initial click within this box activates the 
cursor. A second click after Bank of Florida is 
necessary to activate its proper location. To 
include the additional information required by 
the lender.

6.  Click the Clause 
Library button on the 
secondary toolbar.

The Clause Library window is displayed 
with clause titles and text. The Clause Type
defaults to Lender Name and All Clauses
are automatically selected. NOTE: When a
Clause Title is selected, the clause text is 
displayed in the Clause Text box

7. With the Conventional 
clause highlighted, click 
OK.

The Clause Library window is closed and 
the Conventional Clause is added to the 
Bank of Florida. This information is 
editable.

8. On the secondary 
toolbar, click the Close
button. Click Yes to Save 
changes.

The Commitment module is closed. 
NOTE: A save is initiated each time a move is 
made to another tab. When closing a module, 
if a save has not been made, a message is 
displayed asking to save changes.

What you Do Comments

1. On the main toolbar, 
click the Policy button.

The Mortgagee tab is displayed. The 
Lender defaults to Bank of Florida with a 
Priority of 1st and a Loan Amount of 
$1,120,000. This information is carried over 
from the Closing File module.

2. Select the Endorse Mtg
tab.

3. In the Policy 
Endorsements Type 
field select 06 ALTA 9 
REM.

In our example the lender is requesting an 06 
ALTA 9 REM.   NOTE: Endorsements may 
also be selected in the Commitment 
Module.

What You Do Comments
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Rating A Substitution Loan Policy/Endorsement

4. Click the Issued With 
Original check box next to 
the 06 ALTA 9 REM
endorsement.

When using an endorsement that was 
previously used in the original policy, make 
sure to click the Issued With Original
check box. This will ensure that the correct 
amount is calculated.

5. On the secondary 
toolbar, click the Close
button. Click Yes to Save 
changes.

NOTE: A save is initiated each time a move is 
made to another tab. When closing a module, 
if a save has not been made, a message is 
displayed asking to save changes.

What you Do Comments

1.  On the main toolbar, 
click the Premium 
Calculation (Rating) 
button.

A Premium Calculation (Rating) 
message appears alerting you that your file is 
incomplete. Users need to complete the 
Original Policy fields on the Policy Tab of 
the Policy module.
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2. Click OK. Rating Information Type reflects 
Substitution Loan.   NOTE: Policies over 
$1 Million are typically rated as Non 1-4 
Residential. Click Yes if you would like 
DoubleTime to automatically deselect the 1-4 
Residential indicator. 

3. Click No.

4. Select the Policies tab. The Policies tab is displayed.

5. Click the Policy Number 
field and type 8126598.

You must enter the Original Mortgagee Policy 
information prior to receiving the calculated 
Substitution rate.

6. Click the Effective Date 
field and type 071509.

You must enter the Original Mortgagee Policy 
information prior to receiving the calculated 
Substitution rate.

7. Click the Unpaid 
Principal Balance field 
and type 1084000.

You must enter the Original Mortgagee Policy 
information prior to receiving the calculated 
Substitution rate.
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8. Select the Worksheet tab. The Substitution Loan Rating 
Worksheet is displayed.

9. Click the Print button on 
the secondary toolbar.

The Print Options window opens

10. Click OK. The Substitution Loan Rating 
Worksheet prints.

11. On the secondary 
toolbar, click the Close
button. 

The Premium Calculation (Rating) save 
dialog box is displayed. 
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Tips

1. On a new Substitution Loan where a New Policy is $250k or more, and the 
previous Mortgagee Policy is from a different underwriter, that previous 
policy must be e-mailed to finance-customer-service@thefund.com or faxed 
to (407) 241-8685.

2. In the case where the unpaid principal balance is $250k or more, any lender 
can make a substitution loan with the same borrower on the same property 
and the special rate shall apply.

3. If the new lenders are different and the unpaid principal balance is less than 
$250k, the original rates shall apply.
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Settlement Statements Using a GFE HUD

Concept
The Settlement Statements module automates and speeds the preparation of the 
GFE HUD and other settlement statements including the former two-page HUD-1 
which remains available to DoubleTime users. Data entry is minimized because much 
of the information necessary for completion has already been entered in other 
modules, such as Closing File. The calculations are automatically performed and the 
repetitious typing of numbers is eliminated. The Settlement Statements module is 
flexible in that information can be entered as you receive it or you can complete the 
entire Settlement Statement at one time. You can view the tabs, which are in the same 
sequence as GFE HUD sections, and enter information in any order. In addition to the 
GFE HUD Settlement Statement, there are a variety of forms that can be printed in the 
Settlement Statements module such as Borrower’s Closing Statement,
Seller’s Closing Statement, Loan Closing Statement, Proration 
Worksheet, and Recording Worksheet. These statements and worksheets can 
also be emailed.

Objective
The objective of this lesson is to show you how to use the Settlement Statements
module to complete a GFE HUD Settlement Statement and then how to print the 
completed statement.

Verifying Amounts Due To And Paid By Seller
What You Do Comments

1. On the main toolbar, 
click the Switch Active 
Closing File button. 

A co-worker started this file. They have added 
the Buyer, Seller, Lender and Property. We are 
completing the GFE HUD for them. The 
Closing File Selection window is 
displayed. This window allows you to switch 
the active file to a different closing file 
established within DoubleTime. 
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2. Type 04-0045 in the 
Closing File Number 
box.

3. Click Browse.

4. Click OK.

What You Do Comments
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5. Click the Settlement 
Statements button on the 
main toolbar.

The Update Recording Charges dialog 
box is displayed listing the calculated values 
for the documentary stamps on the deed and 
note, and the intangible tax on the mortgage 
based on the sales price and purchase price. 
DoubleTime uses the appropriate charges 
based on the county in which the property is 
located.

This dialog box is used to update the Old 
Amount with the New Amount. 

NOTE: DoubleTime defaults to the three page 
GFE HUD if a new loan was entered on the 
Loans tab of the Closing File module. To 
manually toggle between the GFE HUD, 
Closing Disclosure and the former two-page 
HUD-1 use the GFE HUD check box on the 
Loans tab of the Closing File module. The 
appropriate type of settlement statement 
should be chosen before any information/data 
is entered in the Settlement Statements
module. Switching the settlement statement 
type after entering data in the Settlement 
Statements module will result in that data 
being lost. However the data that carries over 
into the Settlement Statements module 
from other modules will not be lost.
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6. Click Yes. The Update Recording Charges dialog 
box closes and the Settlement Statements
window displays with the General tab open. 
The module’s title bar displays the file name 
and indicates when a GFE HUD settlement 
statement was selected in the Closing File
module. On the General tab, you can view 
the top portion of page 1 of the GFE HUD 
settlement statement, sections A through I. 
These sections contain loan information, the 
names of the parties, and property and 
settlement information. Use the Closing File
module to change the displayed information 
or to change the type of settlement statement.

Notice that a Tax ID Number or Social 
Security Number is not displayed here for the 
Borrower or Seller. This is the standard format 
for the GFE-HUD and cannot be changed. 

7. Position the cursor over the 
Seller Credits tab.

A brief description of the series purpose is 
displayed. 

What You Do Comments
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8. Click the Seller Credits
tab.

The Seller Credits tab, with the 100/400 
line series, displays showing the contract sales 
price (line 101/401), and the settlement 
charges to borrower (line 103). NOTE: On 
each tab of the Settlement Statement
module, the top half of the window is where 
you will select the line where you want 
information to appear. Once a line is selected, 
a work area is provided for the selected line in 
the bottom half of the window.

9. Double click the 
information symbol .

An information window specific to the current 
tab opens containing instructions taken from 
HUD’s Final Rule. This option is available on 
each tab when the GFE HUD format is 
selected.

What You Do Comments
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10. Click OK when done. The information window closes.

What You Do Comments
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Calculating Adjustments For Items Paid By Seller
What You Do Comments

1. Click the Adjustments - 
Paid tab.

The Adjustments - Paid tab, with the 106/
406 line series, is displayed. 

2. Select line 109/409. Selecting this line allows you to add a paid 
adjustment.

3. Click the Pro-rate check 
box in the work area.

Additional fields open for Line 109/409. The 
Date from defaults to the closing date. The 
Count last day box is automatically 
selected, crediting the day of the closing to the 
seller.

4. Select Association 
Maintenance from the 
Description drop down 
list.

This is the description of the payment by the 
seller that was paid in advance. This is an 
editable field.

5. Type 250 in the Gross 
amount box and press the 
Tab key.

This is the amount paid by the seller for 
Homeowner Association dues. 

6. Select Quarterly from the 
Period drop down list.

This will identify the amount as a quarterly 
payment. NOTE: TAB out of the Gross 
Amount box to activate the Period box.

7. Type 09/30/(current 
year) in the Date to box 
and press the Tab key.

Quarterly dues are prorated and displayed on 
lines 109/409.  NOTE: The Count last day
is automatically selected, crediting the day of 
the closing to the seller. 
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Viewing Buyer’s Credits & Calculating Seller’s Loan Payoff 
What You Do Comments

1. Click the Buyer Credits
tab.

The Buyer Credits tab, with the 200/500 
line series, displays showing the buyer’s 
deposit amount (line 201), and the new loan 
amount (line 202). NOTE: Additional lines 
can be inserted in this series from 209b
through 209g by selecting the Insert button 
on the secondary toolbar.

 NOTE: Click the Deposit Summary
button to view details of the deposit(s), or you 
may also double click on line 201 to view this 
information.

2. Position the cursor 

over line 504 and double-
click.

The Payoff Calculator opens. The 
information entered here is supplied by the 
payoff lender.
Page 574 DT Version: 8.1



Settlement Statements Using a GFE HUD
3. Type 0701(current year)
in the From Date box.

4. Type 0720(current year)
in the To Date box.

The payoff calculation includes several days 
of per diem interest after the closing date to 
allow for transmittal to and posting of funds 
by the payoff lender.

5. Type 43.32 in the Per 
Diem Amount box.

DoubleTime automatically calculates the 
Total Days. The Per Diem amount is 
supplied by the lender holding the mortgage.

6. Type 175675.66 in the 
Mortgage Balance box 
and press the Tab key.

The Mortgage Balance amount is supplied 
by the lender holding the mortgage. When you 
press the TAB key, the Total Payoff 
Amount is calculated.

7. Click Print. The Print Options window is displayed with 
All selected and number of copies defaults to 
1.

8. Click OK. The Payoff figures are printed and the Payoff 
Calculator is re-displayed.

What You Do Comments
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Calculating Adjustments For Items Unpaid By Seller

9. Click OK. The Settlement Statements - your file 
name - Payoff Calculator window closes 
and the Borrower Credits tab is redisplayed 
with the payoff balance on line 504 totaling 
176,542.06. NOTE:(1) The Description 
box is editable so you can show the payoff 
lender’s name. (2) The description for line 
507 defaults to “Deposit is being disbursed 
as proceeds” when the Closing Agent has 
been identified as the party holding the 
deposit in the Closing File module.

What You Do Comments
1. Click the Adjustments - 

Unpaid tab.
The Adjustments - Unpaid tab, showing 
line series 210/510, displays.

What You Do Comments
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2. Select line 211/511. Selecting this line allows you to calculate the 
unpaid county taxes.

3. Click the Pro-rate check 
box in the work area.

Additional fields open for Line 211/511. The 
Date from defaults to the first day of the 
current year. The Date to defaults to the 
closing date. The Period defaults to 
Annually, and can be changed if needed.

4. Type 3733.30 in the 
Gross Amount.

This is the amount of the property taxes for 
the entire year.

5.  Type 4 in the Discount 
percent box.

This is the maximum allowable discount 
which is determined by the Tax Collector’s 
office according to the month in which it is 
paid. 

6. Press the Tab key. DoubleTime calculates the prorated taxes. 
NOTE: The default setting for the Count 
last day box is unselected. 
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Calculating Items Payable In Connection With A Loan
What You Do Comments

1. Review the GFE issued to 
Fred Cowlings. (In your 
office you will use the 
lenders closing instructions 
to prepare loan fees)

The workspace for all sections of page two of 
the GFE HUD includes a GFE Tolerance
drop down list. Depending upon the 
tolerances allowed to a line, various selections 
may be available. Selecting Charge that is 
not associated with GFE, when available, 
enables dollar amounts to be entered inside 
the column for certain lines. DoubleTime 
determines where to place items in the tables 
on page 3 of the GFE HUD based on the GFE 
Tolerance selected for each item as it is 
entered on page 2 of the GFE HUD.

2. Click the Loan Fees tab. The Loan Fees tab showing the 800 line 
series displays. NOTE: In the 800 series the 
GFE Tolerance for lines 801, 802 and 803
have been predefined by the Final Rule and 
cannot be changed.
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3. Confirm line 801 is 
selected.

This line is for the lender’s origination charge. 
The descriptions for line 801 through 803
cannot be changed. The description for lines 
804 through 813 may be edited. 

NOTE: (1) The Veteran’s Administration has required that any VA Mortgages 
have the details of the origination charges noted. It is possible that other lenders 
may impose similar requirements. To accommodate this requirement, 
DoubleTime includes an Itemized Origination Fees and Charges 
Calculator accessible by double clicking on Line 801. The Tips section at the 
end of this chapter includes information about, and instructions on how to enter 
information into, the Itemized Origination Fees and Charges 
Calculator. (2) The Itemized Origination Fees and Charges Calculator
window contains a Print button. Clicking that button will generate the 801 
Origination Statement (which contains signature lines for the borrower). 

What You Do Comments
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4. Type 6000.00 in the 
Outside Clmn Amt box 
of the work area and press 
the Tab key.

The charge displays on line 801 outside the 
column and on line 803 inside the column. 
Line 803 is a roll up line (i.e. the sum of lines 
801 and 802) and the amount is listed inside 
the column. The net amount may be a positive 
number as low as zero, or in the case of a “No 
Cost Loan,” it may be a negative number.

5. Select line 802. This line is used to record the credit or charge 
(points) for the specific interest rate chosen.

6. Type -3000.00 in the 
Outside Clmn Amt box 
in the work area and press 
the Tab key.

This amount is listed outside the column on 
line 802 and automatically rolls up into line 
803.

What You Do Comments
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7. Select line 803. This is the difference between the original 
origination charge and the credit for the 
specific interest rate chosen. NOTE: The 
Payee for line 803 may be changed to a 
Mortgage Broker, the Lender, or left blank.

8.  Double click the 
Amount withheld box 
for the borrower.

The Your Adjusted Origination Charge
of $3,000.00 is displayed in the Amount 
withheld box. This charge will be withheld 
from the loan proceeds by the lender. The 
adjustment will be displayed on the Balance 
Sheet.

What You Do Comments
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9. Select line 804. Per the Final Rule, lines 804 through 811 are 
used for lender required settlement services in 
which the lender restricts selection of the 
service provider. The amounts on lines 804
through 811 are usually listed inside the 
column.  NOTE: (1) The default descriptions 
for lines 804-807 may be changed on the 
Loan Fees tab. They may also be changed 
on the GFE-HUD-1 Comparison tab, and 
the new description will then be carried over 
to the Loan Fees tab. (2) DoubleTime 
allows you to change the GFE Tolerance
category for lines 804-811. If Charge that 
cannot increase is selected, the amount is 
listed outside the column and is rolled up into 
line 801. If Charge that in total cannot 
increase more than 10% is selected the 
amount is listed in the column and may only 
be charged to the borrower. If Charge that 
is not associated with the GFE is 
selected the amount is listed in the column 
and may be charged to the borrower or seller.

10.  Click the Search 
Contact button on the 
secondary toolbar.

The Search Contact window opens. The 
Contact Type defaults to Corporation and 
the Service Provided to Appraiser.

NOTE: The Search Contact button is used 
to associate a contact with the Payee drop 
down list in the Settlement Statements
module. A new contact can be added or and 
existing contact can be chosen.
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11. Select Appraisers, Inc.
and click OK.

The Search Contact window closes and the 
Loan Fees tab is redisplayed. Appraisers, 
Inc. displays as the payee.

12. Type 250 in the P.O.C. 
amount box for the 
borrower and press the Tab
key. 

This charge was paid outside of closing 
(P.O.C.) and will be shown on the settlement 
statement when it is printed. NOTE: P.O.C. 
amounts are also shown in the Preview
mode.

13.  Select line 805.

14.   On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Credit Report.

15. Select Credit Bureau, 
Inc. and click OK.

The Search Contact window closes and the 
Loan Fees tab is redisplayed. Credit 
Bureau, Inc. displays as the payee.

16. Type 50 in the P.O.C. 
amount box for the 
borrower and press the Tab
key.

 

What You Do Comments
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Calculating Items Required By The Lender To Be Prepaid 
What You Do Comments

1. Click the Prepayments
tab.

The Prepayments tab showing the 900 line 
series displays. 

2. Confirm line 901 is 
selected.

NOTE: For some of the lines in the 900 series 
the GFE Tolerance Category has been 
predefined by the Final Rule and cannot be 
changed. The GFE Tolerance level is 
“Charge that can change”.

What You Do Comments
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3. Type 41.30 in the Per 
diem box and press the 
Tab key.

When the interest rate supplied by the lender 
was entered on the Loan tab of the Closing 
File module, DoubleTime automatically 
calculated the per diem rate as well as the total 
interest due from the closing date to the first 
day of the following month. The total amount 
of interest is displayed on line 901 inside the 
column, and the daily interest amount is 
displayed in the Per diem box.
NOTE:The amount in the Per diem box can 
be edited if necessary. For example, in our 
scenario the lender provided an amount 
different than the amount that DoubleTime 
calculated, so it must be edited. 

The Payee defaults to the lender, the From 
date defaults to the closing date, and the To 
date defaults to the first day of the following 
month. The dates can be changed if needed.

4. Select line 903. This line allows you to add homeowner’s 
insurance as required by the lender.

5. Type 1 in the Years box.
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6.  Click the Search 
Contact button on the 
secondary toolbar.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Insurance Comp.

7. Select Home Insurance, 
Inc. and click OK.

The Search Contact window closes. Home 
Insurance, Inc. is now displayed as the 
Payee.

8. Type 750 in the P.O.C. 
amount box for the 
borrower and press the Tab
key.

NOTE: The Policy no and Face amt boxes 
are not a part of the calculations for the 
insurance premiums and are not required.

9. Select line 904. This line allows you to add flood insurance as 
required by the lender.

10.  Type 1 in the Years box.

11.  Select Home Insurance, 
Inc. from the Payee drop 
down list.

Home Insurance, Inc. was previously 
associated with this closing file when we 
selected it as the payee for the homeowner’s 
insurance. NOTE: This illustrates how the
Search Contact button associates contacts 
with a closing file, making a contact available 
for selection in the drop down list.

12.  Type 325 in the P.O.C. 
amount box for the 
borrower and press the Tab
key.

The payee displays on line 904, and 
POC(B*) is automatically displayed in the 
POC box to indicate the Borrower paid this 
fee outside of closing.
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Calculating Reserves Deposited With The Lender
What You Do Comments

1. Click the Reserves tab. The Reserves tab showing the 1000 line 
series displays. NOTE: (1) The GFE 
Tolerance category for the 1000 series has 
been predefined by the Final Rule as “Charge 
that can change.” You cannot select another 
tolerance category for any line in this series. 
(2) Line 1001 is a roll up line (i.e. the sum of 
lines 1002 through 1009) and is listed inside 
the column. This line is not editable. The 
charges on line 1002 through 1009 are listed 
outside the column.
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2.  Select line 1002. This opens the work area allowing the 
homeowner’s insurance reserve to be entered. 

3. Type 2 in the No. Months
box and press the Tab key.

The Month Due defaults to the closing 
month of July. The amount is calculated based 
on the yearly figure entered on the 
Prepayments tab, and is charged to the 
borrower outside the column. NOTE: If you 
select another line or press Enter instead of 
pressing Tab, the calculated amount will also 
display on the appropriate line.

4. Select line 1004. This opens the work area allowing the county 
property tax reserves to be entered. 

What You Do Comments
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5. Type 3 in the No. Months
box and press the Tab key.

The monthly county tax amount is calculated 
and displayed in the Monthly $ box, with the 
total taxes paid by the borrower displayed 
outside the column on line 1004. This amount 
is displayed if you have entered the gross 
amount of county taxes for the proration on 
lines 211/511 or lines 107/407. If the 
monthly amount is not displayed, you can 
enter this information on the Adjustments - 
Unpaid or Adjustments - Paid tabs, as 
applicable, or type it in the work area for line 
1004. NOTE: The tax reserve is charged to 
the borrower. The taxes Month due defaults 
to November. This can be changed.

 Click the Calculator button on the 
secondary toolbar to figure the monthly 
amount when needed.

6. Select line 1005. This opens up the work area to enter the flood 
insurance reserve.

7. Type 2 in the No. Months
box and press the Tab key.

The flood insurance reserve is calculated and 
charged to the borrower outside the column on 
line 1005.

8.  Select line 1009.

9. Type -427.11 in the 
Outside Clmn Amt box
and press the Tab key.

The Aggregate accounting adjustment
figure is supplied by the lender. The amount is 
entered as a negative number because it is a 
credit used to reduce the reserves collected 
from the borrower.
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Adding Title Charges
What You Do Comments

1. Click the Title tab. The Title tab showing the 1100 line series is 
displayed. The Payee defaults to Richard P. 
Bruce, Esq. Line 1101 is a roll up line for 
borrower charges disclosed on the GFE for 
Title services and lender’s title 
insurance. It must always be greater than or 
equal to the sum of charges to the borrower 
shown outside of the columns on lines 1102, 
1104, and applicable lines 1109-1113. 
NOTE: In the 1100 series the GFE 
Tolerance Category has not been 
predefined by the Final Rule and can be 
changed as a function of whether or not the 
provider of this service was identified by the 
lender to the borrower. 
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2. Select line 1102. Mr. Bruce is charging a $250 settlement fee to 
the borrower. This fee will always be entered 
outside the column. This line should not be 
used for Attorney’s fees for services 
unconnected with conducting the settlement. 
NOTE: A Settlement Agent may charge a 
settlement fee on line 1102 to a borrower, a 
seller or both. Any charge to the seller will be 
entered inside the seller’s column only. Any 
charge to the borrower will be entered outside 
the column only. Charges to both the borrower 
and the seller will be entered individually, 
outside the column and inside the seller’s 
column respectively. 

3. Type 250 in the Outside 
Clmn Amt box and press 
the Tab key.

The settlement fee is listed outside the column 
on line 1102, and is rolled into the total on 
line 1101 in the column. 

What You Do Comments
Training Workbook: August 2018 Page 591



Settlement Statements Using a GFE HUD
4. Select line 1109. The description field defaults to Abstract or 
title search. The Florida Department of 
Financial Services requires title agents to 
itemize the abstract or title search fee charged. 
HUD requires the amount be charged to the 
borrower, shown outside the column and roll 
up into line 1101.

5. Type 150 in the Outside 
Clmn Amt box and press 
the Tab key.

Title Search fees should be shown outside the 
columns on line 1109 and must roll up into 
the total entered on line 1101. This 
transaction requires the seller to pay for the 
Title Search. Later in this workbook an 
adjusting entry will be made on page 1 of the 
GFE HUD.

6.  Click the Search 
Contacts button.

The Search Contacts window opens with 
Corporation as the default Contact Type.

7. Select LLC from the 
Contact Type drop down 
list.

8. Select ATFS, LLC and 
click OK.

ATFS, LLC is listed as the payee for 1109.
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9. Double click line 1101. The 1101 Title Services Calculator
opens. The details and dollar amounts 
previously entered on lines 1102, 1104, and 
1109 display on the first three lines. Other 
title charges can be added here, and will roll 
up into the total shown inside the column on 
line 1101.
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10. Click Insert three times. Three blank lines display allowing for 
additional charges to be added.

11. Type Federal Express in 
the first line under 
Additional Fee 
Description and press the 
Tab key.

12. Type 30 in the first line 
under Additional Fee 
Amt and press the Tab
key.

The $30 fee is added to the Sub-total for 
Additional Fees as well as the Line 1101 
amount.

13. Type eRecording in the 
second line under 
Additional Fee 
Description and press the 
Tab key.

14. Type 20 in the second line 
under Additional Fee 
Amt and press the Tab
key.

The $20 fee is added to the Sub-total for 
Additional Fees as well as the Line 1101 
amount.
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15. Type Incoming Bank 
Wire in the third line under 
Additional Fee 
Description and press the 
Tab key.

16. Type 25 in the third line 
under Additional Fee 
Amt and press the Tab
key.

The $25 fee is added to the Sub-total for 
Additional Fees as well as the Line 1101 
amount.

17. Click OK. The 1101 Title Services Calculator
window closes and the additional fees are 
added to the total displayed inside the column 
on line 1101. 
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NOTE: (1) HUD requires the borrower to be charged for the title search, 
documentary stamps on the deed, and owner’s title insurance even if the 
contract between the buyer and seller specifies otherwise. Page one GFE HUD 
adjustments will be made to conform the buyer/seller provisions of this 
transaction with HUD’s requirements later in the workbook. (2) Since the bank 
has identified Richard P. Bruce as a service provider for the borrower, the GFE 
Tolerance should be Charge that in total cannot increase more than 
10%. If the bank had not identified Mr. Bruce as a service provider, the 
tolerance would be Charge that can change. (3) The 1101 Title Services 
Calculator window contains a Print button. Clicking that button will generate 
the 1101 Itemization Report (which contains signature lines for the 
borrower). 
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18. Select line 1103. Regardless of the GFE Tolerance selected, 
the Final Rule requires the Borrower to be 
charged for the premium on the Owner’s 
Policy – even in counties in which the Seller 
customarily pays this charge. The contract for 
this transaction requires the Seller to pay for 
the Owner’s Title insurance policy, even 
though the Borrower has been charged 
according to the GFE. Later in this workbook, 
we will enter the adjusting entry on page one 
of the GFE HUD for this charge. NOTE: (1) 
If the charge for the Owner’s Policy is not 
included on the GFE, change the GFE 
Tolerance category to “Charge that is not 
associated with the GFE” and the dollar 
amount will automatically be moved to the 
Seller’s column. (2) DoubleTime itemizes and 
combines the premiums for endorsements 
with the premium for the appropriate policy.

19. Select line 1104. Regardless of the GFE Tolerance selected, 
the Final Rule requires the borrower to be 
charged for the premium for the mortgagee 
policy. This amount is shown outside of the 
column and rolls up into line 1101. 
NOTE: DoubleTime itemizes and combines 
the premiums for endorsements with the 
premium for the appropriate policy. 

20. Select line 1105 and then 
line 1106.

Lines 1105 and 1106 display the policies 
amounts and are not editable in the 
Settlement Statements module. NOTE: A 
preference in Office Settings is available to 
display Policy Reissue Discount on the 
HUD-1 for all applicable transactions. When 
this preference is selected, lines 1105 or 1106
(as applicable) will include the language 
Policy Reissue Discount and the 
difference between the original rate and the 
reissue rate will be shown.   
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21. Select line 1107 and then 
line 1108.

Lines 1107 and 1108 display the premium 
split between the agent and the underwriter 
and are not editable in the Settlement 
Statements module. NOTE: The Final Rule 
requires that the title insurance premium split 
be shown on RESPA transactions.

22. Select any line between 
1110 through 1113.

Imagine that Mr. and Mrs. Leblanc’s lawyer 
wants Mr. Bruce to include her legal fee as a 
charge to the seller to be paid at closing from 
the proceeds. In order to open the seller’s 
column for this charge, it is necessary to first 
select the GFE Tolerance of Charge that is 
not associated with the GFE.
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Calculating Government Recording & Transfer Charges
What You Do Comments

1. Click the Recording tab. The Recording tab showing the 1200 series 
displays. NOTE: (1) Line 1201 is a roll up 
line for the borrower’s recording charges. The 
amount on line 1201 must be listed inside the 
column. Line 1201 rolls up charges to the 
borrower associated with the GFE that are 
always entered at lines 1202, plus borrower 
charges that occasionally get entered outside 
the column at lines 1205 – 1208 for 
recording miscellaneous loan documents (e.g. 
power of attorney). (2) Regardless of the GFE 
Tolerance selected, the Final Rule requires 
the borrower to be charged for Government 
recording charges that roll up into line 
1201 as well as the Transfer taxes that roll 
up into line 1203. However, the contract for 
this transaction requires the seller to pay for 
these charges even though the borrower has 
been charged according to the GFE. Later in 
this workbook we will enter the adjusting 
entry on page one of the GFE HUD for this 
charge. (3) If the charge for the Transfer 
taxes associated with the Deed are not 
included on the GFE, even though you cannot 
change the GFE Tolerance category, you may 
move the charge from the Borrower’s column 
to the Seller’s column as shown below. (4) In 
the 1200 series the GFE Tolerance has been 
preassigned by the Final Rule for the 
borrower charges on line 1201-1205 and 
cannot be changed. GFE Tolerance selections 
are available for Lines 1206-1208. (5) At 
lines 1202, 1204 and 1205 DoubleTime will 
print a subtotal of the borrower charges on 
each line outside of the columns in 
compliance with the Final Rule. These are 
viewable in the Print Preview mode.

2. Double click line 1202. The Recording Calculator window opens.
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NOTE: (1) When the borrower is selected as 
the payor for a recording fee, the amount will 
automatically roll up into the figure on line 
1201. Any recording charges paid by the 
seller will be totaled and placed in the seller’s 
column on line 1202. (2) The GFE 
Tolerance for the borrower recording 
charges are preset by the Final Rule as 
Charge that in total cannot increase 
more than 10%.

3. Type 2 in the # of Pages
box in the Deed column, 
and press the Tab key.

The calculations will be automatically made 
for recording a 2 page deed. The default 
Payor in this series are set by custom and can 
be changed.

4. Type 24 in the # of Pages
box in the 1st Mortgage
column, and press the Tab
key.

The charge for recording a 24 page mortgage 
is automatically calculated.

5. Type 1 in the # of Pages
box in the 1st Release
column, and press the Tab
key.

The charge for recording a 1 page satisfaction 
of mortgage is automatically calculated. 
NOTE: County specific charges for additional 
names can be added to the Add’l Charges
field(s).
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6. Click OK. The Recording Calculator window closes 
and the calculated amounts are displayed.

7. On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Other and the 
Service Provided is Recording Dept.

8. Select Orange County 
Comptroller and click 
OK.

The Search Contact window closes and the 
Recording tab redisplays. Orange County 
Comptroller now displays in the Payee box 
for line 1202 and lines 1204 - 1208. 
NOTE: This information is not displayed on 
the settlement statement, but determines the 
payee on the Balance Sheet.

9. Select line 1203 Line 1203 is a roll up line. The amount on 
line 1203 must be listed inside the column for 
the borrower and is the sum of borrower 
charges on lines 1204 and 1205.
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Values from the Update Recording Charges 
dialog box are copied to lines 1204 and 1205. 
The total of the amounts for the intangible tax, 
and the documentary stamps on the deed and 
mortgage are charged to the borrower as the 
default. The Final Rule requires the borrower 
to be charged for all transfer taxes associated 
with recording the deed and the mortgage and 
assigns the GFE Tolerance category of 
Charge that cannot increase to them. If 
the contract between borrower and seller 
requires the seller to pay for any of the 
transfer taxes (i.e. documentary stamps on the 
deed) an adjusting entry on page one of the 
GFE HUD for this charge is needed. Later in 
this workbook we will make such an entry.

10. Select line 1206. Additional lines are available for other 
recording fees to be added. 

11. Click the Description
box and type Continuous 
Marriage Affidavit.

12. Double click line 1206. The Recording Calculator window is 
displayed with 1206 as the active line.

13. Type 2 in the Number of 
Pages box.

The calculation will be automatically made 
for a 2 page document. The Payor can be 
changed.

14. Select Seller from the 
Payor drop down list.

15. Click OK. The Recording Calculator window closes.

16. Select Charge that is 
not associated with the 
GFE from the GFE 
Tolerance drop down list.

This is a seller expense, there was no estimate 
on the GFE for this charge. It will not be 
included on the GFE-HUD-1 Comparison
tab.
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Adding Additional Settlement Charges
What You Do Comments

1. Click the Add’l Charges
tab.

The Add’l Charges tab showing the 1300
line series is displayed. NOTE: (1) Line 1301
is selected and is a roll up line for required 
services for which the borrower can shop and 
which were disclosed on the GFE. The Final 
Rule requires the settlement agent to organize 
the settlement charges that will appear in the 
1300 series in such a way that those expenses 
listed on the GFE will be entered above any 
expenses not listed on the GFE. Those 
settlement charges appearing on the GFE are 
required by the Final Rule to be shown with 
amounts outside of the column. All other 
settlement charges in the 1300 series are 
placed inside the column. (2) In the 1300
series, except for the roll up line 1301, the 
GFE HUD includes a drop down selection list 
for GFE Tolerance. Depending upon the 
additional settlement charge, you must select 
the appropriate GFE Tolerance from the 
drop down list. Selection of the choice 
Charge that is not associated with the 
GFE is available on all lines in the series 
(other than the roll up line) and is required to 
enable amounts to be entered inside the 
column (including the seller’s column). When 
Charge that is not associated with the 
GFE is selected for any settlement charge, 
that amount will not appear outside of the 
column and will not be rolled up by 
DoubleTime and totaled at line 1301. It is not 
possible to place any charges in the seller’s 
column if any other GFE Tolerance is 
selected.

2. Select line 1302.
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3. Type Survey in the 
Description box in the 
work area.

4.   On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Surveyor.

5. Select Property 
Surveyors, Inc. and click 
OK.

The Search Contact window is closed and 
the Add’l Charges tab is redisplayed. 
Property Surveyors, Inc. is now displayed 
in the Payee box. NOTE: The GFE 
Tolerance defaults to Charge that in total 
cannot increase more than 10%, but can 
be changed. The default setting is appropriate 
whenever the borrower has used the services 
of a provider identified by the lender and 
which was disclosed on the GFE.
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6. Type 350 in the Outside 
Clmn Amt box and press 
the Tab key.

The $350 survey fee is displayed outside the 
column on line 1302 and rolls up into the 
total listed inside column on line 1301.

7. Select line 1303. Selecting this line allows you to add another 
additional charge.

8. Type Pest Inspection in 
the Description box.

9.   On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Pest Inspector. 

10. Select Pest Inspectors, 
Inc. and click OK.

The Search Contact window is closed and 
the Add’l Charges tab is redisplayed. Pest 
Inspectors, Inc. is now displayed in the 
Payee box. NOTE: The GFE Tolerance
defaults to Charge that in total cannot 
increase more than 10%, but can be 
changed.

11.  Type 75 in the Outside 
Clmn Amt box and press 
the Tab key.

The $75 pest inspection fee is charged to the 
borrower and rolls up into line 1301.
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12.  Select line 1304.

13.  Type Roof Inspection in 
the Description box.

14.   On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Misc. 

15. Select Roof Inspectors, 
Inc. and click OK.

The Search Contact window is closed and 
the Add’l Charges tab is redisplayed. Roof 
Inspectors, Inc. is now displayed in the 
Payee box.

16. Select Charge that is 
not associated with the 
GFE from the GFE 
Tolerance drop down list.

Once Charge that is not associated with 
the GFE is selected the charge can be entered 
inside the column for the seller or borrower.

What You Do Comments
Training Workbook: August 2018 Page 607



Settlement Statements Using a GFE HUD
17. Type 125 in the Paid 
from funds box for the 
borrower and press the Tab
key.

The $125 roof inspection fee is charged to the 
borrower and is displayed inside the column 
since it is a charge not associated with the 
GFE. Notice also that the charge does not roll 
up into the total on line 1301. NOTE: This 
example also illustrates grouping the 
additional settlement charges that roll up 
above the one that does not.

NOTE: There is one more additional 
settlement charge to be entered that will be 
paid by the seller. It could have been entered 
at line 1305 using the procedures illustrated 
above. However, we will use this additional 
settlement charge to illustrate the creation of a 
HUD-1 Settlement Statement Addendum.
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Creating A HUD-1 Addendum
What You Do Comments

1.  On the secondary 
toolbar, click the Insert 
button.

Line 1309, Additional Expenses (See 
Attached Addendum) and line 1310 are 
created after line 1308. NOTE: Each time 
you click the Insert button, a new numbered 
line is generated. You can insert up to 99 
additional lines. Line 1309 maintains the total 
for expenses identified on lines 1310 through 
1409. 

2. Select line 1310.

3. Type Home Warranty in 
the Description box.

4.   On the secondary 
toolbar, click the Search 
Contact button.

The Search Contact window is displayed. 
The Contact Type is Corporation and the 
Service Provided is Misc. 

5. Select Home Warranty, 
Inc. and click OK.

The Search Contact window is closed and 
the Add’l Charges tab is re-displayed. 
Home Warranty, Inc. is now displayed in 
the Payee box.
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6. Select Charge that is 
not associated with the 
GFE from the GFE 
Tolerance drop down list. 

7. Type 300 in the Paid 
from funds box for the 
seller and press the Tab
key.

The $300 home warranty fee is charged to the 
seller. The Addendum will be generated 
automatically when the settlement statement 
is printed. NOTE: The display appears to add 
the additional lines to the page two of the GFE 
HUD. However, when printed the additional 
lines will be shown on a separate addendum. 
The addendum can be viewed in Print 
Preview.
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Page 1 Adjustments For Page 2 Borrower Charges
What You Do Comments

1. Press Ctrl + G . The Go To Line window opens. 

2. Type 200 in the Line 
Number box and click 
OK.

The Buyer Credits tab displays. This 
demonstrates using the Go to Line feature to 
quickly navigate through the GFE 
Settlement Statement module. NOTE: An 
alternate method to accomplish the same task 
would be to select Navigation > Go to Line
from the menu bar.

NOTE: (1) We needed to navigate to page one of the GFE HUD because the 
seller is contractually paying for a closing item that was on the GFE. The Final 
Rule requires that all GFE disclosed charges appear on page two of the GFE 
HUD as a charge to the borrower notwithstanding the contract between the 
borrower and seller. Therefore a credit from the seller to the borrower to offset 
such charges should be listed on the first page of the GFE HUD on lines 209b - 
209g and lines 509b - 509g respectively, as needed. (Common examples will 
include documentary stamps on the deed, title search expenses and owner’s title 
insurance premiums.) (2) Functionality in this series for the GFE HUD allows 
the insertion of additional lines (209b - 209g and lines 509b - 509g) to 
accommodate this Final Rule requirement. These additional lines can be used 
for seller credits to the buyer or can allow access to the buyer or seller side as 
individual entries. To access these lines simply highlight the adjacent 200 series 
line, deselect copy, then click over to the adjacent 500 line which will now be 
enabled for the user to enter additional information and charges. (3) Line 209a
is reserved for proceeds from an additional closing statement, when one is used.

3. Click the Insert button on 
the secondary toolbar.

Line 209b/509b is added.

4. Type Seller Credit - 
Owner’s Title Policy in 
the Description box.
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5. In the Total Amount box 
type 1200 and press the 
Tab key.

The premium amount for the Owner’s Title 
Policy displays on 209b and 509b as a 
credit to the borrower and charged to the seller 
respectively.

6. Click Insert on the 
secondary toolbar.

Line 209c/509c is added.

7. Type Seller Credit - 
Deed Doc Stamps in the 
Description box.

8. In the Total Amount box 
type 1575 and press the 
Tab key.

The documentary stamps on the deed are now 
a credit to the borrower and charged to the 
seller respectively.
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9. Click Insert on the 
secondary toolbar.

Line 209d/509d is added.

10. Type Seller Credit - Title 
Search in the 
Description box.

11. In the Total Amount box 
type 150 and press the Tab 
key.

The title search fee is now a credit to the 
borrower and charged to the seller 
respectively.
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Completing Page 3 Of The GFE HUD
What You Do Comments

1. Click the GFE - HUD-1 
Comparison tab.

Information must be supplied by the lender 
regarding the completion of page 3 of the 
GFE HUD, including the figures to be entered 
into the Good Faith Estimate column for 
comparison to the actual GFE settlement 
statement charges. 
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NOTE: (1) Per the Final Rule, the third page of the GFE HUD contains 3 GFE 
HUD comparison charts and a loan terms table. DoubleTime splits page 3 of the 
GFE HUD into two parts. The three comparison charts appear on the GFE -
HUD-1 Comparison tab and the loan terms table appears on the Loan Terms
tab. The display shows all possible page 2 lines as they potentially could have 
been used, including blank lines. When printed the blank lines will be omitted. 
This feature allows you to enter a page two line description from the comparison 
charts. To see how the charts will appear when printed click the Show Print 
View box. (2) Each Tolerance Category receives its own comparison chart. 
The top chart is for the tolerance category of Charges That Cannot 
Increase. The middle chart is for the tolerance category of Charges That In 
Total Cannot Increase More Than 10%. The bottom chart is for the 
tolerance category Charges That Can Change. (3) When you completed 
page two of the GFE HUD each entry charged to the borrower was associated 
with one of these tolerance categories if the charge was GFE related. 
DoubleTime has used that information to populate the charge descriptions and 
the HUD-1 column amounts. 
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2. Select the Show Print 
View check box.

The blank lines are removed from view.

NOTE: There are Closing Statement 

Alerts  next to some of the lines. This is 
because no amounts have yet been entered for 
the Good Faith Estimate column. We will 
look at alerts later in this workbook.

First, complete each line in the Charges That Cannot Increase section with 
the information from the GFE issued to Fred Cowlings. All amounts are entered 
in the Good Faith Estimate column. NOTE: The amounts in the HUD-1
column cannot be edited on this tab. Changes must be made on the 
corresponding line numbers on page two of the GFE HUD.

3. Type 6000 on the Our 
Origination Charge line 
and press the Tab key.

NOTE: The Closing Statement Alert
disappears once you have entered the amount. 
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4. Type -3000 on the Your 
credit or charge 
(points)... line and press 
the Tab key.

The amount on the Your adjusted 
origination charges line is calculated 
automatically. 

5. Type 2600 on the 
Transfer taxes line and 
press the Tab key.

NOTE: The Closing Statement Alert
disappears once you have entered the amount. 

Next complete the Charges That in Total Cannot Increase More Than 
10% section with the lender provided figures for each line. All amounts are 
entered in the Good Faith Estimate column. NOTE: (1) Tabbing after entry 
of each amount will move the cursor from field to field. (2) A Closing 
Statement Alert appears at the line Increase between GFE and HUD-1 
Charges as you begin entering figures in this section.

6. Type 200 on the 
Government recording 
charges line.

 

7. Type 250 on the 
Appraisal fee line.

8. Type 50 on the Credit 
report line.

9. Type 600 on the Title 
services and lender’s 
title insurance line.

10. Type 1200 on the 
Owner’s title insurance
line.

11. Type 275 on the Survey
line.
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12. Type 50 on the Pest 
Inspection line and press 
the Tab key.

NOTE: (1) DoubleTime completes the last 
two rows of the chart by calculating the total 
of each column and the Increase between 
GFE and HUD-1 Charges amount and 
percentage, if any. (2) Because there is no 
tolerance violation for this chart, the Closing 
Statement Alert is now gone.

Next, complete the Charges That Can Change section with the lender. 
provided figures for each line. 

13. Type 2000 on the Initial 
deposit for you escrow 
account line.

14. Type 413 on the Daily 
interest charges from
line.

What You Do Comments
Page 618 DT Version: 8.1



Settlement Statements Using a GFE HUD
15. Type 1000 on the 
Homeowner’s 
insurance premium for
line.

16. Type 300 on the Flood 
insurance premium for
line.

The GFE - HUD-1 Comparison tab is 
completed.

The final section of page 3 of the GFE HUD is for the loan terms. This 
information is provided by the lender. The content of the Loan Terms chart is 
defined by the Final Rule. Lenders should provide settlement agents with the 
information needed to complete the Loan Terms chart. DoubleTime does not
allow you to enter information directly into two areas of the Loan Terms chart: 
(1) The Your initial loan amount is line, and (2) The Your initial interest 
rate is line. The values for these two fields were entered in the Closing File
module, and may only be edited in that module.
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17. Click the Loan Terms
tab.

NOTE: Amounts are already listed in the 
Your initial loan amount is line and the 
Your initial interest rate is line. 

NOTE: A Reverse Mortgage checkbox has been added to the Closing File
module > Loans tab > Terms tab.  It is used when the loan is a reverse 
mortgage. The appropriate compliance items will be reflected on page 3 of the 
GFE HUD.

18. Type 30 on the Your loan 
term is line.

19. Type 1079.19 on the Your 
initial monthly 
amount... line.

20. Select the check boxes for 
Principal and Interest.

This indicates the initial monthly amount also 
includes these charges. NOTE: There is no 
mortgage insurance on this loan.
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The next five lines contain questions whose default answer is No. For this 
transaction, there are no changes to be made on these lines.

21. Select You have an 
additional monthly 
escrow payment of
option in the last section of 
the Loan Terms table.

22. Type 400.69 in the first $ 
box for the selected option.

23. Type 1479.88 in the 
second $ box for the 
selected option.

24. Select the check boxes for 
Property taxes, 
Homeowner’s 
insurance and Flood 
insurance.

This indicates the payments for these items 
are included in the total initial monthly 
amount owed. The Loan Terms tab is 
complete.
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Viewing Closing Statement Alerts
What You Do Comments

1.  On the secondary 
toolbar, click the Closing 
Statement Alerts button.

The Closing Statement Alerts window 
opens. DoubleTime provides transaction 
specific information on line items that may 
have been inadvertently overlooked or which 
may be logically inconsistent with other data 
in this closing file. There is one reminder 
provided: No broker commission. 
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2. Select the No broker 
commission reminder.

3. Click the Go to Line
button.

This action displays the tab of the settlement 
statement where the information giving rise to 
the selected alert can be edited.

A Closing Statement Alert also displays when a RESPA defined tolerance limit 
has been exceeded. This alert may be triggered by a violation of any single item
in the Charges That Cannot Increase chart, or the totals of the Charges 
That in Total Cannot Increase More Than 10% chart. To address this 
violation, select the alert and click Go to Line. Check that all figures are 
entered correctly for the specific line item as well as on the GFE HUD-1 
Comparison tab. After confirming there is no data entry error, contact the 
lender for information on how the violation will be cured.  NOTE: Depending 
on the manner in which the lender decides to cure the tolerance violation, the 
alert may continue to display when exiting the Settlement Statement
module.
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What You Do Comments
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Entering Broker’s Commission
What You Do Comments

The Brokers tab is displayed showing the 
700 line series. The purchase price of 
$225,000.00 is displayed in the Basis 
Amount box of the work area.

4. Type 6 in the % box of the 
work area and press the 
Tab key.

The commission of $13,500.00 is displayed 
on lines 700, 701, and in the seller’s column 
on line 703. NOTE: The broker fees can be 
added to the settlement statement by typing a 
percentage amount, or by typing the total 
dollar amount on this tab.
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NOTE: The Final Rule has changed the way the 700 series is completed on the 
GFE HUD in important ways. (1) Broker fees no longer appear as percentages 
of the sales price. (2) The total amount of fees paid to the brokers, both 
commissions plus processing fees, must be totaled and appear at line 700. (3) 
Line 704 is reserved for use in the special case circumstance when a real estate 
broker is paid some portion of the broker fees by anyone other than the 
settlement agent (e.g. withholding from the deposit). 

To accommodate the special use of line 704, any incidental broker fees are now 
combined with the commission payable at lines 701 – 703. DoubleTime 
defaults to the seller paying all broker fees including incidental fees. In the event 
the borrower is responsible for any portion of the broker fees, use line 703 and 
enter the amount paid by the borrower in the Paid from funds box for the 
Borrower. DoubleTime will subtract that amount from the seller’s column. 
Alternatively, DoubleTime has added lines 705 and 706, which can be used to 
reflect incidental fees. 

5. Select line 701. Selecting this line allows you to add the payee 
information and split the fee if there is more 
than one broker involved.

6. Type 3 to replace the 6 in 
the % box of the work area.

The commission amount will be split between 
two brokers. NOTE: A dollar amount may 
also be entered in the Commission box, 
including any additional fees owed to the 
broker. DoubleTime will calculate the 
difference and display the typed amount on 
line 701, and the remaining amount on line 
702.

7. Select Realty Company, 
Inc. from the Broker drop 
down list.

Realty Company, Inc., the buyer’s broker, 
is listed as the payee on line 701. NOTE: The 
payee list includes all the contacts previously 
selected for this closing file.

8. Select line 702. The split is calculated and 3% is displayed in 
the Rate box.

What You Do Comments
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9.  Click Search 
Contact on the secondary 
toolbar.

Another broker is to be added. The Search 
Contact window opened with Corporation
as the Contact Type and Real Estate Brk 
as the Service Provided. 

10. Select Better Homes, 
Inc. and click OK.

This is the seller’s broker. The Search 
Contact window is closed and the Role 
Selection window opens.

11. Select Seller’s Broker 
and click OK.

This identifies the payee as the seller’s broker. 
The Role Selection window closes, and 
Better Homes, Inc. is listed as the payee on 
line 702.

NOTE: If the wrong role is selected for the 
broker, it can be changed on the Participants
tab of the Closing File module.

What You Do Comments
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Viewing Totals Summary & Printing The GFE HUD

12. Select line 705. NOTE: Lines 705 and 706 are additional 
lines provided by DoubleTime for any other 
broker charges, such as listing a third broker’s 
co-brokerage fee and identifying the payee 
and amount.

What You Do Comments
1. Click the Totals 

Summary tab.
The Totals Summary tab is displayed. In 
the upper portion of the window is line 1400
from page two of the GFE HUD. In the lower 
portion of the window are lines 300/600
through 303/603 from page one.

What You Do Comments
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2.  On the secondary 
toolbar, click the Print 
button.

The Print Options window is displayed. 
The Print Range defaults to All, Copies to 
1, Print What to HUD-1 and Print to Print 
all pages. NOTE: To print a different 
statement, worksheet, or report, click the 
Print What drop down box and make your 
selection.

What You Do Comments
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3. Click More. A variety of Settlement Statements, 
worksheets, and reports can be printed by 
clicking the desired check boxes.

NOTE: It is a good idea to print out an example copy of these reports for use in 
your office. Not all of them are covered in the training class. These reports may 
also be accessed from Reports on the Menu Bar, while you are in the 
Settlement Statements module. 

4. Click Less. The Print Options window is re-displayed.

5. Click Preview. A Print Preview of the GFE HUD is 
displayed.

What You Do Comments
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6. Use the  
arrow buttons on the 
secondary toolbar to view 
all pages of the GFE HUD.

Note the GFE - HUD comparison on page 3.

What You Do Comments
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7.  On the secondary 
toolbar, click the Print 
button again.

The Print Options window is re-displayed. 

8. Click OK. The Print Options window closes and the 
GFE HUD prints.

What You Do Comments
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Emailing The Closing Statement
What You Do Comments

1. When the settlement 
statement is in Preview 
mode, select eSolutions 
> Email from the main 
menu.

The Settlement Statements—Print 
Preview window converts the file to an 
image file. A list of participants in reference 
to your file is displayed with the opportunity 
to select their email addresses. NOTE: The 
email addresses are established in the 
Contacts or Closing File module.

The EMail Properties window opens.

2. Click the  
button.

The Address Book opens in MS Outlook. If 
necessary, scroll to find your instructor’s 
name.

3. Type (the name of your 
instructor) in the Type 
Name box or select the 
name from the list.
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4. Select your instructor’s 
name and click To ->.

Your instructor’s name is displayed in the To -
> box.

5. Click OK. The Address Book window closes and the 
Email Properties window is re-displayed. 
The instructor’s name you selected is 
displayed at the top of the Participant list. 
NOTE: You may add a message by typing in 
the Message box.

What You Do Comments
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Preparing A 1031 Exchange Closing Statement

6. Click Send. The email is sent. NOTE: A copy of the email 
is also placed in your Sent file.

7.  Click the Close 
button.

The Print Preview is closed.

8.  Click the Close 
button.

The Settlement Statements module is 
closed.

What You Do Comments
1. Within the Maintenance 

(Lists) module, select 
Title, then click OK. 

2. Click Insert and type 
Intermediary to Title. 
Click Close.

What You Do Comments
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3. Copy the completed file by 
selecting Utilities > 
Closing File Copy on 
the main menu. Name the 
file using the same file 
number, but with the letter 
“A” added to the end. 

The entire file is copied, but only the 
Settlement Statement will be printed from this 
file. All other instruments should be printed 
from the original file.

Example: 123456A.

4. Within the Closing File
module, delete either the 
Buyer or Seller, 
depending on who is 
associated with the 1031 
Exchange.

5. Insert the name of the 
party who will be the 
Intermediary in either the 
Buyer or Seller tab. In 
the Name(s) with Status
box, select the name and 
add the verbiage 
Intermediary.

If the Closing Agent wants to add additional 
language, such as “Intermediary for LSL Title 
Company, Inc.,” you can add it to the Title
line in the Signature Block and Notary 
Block.

What You Do Comments
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Tips
1. An alternate way to open the Settlement Statements module is to select 

Modules from the menu bar and choose Settlement Statements.

2.  Use the Double Click! feature on line 201 - Deposit or earnest 
money to   open the Deposit Summary dialog box. NOTE: The Double 
Click! feature can also be used to open the Payoff Calculator on line
504, the Itemized Origination Fees and Charges Calculator on line 
801, the Title Services Calculator on line 1101 and the Recording 
Calculator on line 1202.

3. To itemize origination charges for VA Mortgages, double-click line 801 to 
access the Itemized Origination Fees and Charges Calculator, then 
click the Insert button to add a blank line where a description and dollar 
amount can be typed. A new line should be inserted for each individual 
charge. The calculator will automatically add up the charges as they are 
entered, and display a total at the bottom of the Amount column. Total 
charges in the calculator should not exceed the origination charges entered 
outside the column on line 801; if they do DoubleTime automatically adds 
the excess amount to the total origination charges listed on line 801. NOTE:
(1) You can display and print a report of the itemized charges by selecting 
Reports > Origination Statement from the Menu bar. (2) The 
Itemized Origination Fees and Charges Calculator is not available 
when you have manually entered detail outside the column in any of lines 
804-813. 

4.  Use the Deposit Summary button, located in the Settlement 
Statements toolbar, to open the Deposit Summary dialog box.

5.  Another way to access the Payoff Calculator is to select line 504 and 
click the Payoff Calculator button on the Settlement Statements
secondary toolbar.

6.  Use the Recording Calculator to calculate recording fees for lines 
1202 through 1208 on the Recording tab.

7. If you are preparing an Initial Escrow Account Disclosure 
Statement, be sure to enter the monthly payment information on the 
Reserves tab.

8. In the Print Options window, use the Page Range area to print 
individual pages of the GFE HUD.
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9.  To display the entire GFE HUD, click the Print button on the 
secondary toolbar and select the Preview button.

10. You can display any one report selected in the Print What box by clicking 
the Preview button. You can also select a report to view by selecting 
Reports from the main menu.

11. To print multiple reports at one time, click the More button on the Print 
Options window and select as many different reports as needed.

12.  Click the Calculator button to use the calculator. You can type the 
number on the keyboard or use the mouse to click the numbers on the 
displayed calculator. 

13. If you are printing a HUD-1A for a closing file type of Refinance, click 
Format and select HUD-1A. Click Reports or the Print button and select 
HUD1-A.

14. If you are printing a Buyer’s Closing Statement, Seller’s Closing 
Statement and/or Buyer’s/Seller’s Combined Closing Statement, 
in the print preview mode clicking Tools in the menu bar will allow you to 
select Page Size (letter or legal) and Page Border (on or off). 

15. To obtain a copy of the figures in the Payoff Calculator, leave the Payoff 
Calculator window open after the figures have been calculated. Click the 
Print button.

16.  You can choose to display the Closing Statement Alerts at any time 
by clicking the Closing Statement Alerts button to check for any 
missing items within your closing statement.

17. To fax a GFE HUD from your PC, click the Print button on the secondary 
toolbar, select the Printing to fax machine check box, and click the
Properties button. Select your fax in the Printer Setup window and click
OK. This ensures that all the pages of the GFE HUD are faxed as one “print 
job”, instead of treating each page as a separate fax.

18. To email a GFE HUD from your PC, select eSolutions while in Print 
Preview, and click Email. In order to perform this function, you must be in 
preview mode of all Settlement Statements, including the GFE HUD, and 
you can only use Outlook or Outlook Express to e-mail from the 
Settlement Statement module. A list of participants in reference to your 
file are displayed with the opportunity to select their e-mail addresses. Email 
addresses need to be established in either the Contacts or Closing File 
module on the Phone tab.
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Frequently Asked Questions

19. In the Settlement Statements module there is a new option available 
under the Format menu called GFE Comparison Show Negative 
Percentage. This is an option that can be selected on a per file basis when 
the lender requests page 3 of the HUD to show a negative percentage in the 
Increase Between GFE and HUD-1 Charges column when the total is 
a negative number.

20. A Reverse Mortgage checkbox has been added to the Closing File
module > Loans tab > Terms tab.  It is used when the loan is a reverse 
mortgage. The appropriate compliance items will be reflected on page 3 of 
the GFE HUD.

Question Answer
1. Why aren’t the doc. stamps 

on the deed automatically 
calculated on the GFE 
HUD?

You did not insert a property or purchase price 
on the Property tab of the Closing File
module.

2. Why don’t the payoff 
amount and/or the lender 
display?

Payoff loans must be added in the Closing 
File module > Loans tab. Then the lender 
will be shown as payee on line 504 in the 
work area on the GFE HUD and the payee on 
the Balance Sheet. The payoff amount is 
entered directly in the Settlement 
Statements module. To add the payoff 
amount, type the amount or double-click the 
payoff line in the GFE HUD to bring up the 
payoff calculator. Type the mortgage balance, 
per diem interest, and other miscellaneous 
fees associated with the payoff. Click OK. 
The amount will be displayed in the proper 
box.

3. Why can’t I enter data on 
certain lines (i.e. 506, 
704)?

Certain lines had to be reserved for particular 
verbiage or values required on the GFE HUD. 
For example line 704 is reserved for use in 
the special circumstance when a real estate 
broker is paid some portion of the broker fee 
by anyone other than the settlement agent 
(e.g. withholding from the deposit).
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4. What if I have a 
transaction that requires 
mortgage insurance?

When adding the mortgage on the Loans tab 
of the Closing File module, select Conv 
Ins from the Type drop-down list. In the 
Settlement Statements module, enter the 
amount of the mortgage insurance premium 
on line 902 of the Prepayments tab; then 
enter the number of months to be paid in 
reserve on line 1003 of the Reserves tab.

5. How do I add more lines 
to the 1300 series?

Click the Add’l Charges tab, then click the 
Insert button. An addendum is automatically 
generated, and the addendum total is 
maintained on line 1309.

6. How do I add more lines to 
the 800 Series of the GFE 
HUD for lender fees?

Additional lines cannot be added to the 800
series. However, you can change the 
description on lines 806-811. If you have 
additional lender fees, you can enter them in 
the 1300 series, which permits insertion of 
additional lines, if needed. Exercise caution 
when doing so, especially when preparing the 
GFE HUD comparison charts on page 3.

7. How do I enter a LIP or 
Construction Loan 
account?

DoubleTime allows you to enter the LIP 
(Loan in Progress) or Construction amount on 
Line 104 or 105 of the GFE HUD. Type the 
Description in Line 104 or 105 of the GFE 
HUD, type the amount of the LIP account in 
the Total Amount box. Double-click 
Amount Withheld. 

8. How do I put tax re-
proration language on the 
GFE HUD?

You cannot add tax re-proration language 
directly to the GFE HUD. However, you can 
print the Closing Statement Addendum
document from the Documents module. The 
Closing Statement Addendum document 
includes the tax re-proration language, as well 
as other information, such as the 
Disbursement Authorization language. 

9. How do I enter an 
Aggregate Accounting 
Adjustment if it is a 
negative number?

Type a dash (-), and then type the amount. If 
the lender is withholding this amount (to add 
it to their net proceeds check) double click the 
Amount withheld field.

Question Answer
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10. How do I add a payee in 
the Settlement 
Statements module?

Click the Search Contact button on the 
secondary toolbar to open the Search 
Contact window. Select or add the contact.

11. How do I type a negative 
number?

Type a dash (-), and then type the amount.

12. How do I show a tolerance 
violation that has been 
cured by the lender on the 
GFE HUD?

Most cures can be shown using lines 205 and 
206 on the Buyer Credits tab in the 
Settlement Statements module. These 
lines allow you to enter or select various 
information in the Description, Payor, 
GFE Tolerance, and Total Amount boxes. 
When the GFE Tolerance “Charge that 
cannot increase” is selected, the description 
and dollar amount entered will display on the 
GFE-HUD-1 Comparison tab in the first 
table titled Charges that cannot increase. All 
information will print on page 3 of the GFE 
HUD, and the credit for the cure will display 
on Page 1 of the GFE HUD along with the 
description entered. When the GFE Tolerance 
“Charge that in total cannot increase more 
than 10%” is selected, the information 
displays in the second table titled Charges 
that in total cannot increase more than 10%
on the GFE-HUD-1 Comparison tab. The 
dollar amount will be included on the Total
line and the Increase between GFE & 
HUD-1 Charges line of the table, and all 
information will print on page 3 of the GFE 
HUD.

Question Answer
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13. How do I change the 
holder of the deposit from 
someone else to our firm 
prior to closing?

One way to accomplish this is in the Closing 
File module by following these steps:
• Click on the Deposit tab. 
• Click on the Insert button. 
• Choose your firm in the drop down field for
Deposit Held By. 
• In the Amount field enter the dollar 
amount of monies moved to your firm’s trust 
account. 
• In the Received Date field enter the date 
on which the funds were transferred to your 
firm’s trust account.
• Select the Amount field on the line of the 
former deposit holder.
• Change that amount to 0.00
• Save your work and exit the module.
Note: Sometimes the escrow agent holding 

the deposit changes between the time the 
information has been entered in DoubleTime 
and the date of closing. For example, closing 
agents are sometimes required to have all 
deposit monies flow through their escrow 
account as collected funds as part of the clos-
ing process. 

GFE/HUD-1 700 Series FAQs
Note: Per the Final Rule, the 700 series itemizes:
• Total of the real estate broker’s commission on line 700
• Split of commission to two or more real estate brokers on lines 701 and 702
• Amount of brokerage commission disbursed at settlement on line 703
• Amount the real estate broker retains from the deposit on line 704
• Any additional charges from the real estate broker (such as an administrative 
fee) on lines 705 and 706.

14. How do I enter Broker’s 
commission for two 
Brokers when the Buyer’s 
Broker withholds 
commission and additional 
fees from the deposit?

To enter figures for this scenario see below.

Question Answer
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• The Closing File module shows Deposit Held By the Buyer’s Broker.

• Line 700: Type the total amount of the commission plus any additional fees in 
the Total Real Estate Broker Fees box in the work area.
• Line 701: Edit the commission box to show only what the first broker will 
receive.
• Select the first Broker’s name from the drop down list.
• Type the amount being withheld from the deposit in the Amount Withheld:
box.

• Line 702: Select the second Broker’s name from the drop down list or click 
Search Contacts to select or add a name not shown in the drop down list.
• The commission for line 702 was automatically calculated when the amount 
on line 701 was edited.
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• Note: Information automatically displays on line 704 because according to the 
Final Rule a real estate agent who is holding the borrower’s deposit and with-
holding commission or fees from that deposit must be identified by name on line 
704.
• Line 703: Type the processing fee in the Paid from funds: box for the bor-
rower. Note: The amount of the commission disbursed at settlement (shown on 
line 703) is further reduced by the $250 processing fee.

• Line 704: DoubleTime automatically displays the description “Amount 
retained from deposit...”
• Edit the POC: box to indicate the party (borrower or seller) who made pay-
ment outside of closing (i.e. POC (B*) $15,250.00).

Question Answer
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15. How do I enter Broker’s 
commission for two Brokers 
when the Closing Agent holds 
the deposit? 

To enter figures for this scenario see below.

• Line 705 and 706: These lines may be used to separate administrative fees 
from brokerage commission and to show additional parties sharing in payment 
of brokerage commissions.
• Buyer Credit tab /line 506: DoubleTime calculates the charge to the seller 
for the remainder of the commission on line 506 which is withheld from the 
deposit by the bro-
ker.

• To view the additional POC description entered on line 704 as it appears on 
the GFE HUD, select Reports > HUD-1 from the menu bar

Question Answer
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• The Closing File module shows Deposit Held By the Closing Agent.
• Line 700: Type the total amount of the commission plus any additional fees in 
the Total Real Estate Broker Fees box in the work area.

Question Answer
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• Line 701: Edit the commission box to show only what the first broker will 
receive.
• Select the first Broker’s name from the drop down list.

• Line 702: Select the second Broker’s name from the drop down list or click 
Search Contacts to select or add a name not shown in the drop down list.
• The commission for line 702 was automatically calculated when the amount 
on line 701 was edited.

• Line 703: This line is automatically calculated for this scenario, where the 
Closing Agent holds the deposit. If administrative/processing charges are to be 
paid in addition to the brokerage commission, enter them in the appropriate 
Paid from funds box.
• Line 704: This line is not used when the Closing Agent holds the deposit.
• Line 705 and 706: These lines may be used to separate administrative fees 
from brokerage commission and to show additional parties sharing in payment 
of brokerage commissions.

Question Answer
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16. How do I enter Broker’s 
commission for two Brokers 
when the Closing Agent holds 
the deposit and one Broker has 
additional fees?

To enter figures for this scenario see below.

• The Closing File module shows Deposit Held By the Closing Agent.
• Line 700: Type the total amount of the commission plus any additional fees in 
the Total Real Estate Broker Fees box in the work area.

• Line 701: Edit the Commission: box to show only what the first broker will 
receive.
• Line 702: Select the second Broker’s name from the drop down list or click 
Search Contacts to select or add a name not shown in the drop down list.
• The commission for line 702 was automatically calculated when the amount 
on line 701 was edited.Line 
• 703: Type the additional fee in the Paid from funds: box for the borrower.

Question Answer
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• The amount of the commission paid by the seller is reduced by the amount of 
the additional fee.

• Line 704: This line is not used when the Closing Agent holds the deposit.
• Line 705 and 706: These lines may be used to separate administrative fees 
from brokerage commission and to show additional parties sharing in payment 
of brokerage commissions.
17. How do I enter Broker’s 
commission for two Brokers 
when the Buyer’s Broker 
withholds commission from 
the deposit?

To enter figures for this scenario see below.

• The Closing File module shows Deposit Held By the Buyer’s Broker.

• Line 700: Type the total amount of the commission (no additional fees) in the 
Total Real Estate Broker Fees box in the work area.
• Line 701: Edit the Commission: box to show only what the first broker will 
receive.

Question Answer
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• Type the amount being withheld from the deposit in the Amount withheld:
box.

• Line 702: Select the second Broker’s name from the drop down list or click 
Search Contacts to select or add a name not shown in the drop down list.
• The commission for line 702 was automatically calculated when the amount 
on line 701 was edited.
• Note: Information automatically displays on line 704 because according to the 
Final Rule a real estate agent who is holding the borrower’s deposit and with-
holding commission or fees from that deposit must be identified by name on line 
704.
• Line 703: Only the amount of the commission actually disbursed at settlement 
is displayed in the column on this line.
• Note: An additional charge for the remainder of the commission is automati-
cally charged to the Seller on line 506.
• Line 704: DoubleTime automatically displays the description “Amount 
retained from deposit...”

Question Answer
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• Edit the POC: box in the work area to indicate the party (borrower or seller) 
who made payment outside of closing (i.e. POC (B*) $2,500.00).

• Line 705 and 706: These lines may be used to separate administrative fees 
from brokerage commission and to show additional parties sharing in payment 
of brokerage commissions.
• Buyers Credit tab /line 506: DoubleTime calculates the charge to the seller 
for the remainder of the commission on line 506 which is withheld from the 
deposit by the broker.

• To view the additional POC description as it appears on the GFE-HUD, select 
Reports > HUD-1 from the menu bar.

Question Answer
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Question Answer

GFE/HUD-1 800 Series FAQs
Per the Final Rule, lines 801 through 803 detail the lender’s adjusted 
origination charges. 
• The GFE Tolerance for lines 801 - 803 is predetermined by the Final Rule 
as “Charge that cannot increase,” and cannot be changed.
• Line 801 lists the lender’s origination charge, except the credit or charge for 
the specific interest rate chosen (points). The lender’s origination charge encom-
passes all the lender’s charges for the transaction including all fees for the 
administration, processing and underwriting of the loan. This amount is listed 
outside the column and rolls up into line 803.
• Line 802 is used to credit or charge (points) for the specific interest rate cho-
sen. It no longer contains the mortgage broker name or direct reference to Yield 
Spread Premium (YSP). This amount is listed outside the column and rolls up 
into line 803.
• Line 803 is a roll up line (the sum of lines 801 and 802) and is listed inside 
the column. This amount can be zero or a positive number. In the case of a “no 
cost” loan, the amount may be a negative number. DoubleTime automatically 
calculates the sum of lines 801 and 802 and displays the total inside the column 
at line 803.

1. How Do I enter a rate 
based payment in 
DoubleTime, such as YSP, 
using the GFE HUD?

     To enter figures for this scenario see below.

• Line 801: Type the origination charge, not including the YSP charge, in the 
Outside Clmn Amt: box of the work area.
• For loans originated by mortgage brokers, the amount on line 801 must also 
include all charges to be paid by the borrower for the loan origination and 
include any payments (including YSP) from the lender to the mortgage broker 
for the loan origination.
• Line 802: Type the amount of the charge or credit (as a negative number) in 
the Outside Clmn Amt: box of the work area.
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• Line 803: DoubleTime calculates the total and displays it inside the column.

2. How do I enter a “No Cost 
Loan” in DoubleTime 
using the GFE HUD?

 To enter figures for this scenario see below.

• Line 801: Type the amount of the origination charge in the Outside Clmn 
Amt: box of the work area.
• Line 802: Type the total amount (as a negative number) of the origination 
charge plus all of the third party fees.

Question Answer
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• Line 803: Select line 803 and DoubleTime automatically calculates the sum 
of lines 801 and 802 and displays it inside the column.

3. What if the lender 
withholds a portion or all 
of the origination charge 
(line 803)?

To enter figures for this scenario see below.
• Subtract the amount of the YSP from the 
portion that the lender is withholding from the 
Adjusted Origination Charges on line 
803, typically resulting in a negative number.
• Type that number in the Amount withheld
box for line 803
• Select Reports > Loan Closing State-
ment from the menu bar
• You may save or print the report if needed.
• In the Balance Sheet module, the dis-
bursement amount for line 803 will be the 
total amount payable to the mortgage broker.
• Verify the payee for the line 803 disburse-
ment, select the mortgage broker’s name if 
necessary

Question Answer
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4.  What if the lender does not 
withhold the origination 
charge (Line 803)?

To enter figures for this scenario see below.
• Type the YSP as a negative number in the 
Amount withheld box for line 803
• Select Reports > Loan Closing State-
ment from the menu bar 
• You may save or print the report if needed
• In the Balance Sheet module, split the 
disbursement amount for line 803 between 
the lender and the mortgage broker.

Question Answer
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Import Fund Data File

Concept
If you order Commitments from a Fund branch, you can also request a Fund Data 
File. With a Fund Data File, you can import the data from the product into a new or 
existing DoubleTime Closing File. In addition to the exceptions and requirements, 
you can import other transaction information directly into DoubleTime data fields, 
such as Buyer and Seller Name(s) with Status, Lender Name, and Legal 
Description.

Objective
The objective of this lesson is to show you how to import a Fund Data File and 
establish a new Closing File in DoubleTime from the information in the data file.

Importing a Fund Data File

What You Do Comments

1. Select File > Import 
Fund Data File From > 
File from the main menu 
bar.

The Select Import File window is 
displayed. 

2. Select the Fund branch 
product you have 
downloaded from email or 
Propel.

For example: 04-2011-1181FPX.FPX
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3. Click Open. The Closing File Selection window is 
displayed. You can import this information 
into either a New Closing File or Existing
Closing File. The New Closing File and 
Sale are the defaults, and can be changed.

4. In the New Closing File 
Name box, type 
PoeToPanasevich.
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5. Click OK. Scroll Down 
and look at the various data 
fields that are ready to 
import.

The Fund Data File Import window is 
displayed. 
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6. Select or deselect check 
boxes in the Import
column.

This indicates what information will be 
imported from the file.

7. On the secondary 
toolbar, click Close.

The Fund Data File Save window opens, 
asking if you want to save the Fund Data 
File.

8. Click Yes. A message displays stating “Congratulations 
on the successful import of the Fund Data 
File.”

9. Click OK. A message displays stating “Do you want to 
switch to the active Closing File to [new file 
name].”
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10. Click Yes. The message window closes and the new file 
becomes the Active File in DoubleTime.

11.  On the main toolbar, 
click Open Closing File. 

The Closing File module opens for the new 
file. All imported information displays. Each 
tab can now be completed with any additional 
information necessary to complete the file. 
NOTE: Use the tabs in this module and go to 
the Property > Legal tab and see that the 
lengthy legal description has been imported! 

12. On the secondary 
toolbar, click Close.

The Closing File module is closed. 
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Tips

1.   Filter On — is activated when importing a file. It displays only boxes 
that include data from the Import file.

2.   Filter Off — displays all boxes on the window, whether or not they 
contain data.
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eSolutions Electronic Payment 

Concept
Electronic Payment is available as part of the Electronic Delivery wizard within 
the Premium Calculation (Rating) module. There is also a separate Electronic 
Payment feature available on the main toolbar and on the eSolutions menu of 
DoubleTime. The Electronic Delivery wizard within the Premium Calculation 
(Rating) module only processes the transmission of the policy premium for an active 
closing file that was just completed. In the eSolutions Electronic Payment
option, you can pay for multiple invoices across closing files, as well as for individual 
files. This is very useful when only some users are authorized to make payments, such 
as bookkeepers.

Objective
The objective of this lesson is to show you how to make an electronic payment to The 
Fund for multiple closing files.

Making Electronic Payments For Multiple Files 

What You Do Comments

1.  Click the Electronic 
Payment button on the 
main toolbar.

The Electronic Payment-Invoice 
Selection window is displayed. You can 
select invoices by Title Agent, Branch, 
Closing Date or Invoice Date range, and 
Closing File Number. The default is by 
Invoice Date. NOTE: You may also select 
eSolutions > Electronic Payment from 
the main menu bar to access the multiple 
electronic payment function.
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2. Select Closing Date in 
the Date Selection 
Criteria area.

The To date defaults to the current date.

3. Type 0101CY (CY = 
current year) in the To date 
box.

NOTE: You can also click down arrow in the
To date box to use the calendar option, if 
desired.

4. Click OK. The Electronic Payment - Invoice 
Selection for Payment window is 
displayed. All invoices within the specified 
time frame are displayed.

5.  Click the Select ALL 
Invoices for Payment
button.

Check marks are displayed in the Select
column for the all listed closing files.

6.  Click the Submit 
Selected Invoices for 
Payment button.

The eSolutions Electronic Payment 
window is displayed.
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7. Click Next. The Login window displays requiring your 
FundNet User ID and Password. NOTE: Your 
Administrator will authorize which users will 
have access to the electronic payment 
function. If you are authorized, you may 
establish access in DoubleTime for your user 
ID by selecting Preferences > User 
Settings from the main menu bar, and then 
accessing the Electronic Delivery tab.

8. Enter your User ID and 
Password.

 You may click the Remember User ID 
and Password box, to avoid re-typing it 
each time. 

9. Click Next. The Electronic Payment wizard is 
displayed, connecting to The Fund for 
electronic payment. If previously selected in 
the Closing File module, the Account No. 
and Bank number will display. Click the Get 
Accounts button to select a bank account 
from those that are set up in Preferences > 
Account Maintenance.

10. Enter the Routing No for 
the selected account.

This is a nine-digit number. Routing and 
Account numbers can be added as defaults 
under Preferences > Account 
Maintenance.

11. Click Submit Payment. The Electronic Payment wizard is 
displayed. Upon completion, the Invoice 
Payment Confirmation can be printed for 
your records. You can also print the invoice(s) 
with the Payment Confirmation Number from 
Fund Policy Premium Invoices in the 
Reports module.

12. Click Print. The ePayment Confirmation window is 
displayed. Confirm the transfer of the 
confirmation into Escrow accounting.

13. Click Finish. The eSolutions Electronic Payment
window is closed and the Invoice Selection
window is displayed. This window will 
indicate that all selected invoices meeting the 
Search criteria have been paid.
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Tips

14. Click OK. The Invoice Selection window is displayed 
for you to make another selection.

15. Click Cancel. The Electronic Payment - Invoice 
Selection window is closed.

1. Once electronic payments are made, you will be prompted to bring in the 
confirmation number(s) when going into the Escrow Accounting
module.
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Serialized Forms Module

Concept
The Serialized Forms module contains three components: Create Forms 
Inventory, Delete Forms Inventory, and Forms Tracking. Create Forms 
Inventory is used to add form numbers supplied by the underwriter to your inventory. 
This includes all owner and mortgagee policies, and serialized endorsements. The 
forms are selected and printed in the Documents module with information entered in 
the Closing File, Commitment and Policy modules. Fund serialized form 
numbers can be assigned electronically using eSolutions. For more information, 
select Help > Tutorials > DoubleTime from the main menu bar.

Objective
The objective of this lesson is to add serialized forms for the Owner and Mortgagee 
policies. You will also learn how to delete forms from the inventory.

Creating Forms Inventory 

What You Do Comments

1. Select Modules > 
Serialized Forms > 
Create Forms 
Inventory from the main 
menu bar.

The Create Forms Inventory window is 
displayed with Richard P. Bruce, Esq. as 
the Title Agent. 
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2. Select Old Republic 
National Title 
Insurance Company/
AFTS from the 
Underwriter drop down 
list.

3. Select Owner Policy 
(OF6) from the Form 
Type drop down list.

4. Type OF6 in the Prefix
column.

OF6 displays in the Prefix column.

5. Type 5001 in the Start No
box.

This is the beginning number for the owner 
policies supplied by the underwriter.

6. Type 5005 in the End No 
box.

This is the ending number for the owner 
policies.

7. On the secondary 
toolbar, click the Insert
button.

A second inventory line is created with Old 
Republic National Title Insurance 
Company/ATFS as the Underwriter.

8. Click the Form Type box 
and select Mortgagee 
Policy (MF6).

MF6 is displayed in the Prefix box.

9. In the Start No box, type 
7001.

10. TAB to the End No box, 
type 7005.
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Deleting Forms Inventory 

11. On the secondary 
toolbar, click the Close
button.

The Create Forms Inventory save dialog 
box is displayed.

12. Click Yes. The forms are saved in the inventory and the 
window is closed.

What You Do Comments

1. Select Modules > 
Serialized Forms > 
Delete Forms 
Inventory from the main 
menu bar.

The Delete Forms Inventory window is 
displayed with Richard P. Bruce, Esq. as 
the Title Agent.
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2. Select Old Republic 
National Title 
Insurance Company/
ATFS from the 
Underwriter Name drop 
down list.

3. Select Mortgagee Policy 
(MF6) from the Form 
Type drop down list.

This selection will allow you to delete 
mortgagee policy forms from the inventory 
for Old Republic National Title 
Insurance Company/ATFS. 

4. Type 7004 in the Start No
box.

This is the beginning number of the forms you 
want to delete.

5. Type 7005 in the End No 
box.

This is the ending number of the forms you 
want to delete.

6.  Click the Close
button on the secondary 
toolbar.

The Delete Forms Inventory window is 
displayed.
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7. Click Yes. The Warning Deleting Forms dialog box 
is displayed.

8. Click Yes. The Final Warning dialog box is displayed.

9. Click Yes. The Delete Forms Statistics dialog box is 
displayed showing the total number of forms 
selected and deleted.
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Tips

10. Click OK. The forms are deleted and the Delete Forms 
Inventory window is closed.

1. If the Underwriter or Agent Name lists do not include the names you 
need, use the Contacts module to add them.

2. When a form is added to the Forms Inventory, the initial status is 
Received.

3. When a form is selected in the Title Insurance module, the status is 
changed to Used.

4. To review the inventory of all forms for the agent, select Modules from the 
menu bar, select Serialized Forms, and then choose Forms Tracking. In 
the Select Serialized Forms window, identify the Underwriter and 
Agent and select All for the Form Type.

5. Use the Form Comments tab if a Form Status is changed to 
Transferred or Canceled.

6. To generate a report for a form type, select Reports from the menu bar, 
then choose Serialized Forms. 

7. You may delete a Serialized Form from DoubleTimes Forms 
Inventory, however, this action does not alert ATFS that a jacket has been 
deleted.  Users must also contact The Funds HelpDesk.
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Forms Tracking Module

Concept
The Forms Tracking module contains the status, comments, and history of each 
form created in Create Forms Inventory and eSolutions delivery of serialized 
forms. The final status of each form can be displayed in a report format, using 
Serialized Forms and/or Serialized Forms Electronic Delivery reports in the 
Reports module.

Objective
The objective of this lesson is to show you how to change the status of the owner’s and 
mortgagee policies from Used to Sent to Underwriter.

Assigning A Form To A Closing File & A Form Status 

What You Do Comments

1. On the main toolbar, 
click the Forms 
Tracking button.

The Select Serialized Forms window is 
displayed. 
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2. Select Old Republic 
National Title 
Insurance Company/
ATFS from the 
Underwriter drop down 
list. 

3. Click OK. The Forms Tracking window is displayed. 
The forms that match the search criteria are 
displayed in the Inventory Status tab. 

Displayed in the lower portion of the window 
are the Underwriter, Agent, and Agent #
associated with the selected form.

4. Scroll to OF6-5005, one 
of the jackets you placed 
into inventory. 

NOTE: The Closing File Number column 
is blank next to OF6-5005.

5.  Click the Close
button on the secondary 
toolbar.

6.  Click the Switch 
Active Closing File
Button. 
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7. The Closing File 
Selection window is 
displayed.

8. Type Poe in the Closing 
File Number box and then 
click Browse.

The PoeToPanasevich file is retrieved, 
displayed, and highlighted. 

9. Click OK. The active Closing File switches to 
PoeToPanasevich. 

10. Press CTRL+ALT+P to 
open the Title Insurance 
> Policy module.

The Title Insurance Policy window for the 
active Closing File displays.

11. Select Richard P. Bruce 
from the Signatory drop 
down list. 

12. Select Old Republic 
National Title 
Insurance Company/
ATFS from the 
Underwriter drop down 
list. 
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13. Click on the drop down 
arrow for the Policy No.
box. 

14. Select OF6-5001. This associates this policy jacket with the 
closing file. 

15.   Click the Close
button on the secondary 
toolbar. 

You are prompted to save changes. 
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16. Click Yes. Your changes are saved. 

17. On the main toolbar, 
click the Forms 
Tracking button.

This takes you back to the Forms Tracking 
module.

18. Select Old Republic 
National Title 
Insurance Company/
ATFS from the 
Underwriter drop down 
list. 

19. Click OK. The Forms Tracking window is displayed. 
The forms that match the search criteria are 
displayed in the Inventory Status tab. 

20. Scroll down and select 
OF6-5001.

The Closing File Number column reflects 
that this jacket is now associated with the 
PoeToPanasevich file. The Form Status
box reflects the jacket’s current status as 
Used.

21. Select Sent to 
Underwriter from the 
Form Status drop down 
list.

NOTE: If the policy is sent to The Fund 
electronically, even if it is a paper form, 
DoubleTime will automatically give the 
Form Status of Sent to Underwriter.
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Viewing A Form History 

Tips

22. On the secondary 
toolbar, click the Save
button.

The changes are saved.

What You Do Comments

1. Click the Form History
tab. 

The Form History tab is displayed. This is a 
display-only window showing Form Status, 
Status Date, Closing File No., and 
Assigned To for the selected form.

2.  Click the Close
button on the secondary 
toolbar.

The Forms Tracking module is closed.

1. An alternate way to open the Forms Tracking module is to select 
Modules > Serialized Forms > Forms Tracking from the menu bar.

2. If the Underwriter or Agent Name lists do not include the names you 
need, use the Contacts module to add them.

What You Do Comments
Training Workbook: August 2018 Page 677



Forms Tracking Module
3. When a form is added to the Forms Inventory, the initial status is 
Received. When a form is prepared in the Policy module, the status is 
changed to Used.

4. To review the inventory of all forms for the agent in the Select Serialized 
Forms window, identify the Underwriter and Agent and select All for 
the Form Type.

5. Use the Form Comments tab if a Form Status is changed to 
Transferred or Canceled and type the information pertinent to the form. 
You can use the Spell Check icon for this tab.

6. To generate a report for a form type, select the Reports module on the main 
toolbar and choose Serialized Forms. 

7. To return a Serialized Form to Forms Inventory after associating it to a 
file, within Serialized Form/Forms Tracking, change the status to 
Received. It is then available for another file.
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Tutorials

Concept
The built-in Help menu within DoubleTime contains access to Tutorials. It consists 
of stand alone self paced eLearning programs. These are accessed by choosing Help > 
Tutorials > DoubleTime.

Objective
The objective of this lesson is to acquaint you with the built in Tutorials. 

Run Tutorial 

What You Do Comments

1. Click Help >Tutorials > 
DoubleTime on the menu 
bar. 

The eSolutions Overview tutorial will 
begin. This tutorial demonstrates how to use 
the eSolutions features for Fund Forms and 
Electronic Payment.

2. Click Enable 
eSolutions Features.

This part of the tutorial begins with 
instructions on how to set up the Electronic 
Delivery features and explains the process to 
obtain a commitment number electronically.
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3. Continue to follow the 
directions in the dialog box
on which buttons to click
throughout the Tutorial to 
obtain instruction on 
requesting commitment 
and policy forms 
electronically.

After requesting commitments and policies 
electronically, the Tutorial will instruct you on 
how to file your policies and endorsements 
electronically.
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4. Continue to proceed 
following the directions in 
the dialog box on which 
buttons to click throughout 
the tutorial on electronic 
policy processing.

A message will display confirming the 
Electronic Delivery Process has been 
completed.
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5. Upon completion of the 
Tutorial, click Exit.

A window displays stating if there are any 
additional questions or if you need assistance, 
please click the Contact Us button for our 
toll free Help Desk number and web site 
addresses.

6. Click Exit. The Tutorial ends and DoubleTime is 
displayed.
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Checklist Module

Concept
The Checklist module is where you create and manage automated “to-do” lists for 
various types of transaction files and the location where you can associate a particular 
checklist with a closing file. Checklists display all the actions (tasks) that you want to 
track. The actions on a stock checklist can be customized for a particular closing file 
without impacting the stock checklist form. There are different standard checklists 
available, based on the closing type. In the Checklist >Template Maintenance
module, user-defined checklists can be added.

Objective
The objective of this lesson is to show you how to create and customize a user-defined 
checklist template in the Checklist module. Then you will select the new template in 
the Checklist module for closing file PoeToPanasevich, track actions, and log a 
problem.

Viewing A Checklist

What You Do Comments

1. Select Modules > 
Checklist > Template 
Maintenance from the 
menu bar.

The Checklist Template Maintenance
window is displayed. The default template is 
DoubleTime Training Seminar 
Checklist Template.
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2. Select Stock Template 
For Residential 
Purchase and Sale – 
New Loan from the 
Template drop down list.

The Stock Template For Residential 
Purchase and Sale – New Loan template 
is displayed.

3.  Click the Expand All
button on the secondary 
toolbar.

All levels for each category display. 
NOTE: To expand one specific category, 
click the plus sign (+) by the category number. 
To collapse one specific category, click the 
minus sign (-) by the category number.

4. Select File > Save As 
from the menu bar.

The Save Checklist Template As...
window opens.

5. Type Richard Bruce 
Closing Checklist in the 
text box.

The Richard Bruce Closing Checklist
will be created from the stock template and 
saved as soon as you click OK. 
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Customizing A Checklist Template

6. Click OK. The template is saved with the new name.

What You Do Comments

1. Click the plus sign (+) 
before Category 03 
PROCESS ORDER.

The levels below PROCESS ORDER are 
displayed.
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2. Click the plus sign (+) 
before Category 03.01 
GATHER TITLE 
INFORMATION.

The levels below GATHER TITLE 
INFORMATION display.
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3. Select line 03.01.12 
PREPARE 
COMMITMENT.

4.  Click the Insert
button.

A new line is inserted, and PREPARE 
COMMITMENT has been moved down one 
line.

5. Type Import FPX File 
From Branch in the 
Action Description
column.

Mr. Bruce’s office orders Commitments from 
the Fund branch and imports the electronic 
file into DoubleTime in order to prepare 
Commitments.
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6. Select line 03.01.09
ORDER HARD COPY.
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Selecting A User-Defined Checklist & Tracking Activities

7. On the secondary 
toolbar, click the Delete
icon.

The line is deleted. NOTE: Mr. Bruce’s office 
orders Commitments and other Branch 
Products from the Fund branch. These orders 
automatically are sent with hard copies of 
instruments, so Mr. Bruce does not need to 
separately order them.

8.  Click the Close
button on the secondary 
toolbar.

The Checklist Template Maintenance
dialog box opens.

9. Click Yes. The Checklist Template Maintenance 
window is closed. The Richard Bruce 
Closing Checklist template is available for 
selection for a closing file.

What You Do Comments

1.  Click the Switch 
Active Closing File
Button. 

2. The Closing File 
Selection window is 
displayed.
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3. Type Poe in the Closing 
File Number box and then 
click Browse.

The PoeToPanasevich file is retrieved, 
displayed, and highlighted. 

4. Click OK. The active Closing File switches to 
PoeToPanasevich. 

5. Select Modules > 
Checklist > Closing 
File Checklist from the 
menu bar.

The Select Checklist Template window is 
displayed.
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6. Select Richard Bruce 
Closing Checklist from 
the Checklist Template list.

7. Click OK. The Closing File Checklist window is 
displayed.

8.  Click the Expand 
All button on the 
secondary toolbar.

All levels for each category display. Minus 
signs precede each expanded category 
number.

9. Scroll down to line 
03.01.11 Import FPX 
File From Branch.

10. Click the OK box, and 
insert today’s date in the 
Start and End fields.

We performed these steps on this transaction 
file, earlier in the training session.

NOTE: When you type dates, the slashes (/) 
are automatically inserted. The start and end 
dates are optional.
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Logging A Problem

11.  Select the user name of the 
person responsible for 
completing this action 
from the Responsible 
Party drop down list.

This person is responsible for importing the 
file into DoubleTime.

What You Do Comments

1.  Click the Originate 
Problem button on the 
secondary toolbar.

The Problem Log Maintenance window 
is displayed with the cursor in the 
Description box. Status defaults to In 
Process and Date defaults to the current 
date.
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2. Type Open 2006 
Mortgage!!! in the 
Description box.

NOTE: The FPX file previously imported 
reflects not one, but two open mortgages that 
require satisfaction. This is a problem in the 
current transaction because Mr. Bruce’s office 
did not know about the open, earlier 
mortgage.

3. Select Mortgages from 
the Category drop down 
list.

4. Select Lack of 
Satisfaction from the 
Type drop down list. 

5. Type 0505(current year)
in the Notification Date
box.

Example: 05/05/14.

6. Type the name of the 
person reporting the 
problem in the Reported
By box.

The Reported By box defaults to the name 
of the user currently logged in to DoubleTime 
and can be edited as needed.

7.  Click the Close
button on the secondary 
toolbar.

The save changes dialog box is displayed.
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8. Click Yes. The changes are saved. The Problem Log 
Maintenance window is closed and the 
Closing File Checklist window is 
redisplayed.

9.  Click the Expand All
button on the secondary 
toolbar.

The categories are expanded and the 
Problem symbol also displays next to 
additional lines. 

10. Click the Problem
symbol.

The Problem Log is displayed with the 
information you entered previously. 
NOTE: After the problem is resolved, you 
can change the Status box to Resolved and 
complete the Resolution information.
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Checklist Module
Solving A Problem

11.  Click the Close button 
on the secondary toolbar.

The Problem Log Maintenance window 
closes and the Closing File Checklist
window redisplays.

12.  Click the Print button 
on the secondary toolbar. 
Click OK.

The checklist prints. NOTE: It is a “best 
practice” to print the checklist when you 
update actions.

What You Do Comments

1. Click the Problem
symbol for line 03 
Process Order.

The Problem Log Maintenance window 
displays.
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2. Select Resolved from the 
Status drop down list.

3. Type Satisfaction 
obtained from seller in 
the Resolution 
Description box.

4. Type the name of the 
person resolving the 
problem in the Resolved
By box.

5. Type 0506(current year)
in the Notification Date
box.

Example: 05/06/14.
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6.  Click the Close button 
on the secondary toolbar.

7. Click Yes. The changes are saved. The Problem Log 
Maintenance window is closed and the 
Closing File Checklist window is 
redisplayed.

8. Notice the Problem 
Symbol has changed to a 

 green check mark 
indicating that the problem 
has been resolved.

9.  Click the Close button 
on the secondary toolbar.

10. Click Yes. The changes are saved. The Closing File 
Checklist window is closed.
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Tips 

1. Once you select and save a checklist for a closing file, you cannot choose a 
different checklist template for that closing file. However, you can modify 
the checklist for that closing file. The changes you make will not affect the 
master checklist template.

2.  To collapse all categories, click the Collapse All icon.To collapse a 
single category, click the minus (-) sign preceding the category number.

3.  To expand all categories, click the Expand All icon. To expand a 
single category, click the plus (+) sign preceding the category number.

4.  To insert a new level within a category, click the Insert New Level
icon.

5.  To delete a user-defined checklist, click the Delete Template icon.

6.  An alternate way to open the Checklist > Template Maintenance
module is to click the Template Maintenance icon on the Checklist
toolbar. The selected checklist template is not associated with a closing file.

7.  On the secondary toolbar, click the Print icon to print the checklist. It is 
a good idea to print the checklist at regular intervals throughout the closing 
file process.

8. In the Reports module you can print a Checklist - Problem Report, 
Checklist - Tasks Completed Report or Checklist - Tasks Due 
Report.
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Schedule Closing Module 

Concept
The Schedule Closing module is used to schedule the closing meeting. The 
Schedule Closing module is composed of three sections.

• Closing Meeting tracks the closing date, time, location, and attendees.
• Location Maintenance allows you to enter, delete, or modify the closing 

locations.
• Closing Schedule Report generates reports by location, closing agency, 

and/or closing agent for a specific date or range of dates.

Objective
The objective of this lesson is to show you how to schedule the closing time, select the 
closing location, and select the attendees. In addition, you will learn how to produce a 
Closing Schedule Report.

Scheduling A Closing 
You will schedule the closing time, location, and attendees for your closing file.

What You Do Comments

1.  Click the Switch 
Active Closing File
Button. 

2. The Closing File 
Selection window is 
displayed.
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3. Type Glenn in the Seller 
Name box and then click 
Browse.

The Glenn to Thomas file is retrieved, 
displayed, and highlighted. 

4. Click OK. The active Closing File switches to Glenn to 
Thomas.

5. Select Modules > 
Schedule Closing > 
Closing Meeting from 
the menu bar.

The Schedule Closings window opens 
with the Location tab displayed. The Date
and Closer information is carried over from 
the Closing File module.
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Schedule Closing Module
Selecting Attendees 

6. Confirm that the Date
field reflects the 
appropriate closing date.

If it does not, enter the correct date. 

7. Type 1100 in the Meeting 
Start Time box.

This is the time the meeting will begin. The 
time defaults to AM.

8. Type 1230P in the 
Meeting Stop Time box.

9. Select Richard P. Bruce, 
Esq./Conference Room 
2 from the Name drop 
down list.

The information is copied from the Location 
Maintenance module. 

Click the Location Maintenance
button to add, delete, or modify closing 
locations.

What You Do Comments

1. Click the Attendees tab. The attendees associated with this closing file 
and their roles in the closing are displayed. A 
check mark in the right column indicates that 
the person is to attend the closing and was 
established in the Closing File and 
Settlement Statement modules.

What You Do Comments
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Schedule Closing Module
2. Select the Attend 
Closing check box for

•  Richard P. Bruce Esq., 
Closing Agent
• Realty Company, Inc.
• Better Homes, Inc.
• Susan S. Thomas
• Peter R. Glenn
• Linda Glenn

This indicates that these persons/entities will 
attend the closing.

What You Do Comments
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Schedule Closing Module
Producing A Closing Schedule Report

3. On the secondary 
toolbar, click the Save
button.

The changes are saved.

What You Do Comments

1.  Click the Closing 
Schedule Report button 
on the secondary toolbar.

The Specify Criteria For Closing 
Schedule Report window is displayed.

2. Type 0101(current year)
in the From Date box.

Example: 010111. This is the date you want 
the report to start.

3. Type 0331(current year)
in the To Date box.

Example: 033111. This is the date you want 
the report to end. NOTE: You can select a 
report based on location, Closing Agents, 
and/or Closer.

What You Do Comments
Training Workbook: August 2018 Page 703



Schedule Closing Module
Tips

4. Click OK. The Closing Schedule Report window 
opens with information for all closings 
between the specified dates.

Use the First Record, 
Previous Record, Next 

Record, and Last Record buttons on the 
secondary toolbar to view each scheduled 
closing.

5.  On the secondary 
toolbar, click the Print 
icon.

The report is printed.

6.  Click the Close
button on the secondary 
toolbar.

The Closing Schedule Report module is 
closed and the Schedule Closing window 
is displayed.

7.  Click the Close
button on the secondary 
toolbar.

The Closing Schedule Report module is 
closed.

1. An alternate way to open the Schedule Closing > Location 
Maintenance module is to select Modules from the menu bar, select 
Schedule Closing, then choose Location Maintenance.

What You Do Comments
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Schedule Closing Module
2. An alternate way to open the Schedule Closing > Closing Schedule 
Report module is to select Modules from the menu bar, select Schedule 
Closing, then choose Closing Schedule Report.

3.  To add more attendees for the closing, use the Insert icon. The added 
attendees, if not previously entered, will be available for selection in the 
Contacts module for future files.

4.  Use the Preview icon on the secondary toolbar to view the report as it 
will be printed.
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Practice Session 1
Practice Session 1

Try This
As an employee of Richard P. Bruce, Esq., you will use the information extracted from 
a contract for sale and purchase, along with the information in the New Closing File 
and Title Insurance Commitment segments, to open a new closing file. This 
transaction involves the sale of residential property in Orange County, Florida, with 
the buyers obtaining a new mortgage. There is no payoff. You will also prepare and 
print the commitment.

Practice Session 1 Contract Information

LABEL TRANSACTION INFORMATION

Seller: John R. Davis and Madonna Davis, husband 
and wife

Seller Address: 1234 Tranquil Terrace, Orlando, FL 32801
Seller Phone: 407-889-4000 
Seller SS#: John: 555-33-8888      Madonna: 555-33-6767
Buyer(s): Timothy T. Daniels and Jillian Daniels, 

husband and wife
Buyer Address: 5220 Church Street, Orlando, FL 32801
Buyer Phone: 407-889-1234
Buyer(s) SS/TIN No.: Timothy:555-22-7777 Jillian:333-77-2222
Legal Description: Lot 5, Block 10, HAPPY ACRES, SECTION 

9, according to the plat thereof, as recorded in 
Plat Book 33, Page 56, of the Public Records 
of Orange County, Florida.

Street Address of Property: 1234 Tranquil Terrace, Orlando, FL 32801
Property Appraiser TIN: 11-22-33-4444-00905-10-05
Sellers’ Homestead: Yes
Mortgage(s) to Payoff: No. F&C.
Personal Property Included: None
Purchase Price: $100,000.00
Deposit: $10,000.00 (paid)
Escrow Agent for Deposit: Homefinders Realty Company
Financing Contingency: Yes
Contract Date: October 18, 20__ (CY-1)
Closing Date: February 20, 20__ (CY)
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Practice Session 1
 Set Up New Closing File & Enter Information
Use the information taken from the contract for sale and purchase that appears in the 
preceding table together with the following additional information to set up a new 
closing file in DoubleTime for this transaction.

 Enter Title Insurance Information

Brokers: Homes R Us (Listing) 
Homefinders Realty Co (Cooperating/
Buyers’)

Brokerage Commission: 6% split equally

DoubleTime Field/Tab Information You Use
Closing File No. Your name, PS, and the number 1. 

Example: Mary PS1.
Account No. Friendly Bankers, Inc., 123456-78

Notary Title
Notary Name
Expiration Date

Notary Public, State of Florida
Beth Cullum
March 27, 2021
Note: For Seller & Buyer 

Loan New, conventional insured, first mortgage 
with First Florida Bank
Loan #: 12345
Loan Amount: 96,500.00
Rate: 4.6
GFE HUD is selected by default. 

Participant Referral - Homefinders Realty Company
Print the Closing File Worksheet when you 
have finished entering all of the information.

DoubleTime Field/Tab Information You Use
Commitment Type Commitment (CF6)
Effective Date 01/15/ (current year)
Owner Yes, for purchase price

LABEL TRANSACTION INFORMATION
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Practice Session 1
Mortgagee Lender’s closing instructions state that the 
following language appear after its name as 
Named Insured “its successors and/or assigns 
as their interests may appear”

Requirements
 Insert to create line #3

 Clause Title: Judgments and Other 
Non-Consensual Liens: Proof of Non-
Identity (2) (GR 4.4)

Replace asterisks with:
• John R. Davis
• OR 7888/3233 of Orange County, Florida

Exceptions Will display and associate to file from the 
Master Property Selection made in 
Closing File

Commitment  Electronically request the commitment 
jacket

Endorse Policy No endorsements to Owner Policy.
Lender’s closing instructions state that the 

Mortgage Policy must be issued with the fol-
lowing endorsements:
06 ALTA 8.1 Environmental Protection Lien
06 ALTA 9 REM

Print the Commitment Schedules and Jacket.

DoubleTime Field/Tab Information You Use
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Practice Session 2
Practice Session 2

Try This
As an employee of Richard P. Bruce’s law firm, you will prepare the Policy Rating 
Worksheet, the HUD Settlement Statement, and the Balance Sheet for a closing file 
that has been set up by a coworker. The title insurance commitment for this Orange 
County property has been issued, and the closing is scheduled for August 3 (current 
year). This is a Non-RESPA transaction, because a private lender is involved. Closing 
file number 04-0008 has already been created. You may review the Closing File
module to familiarize yourself with the information.

 Premium Calculation (Rating)

Settlement Statement

DoubleTime Field/Tab Information You Use
Policies Verify the Owner Policy insurance amount is 

$95,000
Verify the Mortgagee Policy insurance 

amount is $85,000
Endorsements Verify the selection of the following:

06 ALTA 5.1 PUD
06 ALTA 8.1 Environmental Protection Lien
06 ALTA 9 REM

Worksheet Print the Policy Rating Worksheet.

DoubleTime Field/Tab Information You Use
Adjustments - Paid Homeowners’ Association fee: $125, paid 

quarterly. Prorate from 08/03/(current year) to 
09/30/(current year)

Buyer Credits Verify $5,000 deposit held by Homefinders 
Realty Co.
Payoff Calculator 
Payoff of seller’s first mortgage loan:
G E Capital Mortgage Corp
From 08/01/(current year) to 08/10/(current 

year)
Per Diem: $22.1233
Mortgage balance: $76,568.85
Note: Print payoff calculations
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Practice Session 2
Adjustments Unpaid County taxes - 
Gross amount: $1,124.24 annually 
Discount: 4% 
Period: Annually
Date from: 01/01(current year)
Date to: 08/03(current year)

Brokers Commission: 7% based on sales price
Split: 
4% to Homefinders Realty Company 

(buyer’s broker)
3% to Realty Company, Inc. (seller’s broker)

Loan Fees Paid by buyer
Appraisal fee: $250 P.O.C. (buyer) to The 

Appraisal Company
Credit report fee: $50 P.O.C. (buyer) to 

American Credit, Inc.
Prepayments Interest per diem: $19.7945

From 08/03/ (current year) to 09/01/ (current 
year)
Hazard insurance: $285 (1 year) to Home 

Insurance, Inc.
Flood insurance: $185 (1 year) to Home 

Insurance, Inc. 
Title Payable to Richard P. Bruce, Esq.:

Closing fee: $250 (buyer $100, seller $150) 
Title search fee: $75 (seller)
Review owner policy premium (seller)
Review mortgagee policy premium (buyer)

Recording Payable to Orange County Comptroller:
Warranty deed, 2 pages (verify buyer) 
Mortgage, 15 pages (verify buyer) 
Release, 1 page (verify seller) 
Continuous marriage affidavit, 2 pages 

(seller)
Add’l Charges Survey: $300 to Angle Surveying Company 

(buyer)
Pest inspection: $75 to Squash Em, Inc. 

(buyer)
Fascia board repairs: $95 to Home Warranty, 

Inc. (seller)

DoubleTime Field/Tab Information You Use
Page 712 DT Version: 8.1



Practice Session 2
Balance Sheet
Did you balance?
Combine all necessary fees.
Print the balance sheet.
Congratulations!

Print the HUD Settlement Statement

DoubleTime Field/Tab Information You Use
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Practice Session 3
Practice Session 3

Try This
As an employee of Richard P. Bruce, Esq., you are processing a new contract for sale 
and purchase with one new mortgage involved. This is a RESPA transaction that 
involves the sale of a residential property in Orange County, Florida, that will not be 
set up as a master property. The lender has provided a GFE, so a GFE HUD must be 
prepared.

Practice Session 3 Contract Information

LABEL TRANSACTION INFORMATION

Seller: Norman Armstrong, and Mary Armstrong, his 
wife

Seller Address: 777 Park Lane West, Harleysville, 
Pennsylvania 19438

Seller Phone:  
Seller SS#: Norman: 222-22-3333 Mary:333-33-4444
Buyer(s): James E. Jones III, a single man
Buyer Address: 413 Bayshore Drive, Windermere, FL 34786
Buyer Phone:
Buyer(s) SS/TIN No.: James: 234-28-3452
Legal Description: Lot 1, Bayshore Estates, according to the Plat 

thereof, as recorded in Plat Book 7, Page 138, 
of the Public Records of Orange County, 
Florida

Street Address of Property:  413 Bayshore Drive, Windermere, FL 34786
Property Appraiser TIN: 05-23-28-0545-00010
Sellers’ Homestead: No
Mortgage(s) to Payoff: Yes
Personal Property Included: Couch and recliner
Purchase Price: $365,000.00
Deposit: $25,000.00
Escrow Agent for Deposit: Homes R Us (is holding $25,000.00)
Financing Contingency: Yes
Contract Date: February 14, 20__ (CY)
Closing Date: March 17, 20__ (CY)
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Practice Session 3
Set Up New Closing File & Enter Information
Use the information taken from the contract for sale and purchase that appears in the 
preceding table together with the following additional information to set up a new 
closing file in DoubleTime for this transaction.

Brokers: Orange Realty, Inc (Listing)
Homes R Us (Cooperating/Buyer’s) 

Brokerage Commission: $21,900 split equally (3% each)

DoubleTime Field/Tab Information You Use
Closing File No. Your name, PS, and the number 3. 

Example: Mary PS3.
Account No. 9987-323 Perpetual Federal Bank
Notary Title

Notary Name

Expiration Date

Buyer:
Notary Title: Notary Public, State of Florida
Notary Name: Beth Cullum
Expiration Date: March 27, 2021
Seller: 
State of: Commonwealth of Pennsylvania
Notary Title: Notary Public, 
State of Pennsylvania

Loan 1) New, conventional uninsured, first mort-
gage
$292,000 with Bank of Florida, 28 Orange 

Blossom Trail, Orlando, FL 32828
Loan No. 512873
Interest Rate: 6%
Ensure Interest Method is 360
Term: 30 years (For information only)
2) Payoff,
First mortgage with Big Time Bankers 

 Mailing address: 2100 Cheney Hwy, Orlando, 
FL 32822
Print the Closing File Worksheet when you 
have finished entering all of the information.

LABEL TRANSACTION INFORMATION
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Practice Session 3
Enter Title Insurance Information

DoubleTime Field/Tab Information You Use
Commitment Type Commitment (CF6)
Effective Date March 1(current year)
Owner Yes, for purchase price
Mortgagee Lender’s closing instructions state that the 

following language appear after its name as 
Named Insured “its successors and/or assigns 
as their interests may appear”

Endorse Policy No endorsements to Owner Policy.
Lender’s closing instructions state that the 

Mortgage Policy must be issued with the fol-
lowing endorsements:
06 ALTA 8.1 Environmental Protection Lien
06 ALTA 9 REM

Requirements Replace the asterisks in the Satisfaction 
Clause with:
08/03/02
233
777
Add Clause: GR-4.2 Judgments and other 

Nonconsensual Liens: Continuous Marriage 
Affidavit
Replace the asterisks with: 
Norman Armstrong 
Mary Armstrong
August 3, 2002

Exceptions E-5.1 Plat: Plat Exception

Replace asterisks with info from legal 
description

Commitment  Electronically request the commitment 
jacket
Print the commitment and Fund Commitment 
Jacket
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Practice Session 3
Premium Calculation (Rating)

Settlement Statement

DoubleTime Field/Tab Information You Use
Print the Policy Rating Worksheet

DoubleTime Field/Tab Information You Use
Update Recording Charge Yes
Buyer Credits Per the Contract, Seller pays:

Owner’s Policy Premium: $1,900.00 
Title Search fee: $125.00 
Document Stamps - Deed: $2,555.00

Payoff Calculator 
Payoff from 3/1/(current year) to 3/20/(cur-

rent year)
Per diem: $43.51 
Mortgage balance: $165,075.00
Note: Print payoff calculations

Adjustments Unpaid County Taxes: $4,175.00 annually, prorate 
with 4% discount – unpaid by seller

Brokers Commission: $21,900.00 (6%)
Split:
$10,950 (3%) to Homes R Us; withhold fees
$10,950 (3%)  to Orange Realty, Inc.

Loan Fees GFE related charges and the payees were 
identified by the lender.
Your credit or charge(points) for the specific 

interest rate chosen: $730.00 (Bank withhold-
ing fees)
Appraisal Fee: $300 to Appraisers, Inc. 

(Bank withholding fees)
Prepayments Per diem interest: $48.6699 (Bank withhold-

ing fees)
Homeowner’s insurance: (1 year) to 
Everystate Insurance Company, $1100.04 

P.O.C.
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Practice Session 3
Reserves Homeowner’s insurance: 2 months
County property taxes: 6 months
Aggregate accounting adjustment: $-366.70 

(Bank withholding total reserves)
Title GFE related charges and the payees were 

identified by the lender.
Settlement or closing fee paid by borrower: 

$250.00
Settlement or closing fee paid by seller: 

$250.00
Abstract or title search payable to ATFS LLC 

paid by borrower: $125.00
Recording Payable to Orange County Comptroller:

Deed: 2 pages (borrower)
Mortgage: 15 pages (borrower)
Release: 1 page (seller)
Continuous Marriage Affidavit: 2 pages 

(seller)
Add’l Charges GFE related charges:

Survey: $250 (borrower) to Florida Survey 
Co.
Pest inspection: $75 (borrower) to Termites R 

Us
GFE - HUD-1 Comparison Good Faith Estimate column figures:

Use figures on the GFE provided to complete 
these columns

Loan Terms Use figures on the GFE provided to complete 
the Terms
Total monthly amount owed including 

escrow account payments: 
You have an additional monthly escrow pay-

ment of: $439.59
That results in a total initial monthly amount 

owed of $2,320.95.   
Includes: Property taxes and Homeowner’s 

insurance
Print the HUD Settlement Statement & 
Recording Worksheet

DoubleTime Field/Tab Information You Use
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Practice Session 3
 Balance Sheet
Ensure your incoming wire fee is $288,384.46.
Combine all necessary charges for respective Payees.
Split sellers proceeds between Norman Armstrong and Mary Armstrong. Norman 
receives $75,000.00, the balance goes to Mary.
Funds from Buyer were received in the amount of $54,362.98.00.
Ensure excess funds disbursement to buyer in the amount of $1,000.00.
Print Balance Sheet

Conveyance
Title Affidavit: Seller clause: Continuous Marriage Affidavit clause from Clause 
Library.
Bill of Sale items: couch and recliner.

Documents

1099-S
Print the 1099-S, copies B & C.

Title Insurance - Use Policy Express Checkout

Create and Print Bill of Sale 
Closing Affidavit (Seller)
FL Warranty Deed (Statutory Form)
Non-Foreign Certification by Individual 

Transferor
Title Affidavit (Seller)

DoubleTime Field/Tab Information You Use
Owner Effective Date: March 17, 20__ (CY)

 Time: 9:00 am
Record Deed  No recording information required
Owner Except Add Exception: Standard exceptions 2, 3, 4, 

and 5 are hereby deleted
Review Owner Exceptions
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Practice Session 3
 Premium Calculation (Rating) - Electronic Delivery

 Electronically deliver the Owner and Mortgagee Policies and all endorsements.
Print the invoice sheet.

 Documents

Mortgagee Confirm Effective Date and Time match 
Owner’s Policy.

Record Mtg No recording information required
Build Mortgage Description

Mtg Except Review Mortgagee Exceptions
Endorse Mtg Review Mortgagee Endorsements

Print: FUND 06 Mortgagee Policy (MF6)
FUND 06 Mortgagee Policy (MF6) Jacket
FUND 06 Owner’s Policy (OF6)
FUND 06 Owner’s Policy (OF6) Jacket

DoubleTime Field/Tab Information You Use
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Practice Session 4
Practice Session 4

Try This
As an employee of Richard P. Bruce, Esq., it is your good fortune to process a new 
contract for sale and purchase with no mortgages involved. This all-cash transaction 
involves the sale of a condominium unit in Orange County, Florida.
Use the Master Property Module section of the training workbook to assist you in 
the preparation of the Master Property record.

Master Property Module

DoubleTime Field/Tab Information You Use
Required Type: Condominium (New)
Name Sunshine State Condominium
General Information Legal Description: Add Condo clause 

from the Clause Library
Replace asterisks with:
Sunshine State
3412
428 
Orange
Note: Leave the asterisks for Unit No. and 

Building in place.
Recording PIN 11-22-33-8228-***

Fill in Book and Starting Page No. 
information

Exceptions Add these clauses:
E-7.2 Condominiums: Recreation Lease
E-7.1 Condominiums: Declaration of Condo-

minium
Replace asterisks with:
Sunshine State Condominium
February 20, 1998
3412
428
Orange County, Florida
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Practice Session 4
Practice Session 4 Contract Information

 Set Up New Closing File & Enter Information

Use the information taken from the contract for sale and purchase that appears in the 
preceding table together with the following additional information to set up a new 

LABEL TRANSACTION INFORMATION

Seller: Barbara O. Bates, a single person,
Seller Address: 28 Diamond Avenue, Fort Lauderdale, Florida 

33309
Seller Phone:
Seller SS#: Barbara: 673-17-8976
Buyer(s): William J. and Wanda Morton, husband and 

wife
Buyer Address: 80 Chestnut Lane, Akron, Ohio 44321
Buyer Phone:
Buyer(s) SS/TIN No.:
Legal Description: Unit #15, Building C, Sunshine State 

Condominium, Orange County, Florida 
Street Address of Property: 150 East Street, Unit 15C, Orlando, FL 32828
Property Appraiser TIN: 11-22-33-8228-00015
Sellers’ Homestead:
Mortgage(s) to Payoff: None. F&C.
Personal Property Included:
Purchase Price: $115,000.00
Deposit: $11,500.00 
Escrow Agent for Deposit: No escrow agent; paid directly to Seller
Financing Contingency: No
Contract Date: August 10, 20__(CY)
Closing Date: October 19, 20__ (CY)
Brokers: None
Brokerage Commission: None
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Practice Session 4
closing file in DoubleTime for this transaction.

Enter Title Insurance Information

DoubleTime Field/Tab Information You Use
Closing File No. Your name, PS, and the number 4. 

Example: Mary PS4.
Account No. 993823433 Great American Bank
Notary Title

Notary Name

Expiration Date

Buyers:
State of: State of Ohio
Notary Title: Notary Public, State of Ohio
Deselect Produced ID check box
Seller:
Notary Title: Notary Public, State of Florida
Notary Name: Beth Cullum
Expiration Date: March 27, 2021

Print the Closing File Worksheet when you 
have finished entering all of the information.

DoubleTime Field/Tab Information You Use
Commitment Type Commitment (CF6)
Effective Date October 15 (current year)
Owner Yes, for purchase price
Mortgagee None. All cash transaction
Requirements Add these clauses:

GR-13.1B Condominiums: Estoppel Letter
I-13.1 Condominiums: Consent
Replace the asterisks with: Sunshine State

Exceptions Review exceptions
Commitment  Electronically request the commitment 

jacket
Endorse Policy No endorsements to Owner Policy.
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Practice Session 4
Settlement Statement

Balance Sheet
Combine fees for: Richard P. Bruce, Esq.
Print: Balance Sheet

Documents

DoubleTime Field/Tab Information You Use
Update Recording Charge Yes
Adjustments - Paid Maintenance Assessments: $215.60 per 

month, for one month – paid by seller in 
advanced (10/19 to 10/31/current year)

Adjustments Unpaid County Taxes: $1,395.00 annually, prorate 
with 4% discount – unpaid by seller

Title Settlement or closing fee: $250 (paid by 
buyer)
Abstract or title search fee: $150 (paid by 

seller)
Title insurance: $650 (paid by seller)

Recording Deed: $18.50 (paid by buyer, payable to 
Orange County Comptroller) 2 pages

Add’l Charges Condominium approval fee: $50 (split 
between the parties, payable to Sunshine State 
Condo Association)
Print Buyer/Seller Closing Statement

Print: FUND 06 Commitment (CF6)
FUND 06 Commitment (CF6) Jacket
FL Warranty Deed
Closing Affidavit (Seller)
Page 724 DT Version: 8.1



Practice Session 5
Practice Session 5

Try This
As an employee of Richard P. Bruce, Esq., you will input a new contact, create a user-
defined clause, and create a customized document.

Contacts Module

Clause Library Maintenance Module

DoubleTime Field/Tab Information You Use
Contact Type Corporation
Name Ciao for Now Bug Control, a Florida 

Corporation
Address > Type > Mailing 555 Second Street

Hialeah, FL 33016
Phone: Business: 305/825-0000

Business Fax: 305/825-0001
Employees Luigi Gavinci, President

Cate R. Pillar, Employee
Services Pest Inspector

DoubleTime Field/Tab Information You Use
Clause Type Affidavit

(New)
Clause Title Tax Proration
Clause The tax prorations are based upon an estimate 

and are accepted by the parties. It is agreed 
that the actual taxes, if different, will be 
adjusted between the parties. Closing Agent is 
not liable for additional taxes.

Note: It is a good idea to use  Spell 
Check after manually adding any text to a 
clause.
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Practice Session 5
Preferences > Document Customization

DoubleTime Field/Tab Information You Use
Master Document 
Selection

Choose Title Affidavit (Seller)
and Select All and Delete

Save as New Master Custom Document Name: Arm’s Length 
Affidavit.
Note: Select All and Delete, in order to arrive 

at a blank document.
Open the Arm’s Length Affidavit in Microsoft 
Word, and then Copy and Paste all of the text 
into the blank DoubleTime document window.

 Insert Field Seller Name(s) w/o status
Legal Description Closing File
Seller Name(s) with Status
Property County
Underwriter Name
Underwriter Name
Seller Signature
Seller Notary Block

Close and Save the new custom document
Documents Module Relate the Arm’s Length Affidavit to the 

closing file for Practice Session 4 and print it. 
Note: If necessary, Switch Active Closing 
File.
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Practice Session 6
Practice Session 6

Try This
As an employee of Richard P. Bruce, Esq., you are to create a master property for 
Island Breeze Subdivision in Palm Beach County. You will then create a master 
closing file for CandC-IslBreeze. In turn, you will copy the new closing file using 
Utilities, Closing File Copy and complete the remaining tasks for this new file. 

Master Property Module

New Master Closing File

DoubleTime Field/Tab Information You Use
Master Property Search 
Selection

Type: Subdivision
Name: Island Breeze
New

General Information Legal Description:
Use Plat (from Clause Library) 
Replace appropriate *** with
Island Breeze
Book 1222
Page 7314
Palm Beach

Recording PIN: 50-43-43-35-04-000-***
Exceptions Add the following clauses:

E-24.1 Municipal/county liens for service 
charges and waste fees 
E-12.11 Water/Submerged Land Rights: 

Streams and creeks
Replace asterisks with:
Little Lake

DoubleTime Field/Tab Information You Use
Closing File No. CandC-IslBreeze
Account No. 99876-11 Sunshine Banks
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Practice Session 6
Utilities > Closing File Copy

Seller C&C Developers, Inc.
Signatory: Steven Smith, President
888 Oak Ridge Road, Hialeah, FL 33016
Federal EIN #: 59-3322110

Edit Name(s) with Status and select the 
following:
State: Florida
Format: for profit

Notary Block Seller Notary Title: Notary Public, State of Florida
Notary Name: Select your name
Expiration Date: July 17, 2021

Property Island Breeze
Loan Add a loan and select the following:

Status: Payoff
Priority: First
Type: Other
Lender Name: Bank of Florida

Save changes and close the file

DoubleTime Field/Tab Information You Use
Utilities > Closing File 
Copy

Existing File: CandC-Islbreeze
New File: Your name, PS, and the number 6.
Example: Mary PS6.

 Select all tabs

 Copy the closing file
Click Yes to Save Changes
Click Yes to switch active closing file to your 
file. Your newly created copy of the CandC-
IslBreeze closing file is now active

DoubleTime Field/Tab Information You Use
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Practice Session 6
Practice Session 6 Contract Information

LABEL TRANSACTION INFORMATION

Seller: C&C Developers, Inc.
Seller Address: 888 Oak Ridge Road, Hialeah, FL 33016
Seller Phone:
Seller SS#: 59-3322110
Buyer(s): Daniel D. Frank and Dawn Frank, husband 

and wife 
Buyer Address: 980 Paradise Palm Place, West Palm Beach, 

FL 33404
Buyer Phone:
Buyer(s) SS/TIN No.: Daniel: 222-22-2222 Dawn: 111-11-1111
Legal Description: Lot 28, Block 10, Island Breeze Subdivision, 

Palm Beach County, Florida 
Street Address of Property: 980 Paradise Palm Place, West Palm Beach, 

FL 33404
Property Appraiser TIN: 50-43-43-35-04-000-10-28
Sellers’ Homestead:
Mortgage(s) to Payoff: Yes. Bank of Florida
Personal Property Included:
Purchase Price:  $100,000.00
Deposit: $10,000.00 
Escrow Agent for Deposit: Richard P. Bruce, Esq.
Financing Contingency: No
Contract Date: November 11, 20__(CY)
Closing Date: December 15, 20__ (CY)
Brokers: None
Brokerage Commission: None
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Finish Closing File & Enter Information
Use the information taken from the contract for sale and purchase that appears in the 
preceding table together with the following additional information to finish setting up 
the closing file.

DoubleTime Field/Tab Information You Use

 Click Open Closing 
File 

Access your file for this transaction, if it is not 
already the active closing file. Enter the 
information about the transaction that appears 
in the preceding table of contract information.

Notary Buyer 
Notary Title: Notary Public, State of Florida
Notary Name: Select your name
Expiration Date: July 17, 2021

Print the Closing File Worksheet when you 
have finished entering all of the information.
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Practice Session 7

Try This
As an employee of Richard P. Bruce, Esq., you are processing a new contract for sale 
and purchase with one new mortgage involved. This is a CFPB transaction that 
involves the sale of a residential property in Orange County, Florida, that will not be 
set up as a master property. The lender has provided a Closing Disclosure, so a 
Closing Disclosure Settlement Statement must be prepared.

Practice Session 7 Contract Information

LABEL TRANSACTION INFORMATION

Seller(s): Norman Armstrong, and Mary Armstrong, his 
wife

Seller Address: 777 Park Lane West, Harleysville, 
Pennsylvania 19438

Seller Phone: Cell # for Norman: 407-777-5555
Seller(s) SS#: Norman: 222-22-3333 Mary:333-33-4444
Buyer(s): James E. Jones III, a single man
Buyer Address: 413 Bayshore Drive, Windermere, FL 34786
Buyer Phone: Home # for James: 407-888-9999
Legal Description: 

**Not a Master Property. 
**This is a subdivision.

Lot 1, Bayshore Estates, according to the Plat 
thereof, as recorded in Plat Book 7, Page 138, 
of the Public Records of Orange County, 
Florida.

Street Address of Property:  413 Bayshore Drive, Windermere, FL 34786
Property Appraiser PIN: 05-23-28-0545-00010
Personal Property Included: Couch and recliner
Purchase Price: $365,000.00
Deposit: $60,000.00 (held by Buyer’s Broker)
Escrow Agent for Deposit: Realty Company, Inc. (is holding $60,000.00)
Contract Date: February 14, 20__ (CY)
Closing Date: March 17, 20__ (CY)
Brokers: Better Homes, Inc. (Listing)

Realty Company, Inc. (Cooperating/Buyer’s) 
Brokerage Commission: $21,900 split equally (3% each)
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Set Up New Closing File & Enter Information
Use the information taken from the contract for sale and purchase that appears in the 
preceding table together with the following additional information to set up a new 
closing file in DoubleTime for this transaction.

DoubleTime Field/Tab Information You Use
Closing File No. Your name, PS, and the number 7. 

Example: Mary PS7.
Account No. 9987-323 Perpetual Federal Bank
Notary Title

Notary Name

Expiration Date

Buyer:
Notary Title: Notary Public, State of Florida
Notary Name: Beth Cullum
Expiration Date: March 27, 2021
Seller: 
State of: Pennsylvania
Notary Title: Notary Public, State of _______

Loan 1) New Lender, conventional uninsured, 
first mortgage of $292,000 with 
Bank of Florida, 28 Orange   Blossom Trail, 

Orlando, FL 32828
• Loan No. 512873
• Purpose: Purchase existing home, 
previously occupied
• Product: Fixed Rate
• Interest Rate: 6%
• Payment Interval: Monthly
• Number of Payments: 360
• Days/Year: 365

2) Payoff Lender is Big Time Bankers
This is Sellers First mortgage  

 Mailing address: 2100 Cheney Hwy, 
Orlando, FL 32822

HINT:  Payoff amount is entered on page 3 
of the CD.
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Enter Title Insurance Information

DoubleTime Field/Tab Information You Use
Participants Bank of Florida (Lender)

          Thomas Price (Loan Officer)
Realty Company, Inc. (Buyer’s Broker)
          Rick W. Robertson (Buyer’s Agent)
Better Homes, Inc. (Seller’s Broker)
          George Bigfoot (Seller’s Agent)

Print the Closing File Worksheet when you 
have finished entering all of the information.

DoubleTime Field/Tab Information You Use
Commitment Type Commitment (CF6R)
Effective Date March 1(current year)
Owner Policy Required: Yes.            

In the amount of purchase price
Mortgagee Policy Required: Yes.              

Lender’s closing instructions state that the 
following language appear after its name as 
Named Insured “its successors and/or assigns 
as their interests may appear”

Endorse Policy No endorsements to Owner Policy.
Lender’s closing instructions state that the 

Mortgage Policy must be issued with the fol-
lowing endorsements:
• 06 ALTA 8.1 Environmental Protection Lien
• 06 ALTA 9 REM
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 Premium Calculation (Rating)

Requirements Replace the asterisks in the Satisfaction 
Clause with:
      08/03/02
      233
      777

Add Clause: GR-4.2 Judgments and other 
Nonconsensual (Nonvoluntary) Liens: Con-
tinuous Marriage Affidavit
      Replace the asterisks with: 
      Norman Armstrong 
      Mary Armstrong
    

Exceptions E-5.1 Plat: Plat Exception

Replace asterisks with info from legal 
description

Commitment  Electronically request the commitment 
jacket
Print the commitment and Fund Commitment 
Jacket

DoubleTime Field/Tab Information You Use
Print the Policy Rating Worksheet

DoubleTime Field/Tab Information You Use
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Closing Disclosure Statement

DoubleTime Field/Tab Information You Use
Page 1 Date Issued: 3/13/(CY)

Use Appendix 11 - Closing Disclosure For 
Practice Session 7 to complete Page 1 
sections: Loan Terms and Projected 
Payments.

Pg.2 
Closing Cost Details

Update Recording Charge - Yes

Make Room For Additional Rows For 
Recording and Transfer Taxes - YES
Use Appendix 11 - Closing Disclosure For 
Practice Session 7 to complete Page 2 
sections: Loan Costs and Other Costs.

Pg. 2, Section A Withhold all fees payable to Bank of Florida 
for section A.

Pg. 2, Section B Withhold the POC amount for the Credit 
Report in section B.

Pg. 2, Section C  Use the Title Premium Allocation button 
on the secondary toolbar to adjust payment of 
the Title Insurance premiums per the contract. 
The Seller is paying for the Owner’s policy in 
this transaction.

Pg. 2, Section E, Lines 01 
and 02,   Recording Fees

Payable to State of Florida:
• Deed: 2 pages (Borrower)
• Mortgage: 15 pages (Borrower)
• Continuous Marriage Affidavit: 2 pages 
(Seller)

Pg. 2, Section F Withhold all fees payable to Bank of Florida 
for section F.

Pg. 2, Section G Withhold all fees payable to Bank of Florida 
for section G.
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 Balance Sheet
Ensure your incoming wire fee is $285,655.84.
Combine all necessary charges for respective Payees.
Split sellers proceeds between Norman Armstrong and Mary Armstrong. Norman 
receives $75,000.00, the balance goes to Mary.
Funds from Buyer were received in the amount of $22,000.00.
Print Balance Sheet.

Pg. 3, Summaries of 
Transactions

Seller’s First Loan Payoff.

Use Payoff Calculator 
• Payoff from 3/1/(current year) to 3/20/
(current year)
• Per diem: $43.51 
• Mortgage balance: $165,075.00
Note: Print payoff calculations

Adjustments Unpaid

County Taxes: $4,175.00 annually, prorate 
with 4% discount – unpaid by seller

Pg. 3, Calculating Cash to 
Close

Use Appendix 11 - Closing Disclosure For 
Practice Session 7 to complete Page 3, 
Calculating Cash to Close.

Page 4 Use Appendix 11 - Closing Disclosure For 
Practice Session 7 to complete Page 4, 
Additional Information About This Loan.

You will need to select Late Charge Type: 
Percent of Principal And Interest for the 
Late Fee.

Page 5 Use Appendix 11 - Closing Disclosure For 
Practice Session 7 to complete Page 5, Loan 
Calculations, Other Disclosures, Contact 
Information and Confirm Receipt.

Print the Closing Disclosure Settlement 
Statement & Recording Worksheet

DoubleTime Field/Tab Information You Use
Page 736 DT Version: 8.1



Practice Session 7
Conveyance
Title Affidavit: Seller clause: Continuous Marriage Affidavit clause from Clause 
Library.
Bill of Sale items: couch and recliner.

Documents

1099-S
Print the 1099-S, copies B & C.

Title Insurance - Use Policy Express Checkout

Create and Print Bill of Sale 
CD Addendum B- Customary Recitals
Closing Affidavit (Seller)
FL Warranty Deed (Statutory Form)
Florida Insurance Premium Disclosure
Non-Foreign Certification by Individual 

Transferor
Title Affidavit (Seller)

DoubleTime Field/Tab Information You Use
Owner Effective Date: March 17, 20__ (CY)

 Time: 9:00 am
Record Deed  No recording information required
Owner Except Add Exception: Standard exceptions 2, 3, 4, 

and 5 are hereby deleted
Review Owner Exceptions

Mortgagee Confirm Effective Date and Time match 
Owner’s Policy.

Record Mtg No recording information required
Build Mortgage Description

Mtg Except Review Mortgagee Exceptions
Endorse Mtg Review Mortgagee Endorsements
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Practice Session 7
 Premium Calculation (Rating) - Electronic Delivery

 Electronically deliver the Owner and Mortgagee Policies and all endorsements.
Print the invoice sheet.

 Documents
Print: FUND 06 Mortgagee Policy (MF6)

FUND 06 Mortgagee Policy (MF6) Jacket
FUND 06 Owner’s Policy (OF6)
FUND 06 Owner’s Policy (OF6) Jacket
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Setting Up
Setting Up

Installing DoubleTime
You will be asked to enter the following information during the installation process:

• User Name 
• Entity Type
• Legal Entity Name
• Tax ID Number
• Office Information (including your address, etc.)
• Types of Services 
• Employees
• Database Backup Interval
• Closing File Defaults (closer, signatory, underwriter, prepared by)
• Buyer and Seller number of witnesses for documents
• User Settings
• Escrow Accounting
• Serialized Forms

Refer to your copy of the DoubleTime Installation Guide for complete 
instructions.

Creating Defaults And Selection Lists
Follow the procedures below to create your own defaults and selection lists in 
DoubleTime.

Setting Up What You Do
Contacts

1. On the main toolbar, click the Contacts 
button.

2. Select the appropriate Contact Type for 
your office. Note: Select Contact Type
“All” to find your office name.

3. In the Name box, type the first few letters 
of your office name until it is highlighted in 
blue in the lower half of the Select 
Contact window.

4. Click OK. The Contact window displays 
your office information. 
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Setting Up
5. Verify the spelling of your company name 
and your Federal EIN number. Your 
Status is Active and that check box should 
remain selected.

6. Click the Employees, Partners, or 
Associates tab (tab name depends on 
Contact type).

7. Click the Insert button to add the 
names of employees in your office. The 
Select window is displayed. The default 
Type is Individual.

8. In the Name box, type Last, First, and 
Middle names. Select Suffix if applicable. 
Type the Social Security No. if desired.

9. Click the New button. The Select window 
is closed and the individual’s name is 
displayed on the Employees, Partners, 
or Associates tab (tab name depends on 
Contact type).

10. Select the appropriate Title. If the individual 
is authorized to sign documents, select the 
Sign? check box.

11. Click the Services tab. Closing Agent
and/or Title Agent check boxes will be 
checked if previously selected. If Title 
Agent is selected, the Underwriter box is 
displayed. Note: If another underwriter you 
need is not listed, enter the underwriter 
name in the Contact module as a 
Corporate contact. 

Click the Insert button to add more 
underwriters.

12.  Click the Close button. The Save
window is displayed. Click Yes.

Setting Up What You Do
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13. On the main toolbar, click the 
Contacts button.

14. In the Name box, type the Last name of the 
employee who is a notary and click OK.

15. Click the Notary Expiration Date box 
and type the notary expiration date for the 
selected employee. Note: Click the Open
button on the secondary toolbar to select 
additional names and repeat steps 13 - 16 to 
add the notary expiration date. If no 
additional notaries are to be identified, 
proceed to the next step. 

16.  Click the Close button. The Save
window is displayed. Click Yes.

Note: Below is a list of some of the Underwriter 
Contacts provided with DoubleTime

American Pioneer Title Insurance Company 
Attorneys’ Title Insurance Fund, Inc.

Chicago Title Insurance Company
Fidelity National Title Insurance Company of Pennsylvania

Fidelity National Title Insurance Company of Tennessee
First American Title Insurance Company

Lawyers Title Insurance Company
Nations Title Insurance of New York, Inc.

Old Republic National Title Insurance Company/AFTS
Old Republic National Title Insurance Company

Stewart Title Guaranty Company
TICOR Title Insurance Company 

Setting Up What You Do
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Preferences 1. On the main toolbar, select Preferences. 
The following choices are available.

•  Office Settings
• Account Maintenance
• Custom Variable Setup
• Document Customization
• Notary Customization
•  Change User Name
• Delete User Name
• User Login
• Change User Password
• Security Administration
• Reset Admin/User Password
• User Settings

2. In Office Settings, establish the Office 
Information (for example, phone number 
and Federal EIN number). Notary, 
Recording, Backup, My Website, and
Escrow Accounting information are also 
entered.

3. In Account Maintenance, insert or delete 
trust/escrow accounts used by your office. 
Note: If an account you no longer use is 
associated with a closing file, click the 
Inactive check box. You will not be able to 
select the account for future files.

4. In Custom Variable Setup, create 
variables for use in the Documents
module.

5. Use Document Customization to 
customize documents for selection in the 
Documents module.

6. Use Notary Customization to customize 
notary block information for documents.

7. In Change User Name, type a specific 
name to define individual User Settings in 
Preferences.

8. In Delete User Name, delete a user name 
that is no longer used in DoubleTime.

Setting Up What You Do
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Setting Up
9. In User Login, log into DoubleTime or 
certain areas of DoubleTime.

10. In Change User Password, change the 
password that you use to log into 
DoubleTime.

11. In Security Administration, set up the 
rights that a certain user name will have in 
DoubleTime.

12. In Reset User Password, reset a 
password that has been misplaced or 
forgotten.

13. In User Settings, select email format, 
closing file defaults, buyer and seller 
number of witnesses, HUD settings, and 
accounting software. 

14. Click the Save button for each 
selection in Preferences.

Note: Preferences and Contacts are used to 
change the defaults and selection lists for 
Closing Agent, Title Agent, Prepared By, 
and Underwriter that were previously selected.
This information is available when you open 
new closing files.

Setting Up What You Do
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Serialized Forms 1. On the main toolbar, select Modules.

2. Select Serialized Forms and choose 
Create Forms Inventory. 

3. Select the appropriate Underwriter, 
Agent, and Form Type.

4. Press the Tab key to move to the Prefix
box. If the Underwriter is Old Republic 
Title Insurance Company/ATFS, a form 
prefix will automatically be displayed. For 
other underwriters, type the prefix.

5. Press the TAB key to move to the Start No
box and type the first form number. 

6. Press the TAB key to move to the End No
box and type the last form number.

7.  Click the Close button. The Save
window is displayed. Click Yes.

Note: Serialized forms can be used in the 
Title Insurance Commitment and Title 
Insurance Policy modules. Note: Old 
Republic National Title Insurance Company/
ATFS commitments are no longer serialized.

Click the Reports button to generate a 
serialized forms inventory report. Note: Fund 
policy numbers can be assigned electronically 
when using the Electronic Delivery process in 
Commitment and Premium Calculation 
(Rating) module. Then the corresponding 
jackets will be available for printing in the 
Documents module. For more information, 
please see Tutorials within DoubleTime Help.

Setting Up What You Do
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Master Properties 1. On the main toolbar, click the Master 
Property button.

2. In the Master Property Search 
Selection window, select the type of 
property, then click New.

3. In the General Information tab, type the 
property information.

4. Click the Recording tab, and type the 
recording information.

5. Click the Exceptions tab.

6. Click the Insert button.

7. Press the TAB key to move to the 
Description box and type your own 
exceptions or

  Click the Clause Library button to select 
Exceptions.

8. Click OK.

9.  Click the Close button. The Save
window is displayed. Click Yes.

Note: Master properties can be selected in the 
Closing File module on the Property tab. 
Exceptions are copied to the Title Insurance 
>Commitment and Title Insurance > 
Policy modules.

Maintenance (Lists) 1. On the main toolbar, select Modules.

2. Select Maintenance (Lists). 

3. Select Line Description (Settlement 
Statement) and click OK.

4. Select the Settlement Statement format.

Setting Up What You Do
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5. To edit a line description, click it and type 
the new description. 

To add a new description, click the 
Insert button. In Line Description, type 
the new description. Press the TAB key to 
move to Closing Statement Section. 
Type the section.

6.  Click the Close button. The Save
window is displayed. Click Yes.

. Note: The Maintenance (Lists) module 
enables you to add or edit Settlement Statement 
descriptions for use in any closing file. You can 
also add to or edit other lists in DoubleTime.

Setting Up What You Do
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User-Defined Clauses 1. On the main toolbar, select Modules.

2. Select Clause Library Maintenance. 

3. Select a clause type in the Clause Type 
box and click New.

4. Type the clause title in Clause Title. Press 
the TAB key to move to Clause. Type the 
clause text.

5.  Click the Close button. The Save
window is displayed. Click Yes.

Note:  Click the Clause Library button in 
any closing file to select user defined clauses.

Document Customization 1. On the menu bar, click Preferences/
Document Customization.

2. Select a DoubleTime master document that 
is similar to the one you want to create. 

3. Type the new master document name and 
click OK.

4.  Make the required changes to the document 
or 
copy a document from your word processor 
and paste it into a DoubleTime document. 
Insert variable fields in your document.

5.  Click the Close button. The Save 
Changes window is displayed. Click Yes.

Note: Custom documents can be selected in any 
closing file.

Setting Up What You Do
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User Defined Checklist 
Templates

1. On the main toolbar, select Modules.

2. Select Checklist, then Template 
Maintenance.

3. Select a DoubleTime standard template that 
is similar to the one you want to create. 

4. On the menu bar, select File, then Save As. 

5. Type the new checklist template name and 
click OK.

6.  Click the Close button. 

Note: User-defined checklist templates can be 
selected in any closing file.

Setting Up What You Do
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ATIDS Integration
 ATIDS Integration 

Introduction
ATIDS Integration is a support transaction which allows the display of property and 
name information on the screen. This information is very helpful when trying to 
determine the parties on a property or name document or to view which legal 
description a property document is posted to the ATIDS system. Once the transaction 
is performed your legal description will then automatically default for all of your 
search transactions. A file must be established in DoubleTime to use the ATIDS 
Integration. 

Note: For this lesson we will use file number 04-0045.

Look Up Legal Description

What You Do Comments

1.  In the Closing File
module’s secondary
toolbar, click the ATIDS 
Integration button.

The eSolutions ATIDS Integration wizard 
is displayed. 

2. Click the Look Up Legal 
Description option.
Page 752 DT Version: 8.1



ATIDS Integration
3. Click the Next button. The FundNet Login window is displayed.

4. Enter your User ID and 
Password and click 
Next.

The FundNet User ID and Password 
defaults from selecting the Remember my 
Password option when setting up the 
ATIDS tab in User Settings.
The ATIDS Initial Request window is 
displayed as it connects you to ATIDS.
The Look Up Legal Description window 
is displayed.
Note: The county defaults to Palm Beach 
county. This information is carried over from 
the Property tab in the Closing File
module.

What You Do Comments
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5. In the Book Number
box, type 11841.

6. In the Page Number box, 
type 765.

This is the OR Book and Page number of the 
deed for Jean Luc Leblanc and Francine 
Leblanc.

What You Do Comments
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7. Click the Next button. The Look Up Legal Description window 
is displayed, showing how this document is 
posted in ATIDS. Note: The legal description 
to be searched is automatically selected.

8. Click Print.  

9. Click Finish. The Welcome to DoubleTime’s ATIDS 
Integration window is displayed.

What You Do Comments
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Prior Policy Search
This transaction is used to search for prior Fund title policies in subdivisions and 
condominiums. Corresponding plat information is displayed along with the number of 
policies found, if any. Prior Fund policies are indexed from 1948. Prior policies are 
available only when you open a Title Yes file.

What You Do Comments

1. Select the Prior Policy 
Search option.

 

2. Click Next. The Fundnet Login window is displayed.

3. Click Next. The ATIDS Initial Request window is 
displayed as you are connected to ATIDS.
The Prior Policy Search window is then 
displayed. The legal description to be 
searched is automatically displayed. The 
information is carried over from your Look 
Up Legal Description Search.
Note: If the Look Up Legal Description 
Search transaction was not performed, the 
Source of Plat would default to Plat Book 
and the County to Palm Beach, and you 
would manually type the legal description. 
Click Insert to search additional legals.
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ATIDS Integration
The Search From Date defaults to 01/01/
1900 and the Search Through Date
defaults to today’s date.

4. Click the Next button. The Prior Policy Search Criteria window 
is displayed with detailed policy information. 
Note: A separate option is available to order 
prior policies once you have performed your 
property search. 

What You Do Comments
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Add Or Change An ATIDS File
This transaction is used to add an ATIDS file. A separate file number must be added 
for each new closing transaction. The proper bill code must be assigned to the file in 
this transaction. This transaction also allows the change of certain file related 
information.

5. Click Print.

6. Click Finish. The Welcome to DoubleTime’s ATIDS 
Integration window is displayed.

What You Do Comments

1. Select Add or Change an 
ATIDS File.

 

2. Click Next. The Fundnet Login window is displayed.

3. Click Next. The ATIDS Initial Request window is 
displayed as it connects you to ATIDS.
The Add or Change File window is then 
displayed.
The Function box automatically defaults to 
Add when this transaction is initially 
performed. After the file has been added, the 
Function box will default to Change.

What You Do Comments
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Property and Name
This transaction generates a printout of a document reference information found for 
the legal description(s) searched. Only documents containing a legal description are 
obtained from this option. Examples of document types include deeds, mortgages, 
assignments, and satisfactions of mortgages. This option allows you to search property 
records for two types of legal descriptions: Platted legal descriptions such as 
subdivisions and condominiums and acreage legal descriptions (unplatted land).

4. Click the Ordered By box 
and type your name. 

 The Ordered By box is required and will 
appear on your account’s billing activity. 

5. Click the Description box 
and type Leblanc/Realistat 
Realty.

The Description box is also required and 
will appear on your account’s billing activity. 

Note: The option, Do you propose to 
issue a title insurance endorsement/
policy on Old Republic National Title 
Insurance Company/ATFS on this 
transaction?, defaults to Yes. This 
information is carried over from selecting 
FUND as the underwriter in the Closing File
module.
The Bill Code defaults to Title Search. 
This code also determines the results of the 
property search and the cost of the file.

6. Click Next. The ATIDS file is added.

What You Do Comments

1. Click the Property and 
Name Search option.

 

2. Click Next. The Fundnet Login window is displayed.

3. Click Next. The ATIDS Search Request window is 
displayed as it connects you to ATIDS. The 
Search and Delivery Options window is 
displayed.
Note: The Search option defaults to 
Property and the Delivery option defaults 
to Send to Document Order Queue and 
Send to ATIDS XE.

What You Do Comments
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4. Click Next. The Property Search Information
window is displayed. The property search 
information is automatically displayed. This 
information is carried over from the Look Up 
Legal Description Search. 
Note: If the Look Up Legal Description 
Search transaction is not performed, the 
Source of Plat defaults to Plat Book and 
the County defaults to Palm Beach. Type 
the legal description. Click the Insert button 
to search any additional legals. 
If you have an unplatted legal description, 
select the Acreage tab.

What You Do Comments
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5. Click the From Date box and 
type 6152000.

The effective date of the prior policy was 
retrieved from the Prior Policy Search. 
This policy can be used as your base.

6. Click the Next button. The Through Date automatically defaults to 
the certification date on the ATIDS system. 
The Property/Name Search Request 
window is displayed as you are connected to 
ATIDS. 
The Search Results window is displayed.

What You Do Comments
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Name Search
This transaction is used to perform searches on personal names and/or commercial 
names. Name-related documents do not contain legal descriptions. A name search 
finds recorded documents such as judgements, divorces, probate, and federal tax liens.

7. Click Print.

8. Click Finish. Note: The condensed printout now has a 3/4-
inch header to allow room to punch holes for 
filing. The instruments are no longer split 
between pages; they are separated by divider 
lines, which allow for easy reading.
The eSolutions ATIDS Integration 
Search window is displayed.

What You Do Comments

1. From the eSolutions ATIDS 
Integration Search 
window, click the Name 
Search option.

 

What You Do Comments
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2. Click Next. The Fundnet Login window is displayed.

3. Click Next. The Name Search window is displayed.

The County automatically defaults to Palm 
Beach. 
The buyer and seller names also default on 
both the Personal and Commercial Name
tabs. This information is carried over from the 
Buyers and Sellers tabs of the Closing 
File module.
Note: Click the Options button for more 
search options.

4. Click the Commercial 
Name tab and then click the 
Variations button. 

The Connecting to ATIDS window is 
displayed, asking if you want to proceed. 

5. Click Yes. The Name Search Variation Results
window is displayed.
Note: Select any name variations you wish to 
search.

6. Click OK. Note: If adding additional names, click the 
down arrow in the Role Type field and select 
the appropriate role for the entity.

What You Do Comments
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7. Click Next. The ATIDS Search Request window is 
displayed as you are connected to ATIDS. The 
Search Results window is displayed. If you 
have an unplatted legal description, select the 
Acreage tab.
Note: Select the Commercial tab to view the 
Search results for Realistat Realty.

8. Click Print. Both the Personal and Commercial search 
results are printed.

9. Click Finish. The eSolutions ATIDS Integration 
Search window is displayed.
Note: Personal names and commercial names 
are displayed on separate printouts.

10. Click Back. The eSolutions ATIDS Integration 
Welcome window is displayed.

What You Do Comments
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Order Prior Policy
This transaction is used to order a hard copy of a prior Fund policy when issuing an 
Old Republic National Title Insurance Company/ATFS policy. A copy of the prior 
Fund policy is faxed to the member. A TITLE yes file must be opened.

What You Do Comments

1. Click the Order Prior 
Policy option.

 

2. Click Next. The Order Prior Policy window is 
displayed.

3. In the Phone box, type 
(your phones number).

4. In the Ordered by box, type
(your name).

5. In the Fax Number box, 
type 4072401106.

Prior Fund policies are faxed to the member’s 
office.

6. Click the Select box in 
Select Prior Policy next to 
the OPM.

Note: Whenever possible, use the Owner’s 
Policy as the base title. If a prior Owner’s 
policy is not available, then use a prior 
Mortgagee Policy. However, the Search From 
Date on the property search performed will 
need to start from the date of the deed into the 
mortgagor.
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Order Document Hard Copies
This transaction is used to order hard copies of documents that were found as a result 
of the property or name searches. This transaction also allows you to order documents 
related to the closing file that were not found in the original searches. The Order 
Document Hard Copy transaction has a variety of delivery methods, such as: 
branch delivery, fax, mail, electronic delivery, etc. 

7. Click Next. The ATIDS Order Prior Policies window 
is displayed as you are connected to ATIDS.
The Prior Policy Order Confirmation
window is displayed.

8. Click Print.

9. Click Finish. The Welcome to DoubleTime’s ATIDS 
Integration window is displayed. 

What You Do Comments

1. Click the Order Document 
Hard Copies option.

 

2. Click Next. The FundNet Login window is displayed.

What You Do Comments
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3. Click Next. The ATIDS Initial Request window is 
displayed as you are connected to ATIDS and 
retrieves your documents.
The Document Hard Copy Selection
window is displayed.
The Order information is carried over from 
the Prior Policy Order request.

4. Click the Select Property 
Documents button.

The Select Property Documents window 
is displayed.

What You Do Comments
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5. Click the Select boxes for 
the desired Property 
Documents.

6. Click Close. The Document Hard Copy Selection
window is displayed.

7. Click Select Name 
Documents.

What You Do Comments
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8. Click the Select boxes for 
the desired Name Documents.

Note: Scroll down to view all searched names.

9. Click Close. The Document Hard Copy Selection
window is displayed.

10. Click Additional Search 
Related Documents.

The Additional Search Related 
Documents window is displayed.

What You Do Comments
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11. Click the Primary 
Reference Source drop 
down list and select Plat 
Book.

12. Click the Book box and type 
29, then press TAB and type 
196.

Click Insert for any additional documents 
needed.

13. Click Close.

14. Click Next. The Hard Copy Request Confirmation
window is displayed.

15. Click Finish.

What You Do Comments
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Property / Name Search Update
The Update transaction allows you to update your property and name searches from 
your initial search with a single click. A property and name update search is performed 
prior to the closing and again prior to issuing the final title policy. This transaction will 
only show property documents that posted since your last search. 

What You Do Comments

1. From the Welcome to 
DoubleTime’s ATIDS 
Integration window, click 
Property and Name 
Search. 

 

2. Click Next. The FundNet Login window is displayed.

3. Click Next. The ATIDS Search Request window is 
displayed as you are connected to ATIDS.
The eSolutions ATIDS Integration 
Search window is displayed.

4. Select Update. The Order information is carried over from 
the Prior Policy Order request.

5. Click Next. The Property Name Search Update
window is displayed.

6. Click Next. The FundNet Login window is displayed. 
Note: The legals and names from your 
previous searches automatically default and 
are selected for you.
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7. Click Next. The ATIDS Search Request window is 
displayed you are connected to ATIDS.  The 
Property Search Results window is 
displayed.

8. Click Next. The Name Search Results window is 
displayed.

What You Do Comments
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9. Click Print.

10. Click Finish.

What You Do Comments
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Main Toolbar
This toolbar is present at all times when DoubleTime is open.

Button Name Function (Notes)
New Closing 
File

Opens a blank file allowing a new transaction to be 
entered. (Not available unless all modules are closed.)

Open Closing 
File

Opens an existing closing file.

Switch Active 
Closing   File

Closes the currently active closing file and opens a new 
closing file. (Not available unless all modules are closed.)

Commitment Opens the Commitment module allowing the creation 
of a title insurance commitment for the new transaction.

Premium 
Calculation 
(Rating)

Opens the Rating module allowing the premium for title 
insurance to be calculated.

Policy Opens the Policy module allowing the completion of 
title insurance policies for a completed transaction.

Forms Tracking Opens the Forms Tracking module allowing the 
tracking of serialized policy forms from the underwriter.

Order Branch 
Product

Opens the Order Branch Product module allowing 
users to order Fund Branch Products within the 
application. 

View Branch 
Product Orders

Opens the View Branch Product Orders module 
allowing users to check the status of orders placed 
through the Branch Products Order wizard in 
DoubleTime. Fund Data files can be imported from the 
View Branch Products Order wizard.

Order 
PropLogix 
Product(s)

Opens the Order PropLogix Product(s) module 
allowing users to order PropLogix Products within the 
application. 

View 
PropLogix 
Orders

Opens the View PropLogix Orders module allowing 
users to check the status of orders placed through the 
Order PropLogix Product(s) wizard in DoubleTime. 
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Electronic 
Payment

Opens the Electronic Payment module allowing the 
payment of title insurance premiums to the Fund.

Settlement 
Statements

Opens the Settlement Statements module allowing 
the settlement statement to be completed.

Balance Sheet Opens the Balance Sheet module which provides a 
summary of deposits and disbursements. Allows for 
combining and splitting of disbursements as well as 
printing of mailing labels. (Payee addresses may also be 
printed directly on checks to allow for the use of window 
envelopes.)

Escrow 
Transaction 
Management

Opens the Escrow Transaction Management
module, The Fund’s accounting package, allowing for 
posting, tracking, and managing of all transactions within 
escrow accounts. Disbursement checks may also be 
printed directly from this module. (This accounting 
package is not automatically included with DoubleTime, 
your office administrator can choose to use this 
accounting package or another one. DoubleTime data can 
also be exported to external software.)

1099-S Opens the 1099-S module allowing for generating, 
tracking, electronic filing and year-end maintenance of 
1099-S forms.

Notes Opens the Notes module allowing users to create and 
save file specific notes that can be viewed by other 
DoubleTime users in the office.

Loans Opens the Loans module allowing for preparation of 
loan paperwork when required by a transaction or lender. 
Loan documents can be printed in the Documents
module.

Conveyance Opens the Conveyance module allowing for adding 
clauses to deeds, title affidavits, and bills of sale. Grantor 
and grantee information for deeds may also be modified 
in this module.

Documents Opens the Documents module allowing for the 
preparation and printing of documents such as title 
commitments, title policies, deeds, affidavits, bills of 
sale, and other closing documents.

Button Name Function (Notes)
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Secondary Toolbar
These buttons are available when the listed module(s) is open.

Contacts Opens the Contacts module, which is an electronic 
address book. Contact information may be viewed, 
modified, or added.

Master Property Opens the Master Property module allowing for the 
storing and maintenance of property information such as 
the legal description, recording information, and 
exceptions.

Checklist Opens the Checklist Template module allowing for 
the use of an electronic “to-do” list for each closing file.

Reports Opens the Reports module allowing for the preparation 
of reports using specific data such as Closing File by 
Closer or Contact List by Service Type.

Launch 
Reflection

Opens the Reflection program allowing access to ATIDS.

Fund Title 
Notes and 
Standard 
Commitment 
Clauses

Opens electronic copies of Fund Title Notes and the 
Standard Commitment Clauses manual.

Exit Closes the DoubleTime software.

Button Name Module(s) Function (Notes)
Accounting 
Export

Balance Sheet Create a file to be imported into 
accounting software other than 
DoubleTime Escrow Accounting.

Address Balance Sheet View or edit a payee’s address.

Agent 1099-S View or edit the filing agent 
information. (Available when 
viewing a specific1099-S form.)

Button Name Function (Notes)
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Amortization 
Calculator

Loans Calculate and print amortization 
schedule.

ATIDS 
Integration

Closing Interfaces with ATIDS to perform 
searches.

Automatic 
Renumber

Policy Renumber clauses on a 
commitment or policy.

Build Clause Policy Create owner or mortgagee clauses 
from the data entered. (Active only 
on the Owner, Record Mortgage, 
or Requirements tabs.)

Calculator Premium 
Calculation

Accesses the windows calculator.

Cancel Notes Allows a user to cancel a note in 
the Notes module before it has 
been saved.

Change Year 1099-S Year End 
Maintenance

View 1099-S forms for a different 
year. (Accessible only by selecting 
Modules > 1099-S > Year End 
Maintenance from the main 
menu.)

Clause Library Closing Opens the Clause Library window 
allowing you to search for and 
select clauses to be inserted into a 
document or text field.

Close All Closes the current open module.

Closing 
Statement 
Alerts

Settlement 
Statements

Indicates missing information on 
the settlement statement.

Closing 
Protection 
Letter

Closing Order a Closing Protection Letter 
electronically from The Fund.

Collapse All Checklist Displays only the top level items 
on the current checklist.

Button Name Module(s) Function (Notes)
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Combine Balance Sheet Combines deposit or disbursement 
amounts.

Commitment 
Jacket Request

Commitment Request and receive commitment 
jacket electronically.

Copy Documents Duplicate the selected text and 
place on the clipboard.

Copy 
Commitment 
Exceptions

Policy Add or replace the existing 
commitment exceptions in a 
policy.

Copy Master 
Property 
Exceptions

Commitment Copies exceptions from the Master 
Property to the commitment. (Only 
active on the Exceptions tab of 
the Commitment Module.)

Create File 1099-S Year End 
Maintenance

Combines the 1099-S records into 
an electronic file that can be sent 
to the IRS. (Accessible only by 
selecting Modules > 1099-S > 
Year End Maintenance from 
the main menu.)

Create Master 
Property

Closing Creates a Master Property
within the Closing File module. 
Exception clauses added in the 
Commitment or Policy modules 
can be exported into a Master 
Property.

Custom 
Variable Data

Closing;
Documents

Add file specific data to the 
custom variable.

Cut Documents Deletes the selected text and 
places it on the clipboard.

Delete Documents Removes the selected text.

Deposit 
Summary

Settlement 
Statements

Displays the deposit information 
for the open closing file.

Button Name Module(s) Function (Notes)
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Deselect all of 
the categories

Notes Deselects all of the categories in 
the Filter Notes window.

Electronic 
Delivery

Premium
Calculation

Submits policies, endorsements, 
and the rating worksheet 
electronically to The Fund.

Escrow 
Accounting

Balance Sheet Opens the Escrow Accounting 
module.

Excess Funds Balance Sheet Captures excess funds brought in 
by the borrower and creates a 
disbursement for the excess funds 
to the borrower.

Expand All
Checklist Displays all items on the current 

checklist.

Export Balance Sheet Prepares a file that can be 
imported into an accounting 
program.

First Page/
Record

Premium
Calculation

View the first page of a multi-page 
worksheet.

Generate 
Mailing Labels

Balance Sheet Generate labels for each payee 
with a line item disbursement on 
the open balance sheet. (Use with 
Avery 5161 labels; 20 per sheet.)

Insert Closing File;
Commitment;
Policy;
Settlement 
Statements;
1099-S; Loans;
Conveyance;
Contacts; Master 
Property;
Checklist

Creates a new blank row in the 
selected area. (Button may not be 
active on all tabs of a module.)

Insert Degree 
Symbol

Closing File;
Documents

Insert a degree symbol (°) into a 
legal description. (Only active 
when cursor is in a text field.)

Button Name Module(s) Function (Notes)
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Insert Field Documents Inserts a field into the document 
displayed at the cursor location.

Insert Name 
Clause

Closing Creates a clause identifying a party 
to the closing.

Insert New 
Level

Checklist Adds a line below the selected line 
and indented one level. Used to 
select a name clause to be added to 
the Buyer or Seller’s names.

Last Page/
Record

Premium
Calculation

View the last page of a multi-page 
worksheet.

Next Page/
Record

Premium
Calculation

View the next page of a multi-page 
worksheet.

Notepad Settlement 
Statements

Opens the Windows Notepad to 
store file specific notes.

Open Clause Library 
Maintenance;
Contacts;
Documents;
Loans;
Maintenance 
(Lists); Master 
Property;
Premium 
Calculation 
(Rating);
Reports;
Schedule 
Closing;
Serialized Forms

Opens a new document, file or list.

Originate 
Problem

Checklist Creates a description of a problem 
with the closing file.

Paste Documents Pastes selected text at cursor 
position.

Button Name Module(s) Function (Notes)
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Payee List Balance Sheet Add or edit a payee on the balance 
sheet.

Payoff 
Calculator

Settlement 
Statements

Used to assist with calculating 
payoff amounts. 

Premium 
Calculation 
(Rating) Quote

Premium 
Calculation

Used to estimate the premium cost 
when a transaction file hasn’t been 
opened.

Previous Page/
Record

Premium 
Calculation

View previous page of a multi-
page worksheet.

Print Closing File; 
Premium 
Calculation 
(Rating); 
Settlement 
Statements; 
Balance Sheet; 
1099-S; 
Conveyance; 
Documents; 
Reports

Prints the current document, 
statement, worksheet, or report.

Print Preview Documents Displays a document as it will be 
printed.

Recording 
Calculator

Settlement 
Statements

Assists with calculating recording 
charges by entering the number 
pages contained in the instrument 
to be recorded. (Only active on the 
Recording tab.)

Refresh Documents Redisplays the module after 
information has been added or 
changed.

Replace Field 
with Text

Documents Converts a data field into the text 
named in the data field label.

Reply Notes Allows users to reply to existing 
notes in the Notes module.

Button Name Module(s) Function (Notes)
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Re-retrieve 
Product From 
Fund Services

View Branch 
Product Orders 

Allows users to re-retrieve branch 
product orders that have new 
information.

Rulers On/Off
Reports Toggle between displaying or 

removing the rulers along the side/
top of document window.

Save All Retains the changed or added data.

Search Contact Settlement 
Statements; 
Conveyance

Opens the search contact 
window allowing the addition or 
choosing of a contact.

Select all of the 
categories

Notes Selects all of the categories in the 
Filter Notes window.

Set Document 
Options

Documents Rename a document or select the 
paper size.

Show Payee 
Address 
Information

Balance Sheet Displays/Hides the address for a 
selected payee.

Signature/
Notary

Closing; 
Documents

Allows modifications to the 
signature and Notary blocks, such 
as number of witnesses, and names 
of witnesses and Notary. (Only 
available in Closing Module after 
the Buyer and Seller tabs have 
been completed.)

Sort Reports Arrange the report information in 
either ascending or descending 
order.

Spell Check All Check highlighted text for spelling 
errors. (Active only when cursor is 
in a text field.)

Split Balance Sheet Divide the amount of a deposit or 
disbursement between two or more 
parties.

Button Name Module(s) Function (Notes)
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Template 
Maintenance

Checklist Opens the Checklist/Template 
Maintenance module.

Title Premium 
Allocation

Settlement 
Statements

Opens Title Insurance 
Calculator for the county in 
which the property is located. 
Allows a Payor to be changed 
from the default settings for the 
county. 

Undo Edits Documents Reverses the last action performed.

Undo Combine Balance Sheet Return the combined deposits or 
disbursements to individual 
amounts.

Undo Split Balance Sheet Return the split deposit or 
disbursement amounts to the 
original amount.

Update Lender Closing Changes or adds new information 
to the lender listed for a particular 
loan.

Update Order 
Status

Order Branch 
Product

Refreshes the Branch Product 
Order Search window by 
automatically connecting to The 
Fund and checks for any Branch 
Product orders that were waiting 
for pickup, and delivers them.

Use Legal 1099-S Forms Toggles the 1099-S field 3 
between the property address and 
property legal description; either 
may be used on the 1099-S form. 
(Available only when a specific 
1099-S form is displayed in 
DoubleTime.)

View Field 
Names

Documents Reveals the names of any merged 
fields in the document.

View Record 1099-S Displays the 1099-S form for the 
open closing file.

Zoom Reports Reduce or enlarge the displayed 
report.

Button Name Module(s) Function (Notes)
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Appendix 3 - DoubleTime Express Policy Checkout 
Reference Guide

 POLICY MODULE
The Policy module allows you to enter information such as serialized numbers, effective date, and 
time. Any information entered in the Commitment module will automatically flow into this module 
such as owner, lender, dollar amounts, and exceptions.

Note: Users must first be setup in the Fund’s website (www.thefund.com) in order to be able to 
transmit Policies & Endorsements electronically. 
Note: See The Fund Concept article Shortcut To The Finish Line: Fund Introduces ‘Policy - 
Express Checkout’ by Philip A. Holtsberg in the January 2014 issue for more detail on this 
efficient process. 

STEPS TO ISSUE OLD REPUBLIC NATIONAL TITLE INSURANCE COMPANY 
POLICIES AT CLOSING THROUGH ATTORNEYS’ TITLE FUND SERVICES, LLC: 

Process Steps

1. Select the Policy module in DoubleTime.

2. If Issuing an Owner’s Policy, select the Owner’s tab. Ensure that the 
displayed information is correct. Make any changes necessary. In the Date 
of Policy fields enter the date and time as the date and time of the funds 
disbursement.  A date is required; however, a time is not required. If no time 
is entered the system will put in a default time of 12:00am.   Most people use 
9:00am. 

3. Select the Record Deed tab. Recording information does not need to be 
entered.

4. Select the Owner Exceptions tab. Review, add or edit any owner exceptions 
as needed.

5. Select the Endorse Owner tab. No action is required. If owner endorsements 
were selected in the Commitment module then selecting this tab will deliver 
the endorsements to the Document module. 

6. If Issuing an Owner’s Policy only and you do not electronically transmit 
your policies you may proceed to step 12 to obtain policy jackets. If your 
policies are completed and you are ready to electronically transmit your 
policies to The Fund you may proceed to step 15 to obtain policy jackets.
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7. If issuing a simultaneous Mortgagee Policy, select the Mortgagee tab. 
Ensure that the displayed information is correct. Make any changes 
necessary. Proceed to step 9 Record Mtg tab.

8. If issuing a Mortgagee Policy only, select the Mortgagee tab. Ensure that the 
displayed information is correct. Make any changes necessary. In the Date 
of Policy fields enter the date and time as the date and time of the funds 
disbursement.  A date is required; however, a time is not required. If no time 
is entered the system will put in a default time of 12:00am.   Most people use 
9:00am. 

9. Select the Record Mtg tab. Recording information does not need to be 
entered.  Select the Build Mortgage Description button located on the 
secondary toolbar. Since no recording info has been entered DT 
automatically types in the language “… dated 1/15/2014 to be recorded in 
the Public Records of Orange County. Florida, which encumber the land” in 
the Mortgage Description field.

10. Select the Mtg Except tab. Review, add or edit any mortgagee exceptions as 
needed.

11. Select the Endorse Mtg tab. No action is required. If mortgagee 
endorsements were selected in the Commitment module then selecting this 
tab will deliver the endorsements to the Document module.

12. If you DO NOT electronically transmit your policies use the following steps 
to obtain policy jackets. While in the Policy module select the Policy Jacket 
Request button located on the secondary toolbar. A wizard will open that 
will assist you in electronically requesting policy jackets from The Fund. 
The jackets will be delivered to your Document module.

13. Select the Close button located on the secondary toolbar. The Policy module 
will be closed.

14. Select the Document module. All schedules, endorsements and jackets are 
available to be printed. 

15. If your policies are complete and you are ready to electronically transmit 
your policies to The Fund use the following steps to obtain policy jackets. 
Select the Premium Calculation (Rating) module.

16. Select the Electronic Delivery button located on the secondary toolbar. A 
wizard will open that will assist you in electronically requesting policy 
jackets and delivering your completed policies and worksheet’s to/from The 
Fund. The jackets will be delivered to your Document module. 

Process Steps
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17. An invoice will appear and you may use the print button at the bottom of the 
window to print the invoice. Send your check along with this invoice to The 
Fund. 

18. If you pay your policy premium electronically select the Next button at the 
bottom of the wizard. Follow the directions in the wizard to complete your 
electronic payment.

19. To exit the wizard select the Close button located at the bottom of the wizard 
window.

20. Select the Close button located on the secondary toolbar. The Premium 
Calculation (Rating) module will be closed.

21. Select the Documents module. All schedules, endorsements and jackets are 
available to be printed. 

22. Be sure to generate the Fund Policy Privacy Notice to be given to the 
insured with the Owner’s Policy.

Process Steps
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DoubleTime has the features needed to easily create an end-of-year data file for all of 
the 1099-S transactions. Once the file has been created, it can be electronically 
uploaded to the IRS computer system via their FIRE (Filing Information Returns 
Electronically) system. Submitting electronically eliminates the need to re-type 1099-
S forms manually after each closing. This saves a tremendous amount of time when 
reporting annually to the IRS.

STEPS TO FILE 1099-S RECORDS 
ELECTRONICALLY WITH THE IRS

1. A Transmission Control Code (TCC) must first be obtained from the 
IRS before you can file electronically. In order to obtain a TCC, you must 
complete the IRS Form 4419 (available from the IRS and its website). The 
form can be opened in your web browser by linking to: www.irs.gov/pub/
irs-fill/f4419.pdf. This form must be completed, signed and mailed or faxed 
to the IRS. Their fax number is (toll free) 877-477-0572 or 304-579-4105, 
but DO NOT do both (faxing and mailing). Make sure to include a cover 
sheet. The IRS will then assign a unique 5-digit TCC to identify your 
Company/Firm as the reporting agent. By faxing in the completed form, it 
takes less than 30 days to receive your TCC number from the IRS. The 
number will be mailed back to your office in a letter form.

2. After receiving your 5-digit TCC from the IRS, it must then be entered into 
DoubleTime. From the Menu Bar, click on Preferences > Office 
Settings. You will see a designated field for the entry of your TCC
number. This is a onetime setup for all 1099-S being reported whether 
transmitting files closed under an Attorney’s name or under a Title Company 
owned by the Attorney.

3. For each closing file in DoubleTime that requires a 1099-S, you must 
access the 1099-S module and make sure to click YES when asked to save 
when exiting the module. Saving is what actually creates the 1099-S for the 
file. See page 214 in this workbook for detailed instructions.

4. At this point, the user can transmit the FILE to the IRS.
• The FILE can be uploaded to the IRS FIRE system via internet at http://
fire.ire.gov. 
• The FILE must be uploaded via the website no later than March 31.
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5. Internal Revenue Service contact information is shown below. They can 
answer all questions regarding electronic filing. They can also explain the 
steps needed to upload your FILE into their FIRE system.

Internal Revenue Service Enterprise
Computing Center – Martinsburg
Information Reporting Program

230 Murall Drive
Kearneysville, WV 25430

PH: 866-455-7438 Time: 8:30 a.m. to 4:30 p.m. EST

STEPS TO FILE 1099-S RECORDS 
ELECTRONICALLY WITH THE IRS
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The Florida Title Insurance Data Call requires all Florida Licensed Title Agents to 
capture certain information regarding their practices’ income and expenses. This effort 
became effective January 1st, 2014 and will be an annual report to the state for their 
determination of a fair promulgated rate for title insurance. As agents earn up to 70% 
of the premium, the agents’ activities and financial picture must be understood by 
regulators to ensure that the rates are fair to consumers and that title agencies earn a 
rate of return on their capital. Quality information on the financial requirements of title 
insurance agents is critical to the state’s ability to set fair rates.
The Data Call consists of four parts. 
1. The Florida Agent Statistical Plan - The Florida Agent Statistical Plan contains 98 
data elements. It includes sections labeled General Information, Agency Information, 
Risk Assumption, Income, Expenses, Direct Agency Loss and Loss Avoidance 
Expenses.
Agents’ sources of information for the data elements:
a) As identified in the General Information section, 39 of the data elements are to be 
drawn from the title agency’s tax returns.
b) DoubleTime will generate reports to provide the information for data elements: 30, 
31, 32a, 32b, 32c, 36, 37a, 37b, 37c, 37d, 38, 39, 40, 41, 42 and 48.
c) The remaining 49 data elements in the Statistical Plan portion are not routinely 
captured by closing software. Most are business expenses that are not detailed on tax 
returns. Some elements are specific business practice questions that must be tracked 
through the year. For example, line 34 asks agents to identify the number of searches 
they have acquired that include suggested or draft exceptions, how many do not, how 
many searches are acquired from a third party vendor and how many are conducted by 
an employee. 
2. Schedule A - Schedule A contains six short answer questions primarily seeking 
information about the underwriters, abstractors and software providers an agent does 
business with. 
3. Schedule B - Schedule B seeks to identify the amount of time title agency 
employees spend on search functions, primary title functions and closing services 
together with the cost of performing the functions. Schedule B contains fields labeled 
with Roman numerals and letters. Agents are only required to respond to the 5 fields 
identified with Roman numerals. The fields identified with letters are meant to be 
examples of the activities to be captured in the Roman numeral fields.
 4. Schedule C - Schedule C requires agents to report the premium and number of 
transactions insured by the type of interest insured (owner, first mortgage, junior 
mortgage or leasehold), amount of the policy (among 5 amount levels) and rating 
(reissue mortgagee, reissue owners, substitution, new home discount and 
simultaneous). DoubleTime will provide reports providing all of this information. 
Schedule C also seeks information on any losses the agency paid. Agents will need to 
keep such information separately.  DoubleTime does not track any of the losses paid 
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by your agency. This information will need to be tracked separately by your 
agency.
NOTE: To ensure DoubleTime will produce accurate Data Call reports, the 
following nine items have been identified that will require your attention: 
1. Closing File Status - For every closing that has been successfully completed, 
change the Closing File Status in the Closing File module under the General Tab to 
‘Closed’.  If the file is no longer valid, set the Closing File Status to ‘Cancelled’.   

2. Policy Status – If a physical policy jacket was obtained from the Forms Control 
department and the policy is no longer valid, set the policy Form Status to “Canceled” 
in the Serialized Forms tracking module.

For detailed instructions refer to the Forms Tracking Module in the Additional 
Features section of the DoubleTime workbook.
3. Issue Date on Policies - Be sure to enter a Date of Policy and Issue Date for each 
policy in the Title Insurance Policy module under the Owner and/or Mortgagee tab. 
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4. Residential 1-4 Indicator - For Residential or Non-Residential, make sure the 
Residential 1-4 checkbox in the Premium Calculation (Rating) module is set correctly 
under the General Information tab. 

5. Type of Estate - For leasehold policies, make sure the Type of Estate is set to 
Leasehold in the Title Insurance Commitment module under the General tab.

6. ePayments - If you do not use the DoubleTime Electronic Payment feature, the 
Premium Remitted value will not be available for reporting and will need to be 
obtained manually. 
7. Rebate Amounts - You must include the text Butler Rebate in the Closing 
Statement description for DoubleTime to find the Rebate Amounts for the report. 
8. Construction Loan Update Endorsements - At or before the closing for a 
Construction Loan, select the Construction Loan Update Endorsement(s) that will be 
issued in the Title Insurance module under the Endorse Policy tab and enter the issued 
date. 
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9. Duplicate Title Agent Contacts - Verify that duplicate title agent contacts do not 
exist by going to the Closing File module and checking the Title Agent tab.  Having 
duplicate Title agent contacts may produce incomplete Data Call statistics if some 
closings are associated with one instance or another.  Duplicate title agent contacts can 
be inactivated in the Contacts module but the files they were previously associated 
with will need to be changed to show the active title agent contact.    

DoubleTime’s Data Call module can be accessed by selecting ‘Modules’ on the top 
menu bar and then selecting ‘Data Call’.
On the ‘Data Call Criteria’ window, different search criteria can be selected to generate 
reports.  The search criteria includes: 
 • Title Agent – If multiple title agencies exist in your database, the Data Call reporting 
will need to be run for each contact.   
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• Residential or Commercial – Checking the ‘1-4 Residential’ box will provide data on 
all residential closings.  Unchecking the ‘1-4 Residential’ box will provide data on all 
commercial closings. 
• Year – DoubleTime will provide data for the selected year. 
• Date Range – DoubleTime will provide data for the given date range. 

On the ‘Data Call’ report window, the top portion of the data pertains to Part 1- The 
Florida Agent Statistical Plan.  The bottom portion of the data pertains to Part 4 – 
Schedule C.   
Double clicking on the information bubble next to the ‘Risk Assumption/Income 
Description’ will display the instructions for that data element. 
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Double clicking on the value next to the ‘Risk Assumption/Income Description’ will 
display detail information for that data element.  The detail information can be printed 
as a separate report. 
Selecting the Print button or the Print option from the File menu will generate a report 
printout of all data currently being displayed in the Data Call module. 
For more information on the Florida Title Insurance Data Call, please contact The 
Fund’s Risk Management department at 1-800-336-3863.  For more information on 
using the DoubleTime Data Call module, please contact The Fund’s Help Desk at 1-
800-421-9378.
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